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In the present age of globalised competition, Information and Communication Technology has enormously 

influenced every sphere and established itself as an integral part of our life. 

Kips, with its vast experience in School Computer Education, has designed the books for the Vocational 

course of class IX(Level 1) and class X(Level 2). It has been done by keeping in viewthe latest changes in this 

ever-growing field. The book with its lucid writing style and the latest interactive teaching techniques 

emphasises on Tool based learning. Books IX and X are free from rote learning and enables even a below-

average student to understand the concepts quickly and motivates him to learn in an interesting and a 

better manner. 

CONTENTS AND KEY FEATURES 

The book is based on the guidelines given by National Skills Qualifications Framework (NSQF) and caters to the 

latest syllabus prescribed by CBSE forSubject Code 402. 

This book introduces the students to the basics of Employability Skills. Besides providing the basics of 

Keyboarding Skills, the book also covers Office Tools -Writer, Impress, and Calc using Libre Office. 

Objective and Subjective exercises have been incorporated in this book to impart knowledge based learning. 

To enhance the practical aspects of the theoretical knowledge, Lab Activities have been given at the end of each 

session. 

Practically, this book provides every ingredient to kindle scholastic and co-scholastic urge within a students 

which is an effortto incorporate holisticeducation in theschool curriculum. 

We are quite optimistic that this book will prove to be a boon to the students and will serve as a perfect teaching 

and learning tool for both the students and teachers. 

To improve this book further, suggestions are welcome at info@kips.in. 
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EEDBC' 
Sender Receiver 

(Individual or Group) (Individual or Group) 

UNIT - I: Communication Skills 

CHAPTER 

Communication Cycle 
Communication is the process of transferring or sharing of information between two or more people. It is a two-way 

process of reaching mutual understanding, in which participants not only exchange information, news, ideas, and 

feelings but also create and share a new meaning. 

The scope of communication is not limited to only two or more people, instead, it involves the whole society. Man is a 

social animal, and he cannot remain in isolation. It is his basic need to interact with others. Communication is the 

foundation of all human relationships. We communicate every day with our family, teachers, friends, and pets. The need 

for communication has evolved from the stage of early humans and sign language which contributed to the development 

of verbal and written messages. We have now reached the age of satellite and computer technology which has brought 

about a revolution in the field of communication. 

II  COMMUNICATION: ATWO-WAY PROCESS 

Communication is a two-way process. Communication is not merely the 

transmission of a message; it also includes an understanding of the 

message. In this process, one person is the sender, and he conveys a 

message to another person or a group of persons who is the receiver. 

When the receiver gets the message, he sends back a response, 

acknowledging the message was received. So, effective communication 

always involves feedback from the receiver. 

An effective communication is a communication between two or more people where the intended message is 

successfully delivered, received, and understood. 

FEATURES OF EFFECTIVE COMMUNICATION 

4 Communication is a meaningful process that involves a sender and 

a receiver. While communicating, both should share a mutually 

accepted code, i.e., a common language. 

4  A message should be clear. It should convey the right meaning to 

others. 

4  Listening to others is a very important aspect of effective 

communication. 

+ Communication is a process in which there is an input and an output. A meaningful communication results in a 

response from the receiver. 

IMPORTANCE OF COMMUNICATION SKILLS 

Effective communication is essential in every sphere of life, be it personal, professional, or social. It includes all the 

aspects of visual, auditory, and body language to appeal to the listener. 

The following story illustrates the importance of clear and comprehensive communication. 

Learning
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Afather planned an urgent trip to his son's home in anotherstate. He sent an e-mail to his son. In the mail, 

he wrote 'Reach Tomorrow' instead of 'Reaching Tomorrow', by mistake. When the father reached his 

son's home, his daughter-in-law was surprised to see him because the son had already left to visit his 

father. The daughter-in-law showed him the e-mail which stated 'Reach tomorrow' instead of 'Reaching 

tomorrow'. 

The three missing letters 'ing' created miscommunication and a big confusion. 

Instead of receiving the message that the father was arriving the next day, the 

son got the message that his father was asking him to come the next day. This 

example illustrates the importance of sending (coding) a message and receiving 

(decoding) a message accurately. Miscommunication can cause serious 

problems. It can have far-reaching consequences, resulting in loss of time, 

money, trust, and mayalso impact relationships. 

IMPACTOF EFFECTIVE COMMUNICATION ON OUR LIVES 

It encourages active participation in group discussions and cohesive teamwork. 

Ithelpsin building relationships with others. 

It enables a leader to cultivate a sense of common goal among 

the team members and drive them to work in a spirited manner. 

Ability to communicate effectively builds your confidence and 

equips you to respond and articulate aptly in any situation. 

Effective communication helps in handling various conflicts or 

misunderstanding in an organisation. 

Effective communication saves time and reduces stress and 

anxiety levels. 

It fosters success in professional and personal life. 

EMENTS OF COMMUNICATION CYCLE 

mentioned above, communication is a dynamic, two-way process. The essential elements of the communication 

process are: 

Message: Information to be conveyed 

<r Encoding: Formation of the message 

+ Receiver: One who receives the message 

+  Feedback: Response 

Sender: One who sends the message 

Communication Channel: Medium 

Decoding: Interpretation of the message 

Sender —* Encoding — 

A 

Message —* Decoding —+ Receiver 

  

+ 

+ 

+ 

+ 

EL 

As 

Feedback,4 
-J 

Communication Cycle 
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Sender: A sender is an individual or a group, who has an idea or information which he wants to communicate with others. 

The sender selects the channel based on factors like nature of the message, the kind of the audience (receiver), and the 

situation. The sender becomes the source of the message. In the previously given example, the father is the sender. 

Message:  It is the encoded idea sent by the sender. The message could be verbal (written or spoken) or non-verbal (such 

as body movements, gestures, facial expressions, eye contact, tone of voice, etc.). The message in the example is what 

the father wanted to convey, i.e., 'Reach Tomorrow'. 

Encoding:  Translation of an idea into a message by the source is called encoding. The message may be encoded in any 

combination of mutuallyunderstoodwords, signs orsymbols.Thesymbolsorsigns used must be clearto both thesender 

and the receiver. While encoding a message, one needs to consider what content to include, how the receiver will 

interpret it, and how it may affect one's relationship. Thus, encoding is guided by the nature and the purpose of the 

communication as well as the relationship between the sender and the receiver. Encoding in this example is transcribing 

the e-mail. 

Communication Channel:  This is the means through 

which the message travels from the source to the 

receiver. Channels could be either oral or written. 

However, with the advancement in technology, visual 

channels are now becoming more common. The 

standard channels these days include-video 

conferencing, video chat, telephone, etc. Written 

forms include text messages, memos, letters, reports, 

e-mails, fax, etc. In the example, the message is sent 

through an e-mail which is a transmission channel. 

Receiver:  The person or group that receives the message is known as the receiver. The receiver is the one who decodes or 

interprets the message. It is important to note that the meaning of the communication is what is interpreted, and not 

what was intended. Anyerroron the part ofthe receiver may make the communication ineffective. In this story, the son is 

the receiver. 

Decoding:  It is the process of deriving meaning from the received message. The message should be worded carefully, so 

that the receiver easily understands it. If the message is encoded while keeping the receiver in mind, it will be easier to 

decode it. For example, the words and tone you choose to express your thoughts to a friend will be different from what 

you choose foryour parents and teachers. This is because you knowthey will interpret or receive the message differently. 

In the example, decoding is son's interpretation of his father's e-mail. 

Feedback:  The cycle of communication is complete 

when the sender receives the feedback from the 

receiver. Without feedback, the sender cannot confirm 

if the receiver has interpreted the message correctly. 

Feedback is also given and received to improve 

behaviour and performance. A constructive feedback 

informs and motivates people to improve themselves. 

In the given example, feedback was missing, that is why 

the communication cycle broke down in this case. 

The entire cycle of communication will start all over 

Encodes 
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Decode 
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Play Chinese whisper in the class. The teacher will whisper a phrase in the first 

student's ear, and the student will whisper the same phrase in the next 

student's ear, and so on. The last student who hears the phrase will say it out 

loud. 

+ Is the phrase told by the teacher same as the one interpreted by the last 

student? 

+ Discuss how the message changed as it travelled from one source to 

another. 

LearnIng 
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again if the sender feels that the message was not understood correctly. This can be easily understood with the given 

communication process. 

BARRIERS TO EFFECTIVE COMMUNICATION 

A brrier to effective communication is any factor, individual, 

situational, or environmental, that prevents the receiver from 

receiving and understanding the message accurately. These 

barriers can lead to misunderstanding and confusion between 

a snder and a receiver. Some of the significant barriers are 

guided bythe nature and purpose of communication as well as 

the relation between the sender and receiver. 

Environmental Barriers:  These are the physical conditions that 

affect the communication process. For example, defective 

insruments, poor lighting, uncomfortable seating arrangements, and unhienic room conditions distract listeners. 

Situational Barriers:  The factors like distance, noise, and distractions cause unnecessary disruption in the 

communication process. Forexample, loud musicand noisefromgeneratorsorothermachinery. 

Individual Barriers: Some of the individual barriers are as follows: 

Attitudinal:  Factors like age, gender, lack of interest, discomfort with the topic, culture, and socio-economic or 

professional status define how a listener perceives and interprets the message. 

+ Linguistic Ability: Speech disorders or other physical disabilities can distort the communication process. 

Additionally, the lack of proficiency in the languageaffectsthe interpretation of the message as well. 

If the listener is preoccupied or distracted orjust not interested in the conversation, he will likely be not 

attentive. It may result in an adverse effect on the outcome of the communication. 

+ Emotional State: Emotions of the sender atthe time of encoding may result in the usage of wrong words ortone that 

may lead to miscommunication. Likewise, the receiver may misinterpretthe message due to his emotions. 



IIRIIJ Feedback Receiver Environmental - Listening communication channel 

ASSESSMENT TIME 

A Fill in the Blanks: 

1. Without the sender cannot confirm ifthe receiver has interpreted the message correctly. 

2. Physical conditions that affect the communication process are called barriers. 

3. The is the means through which the message travels from the source to the receiver. 

4. The is the one who decodes or interprets the message. 

5,   to others is a very important aspect of effective communication. 

B. Answer the Following Questions: 

1. Whatiscommunication? 

2. What are the features of effective communication? 

3. List the barriers to effective communication. Explain any two. 

4. Sidhant is preparing for his first campaign speech. Advise him about the possible barriers to effective 

communication and how can he avoid them? 

A. Draw a diagram ofthe Communication Cycle and explain it orally. 

B. Role Play the following situations in the class: 

Situation 1: Two classmates are conversing over the telephone. The 

caller was absent from the school due to illness and calls up his classmate 

to find out what lessons were taught and what homework was given in 
every subject. 

Situation 2: A student is introducing himself by highlighting his interests, 
hobbies, strengths, and weaknesses. 

Situation 3: You are conversing with your friend, and you are interested 

to know that how was his trip to the wildlife sanctuary. 

Let's Use Creativity 

GROUP DISCUSSION 
Divide the class in two groups and conduct a group discussion on the topic, 
Various barriers to effective communication and their impact on the 
communication cycle. 

Learning 
Computers with 



UNIT - I: Communication Skills 

CHAPTER 

Various Methods of Communication 
Communication means exchanging ideas, opinions, or information among people. People use different methods of 

communication to express themselves. The choice of the method depends on various factors, such as the urgency of the 

message, the time availability, the expenditure involved, the intellectual and emotional level of the sender and the 

receiver. 

II  METHODS OF COMMUNICATION 

There are three basic methods of communication: 

1.Verbal 2.Non-verbal 3.Visual 

II  VEbhLCOMMUNICATW 

Verbal Communication involves the use of words in delivering the intended 

mesage. Words are the most accurate and powerful tools to express and share 

ideas. 

There are two primary forms of verbal communication. 

- Oralcommunication 

+ Written communication 

ORAL COMMUNICATION 

  

Video-conferencing, 

The process of expressing information or ideas through spoken words is 

known as Oral Communication. 

Oral Communication is a more natural form of communication than the 

written form. The most significant advantage of oral communication is that it 

provides immediate feedback and clarification. Both, the speaker and the 

listener take turns to speak and enter into a kind of dialogue to make the 

whole communication process purposeful. It isa time saving and useful tool. 

It lends a personal touch to the entire interaction. Telephonic conversation, 

voice mails, general conversation, speeches, meetings, seminars, group discussions, etc., come 

underthe category of oral communication. Thefactorsthat determinethe effectiveness of an oral communication are: 

Pc2:  It means how fast or slow you speak. If the speaker talks too fast, the receiver may not be able to absorb and 

interpret the message correctly. On the other hand, if the speaker talks too slow, the receiver 

might lose interest. 

Clarity in Pronunciation:  It refers to speaking words clearly and correctly, including the 

correct sounds of the letters with proper emphasis. 

Volume/Pitch:  It means how loud or soft yourvoice is. If the speakertalks in loud volume with 

someone sitting across the table, he may sound dominating, and the receiver might feel 

detached/unconnected. On the other hand, speaking in a soft voice leads the receiver to 

thinkthatthe speaker is shyor not confident. So, you need to have a balancedtone. 

Learning 
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Choice of Words:  It refers to choosing the appropriate words while communicating. 

Consider the following example, where a remark about someone's shoes using two 

different words leads to entirely different interpretations by the receiver. The table given 

below lists the comments and the interpretations. 

These shoes are very cheap. 

 

a. The shoes look shabby. 

b. The shoes are not costly. 

  

The shoes are not costly. 

 

These shoes are very economical. 

  

   

Therefore, while drafting your message, carefully choose words that communicate your meaning clearly and leave little 

scope for misinterpretation. 

iL\':  It refers to the ability to speak with ease and accuracy in a Ianguage.To talk with fluency means that your speech 

flows well and there are not many interruptions to that flow. It keeps the receiver engaged. For example, too many 

pauses and words like, um, ah, you know, etc., used by the speaker, may distract the receiver and break the flow of 

communication. 

Length of Communication:  The conversation should be simple, short, and to the point. If a speaker talks for a long 

duration of time about things which are not relevant to the topic, the listeners lose interest in the speech and the 

purpose of the speech is defeated. On the other hand, a conversation which is short conveys the message clearly and 

concisely and keeps the listenersengaged. 

ADVANTAGES OF ORALCOMMUNICATION 

+ It is interpersonal and helps in building relationships. 

+ It encourages involvement in team work and decision making process. 

Oral message provides prompt feedback. 

+ It is cost efficient. 

+ It is a preferred mode of communication for private or confidential matters. 

DISADVANTAGES OF ORAL COMMUNICATION 

+ In thisform of communication, emotions arevisible and hence can lead to miscommunication. 

+ Ithasnolegalvalidity. 

It does not provide a permanent record and the message can easily be forgotten. 

+ It may be difficult for certain people to understand speech due to various accents and pace used in oral 

communication. 

+ This form of communication is not suitable for lengthy messages. 

WRITTEN COMMUNICATION 

- ________ 
It involves sending messages in the form of written words to convey 

information. Written communication is the most formal form of 

communication. It isa n innovative activity of the mind that involves a careful 

choice of words and their placement in the correct order. Examples of written 

Learning 
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cormunication include letters, reports, resumes, brochures, circulars, memorandums, contracts, notices, etc. 

Nowadays written communication has become shorter and faster. SMS and messengers like WhatsApp, e-mails, social 

media, etc., are some of the standard mediums of written communication. For effective written communication, the 

message should be meaningful, concise, and complete. 

ADVANTAGES OF WRITTEN COMMUNICATION 

+ Written communication allows the sender to thoughtfully draft clear and comprehensive message. 

+ Written content has legal validity. 

+ It is a suitable mode of communication for lengthy messages. 

DIADVANTAGES OF WRITTEN COMMUNICATION 

Written communication requires time for drafting the message. 

+ Written communication may involve postage cost. 

+ Written message causes feedback and consequently delays in decision making. 

NON-VERBAL COMMUNICATION 

Non-verbal Communication means communicating without the use of 

words, oral or written. It can be effectively used to enhance our verbal 

communication. It includes our body language, gestures, facial 

exp essions, eye contact, pointing fingers, etc. 

1 No -verbal signs can convey thoughts and feelings in the absence of 

ver al communication. How we say something, is often more 

important than what we say. Research by Albert Mehrabian suggests 

that non-verbal communication has a more significant impact on the 

receiver than the speakers words. 

The different elements of non-verbal communication are: 

Facial Expression: It is the most noticeable aspect of non-verbal communication. The look 

on a person's face is often the first thing we see, even before we hear what he has to say. 

Gestures: Conscious hand and body movements and signals are 

an essential way to communicate without words. Some of the 

common gestures include waving, pointing, and using fingers to 

indicate numbers. However, some unconscious gestures also 

convey one's state of mind, for example, glancing at thewatch is 

interpreted as a sign of disinterest or a desire to leave the 

conversation. 

Additionally, different cultures recognise their specific gestures, for example, in India, we fold our hands to greet others 

and express our regards for others, but this gesture has no significance in other parts of the world. 

Voice:  Non-verbal speech such as tone, pitch, volume, modulation, rhythm, and rate are essential elements of 

corthmunication. When we speak, other people read our voices in addition to listening to our words. These non-verbal 

sounds provide subtle but powerful clues into our true feelings and what we mean. For example, the tone of voice can 

Learning 
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indicate sarcasm, anger, affection, or confidence. A loud tone of voice might be interpreted as a sign of approval and 

enthusiasm, while a soft tone of voice may be construed as a sign of nervousness. Even lack of sound and silence can 

communicate a lack of interest orunderstandingoreven hard feelings in a face to face discussion. 

Body Language: We communicate numerous messages through our body 

language. Body language includes facial expressions, eye movements, hand 

gestures, posture, etc. For example, standing erect and leaning forward 

communicates to listeners that you are approachable and friendly. Using 

appropriate expressions and gestures strengthen your speech. For example, in 

a declamation contest, if your body language reflects confidence, your speech 

will have a greater impact on the audience as well as on the judges. 

Eye Gaze:  The movement of eyes like looking, staring, and blinking is an 

essential form of non-verbal communication. Eye gaze also determines if 

someone is being honest or not. Steady eye contact may be interpreted as the 

person being truthful and trustworthy. 

Physical Contact: Communicating through physical contact is another essential non-verbal behaviour. Sometimes, a 

touch may be able to express the feelings more effectively than the words. For example, a warm hug from a mother 

consoles a child, whereas, a firm grip of a mother shows her control to prevent the child from doing something wrong. 

Dress and Appearance: In oralforms ofcommunication,the appearance of both the speakerand the surroundings play a 

vital role in creating an impact on the audience or receiver. For example, a well-dressed person gives an impression of 

position and power, thus generating respect from others. 

ADVANTAGES OF NON-VERBAL COMMUNICATION 

+ Non-verbalcommunication complements a verbal message. 

+ Physical gestures greatly help handicapped people, especially deaf people. 

DISADVANTAGES OF NON-VERBAL COMMUNICATION 

+ It is difficultto analyse a non-verbal message, thus leaving a greater possibilityof distortion of information. 

+ In non-verbal communication, long conversation and necessary explanations are not possible. 

Play the game of Dumb Charades. Choose a theme, such as phrases, names of movies, famous personalities, etc. 

Divide the class into two groups, Group A and Group B. Group A decides upon a word or a phrase as per the selected 
theme. Group A then calls a member of Group B and tells him the name secretly. This member then has to enact the 

name through body gestures and signs and his team has to guess the correct name by following the gestures. The 

person enacting has to follow specific rules. Some of them are: 

a. Hecannotspeak. 

b. Certain gestures can be decided beforehand. For example, a thumbs up sign means Hindi language and a 

thumbs down sign means English language. 

c. Use fingers to tell the numberofwords in the name. 

Learning 
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PctrPD4,,t Types of Visual Aids 
pres.,ttIon 

information and understand the concept much more 

For Better Concept Clarity 

II  VISUAL COMMUNICATION 

Any verbal or non-verbal communication utilising the sense of 

sight is known as Visual Communication. 

Visual communication skills involve the judicious use of visual 

aid to make a penetrative and lasting impact on a receiver's 

mird. Graphs, charts, maps, PowerPoint presentations, 

overhead projectors, smart-boards, white and black boards, 

models, paper handouts, etc., are the different types of visual 

aids that help in conveying a message effectively. For example, 

an ducator can impart knowledge on a particular topic to the 

students in an effective manner with the help of a smart board, 

picture, or a diagram. These visual aids help students to retain 

clearly and quickly. The use of visual aids grab the attention of the students and keep them engaged. 

ADVANTAGES OF VISUAL COMMUNICATION 

+ Visual aids like graphs, diagrams, models, etc., make oral communication more meaningful. 

+ Use of visual aids makes complex data easyto comprehend. 

+ Visual aids make the communication more interesting. 

DISADVANTAGES OF VISUAL COMMUNICATION 

+ Some of the aids used in visual method of communication are costly. 

+ Sometimes visual presentation of information becomes complex. 

+ Sometimesvisualtechniquestakemuchtimetocommunicate. 

Imagine a situation where a person is on a vacation in a foreign land. He goes on a city tour with a group. Due to some 

communication gap, he is left behind, He is not well versed with the native language. How will he reach back to his 

hotel? Which visual aids should he use to reach the hotel? 

Thus, we see that skilful use of the three methods of communication strengthens the sender's message and its impact. In 

some circumstances, they also serve to substitute one another like gestures may be used to replace words, or a phone 

conversation may replace a face-to-face conversation to add a personal touch to the interaction. As non-verbal cues are 

absent in written communication, it is important to maintain accuracy, brevity, and clarity. Overall, the most important 

part is that you need to have awareness about which method is appropriate in a given situation. The chosen method of 

communication depends entirely on the type of situation that one comes across. A good understanding of the various 

methods of communication helps in dealing with people in a more effective way. 

Jim Rohn rightly says it: 

"If you just communicate, you can get by, but if you communicate skillfully, you can work miracles". 
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Divide the class in two groups and conduct a group discussion on the topic, 'How 
Non-verbal Communication may help or disrupt a communication 
cycle?'. 

ASSESSMENT TIME 

  

      

      

A. Fill in the Blanks: 

is the most noticeable aspect of non-verbal communication. 

2. The most significantadvantage of oral communication is that it provides immediate  

3. The use of grabthe attention ofthestudents and keep them engaged. 

4. communication is the most formal form of communication. 

5. Tone is an example of communication. 

1. 

HINTS I 

   

 

Feedback Facial Expressions Written Visual aids Non-verbal 

  

    

B. Answer the Following Questions: 

1. What are the advantages and limitations of oral communication? Explain with examples. 

2. Explain with the help of an example how body language may support or contradict a message. 

3. What is the significance of Visual communication? 

4. Prateek wants to share the marking criteria for the final project with his team mates. Suggest him the 

preferred channel for this task and give reasons for the same. 

5. Enlist the disadvantages of Non-verbal communication. 

1. Make a PowerPoint presentation on some common body language errors that one should avoid while 

corn mu n icati n g. 

2. Enacta scene in the classwhere you have to use all threemethodsof communication. 
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UNIT - I: Communication Skills 

CHAPTER 

Perspectives in Communication 
Mr and Mrs Sharma have just shifted to a new neighbourhood with their son Vivaan. Vivaan has Downs Syndrome 

(a genetic disorder, which causes a person to have distinct physical features and mental ability). Mrs Sharma takes her 

son to the park every evening. No child interacts with her son except Rohan. All the 

mothers except Rohan's mother have told their children not to play or talk with 

Vivaan fearing that he might get violent with their children. Rohan's mother has read 

a lot about children with Downs Syndrome. While all the mothers think that children 

with special needs are prone to violence, Rohan's mother knows this is not true. So 

without knowing Vivaan, all the mothers have formed the wrong perspective about 

him. This wrong perspective is affecting their communication with the Sharma family. 

Let us learn what 'perspective' is, how it is formed, and how it affects our daily life. 

Iii  PERSPECTIVE IN COMMUNICATION 

Perspective is an individual's point of view through which we interpret and 

understand every communication and event happening around us. 

Different people have different perspectives as everyone sees things 

differently from others. We convey and interpret messages through the filters 

of our knowledge, beliefs, and motives. These filters form the basis of our 

perspective and reflect the way we see the world, the way we think about the 

persons we are communicating with, and the way we communicate with them. 

• Il  FACTORS AFFECTING PERSPECTIVES IN COMMUNICATION 

VISUAL PERSPECTIVE 

Our brain processes the information seen through the eyes and interprets it. Visual perspective refers to our tendency to 

focus only on the parts ofa scenario that we are most inclined to notice. 

Let us understand the concept of visual perspective from the examples given below. 

Look at the given figure. What do you see? 

The figure has two visual perspectives. One is of two black faces in the foreground with a white 

background. The other is of a white vase in the front with a black background. We usually see 

only one of the perspectives at first. The second perspective is visible either after some time or 

when someone tells us to observe more carefully. 

Thus, we see that both the perspectives are valid. Similarly, you must have heard people say 

'Beauty lies in the eye of the beholder'. It is not the eyes but the brain that tells us to think of 

something as beautiful or not. Most of our visual perceptions are judgments that we make 

about people we are communicating with. Some of the judgments that we make are about: 

+ Qualification of the person 

+ Mental capability ofthe person 

+ Position and the financial status of the person 
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hej 

 

     

hallo 

    

hello 
yEtá 

3RPBO 

LANGUAGE 

Perspectives play a role in the interpretation of words as well. Some words can have 

very different meanings depending how we interpret them. 

Larry Barker said 'Effective listeners remember that 'words have no 

meaning - people have meaning'. The assignment of meaning to a 

term is an internal process as meaning comes from inside us. And 

although our experiences, knowledge, and attitudes differ, we 

often misinterpret each other's messages while under the illusion 

that a common understanding has been achieved." 

Example 

Consider this Statement 

'The man is fair'. 

The statement may be interpreted in two different ways, such as: 

The man hasfaircomplexion. 

The man is unbiased in his judgement. 

Most of the times we think our intended meaning may be clear, but we cannot always be sure 

thatthe other person will read or hear the statements in the same way as we meant it. 

The interpretation depends upon the meaning orconnotation that a receiverassociateswith 

the word. Therefore, it is advisable to use words and synonyms that express the exact 

thought or emotion and leave the leastto interpretation. 

PAST EXPERIENCES 

Let's Discuss 

Discuss a few examples to 

show how an expression 

can be misinterpreted 

based on ones 

perspectives in 

communication. 

We enter a situation or communication with certain expectations of what will 

happen and behave accordingly. These are based on the filters or perspectives that 

we have developed due to our past experiences. For example, you are incredibly 

nervous the first time when you perform on a stage, but after your teacher and 

classmates appreciate your performance, you are much more comfortable and 

confident the next time you step on the stage. 

More examples of how past experiences affect our behaviour are: 

Past Experience.----- - - Resulting Effect on Communication 

You spoke in the class and the class laughed. 1= 

Your classmate refused the last time you asked 

him to give his Science notebook. 

You hesitate in speaking up in the class. 

You don't ask him this time, even though 

he may have agreed this time. 

All of us have positive as well as negative experiences throughout our lives. However, we 

must take care that our past negative experiences do not affect our behaviour orthe way we 

communicate with others. Some negative experiences, however, also serve as a caution, 

and help us to protect ourselves from dangerous situations. 
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Lets Discuss 

Discuss how your past 

experiences in the 

classroom have affected 

your communication. 



A TUDE 

  

Attitude is a mindset that decides how an individual perceives an idea or a situation and responds to it. The following 

example illustrates how our attitude influences our perception. 

Look at the glass of water, is it half-filled (halffull) or half empty? 

     

When looking at the glass of water, there can be two opinions - one stating it as half-full, while the other 

considering it half empty. These opinions or perceptions depend upon the person's state of mind and his 

attitude. This example is often used as a metaphor for life to distinguish optimistic people from the 

pessimistic. Some people focus on the opportunities provided to them and feel grateful, while others 

choose to focus on the lack of facilities and complain about their life. Thus, people's attitudes define what 

they perceive and what they experience. 

     

     

     

PREJUDICE 

Prejudice is an idea or opinion that is not based on fact, logic, or experience. Prejudice is 

considered a negative attitude, especially when it is related to hatred or intolerance for 

certain groups of people. Prejudices are partly due to culture and partly due to personal 

preferences. When we act on our prejudices, then it becomes discrimination. When we 

discriminate, we make decisions without trying to find all the necessary information about 

the person orthe group that we are judging. 

Some examples of prejudices are social status, gender bias, our attitude towards specially abled people, and antipathy 

towards a particular religion, or a cultural group. 

When we categorise people, we do not considerthem as individuals. We overlooktheir individual qualities and therefore 

fail to understand and appeal to them. Communicating with a person based on our prejudices reduces our chances of 

having a successful communication and producing desired results. Therefore, while talking, the goal should be to view 

every person orsituation with a new perspective, in spite of the preconceived notions aboutthem. 

It is a common prejudice among people that women are not physically as strong as men. Today, however, 

women have proved this notion wrong and are excelling in physically challenging fields like military, law 

Example enforcement, sports, etc. 

ENVIRONMENT 

Do you speak to your parents in the same way that you do to your friend? 

Are you formal while talking to the people you know well? The answer to 

these questions would be a 'No'. All of us communicate differently in 

different environments. For example, some students hesitate to voice their 

opinions in the classroom, while others thrive on the attention of their 

classmates. Therefore, while some students enjoy and learn more from 

classroom discussions, the shy students do not speak up in the class. If the 

teacher talks to the shy students personally, they are better able to convey 

their problems and opinions. Recognising how the environment affects your communication with others helps you to 

understand whysomeone might be communicating in a particular way. This understanding further helpsyou to create or 

choose an environmentthat is conducive forthe specificcommunication. 
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Lets Discuss 

How do you behave in 

front of a teacher who has 

a reputation of being very 

strict? 

Let's Discuss 

How do you talk to your 

friends in the presence of 

your parents and in their 

absence as well? 

For instance, in the above example, if the teacher knows her student's personality, she can 

hold fruitful discussions in the class and also give personalattention to the shy students. 

FEELINGS 

There are two ways in which your feelings can influence your communication with another 

person: 

+ The first one refers to the way how you feel on a specific day. If you are feeling well, you 

will communicate as usual, and if you are feeling sick or in a bad mood, you will talk 

differently. Since your wellbeing changes, it transforms your way of communication on 

a particular day. Imagine, your teacher snubs you and your friend comes to discuss her 

weekend plans with you. How would you react? Do you generally respond the same way 

to such requests from your friends? Your friend, however, may end up feeling hurt. 

Therefore, if you are finding it difficult to communicate due to illness or other physical 

or mental stress, acknowledge it. It will help others to understand that the change in 

yourcommunication style is due to your illness or stress. 

+ The second aspect related to feelings refers to how you feel about a specific person. 

When you genuinely like someone, you communicate with him in a very positive way. 

However, when you interact with someone you do not like, your style and body 

language changes. 

BELIEFS 

Our beliefs form a vicious cycle. Our unique perspectives, with which we 

interpret any message or event, stems from our belief system. Beliefs shape our 

behaviour, which in turn affects our communication style, Our communication 

style elicits responses from others and determines the result of an interaction, 

and the reactions further reinforce our beliefs. 

 

Beliefs 

 

Behaviour 

Communication 
style 

Rohan believes that nobody likes him. Due to this belief, he does not trust anyone and stays aloof. He usually 

behaves aggressively because he thinks that this is the only way to show his resentment towards others. 

Because of this behaviour and communication style, people avoid interacting with him. This response 

Example reinforces his belief that nobody likes him. 

Therefore, the belief system is a vicious cycle that repeats itself, unless we make a conscious decision and put in 

disciplined efforts to change it, so that we can think, behave, and communicate in a better way. 

Moreover, a change in how we act and communicate will change the way other people treat us. 

Dr Eric Berne's theory on Transactional Analysis aptly describes the effect of our belief system on our behaviour. This 

theory outlines how we treat ourselves, how we relate and communicate with others. Dr Berne has proposed four 'life 

positions' that each of us maytake in approaching any interaction. 

The four positions are: 'I'm OK: You're Not OK 'I'm OK: You're OK 'I'm Not OK: You're Not OK 'I'm Not OK: You're OK' 

These life positions represent combinations of one's attitude about oneself and the other people with whom he is 

interacting. For example, 

I'm not OK-I do not believe in my opinions and decisions. 
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I'm OK 

I'm OK: You're OK 

I'm not OK 

I'm not OK: You're OK 

Communication style: Assertive 

Behaviour: Clear and calm tone 

Outcome: Most productive 

Communication style: Passive, Nervous 

Behaviour: -lesitates to assert ideas, Puts 

inadequate efforts 

Outcome: Not productive 

You're 

OK 

I'm OK: You're not OK 

Communication style: Aggressive 

Behaviour: Loud and Angry 

Outcome: Not productive 

I'm not OK: You're not OK 

Corn m unication style: Passive-Aggressive 

Behaviour: Evades conflict, Does not 

accept/follow the group's decisions 

Outcome: Not productive 

You're 

not OK 

A. Fill in the Blanks: 

1 is a negative attitude, especially when it is related to hatred or intolerance for certain 

groups of people. 

2. is a mindset that decides how an individual perceives an idea or a situation and 

responds to it. 

3. Our also serve as a caution, and help us to protect ourselves from dangerous situations. 

4. A person with 'I'm OK: You're OK' life-position has an Communication style. 

5 When we people, we overlook their individual qualities and therefore fail to understand and 

appeal to them. 

HINTS Prejudice categorise - Attitude Assertive Past Experiences 

B. Answer the Following Questions: 

1. Write two instances where your perspective has influenced your behaviour towards a classmate or a friend. 

2. Has any of your past experiences affected your communication with others? State how it affected the outcome 

of the communication. 

3. How does the environment affect communication? Cite an example. 

4 Surabhi and her friends are debating about an artwork. Some of them think that it is a jungle scene, while 

others perceive it as the life journey of a person. Which factor is influencing their perspective towards that 

artwork? 

  

You 1re OK- think you are superior and have betterjudgment than me. 

The'efore, when you approach a situation with the life-position, "I'm not OK - You're OK", you begin by 

putting yourself in an inferior position. You hesitate to express your opinion or refute others' claims, 

thereby not contributing to the process in any meaningful way. The following diagram depicts the 

communication style, behaviour, and possible outcomes of interactions when one approaches 

interpersonal situationswith each one of these life-positions. 
Dr. Eric Berne 

ASSESSMENT TIME 
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7Cs of 
Communication 

 

Clear 

 

Concise 

  

Courteous 
Conside- 

ration 

UNIT - I: Communication Skills 

CHAPTER 

Basic Writing Skills 
Written communication is the most effective mode of communication. It is more formal and less flexible than oral 

communication. The written form is helpful in keeping a record of the conversation for future reference. 

The effectiveness of written content depends on the correct choice of words, their 

organisation into a right sentence sequence, and the cohesiveness in the sentences. 

     

  

Complete 

  

     

 

Correct 

   

Concrete 
7C's of Communication 

     

There are seven elements of communication which are popularly known as the 7C's 

of Communication. They are regarded as a checklist that helps to improve the 

professional communication skills and increase the chances that the message will 

be understood in exactlythe same way as it was intended. 

1. Clear: The message should not be vague or confusing. 

2. Correct: The message should be free of any grammatical and spelling mistakes. 

Also, the facts mentioned in the message must be relavant and accurate. 

3. Complete: The message should be complete, i.e., it must include all the required information. The complete message 

answers most of the questions that receivers might have, thus reducingthe need forfurthercorrespondence. 

4. Concrete: The content should be supported by facts and figures. 

5. Concise: The message should be precise and to the point. A short and brief message helps to retain the receiver's 

attention and saves time. 

6. Consideration: The sender must take into consideration the receiver's opinions, knowledge, mindset, background, 

etc., to communicate effectively. 

7. Courteous: The sender must considerfeelings and viewpoints of the receiverwhile draftingthe message. 

• II  WRITING SKILLS 

To communicate well, we must have a good command over the language in which we are communicating. At the same 

time, we must take care that there are no grammatical errors in the writing. To improve our writing skills, we will study 

aboutthe basic components of English grammar and how they should be used effectively. 

• ii PHRASES 

When we communicate with each other, we express our thoughts and ideas through words. A group of words that make 

complete sense is called a sentence. 

Now look at the following group of words: 

a sweet smelling rose 

will be going 
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up the mountain 

behind the cupboard 



Do they make complete sense? No, they don't. 

Therefore, they are not sentences. These are called phrases. 

A phrase isa group of words that form a unit within a sentence but is incomplete independently. A phrase lacks both the 

subject and the object. 

Examples: 

Girl in the brown hat (phrase) 

The girl in the brown hat looked confused. (sentence) 

The phrase in the above example makes complete sense when it is a part of the sentence. 

TYPES OF PHRASES 

There are different kinds of phrases: 

1. A noun phrase acts like a noun in a sentence. 

Example: He was looking atthe painting of a sailing boat. (noun phrase-sailing boat) 

2. Averbphraseis a group of mainverbs and helping-verbswithina sentence. 

Example: She had been living in London. (verb phrase - had been living) 

3. An adjective phrase is built around an adjective and consists of adjectives and/or articles. 

Example: He has led a very interesting life. (adjective - interesting, describes the object - life) 

4. An adverbial phrase is built around an adverb by adding words before or after it. 

Example: The economy recovered very slowly. (adverbial phrase - very slowly) 

5. A prepositional phrase always begins with a preposition and is followed by a noun. 

Example: I long to live nearthe sea. (prepositional phrase - near, noun - sea) 

PRACTICE   

      

 

TIME  

   

    

      

Ic entify the type of phrases given in bold in the following sentences. 

a. The mobile phones are unexpectedly inexpensive nowadays. 

b. We are going to meet the Chief Minister next week. 

c. I enjoy walking early in the morning. 

d. Don't you have a train to catch? 

e. Tell your brothers not to fight over petty things. 

f. The man reacted very excitedly to the news. 

II  SENTENCES 

A group of words that makes complete sense is called a sentence. A sentence must contain a subject and a predicate. 

Examples: 

colour blue favourite is my. (makes no sense, therefore it is not a sentence) 

Myfavourite colour is blue. (makes sense, therefore it is a sentence) 
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KINDS OF SENTENCES 

There are four kinds of sentences: 

1. Assertive or declarative sentence (a statement) 2. Imperative sentence (a command) 

3. Interrogative sentence (a question) 4. Exclamatory sentence (an exclamation) 

1. An Assertive sentence is a sentence thatstates a fact. Such a sentence is a simple statement that indicates, asserts or 

declares something. 

Examples: 

Jane is a student. She lives in a big city. 

Isaw myfriend in the market. 

2. An Imperative sentence is a sentence which gives a command, makes a request, or expresses a wish. This type of 

sentence may end with a full stop or an exclamation mark. 

Examples: 

Go to your room. (an order) 

Please lend me your book. (a request) 

Have a good time at the picnic! (a wish) 

3. An Exclamatory sentence is a sentence that expresses sudden and strong feelings, such as surprise, wonder, pity, 

sympathy, happiness, orgratitude. 

Examples: 

What a shame! 

Bravo! Well done! 

4. An Interrogative sentence is a sentence that asks a question. 

Examples: 

What is your name? 

Where doyou live? 

— •_7_ - I;A1.x'ul['I1 
Read the following sentences and state their type. 

1. I didn't have time to finish my homework last night. 

2. Harry, try the other door. 

3. IIoveyousomuch! 

4. 1am ten years old. 

5. What a beautiful painting! 

6. Stay in your seat. 

7. Are you ready to go? 

8. Please pass the salt. 
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PRACTICE 
In each of the foflowng sentences, circle the subject and underline the predicate. 

1. An unusual event occurred at our beach last summer. 

I 2. Two girls were jogging along the beach. 

3. They heard a strange sound. 

4. Thrashing around in the waterwas a dark object. 

5. A helpless dolphin was being tossed around by the waves. 

6. The worried joggers called the Centre for Coastal Studies. 

7. Two dolphin experts soon arrived at the beach. 

8. They moved into the cold surf near the dolphin. 

9. The healthy dolphin was released into the ocean several months later. 

10. Have you ever been to the ocean? 

PARTS OF SENTENCE 

Evry complete sentence contains two parts: a Subject and a Predicate. 

A subject is a word or a group of words which conveys the names of persons or things about whom or which we are 

speaking. 

Apredicate, on the other hand, is the part of a sentencewhich containsa verb and statessomething about the subject. 

Letus learn more about subject and predicate through the following sentences: 

The book fell off the table. 

In this sentence, 'The book' is the subject because something is being said about it and 'fell off the table' is the 

predicate because that is being said about 'The book'. 

The subject in a sentence usually comes first. However, in certain cases, it is placed after the predicate for the sake of 

emphasis. For example: 

Down went the ship. 

To determine a subject in a sentence, ask 'who' and the answer would be the subject. 

On the contrary, ask 'what' aboutthe subject, and the answerwould be the predicate. 

In the sentence given above, when you ask who, the answer is - the ship. This is the subject. When you ask what, the 

answer is - went down. This is the predicate. 

In imperative sentences, the subject is not explicitly stated; rather it is implied. Look atthe given sentence. 

Sit down. 

in this sentence, the subject 'you' is implied. 

RULES FOR WRITING A SENTENCE 

+ Useshortsentences 

+ Limit sentence content 

+ Economise on words 

+ Arrange the sentences in a propersequence 

+ Design sentences to emphasise the topic 
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INTERJECTION CONJUCTION 

Refers to a word that describes, modifies, or gives more 

informationaboutanounora pronoun. 

Examples: cold, happy, young, two, fun 

The littlegirl hasa pink hat. 

Refers to a word that shows an action or a state of being. It 

can show what someone is doing or did. 

Examples: go, speaking, lived, been, is 

Listen to the word and then repeat it. 

Refers to a word that modifies the meaning of a verb, an 

adjective or another adverb, expressing manner, place, 

time, or degree. 

Examples: slowly, very slowly, well, too 

Yesterday, I ate my lunch quickly. 

Refers to a word that shows the relationship of a noun, 

noun phrase, or pronoun to anotherword. 

Examples: at, on, in,from, with, about 

lleftmy keys on the table foryou. 

Interjections 
/ 

Verbs Prepositions 

Conjuctions Parts of Speech E (AdJecth 

Pronouns 

Refers to a word that is used to name a person, a thing, an 

animal, a place, oran idea. 

Examples: Mohit, London, table, hope 

Ram uses a blue pen to write letters. 

Refers to a word used in place of a noun or a noun phrase 

to avoid repetition. 

Examples: I, you, it, we, us, them, those, he, she, her, him 

Iwant herto dance with me. 

NOUN PRONOUN 

ADJECTIVE VERB 

ADVERB PREPOSITION 

Each word in the English language belongs to a particular class or part of speech. There are eight parts of speech in 

English grammar. 

Refers to a word that joins two words, ideas, or phrases 

togetherand shows how they are connected. 

Examples: and, or, but, because, until, if 

Iwas feeling hot and tired but I stillfinished my work. 

Refers to a word or phrase that expresses a strong 

emotion. They are usually followed by an exclamation 

sign'!'. 

Examples: Ouch! Hey! Wow! Oh! Ugh! 
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PRACTI  CEjj- 
Iead this story and identify the parts of speech for the words given in boId 

nce when Winston Churchill was the prime minister of Britain, he called a taxi and told the driver to take him to 
the BBC studio. 

"I am sorry, Sir", said the driver, who failed to recognise him. "I can't go that far, Mr. Churchill is to give a 
speech in an hour and I want to go home to hear him". 

Churchill was so pleased that he gave him a one-pound note. "Oh, how kind you are!", said the taxi-driver. "Get 

in, Sir. I'll take you wherever you want to go. I don't care for Churchill's speech." 

was  I  failed   speech  oh  

Britain  am  recognize  to  go  

driver  sorry  far  him  for  
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An article is a word used to modify a noun, which is a person, place, object, or idea. There are two different types of 

articIesthatare used in writing and conversation to point out or referto a noun ora group of nouns: 

+ IndefiniteArticle 

+ DefiniteArticle 

INDEFINITE ARTICLES  -  A AND AN 

'A' and 'An' are the two forms of the indefinite article. As a determiner, these articles are used before Singular Countable 

Nouns (SCN). The main function of the indefinite articles is to indicate that the noun they precede does not refer to any 

particular person or thing, Usually, these articles are used to introduce new concepts. For example, 'a teacher' refers to 

anyteacher and nota specific teacher. 

Rul s for using the indefinite article (a/an) 

'a'is used: 

Before a singular, countable noun when it is mentioned forthefirsttime. 

Example: 

I sawa lion inthezootoday. 

Before a singular countable noun or adjective beginningwith a consonant sound. 

Examples: 

I saw a movie. She found a book. 

Heateabanana. Abeautifulflower. 

To express quantity. 

Examples: 

alotof; abitof; afew; alittle 

In certain exclamatory expressions. 

Examples: 

What a beautifulshot! What a pity! 



'an' performs the same function as 'a' but 'an' is used before singular countable nouns which begin with a vowel sound 

(a, e, i, o, u). 

Examples: 

He ate an apple. I want to eat an orange. 

She works as an actor. Carry an umbrella to the market. 

DIFFERENCE BE1WEEN 'A' AND 'AN' 

'a' and 'an' have the same meaning. 'a' and 'an' both are indefinite articles. 

The difference depends on the sound at the beginning of the next word. 

Use 'a' when the next word starts with a CONSONANT 

SOUND. 

Examples: 

Use 'an' when the next word starts with a VOWEL 

SOUND. 

Examples: 

abook afrog anappie an orange 

acar alemon an egg an umbrella 

adog atruck an insect an actor 

REMEMBER 

The initial sound is important, not the spelling. 

The followingwords begin with vowel letters but notvowel sounds. Therefore, they have the article 'a' beforethem. 

Examples: 

a university (The U at the beginning of universitysounds like You.) 

a one rupee note (The Oat the beginning of one sounds like W.) 

a European (TheE is silent and the U sounds like You.) 

a unit (The U at the beginning of unit sounds like You.) 

The following words begin with consonant letters but have vowel sounds. Therefore, they have the article 'an' before 

them. 

Exam pies: 

an hour, an heir (The H at the beginning of hour and heir is silent.) 

an MP, an SP (The M and Ssound like Em and Es respectively.) 

If a singular countable noun is preceded by an adjective, a or an is used before the adjective, according to its initial 

sound. 

Examples: 

He is an honest man. It is a useful book. 

The indefinite article in not normally used before uncountable nouns, such as water, sugar, wheat, iron, music, 

beauty, etc. Therefore, we do not say 'I had a water' but we can say 'I had a glass of water' since glasses can be 

counted. 
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DEFINITE ARTICLE -THE 

The definite article, 'the' can be used with both countable nouns-singular as well as plural-and uncountable nouns. Its 

maii use is to specify a person, place, orthing. It is used when the noun that follows is already known. 

Example: There is a duster on my desk. Get me the duster. 

'The' is used before 

+ A singular noun when it refers to a particular class orgroup. 

Example: The bicycle is a common man's vehicle. 

+ The names of rivers, mountain ranges, gulfs, seas, oceans, groups of islands, names of ships, etc. 

Examples: the Ganga; the Himalayas; the Indian Ocean 

~ The names of countries in plural. 

Examples: the United Kingdom; the United States of America 

The names of religious books. 

Examples: theRamayana; theVedas; theGita; theBible 

+ Hotels, museums, and certain buildings. 

Examples: the Ashoka Hotel; the Central Bank; the Ministry of Defence; theTaj Mahal; the Red Fort 

+ The names of newspapers and magazines. 

Examples: the Tribune; theTimes of India 

+ The superlatives of adjectives. 

Examples: the best boy; the worst thing 

+ Descriptive adjectives referring to a whole group or class. 

Examples: 'the rich' refers to people who are rich; 'the poor' refers to poor people. 

+  Namesofracesandcommunities. 

Examples: the Sikhs; the Chinese; the English 

+ Uncountable nouns. 

Example: lliketo run in the grass. 

Do not use 'the' before: abstract nouns, plural nouns, proper nouns, names of materials, meals, colours, names of games, 

when used in general sense. 

Exam pies: 

+ Gold is a precious metal. (Name ofthe material) 

+ Children like chocolates. (Plural noun) 

+ Ram is leaving tonight. (Proper noun) 

+ Dinneris ready. (Dinner isa meal) 

+ Virat Kohli playscricket. (Name ofthe game) 

We do not use the with some expressions, such as: all day, all night, bytrain, by air. 
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A. Fill in the blanks with the appropriate article, a, an, or the. If no article is needed, leave 

the space blank. 

1. I want apple from that basket. 

2. church around the corner is beautiful. 

3. Mohit speaks  Punjabi. 

4. I borrowed pencil from your pile of pencils and pens. 

5. One of the students said,"  professor is late today. 

6. I bought umbrella to go out in the rain. 

7. My daughter is learning to play violin at her school. 

8. Please give me cake that is on the counter. 

9. I lived on Main Street when I first came to town. 

10.  apple a day keeps the doctor away. 

B. In each of the following sentences, there is an error in the use of articles. Underline the 

incorrect word and then rewrite the sentences using correct articles. 

1. A Chinese have decided to choose an national flower but they are divided on a choice. 

2. Some favour a pansy while others prefer an plum blossom. 

3. Since both flowers have their admirers, it is going to be an close contest. 

51I PARAGRAPH WRITING 

In the English language, the fundamental unit of composition is a paragraph. A paragraph consists of several sentences 

that are grouped together and discusses one main subject. Thus, a paragraph is essentially a collection of sentences that 

all relate to one centra Itopic. 

Before you begin writing your paragraph, you must have a clear idea of what the paragraph is going to be about, i.e., you 

should have a topic to write on. Without a definite idea of what the main topic is, your paragraph will lack focus, clarity, 

and unity. 

Think about the topic on which you want to write. Consider, the most relevant ideas or issues relating to that topic is. As 

paragraphs are usually short, it is essential that you try to touch upon allthe main ideas, without going off the subject and 

maintaining the length of the paragraph. 

HOWTOWRITEAG000 PARAGRAPH 

Listed below are some of the sections you musttake care of, when writing a paragraph. 

Topic of Paragraph 

First, decide the topic about which you are going to write the paragraph. 
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Introduction/Topic Sentence 

Make one sentence that tells about the topic which will feature in the rest of the paragraph. This is called a topic 

sentence', which works as an introduction to your paragraph. Good topic sentences should always contain a topic and a 

controlling idea. 

The topic is the main subject matter or idea covered in the paragraph. The controlling idea focuses on the topic by 

providing direction to the composition. 

Example: People can avoid accidents on road bytaking certain precautions. 

(In the above example, topic sentence is 'accidents on road' and controlling idea is 'taking certain precautions'. 

S upport/Expla nation 

Afterstatingthetopic sentence, provide information in 7-8 sentences to explain and clarify more about the topic. 

Conklusion 

After illustrating your point with relevant information, add a concluding sentence that summarises. the points made in 

the aragraph. 

Pro fread 

Thelast step in writing a good paragraph is proofreading and revision. Before submitting, look over your writing at least 

onemoretime. Make sureyour paragraph makes sense. 

RULES FOR WRITING A PARAGRAPH 

+ Give the paragraph unity 

+ Keep the paragraph short 

+ Make use of topic sentences 

+ Leave out unnecessary details 

+ Give the paragraph movement 

+ End the paragraph with a concluding sentence 

A paragraph is usuallyjudged on the following criteria: 

1. Introduction (IncludingTitle) 

2. Support/Explanation 

This is further divided into 

+ Content 

+ Expression (Fluency, Grammar, and Spelling) 

+ Sequencing 

3. Conclusion 

A sample paragraph is given below: 
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DISCIPLINE 

Discipline means order or code of behaviour. It refers to the ability to control one's own feelings. Life without 

discipline is meaningless. We need to be guided by rules. Discipline is a must whether we are at school or at home. It 

is equally necessary whether we are in the office or in the playground. Our life, our society, our country, or even the 

world will go astray without discipline. So, some sort of discipline is required everywhere. Even the nature follows an 

order. A small disturbance in the nature leads to chaos. Discipline has to be learnt in every walk of life. At school, the 

students are taught to behave well. They are taught to respect their elders. Even on the playground, children are 

taught to follow the rules of the game. Childhood is the most formative period in which the value of discipline can be 

learnt. Success in life only comes through discipline. 

-7Ilj[Ijf4A14 

Develop paragraphs from the given outlines. 

A. IMPORTANCE OF THE INTERNET 

Network of computer systems  using standard communication protocols  large volume of 

precious and useful information  service provided by both-government and private organisations 

provides the most exciting mode of communications can send an e-mail to anyone across the 

globe  low cost of sending an e-mail  collect information from various websites on different 

subjects education, medicines, literature, software, computers, business, entertainment, friendship 

and leisure  newspapers, magazines and journals from any country of the world are available on the 

Internet  endless possibilities. 

B. DRUG ADDICTION 

Can destroy lives  serious health issue  affects addicts, their families and society  

severe physical effects on the addict's body experience many physical symptoms including sickness, 

fever, sweats and shakes, loss of appetite and weight face the danger of contracting serious diseases 

AIDS, hepatitis and other communicable diseases. Families and friends of drug addicts  also 

affected by their addiction  leads to serious financial problems, loss of trust  family break up 

and divorce  increase in crime rates  more security and hospital care needed  

destructive way to live more should be done something that affects the society as a whole. 
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ASSESSMENT TIME 

A. Multiple Choice Questions: 

1. The written form of communication is than oral communication. 

re formal and less flexible b, More flexible and less formal 

re flexible and more formal d. Less flexible and less formal 

hecklist comprising of various elements of communication skills is called  

's of communication b. 5 Es of communication 

's of Communication d. 5 C's of communication 

up of words that make complete sense is called a  

a5e b. Sentence 

Dject d. Predicate 

-i of the following is nota kind of sentence? 

a. Mo 

c. Mo 

Thec 

a. 7 E 

c. 7C 

A g ro 

a. Ph 

c. Su 

Whic 

a. As 

c. Em 

;ertive b. Interrogative 

pirical d. Exclamatory 

 is the part of a sentence that contains a verb and which states what is said about the subject. 

b. Prefix 

d. Pronoun 

A 

a. Predicate 

c. Preposition 

Fill I n the Blanks: 

rd or a group of words which conveys the names of persons or things about whom or which we are 

dng is called the  

A wo 

spea 

sentence gives a command, makes a request, or expresses a wish. 2. An. 

3. A complete sentence consists of a subject and a that describes the subject. 

4. A word that describes, modifies, or gives more information about a noun or a pronoun is called an 

entence that summarises the main points made in a paragraph iscalled  sentence. Thes 

An. is a words or a phrase that expresses a strong emotion. 

concluding HINTS I Interjection Predicate Imperative Adjective Subject 

C. Answer the Following Questions: 

Lists me of the important elements that make written content effective. 

Ans:The effectiveness of written content depends on the correct choice of words, their organisation into a right 

sentence sequence, and the cohesiveness in the sentences. 

What are the different kinds of phrases? 
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b. A verb phrase c. An adjective phrase a. A noun phrase 

g. Courteous: The sender must consider feelings and viewpoints of the receiver while drafting the 

message. 

Learning 
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There are five different kinds of phrases: 

d. An adverbial phrase e. A prepositional phrase 

What kind ol a sentence asks a question 

Ans: A sentence that asks a question is called an interrogative sentence. 

4. List the seven elements of effective written communicThon 

Ans: The seven elements of effective written communication are: 

a. Clear: The message should not be vague or confusing. 

b. Correct: The message should be free of any grammatical and spelling mistakes. Also, the facts 

mentioned in the message must be accurate. 

c. Complete: The message should be complete, i.e., it must include all the relevant information. The 

complete message answers most of the questions that receivers might have, thus reducing the need for 

further correspondence. 

d. Concrete: The content should be supported by facts and figures. 

e. Concise: The message should be precise and to the point. A short and brief message helps to retain the 

receiver's attention and saves time. 

f. Consideration: The sender must take into consideration the receiver's opinions, knowledge, mindset, 

background, etc., to communicate effectively. 

D. Answer the Following Questions: 

1. Give one example for each of the four kinds of sentences. 

2 What are prepositions? Explain with the help of an example. 

3. What are Interjections? What is their importance in the written form of communication. 

4 What are indefinite articles in the English language? Where are they used? 

5 What rules should we follow while writing a paragraph? 

E. Application Based Questions: 

1. Srishti has to write a paragraph on the topic Conservation of Environment' for her assignment. She does not 

rememberthe assessment criteria for paragraphs. Help her to outline the grading criteria of a paragraph. 

Akshay wrote a sentence, 'I bought a HD television set' in his English test, and the teacher marked it incorrect. 

Can you help him to write the correct sentence? Tell him the rules that he should follow while using articles in 

sentences. 



+ 

Communication is the process of transferring or sharing of information between 

two or more people. It isa two-way process of reaching mutual understanding. 

The essential elements of the communication process are, Message, Sender, Encoding, Communication 

Channel, Receiver, Decoding, and Feedback. 

Features of effective communication include a mutually accepted code (e.g., common language), clear coding 

of the message, listening, and appropriate feedback. 

A barrier to effective communication is any factor, individual, situational, or environmental, that prevents the 

receiver from receiving and understanding the message accurately. 

Various barriers to effective communication include Environmental, Situational, and Individual barriers. 

Personal attitude, Linguistic ability, Inattention, and Emotional state are some of the Individual barriers. 

There are three basic methods of communication: Verbal, Non-verbal, and Visual. 

The process of expressing information or ideas through spoken words is known as Oral Communication. 

There are two primary forms of verbal communication, Oral and Written. 

The factors that determine the effectiveness of an oral communication are, Pace, Clarity in Pronunciation, 

Volume/Pitch, Choice of Words, Fluency, and Length of Communication. 

Written communication involves sending messages in the form of written words to convey information. Written 

communication isthe most formal form of communication. 

Non-verbal communication means communicating without the use of words, oral, or written. 

The different elements of non-verbal communication are: Facial Expression, Gestures, Voice, Body Language, 

Eye Gaze, Physical Contact, Dress and Appearance. 

Any verbal or non-verbal communication utilising the sense of sight is known as Visual Communication. 

Graphs, charts, maps, PowerPoint presentations, overhead projectors, smart-boards, white and black boards, 

models, paper handouts, etc., are the different types of visual aids. 

Judicious use of visual aids help students to retain information and understand the concept much more clearly 

and quickly. 

Effective communication encourages participation and team spirit, strengthens relationships, builds 

confidence, reducesanxiety, and fosters personaland professional success. 

Factors affecting perspectives in communication are, Visual, Language, Past experiences, Attitude, Prejudice, 

Environment, Feelings, and Beliefs. 

Attitude is a mindsetthat decides how an individual perceives an idea or a situation and responds to it. 

Prejudice is an idea or opinion that is not based on fact, logic, or experience. 

Theory of Transactional Analysis postulates four life-positions that influence one's behaviour, namely, 

'Im OK: Voure Not OK, Im OK: You're OK', I'm Not OK: You're Not OK', 'I'm Not OK: You're OK' 
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A. Multiple Choice Questions 

1.(b) 2.(d) 3.(d) 4.(d) 5.(b) 

B. Give one word answer 

1. Courteous 2. Written Communication 3. Decoding 4. Visual Perspective 5. Prejudice 

BRAIN DEVELOPER 

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

A. Multiple Choice Questions: 

1. A messageshould be to convey the right meaning to others. 

a. Difficult b. Clear c. Complex d. Coded 

2. Which of these is not a barrier to effective communication? 

a. Hearing and Visual problems b. Noise and Distraction 

c. Lack of interest d. Listening attentively 

3. Which one of the following is not a method of communication? 

a. Verbal communication b. Non-verbal communication 

c. Visual communication d. Non-visual communication 

4. Examples of Non-verbalcommunication include  

a. Voice mails b. Tone c. Gestures d. Both b & c 

5. Perspective is an individuals  

a. Belongings b. Point of view c. Future d. Activity 

B. Fill in the Blanks: 

1. Being  means the sender must consider feelings and viewpoints of the receiver while 

drafting the message. 

2. The most formal form of communication is  

3. The process of deriving meaning from the received message is called  

4. refers to our tendency to focus only on the parts of a scenario that we are most inclined to 

notice. 

5. is an opinion that is not based on fact, logic, or actual experience. 

SECTION 2: THEORY QUESTIONS-(SOLVED) 

1. Define Encoding? 

Ans: Translation of an idea into a message by the source is called encoding. The message may be encoded in any 

combination of mutually understood words, signs, or symbols. 

2. What is a communication channel? 

Ans: A communication channel is the means through which the message travels from the source to the receiver. 

For example, video chat, telephone, text messages, and e-mails. 

3. Name the various methods of communication. 

Ans: There are three different methods of communication, namely, Verbal communication, Non-verbal 

communication, Visual communication. 
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4 What is Visual communication? 

Ans: Any verbal or non-verbal communication utilising the sense of sight is known as visual communication. 

5 How do past experiences affect our perspective? 

Ans: We enter a situation, a conversation, or a communication with certain expectations of what will happen and 

behave accordingly. These are based on the perspectives that we have developed due to our past 

experiences. 

3 

4 

2 

3 

4 

5 

SECTION 3: SHORT ANSWER TYPE QUESTIONS-(UNSOLVED) 

What is Effective communication? 

What do you understand by the phrase Barriersto Effective communication? 

Define Non-verbal communication. List the main elements of Non-verbal communication. 

Define Verbal communication. What are the two forms ofVerbal communication? 

Enlist the factors affecting perspective in communication? 

SECTION 4: LONG ANSWER TYPE QUESTIONS-(UNSOLVED) 

State the importance of effective communication. 

What is Encoding? What is its significance in the communication cycle? 

What do you understand by written communication? 

Discuss the role of non-verbal elements in effective communication. 

Comment on the statement, 'Our beliefs form a vicious cycle'. Support your answer with an example. 

SECTION 5: APPLICATION BASED QUESTIONS-(UNSOLVED) 

Aryan is preparing for a declamation contest. Help him to prepare a list of all the elements of non-verbal 

communication that he should consider while giving his speech. 

You want to get a pet dog, but your elder brother told you that no matter how much you try to convince your 

parents, they will not allow you to get a dog. What factordo you think contributed to his perspective? 

Sushant is a new manager, and he wants to share his ideas and working protocol with his team. Compare the 

advantages and disadvantages of oral and written communication and suggest him which form of 

communication would be more effective. 

Mr Sharma is often seen quarrelling with others. He has complaints about everyone in the neighbourhood. 

Which life-position is influencing his behaviour. 

Smriti walked into your school and came across your Science teacher, who generally comes well-dressed and 

looks very confident. Smriti assumed that he is the principal of the school. What factor is affecting her 

perspective? 
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Directing 

1. Initiative 2. Organisation 

ORGAN ISATION SKILL 

Importance of Self-Management 
Self-management is managing yourself to achieve the pre-determined tasks or goals that you have set for yourself by 

regulating your actions, organising your time, and being accountable for your decisions. Appropriate self-management 

can help students perform better in school, can reduce delinquent behaviours, and can help individuals perform better 

on the job. 

Who manages things in your house? Your mother. She takes care of everything right from cooking, washing clothes, your 

studies, buying stuff for everyone, and the house. Have you ever 

wondered how she manages to do so many tasks? She does this by 

setting a goal - the family's well-being. Then, she identifies the tasks 

to be completed to achieve that goal. She plans and delegates the 

responsibilities, and ensures to finish the tasks in time. She 

recognisesthe resources she has, such as time, money, help, etc., to 

complete those tasks and allocates her resources according to the 

family's priorities. Now, since nobody is directing herto do all of this, 

she is setting and achieving goals all by herself, she is self-managing. 

Self-management is a great skill to be developed for life and work. 

Let us learn howto develop self-managementskills. 

SELF-MANAGEMENT SKILLS 

Self-management comprises three key skills: 

3.Accountability 

INITIATIVE 

Initiative means doing the right thing without being told what to do. 

Initiative requires one to believe in one's own capabilities, and be 

resilient to work, even when faced with obstruction and 

disappointment. For example, as a student, you can identify areas of 

improvement in your school environment, such as apathy and 

disrespect for teachers, bullying, discipline, cleanliness, etc., and talk 

to your teachers and the principal about it. You can volunteer to 

address the issues in the school assembly, educate fellow students 

and staff, and inspire others to join you to resolve the issue. 

Organisation skill is the ability to use your time, energy, and resources effectively to achieve the goals you have set for 

yourself. Being organised saves your time and energy, helps you to complete tasks efficiently, and therefore makes you 

more productive. To develop organisational skills, you need to follow the below mentioned steps. 
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Prioritise and 

Schedule 

Give Time 

Slot 

Planning 

Identify and Define Specific Goals: To achieve a goal, it is important to clearly define your goal. For example, your goal is 

to have a holistic growth which encompasses intellectual, physical, artistic, emotional, creative, and social development. 

Break Down Goals Into Smaller Tasks: To achieve bigger goals, it is 

essential to break them into smaller, actionable tasks. Adopt the 

SMART strategy while setting and defining your targets. SMART is 

an acronym for Specific, Measurable, Achievable, Realistic, and 

Time-bound. Thus, adopting SMART strategy means you can 

clarfy your ideas, focus your efforts, use your time and resources 

proIuctively, and increase your chances of achieving what you 

want in life. 

pecific: A well-defined task helps you to focus your efforts. For example, instead of saying, 'I will cover my syllabus in 

time', a more specific task would be, 'I will complete Subject 'A' bytomorrow'. 

+ Measurable: A goal without a measurable outcome is like a sports competition without a scoreboard. Make your 

rogress measurable. For example, rather than saying, 'I will speed up my learning', a more measurable target would 

be, 'I will solve 20 Math problems in 2 hours'. 

+ Achievable: Set targets that are realistic and can be achieved. Setting unattainable targets result in a false sense of 

failure, loss of motivation, and low self-regard. For example, rather than saying, 'I will learn this whole poem in 1 

hour', a more achievable target would be to say, 'I will read this poem five times now'. 

+ Realistic: Devise a realistic plan. For example, rather than saying, 'I will devote 8 hours to my studies after school 

every day', a more realisticgoal may be to say, 'twill study 3-4 hours regularly'. 

[Time-bound: A time-bound target informs you whether you are progressing at the right pace or not. For example, 

ratherthan saying, 'I will completethis chapter', a time- bound target would be, 'I willfinish this chapter by 8pm'. 

lime-Management: It refers to managing time effectively so that the right time is allocated to the right activity. Effective 

time management allows individuals to assign specific time slots to activities as per their importance. Following steps 

help in managingyourtime in the best possible way: 

+ Planning: An important part of time management is planning. In order to control your workload, it is important to 

learn to plan each day, week, month, and year. Always be realistic in estimating the time to accomplish the tasks, as it 

helpsyou to create effective planning. When you followyour plan, you are more organised. Agood work plan enables 

you to start being realistic about how much work you can take on, how much time it will take, and what activities will 

it involve. For example, when you get your exam date sheet, prepare a study plan. Write down how many exams you 

have and the days on which you have to take 

them. Then organise your time accordingly. You 

may want to give some exams more study time 

Learn to than others. 

say No'	 + Estimate time required for each task: Be realistic 

in estimating the time required to accomplish the 

tasks as it helps you to plan effectively. For 

Spending the right example, if you are participating in a debate 

time on  right activity contest, estimate how much research time do 

you need? How long will it take you to write it, 

proofread it, and practice it? 



Evaluating Time Management 

+ Prioritise and Schedule:  Prepare your schedule to accommodate the planned tasks and other activities. Write down 

the important activities that need to be done in a single day againstthe time that should be allocated to each activity. 

Prioritise your tasks based on importance and urgency while preparing your schedule. For example, consider your 

school calendar for exams, weekly and daily assignments, school events, family special events, friends' birthdays, 

etc. See if you can accommodate all of them, and if you cannot, then choose which ones are more important and 

which ones you can forego. Make weekly and dailyto-do lists accordingly. 

± Learn to say 'No:  Always refer to your schedule and to-do lists before committing to new projects. One of the 

reasons we become overloaded is that we have a tendency to say 'Yes' when people ask us to do things. Learn to say 

'No' if your schedule does not allow taking on a new responsibility. It is one of the golden rules of time-management. 

If you find it hard to say 'No', think about the negative consequences of always saying 'Yes'. Analyse what tasks you 

will have to postpone, to fulfilthe new request and how will it affect your biggergoal. 

+ Spending the right time on right activity:  Set a time limit to complete the task. If you set a time constraint on a 

particular task, it will make you to be more focused and efficient. For example, instead of working on a project and 

thinking of doing it until it's done, set a limit of, say, 5 hours. 

Identify which statements are befitting you the most. Put a tick (i")  mark in the correct box. 

I am late for functions/appointments. 

I miss appointments. 

I rush at the end of a task. 

I miss stipulated target dates. 

I take too long to complete a task. 

I run out of time while completing tasks. 

I am not aware of how long it would take me 
to complete a task. 

I forget what I have to do. 

SCORING: 

+ If your response to all the above statements is 'No', then you seem to have good time-management skills. 

+  If your response to some statements is 'I don't know', then you seem to lack awareness about your 

time-management. Speak to people who know you well and find out what they think about your time-
management skills. 

+ If your response to any of the above is 'Yes', then that is the specific aspect of time-management you need to 
work on. 

1 
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ACCOUNTABILITY 

Accountability is a vital component of self-management. Accountability and responsibility are interrelated to each other, 

but they don't mean the same thing. The main difference between responsibility and accountability is that responsibility 

can be shared, while accountability is personal. Responsibility for a task may be assigned to you by someone else, like a 

teacher or a parent, but being accountable means being answerable for your actions. It is the mindset, where a person is 

expected to take ownership of his actions and not to blame other people or events for delays, failures, and incompletion. 

Accountability develops the following characteristics: 

Avoiding Procrastination: Procrastination is defined as the avoidance of doing a task that needs to be accomplished. 

Proci astination is choosing a different, usually less important and enjoyable task, to avoid doing an unpleasant and 

more difficult task. However, procrastination not only results in loss of productivity but it also often results in guilt 

and I oss of self-confidence. You can adopt the following strategies to avoid procrastination: 

+ 

+ 

Acknowledge that you are procrastinating. The mere 

acknowledgement helps in curbing it. 

Refer to yourto-do list and remind yourself of your bigger goal. 

It is advisable to keep your to-do list displayed where you can 

see it often. 

Refer to your to-do list often. Promise to reward yourself after 

completion of the task. 

Make it a habit of scheduling your more laborious tasks before more enjoyable tasks, so that you can complete 

them before your energy level goes down in the day. Also, the attraction of doing enjoyable activities will 

motivate you to finish the difficult tasks in time. 

Adopting Problem-Solving Attitude: A problem-solving attitude is 

a must in every area of life. Despite all the planning, you may face 

hardships, obstructions, delays, and failures in your life. When 

such hindrances occur, it is natural for people to get into a 

problem-centred mindset. People try to find the source of the 

problem and blame other people or events for the delay or failure. 

However, problem-centred mindset does not help to achieve 

anything. On the other hand, a solution-centred attitude helps 

one to focus on the possible solutions, which not only lifts the 

spirit but also resolves the problem and helps you to move 

towards success. 

Managing Your Own Emotions:  Emotions always get in the way of rational interpretation of a situation. They usually 

prevent us from working towards the best or most constructive solutions. Often, people either over-express their 

feelings (excessive anger, passiveness) or suppress their feelings to cope with the situation. However, different 

circumstances require different emotional reactions and expressions. Although it is essential to allow yourself to 

experience and acknowledge your emotions, it is even more important not to act on your emotions instantly. Give 

yourself time to regain your composure before you act. Although emotions may seem like a natural and uncontrollable 

phenomenon, however, you can apply reason to change how you feel in a situation, and thereby manage your actions 

and reactions in a challenging situation. 
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- Whatshould I do in this situation? Does this action help in fixingthe problem? 

- Howwill my action affect me and other people? Howwill it affect my bigger, long-term goal? 

+ What are the alternative actions I can take that will actually help betterthis situation? 

+ Can ltalkto someone who can guide me or help me through this problem? 

Coping With Distress: Unforeseen and unfortunate events like illness, injuries, death in the family, or some other tragic 

event may happen in your life. It may have a significant impact on your emotional and physical well-being. Find a suitable 

coping mechanism in such circumstances like, surround yourself with people who can provide you with the required 

emotional and practical support, count your blessings in life, distract yourself with pleasant things, indulge yourself in 

any physical activity, or draw attention on others' experience to pull yourself out from a depressing situation. 

POSITtVE RESULTS OF SELF-MANAGEMENT 

Self-management is an essential skill for everyone as it teaches you to be productive, no matter what the circumstances 

are. As we grow, the demands on our time and efforts increase from all aspects of our life. This 'pull' from all directions 

brings excessive stress and confusion in our minds. Self-management allows us to set up our priorities, and allocate time, 

resources, and efforts for activities according to the preferences that 

we have set. Therefore, it helps us to avoid unnecessary confusion, 

delays, the stress of pending tasks, and guilt of not being able to attend 

to important issues. The practice of self-management benefits you in 

the following five ways: 

+ Makes you more organised: While planning your schedule like 

allotting time slots for your studies, relaxation breaks, and other 

essential activities, you learn the vital skill of organising and 

allocating all your resources. 

+ Instils discipline: When you make a schedule and commit yourself 

to do it in the stipulated time, you reject other unimportant 

invitations from anyone else. It happens because you are clear 

that undertaking any unscheduled activity would mean cancelling 

the scheduled plan and failing to achieve the target. 

+ Helps in attaining goals: If you make a schedule for exams and follow it in a disciplined way, you will be able to 

prepare foryour exams and attain your set goals. 

+ Enhances self-confidence: When you set goals and achieve them, that give you the confidence to pursue more 

significant and more challenging goals. Self-confidence, in turn, gives you the courage to take the initiative wherever 

there is an opportunity. This cycle of initiating and achieving goals helps you rise higher in life. 

~ Commands respect from others: When people around you, your family, teachers, classmates and friends, watch you 

performing to achieve good results, without any push or supervision they start respecting you. Your parents and 

teachers realise that they do not need to control or force you. Also, your peers get inspired byyou. 

In essence, self-management skill will help you to live a more organised, stress-free, and a fulfilling professional and 

personal life. 
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ASSESSMENT  TIME 

A. Multiple Choice Questions: 

1. The S' in SMART strategy stands for  

a. Short b. Specific c. Schedule d. Systematic 

2. A  target informs you whether you are progressing at the right pace or not. 

a. Defined b. Time-bound c. Schedule-bound d. Accountable 

3. skill is the ability to use yourtime, energy, and resources effectively to achieve goals. 

a. Organisation b. Scheduling c. Accountability d. Time management 

4. It is important to prepare a  to accommodate the planned tasks and other 

activities. 

a. Schedule b. Date-sheet c. Planning d. Task-sheet 

5. A  attitude helps one to focus on the possible solutions. 

a. Good b. Problem-centred c. Time-bound d. Solution-centred 

B. Fill in the Blanks: 

1. skill is the ability to use your time, energy, and resources effectively to achieve 

the goals you have set for yourself. 

2. Being accountable means being  for your actions. 

3. The avoidance of doing a task that needs to be accomplished is called  

4. The mind-set that helps us to focus on the possible solutions is called  attitude. 

5. means doing the right thing without being told what to do. 

HINTS Procrastination - Organisation Responsible Initiative Solution-centred 

C. Answer the Following Questions: 

1. What do understand by the term Management? 

Ans: Management is the art of planning, organising, directing, and controlling the resources and tasks, efficiently 

and effectively, to achieve a goal. 

2. Mention the three key skills required for Self-management. Describe each one briefly. 

Ans: Self-management comprises three key skills-Initiative, Organisation, and Accountability. 

+ Initiative means identifying a problem and working to solve a problem without being told what to do. 

+ Organisation skill is the ability to use your time, energy, and resources in an effective way to achieve 

the goals you have set for yourself. It includes defining tasks, managing time, and preparing and sticking 

to your schedule. 

Accountability means holding yourself answerable for the completion of the task. It involves avoiding 

procrastination, adopting a solution-centred attitude, managing your own emotions, and coping with 

distress. 

3 What does the acronym SMART stands for? 

Ais: SMART is an acronym for Specific, Measurable, Achievable, Realistic, Time Bound. It is a strategy for setting 

and defining targets to help achieve the final goal. 



For Better Concept Clarity 

Hold a group discussion in the class on the topic, 'The Positive Results of Self-management'. 

4. List any three characteristics used to assess time-management skills. 

Ans Following are the characteristics that indicate poor time-management skills - missing appointments, not 

knowing how long it takes me to complete a task, and forgetting tasks. 

5. What are the strateqies to avoid procrastination? 

An Following are some of the strategies that help in avoiding procrastination: 

i. Acknowledge procrastination. 

ii. Make and display to-do list in the work area. 

iii. Schedule harder tasks before the enjoyable tasks. 

iv. Reward yourself for completing task in a timely manner. 

D. Answer the Following Questions: 

1. What is self-management? How is it different from management? 

2. Discuss the importance for devising a realistic and time-bound plan. 

3 The chapter mentions 'measurable' as part of the SMART strategy. What do you understand by it? How do you 

measure your progress? 

4 What is the importance of self-management? Explain briefly. 

5 Discuss any three strategies of Organisation Skill that you would like to apply in your life. How do you hope to 

benefit from them? 

Application Based Questions: 

Sumit always complains about not having enough time to finish his homework. He wonders how others are 

able to finish their homework and still have time for hobbies. Suggest him a few tips to manage his time 

effectively. 

Aarti has volunteered to make a project for the inter-school science competition. The competition is a month 

away, and she has not even started working on the project. Suggest her some steps to be accountable and 

finish the project in time. 

Think of a goal you want to achieve. Apply the SMART strategy to develop a plan for achieving it. Track your 

progress. After achieving your goal, record what self-management principles did you employ and how did they 

help you. Do a write-up on your experience and your learning from the entire process. 
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UNIT -  II:  Self-Management Skills  

CHAPTER 

Building Self-Confidence 
Self-confidence means having trust in one's own judgement and ability. It is reflected in one's belief that he is a valuable 

person and capable of accomplishing what he wishes to do. Self-confident people have three main attributes: 

Belief in one's own capability + Ready to accept any challenge + Willingness to take risks 

• II  FACTORS INFLUENCING SELF-CONFIDENCE 

Confidence is not genetically inherited. Many factors influence our beliefs about our capabilities. Three most prominent 

factors that contribute to building confidence are: 

1. Social Factors 2. Cultural Factors 3. Physical Factors 

SOCIAL FACTORS 

Society plays a critical role in shaping and building our self-confidence. Our society comprises our family, 

neighbourhood, friends, relatives, school, and even strangers. Our initial interactions with society leave a lasting impact 

on our attitude and outlook towards ourselves. Evaluations from parents, teachers, schoolmates, and friends can affect 

the ways how we perceive ourselves, which then progressively build up our self-confidence. 

The attitude of parents toward their child creates the first significant impact on 

him especially in his initial years of his life. For example, lack of love and 

attention, harsh physical and mental punishments, and excessive criticism and 

derogatory remarks on a child's mistakes can break his confidence, instil a fear 

of failure in him, and make him hesitant to take on challenges. On the other 

hand, overprotective parenting style also hampers a child's self-confidence. 

Shielding a child prevents him from facing any pain and struggle. It also prevents 

him from developing resilience and coping with stress and failure. He may come 

to believe that he is incapable or inadequate. Therefore, a balanced approach to 

parenting is necessary to build a child's confidence. When a child commits an 

error, parents should encourage him for trying again and guide him on how to perform better the next time. This kind of 

behaviour prepares the child to accept new challenges, teaches him to consider failure as a part of life, and helps in 

developing self-confidence. 

CULTURAL FACTORS 

Culture refers to the characteristics of a particular society, community, or ethnic 

group reflected in its practices and beliefs. 

Culture influences a child's development and behaviour. Children growing up in 

different cultures receive specific inputs from their environment. For that reason, 

there is a vast range of cultural differences in children's beliefs and behaviour. 

Cultural competence comprises an understanding of all aspects of a culture, i.e., 

social, educational, and organisational, in which we live and participate. 
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Let's Know More 

Nicholas Vujicic, founder 

of 'Life without Limbs', an 

international non-profit 

organisation is an 

inspiration to millions. He 

founded 'Attitude is 

Altitude', a secular 

motivational speaking 

company. Nicholas was 

born with Tetra-Amelia 

syndrome, i.e., without 

fully formed limbs. He is 

one of the seven known 

individuals on this planet, 

who live with this 

syndrome. He has starred 

in the short film 'The 

Butterfly circus' and was 

awarded 'Best actor in a 

Short Film' at 

the 'Method Fest 

Independent Film 

Festival'. 
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For example, some cultures value independence, individuality, self-esteem, and asserting 

oneself as important aspects of personality. Children from such cultures are outgoing, 

eagerly explore new situations, demonstrate competence, and have self-confidence. On the 

other hand, some cultures honour traditional values, relations, and obedience. Children 

from such cultures cultivate the need to maintain interdependent relationships. 

PHYSICAL FACTORS 

Physical factors like healthy physique, healthy mind, good appearance, etc., play an 

important role in developing self-confidence in a person. 

Moreover, in every culture, good looks are always 

appreciated and admired, which affect a person's 

self-confidence. It is a good practice to maintain good 

hygiene and physical appearance, but over-emphasis on 

the unrealistic image of beauty, as portrayed in media, 

may adversely affect self-confidence. 

Physical disability instils a sense of dependency in an 

individual. If a physically disabled person suffers from social discrimination and exclusion, 

this may lead to low self-confidence. However, a positive attitude and strong will can surely 

help a disabled person to overcome his physical limitations and motivates him to accept the 

challenges. Nicholas Vujicic is an excellent example of success through positivity and 

perseverance despite being born without arms and legs. 

Various attitudes that define the level of confidence among people are reflected in their 

behaviour, body language, and way of speaking. 

II  VARIOUS ATTiTUDES OF PEOPLE 

The above-mentioned factors determine how confident a person feels. You meet 

so many people every day, in your school, home, and neighbourhood. Some 

people may strike you as very confident, while some others may not appear as 

confident. 

Various attitudes of people, reflected in their behavior, body language, and way of 

speaking, define their level of confidence. 

ATTITUDES OF PEOPLE WITH LOW CONFIDENCE 

+ Fear:  Theyare anxious aboutthe possibility of failure. 

+ Value others' opinion:  They depend on other people's approval and validation to feel good about their ideas. 

+ Over critical:  Theytend to focus on their shortcomings like physical appearance, lack of knowledge, etc. 

+ Poor time-management:  They are unable to decide on priorities and focus on tasks. 

+ Unpreparedness:  Since they do not expect success, they do not put in the necessary efforts. 

+ Lack of Initiative:  They do not feel motivated to bring about change or improvisation. 

+ Reluctantto dealwith others:  Such people make excuses and tryto evade confronting people. 

+ Negative outlook:  They focus on past failures instead of learning from the experiences. 



ATTITUDES OF SELF-CONFIDENT PEOPLE 

Self-confident people have the following attitudes: 

+ Viewto the world:  They have a positive outlook towards themselves and situations surrounding them. 

+ Realistic view of self: Confident people are able to recognise their strengths and accept their weaknesses at the 

same time. 

+ Trust own ideas and beliefs:  Confident people rely on theirown ideas and beliefs ratherthan on others opinions. 

+ Deal with mistakes:  Confident people accept their mistakes rather than covering or justifying it. Moreover, they are 

willing to learn from it. 

+ Focus on growth: In spite of recognising their weaknesses, they choose to focus on the opportunities to grow rather 

than concentrate on their shortcomings. 

We can say that a balance and rationality in attitude are the hallmarks of self-confidence. A self-confident person shows 

the willingness and courage to face new challenges and works hard to attain his goals. This success further strengthens 

his confidence. Whereas, a lack of confidence puts them in a vicious cycle, where the fear and unpreparedness prevent 

them from succeeding, and the failure further reinforcestheirsense of inadequacy leadingto low self-confidence. 

Self-confidence is an essential attribute as it helps you in making a better and happier life for yourself. Not everyone is 

born with self-confidence, however, it can be developed. The following section explains some practical ways to build 

self-confidence. 

BUILDING SELF-CONFIDENCE 

"self-confidence can be learned, practiced, and mastered-just like any other skill. Once you master it, everything in 

your life will change for the better" - Barrie Davenport. 

Building self-confidence is a process that takes efforts and commitment. It requires you to cultivate a positive attitude 

about yourself, to set goals, and take risks. Following techniques will not only assist you in building your self-confidence 

but also in sustaining it in the long run. 

SWOT Analysis: SWOT stands for Strength, Weakness, Opportunity, 

Threat. This analysis is a useful technique for understanding your 

strengths and weaknesses. It also helps you in identifying both the 

opportunities open to you and the threats or challenges you will 

possibly face. 

T 
Threats 

The analysis helps you to recognise your talents and abilities. It also helps you tofind or choose opportunities that utilise 

your core strengths. 
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Follow the given steps to perform the analysis: 

1. Identify  Your Core Strengths: Make a list of things that you do well. 

Remind yourself of your achievements, big or small, and identify 

the skills that were needed for the achievement. Analyse what you 

enjoy doing the most. This will help you in identifying your core 

strength. 

 

Strengths 

   

Weaknesses 

        

         

   

SWOT 

   

         

Opportunities 

   

Threats 

 

     

2. Identify Your Weaknesses: Examine the areas in which you need to 

improveand thethingsthat often set you back. Askyourselfthefollowingquestions: 

+ What are your negative work habits? 

+ Which subject orskill hinders yoursuccess? 

+ What arethe areas you need to improve upon accordingto your parents and teachersfeedback? 

3. Opportunities: Identify the avenues to exhibit and utilise your core skills. Also, find the sources and support 

systems that can help you to prepare for challenges and sharpen your skills. 

4. Threat:  Research the Internet, read articles, and talk to the experts to get a realistic picture of the opportunity 

you want to pursue. Make a list of all the possible challenges and pitfalls. This will help you to prepare aptly for 

the challengesyou are going to face on the way to your success. 

For Better Concept Clarity 

BUILDING SELF-CONFIDENCE 

After analysing your strengths and weaknesses and identifying potential 

opportunities and threats, you will have to set yourself in action. Take on a task 

that you have been too scared to do. Be sure to set a small goal at first and practise 

the art of planning and perseverance and attain success, no matter how small it 

mayseem to others. Forexample,takean unfamiliarjourneyon publictransportor 

volunteer to give a presentation or a speech. 

Here, it is important to apply the principles of self-management you have learned in the previous chapter to strengthen 

your attempts, stay on task, and attain success. Follow the given steps to build your self-confidence: 

Set a Well Defined Goal: Use the SMART strategyto outline a suitable goal foryourself. 

Organise vourself:Applythe organisation skillsthatyou learned in the previous chapter, such as: 

+ Breakthegoalintosmallertasks. 

+ Definethetimelimitforeachtask. 

+ Prioritise yourtasks and make a schedule, and stickto it. Hold yourself accountable and avoid procrastination. 

+ When you meet any obstacle, remind yourself that this is bound to happen and you need to find ways to address it or 

move on despite it. Remember, an obstacle is only an indication of progress and not failure. 
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Recap Self-management is managing yourself to achieve the pre-determined tasks or 

goals that you have set for yourself by regulating your actions, organising yourtime, 

and being accountableforyour decisions. 

Self-management comprisesthree key skills-Initiative, Organisation, and Accountability. 

Organisation skills include identifying and defining specific goals, breaking down goals into smaller tasks 

(Adopting the SMART strategy), and time-management. 

Positive results of self-management makes you more organised, instils discipline, helps in attaining goals, 

enhances self-confidence, and commands respect. 

+ Display reminders of your goal and a vision of your success where you can see them repeatedly. This will help you to 

manage your moods and emotions as these reminders will bring your focus backtoyourgoal. 

Be Assertive: Have faith in your beliefs and abilities. Do not feel obligated to prioritise others demands over your goal 

and plan. Yourgoal is as important to you as their plan is important to them. 

Experience:  Gaining experience requires you to take the first step no matter how hard it may seem, and then keep 

practising. Each incident of success will take your self-confidence a step further. You will also learn to overcome obstacles 

and liandle failures as you will notice that they are inevitable parts of the process and not the end of the process. 

Surround Yourself with Positive People:  Always keep yourself in the company of positive people. Avoid any negative or 

discouraging influences and focus on the positive voices, including your own. It will uplift your thought process and keep 

you motivated. 

Care ForYourself and Others:  Staying clean and dressing well is positively related to positive attitude and uplifted mood. 

A well-dressed and well-groomed person generally commands more respect from others. Also, nothing makes you feel 

bettr about yourself than being useful to others. So, make meaningful contribution to the society by volunteering for 

charties that are compatible with your core strength. 

Be Prepared: Assess the requirements of a task and work hard to prepare yourself for it. Your confidence will naturally 

rise, if you are good at yourjob. 

Self-confidence may seem hard to attain, but it is attainable through practice and perseverance. Remind yourself of your 

qualities and talents, and value them. Treat yourself like you would like to be treated by others, and you will notice the 

difference in people's attitude towards you. 

In summation, the key to gaining self-confidence is, to recognise your strengths and success and learn from your 

weaknesses and mistakes. 
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b. Organisational 

d. Situational 

outlook. 

a. Emotional 

c. Institutional 

4. People with self-confidence have a  

a. Negative b. Arrogant 

c. Outward d. Positive 

5. People with low confidence are  

a. Smart 

c. Unprepared 

B. Fill in the Blanks: 

b. Pleasant 

d. Arrogant 

HINTS . Society .. Self-confidence Overprotective Threats aculture 

ii. Cultural Factors iii. Physical Factors i. Social Factors 

2. Mention any three attitudes of self-confident people. 

Ans: Self-confident people usually possess the following three attitudes: 

i. Realistic view of self: Confident people are able to recognise their strengths and 

weaknesses at the same time. 

ii. Deal with mistakes: Confident people accept their mistake rather than covering or 
Moreover, they are willing to learn from it. 

accept their 

justifying it. 

ASSESSMENT TIME  ft 
A. Multiple Choice Questions: 

1. prevents a child from developing resilience and coping with stress and failure. 

a. Authoritative Parenting b. Regular Schooling 

c. Overprotective Parenting d. Playing 

2. adversely affects self-confidence of a child. 

a. Overprotective parenting b. Love and care 

c. Physical Punishment d. Both a and c 

3. Cultural competence comprises an understanding of all aspects of a culture that is, social, educational, and 

1. Trust in one's own judgement and ability is called  

2. Our family, neighbourhood, friends, relatives, school constitute our  

3. parenting shields a child from facing any pain and struggle. 

4. The characteristics of a particular society, community, or ethnic group reflected in its practices and beliefs are 

collectively referred to as  

5. Possible challenges and pitfalls in the pursuit of a goal are termed as  

C. Answer the Following Questions: 

1. What are the three most prominent factors that contribute to building confidence are? 

Ans: The three most prominent factors that contribute to building confidence are: 
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Divide the class in two groups and conduct a group discussion in the class on 

the topic, 'Steps to Build Self-confidence'. 

iii. Focus on growth: In spite of recognising their weaknesses, they choose to focus on the opportunities to 

grow rather than concentrating on their shortcomings. 

What is SWOT? How is it useful? 

An:  SWOT stands for Strength, Weakness, Opportunity, Threat. It is a technique that helps one to analyse one's 

own strengths and weaknesses. It also helps one in identifying both the available opportunities and possible 

threats or challenges. 

4. Mention any three steps we can take to organise our self. 

An-: Following steps help us to organise ourselves: 

i. Prioritising our tasks ii. Make a schedule orTime-table iii. Avoid procrastination 

5. How does the Opportunity' part of SWOT analysis help in developing self-confidence' 

An The 'Opportunity' part of SWOT analysis helps us to recognise projects or challenges that align with our core 

strengths. By pursuing the projects that are compatible with our strengths and interests, we are more likely to 

succeed and sharpen our skills in the process. 

D. Answer the Following Questions: 

1. What is the importance of experience in building self-confidence? 

2. Lack of self-confidence puts one in a vicious cycle. Comment and support your answer with an example. 

3. What role does parental attitude play in building one's self-confidence? 

4. Draw a contrast between attitudes of people with low and high self-confidence. 

3. 

     

     

For Better Concept Clarity 

  

     

Role-Play 

+ Ask the students to imagine being a famous sportsperson/actor and address a press conference after 

succeeding in cricket series/block buster movie. 

Using Creativity 

+ Imagine that your school is preparing for its annual function next month. Do a SWOT analysis and find 

out your strengths and weaknesses. Make a list of the activities in which you can participate in your 

annual function. Make another list of the potential difficulties (threats) you may face. Then, make a 

step-wise plan for preparing yourself for the activity. 
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I 
UNIT - Ill: Information and Communication Technology Skills 

CHAPTER 

Introduction to ICT 
Technological development has revolutionised our everyday life to a great extent. It has led to the emergence of a new 

global economy. Technology has virtually transformed the world into a global village. Nowadays, with the click of a 

button, you can find any information you want. 

INFORMATION AND COMMUNICATION TECHNOLOGY 

CT is an acronym for Information and Communication Technology. It refers to all the devices, 

networking components, applications, and systems that allow people and organisations to 

interact in the digital world. ICT comprises all communication technologies such as the Internet, 

mobile phones, satellitetransmission, wireless networks, etc. 

I  ROLEAND IMPORTANCE OF ICT 

Everyaspectofourdailyroutine has alteredwith the adventof CT. It helpsto improvethequalityof ourlives, bygiving us 

an easyaccessto information as well as a large number of products and services. ICT has transformed the way we live, the 

way we work, the way we conduct business, and the waywe communicate with each other. 

ICT IN WORKPLACE 

The World Wide Web has made it possible to search for information on varied issues such as education, health and 

nutrition, current affairs, social aspects, finance, and many other important issues, which help us to improve and enrich 

ourlives. ICT is very helpful at the workplaces that use robots and artificial intelligence in the manufacturing of products. 

ICT is used in many otherworkplaces.like: 

+ Theminingindustry,forprospecting 

+ Auto industry and aerospace industry, for research, design, 

engineering and manufacturing, assembling as well as fault 

diagnosis, and safetytests and simulations. 

+ Power plants, for power generation and distribution 

+ Telecommunications industry, for building and maintaining 

networks 

+ Finance agencies have access to a large amount of information about companies and markets all over the world, 

which helpthem in analysingand predictingfuturetrends 

The potential application of ICT is only limited by our imagination. If used correctly, ICT can impact human lives in an 

effective and positive way and enrich our lives. 

ICTIN EDUCATION 

ICT can be effectively used to develop content and conduct classroom training through videos, expert lectures, and other 

such tools. TV channels, websites, and apps use ICT services to create and transmit educational content and provide 

Learning 
Computers wIth  KIPS 



CT in Education 

online training to students living in the remotest parts of the world. Nowadays, several online educational programs are 

avaiIable that are conducted through video conferencing. 

ICT has improved the process of teaching and learning in many ways, like: 

Students and teachers have access to a wide expanse of knowledge base. 

Students can develop research skills at a young age. 

+ Teachers are able to collaborate and share their ideas and resources 

online. 

ICT IN HEALTH CARE 

lCT is used in the pharmaceutical sector for cutting edge research and 

manufacturing. It helps in hospital management, administration and it also 

helps the doctors and nurses to diagnose, treat, and monitor patients. One 

can search for and learn about various diseases, their symptoms, cures, and 

precautionary measures on the Internet. 

ITN GOVERNANCE 

 

Digital India and e-governance initiatives of the government have resulted in 

providing many government services online, such as processing of 

documents like licenses, collection of taxes, exchange of information with 

citizens, and other government departments. lCT also provides a platform 

for interaction between the government and people through government 

websites and apps. Services, such as tax payment, ordering LPG cylinders, 

enrolling for the electoral process, paying for water and land bills, and 

finding information about different government schemes has been made 

possible because of ICT. 

Id IN BUSINESS 

 

: - 
, @L :. 
, 

 

4iIndiaNewlndia 

   

ICT facilitates e-commerce, which includes marketing, product browsing and shopping, and processing of orders. 

Business communications through e-mail, video conferencing, and mobiles in marketing of products is another major 

use of ICT in business. 

[-commerce (or online shopping) allows the users to search and compare various products and services, which they can 

buy at competitive prices and getthem delivered right at their door steps, thus savingtime and money. 

E-banking facilitates business by helping in banking transactions at any time from anywhere. It has enabled people to 

conveniently and quickly conduct theirfinancial transactions online. 

JI  ICTTOOLS 

The technological tools that facilitate creation, dissemination, storage, and management of information and 

communication are called ICT tools. These tools not only include the traditional technologies like radio and television, 
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but also the modern ones like mobile phones, computers, networks, satellite systems, and so on. They also consist of 

various services and applications associated with them, such as teleconferencing, video conferencing, social networking, 

etc. 

MOBILE PHONE 

A mobile phone helps us in communication, in both by voice and text mode. It also helps us to create 

documents, make presentations, collect data and distribute Information. Mobile phones are used to 

surf the Internet to get information on any topic, in a very short span of time. Through mobile 

phones, students can access various educational videos online, participate in group discussions with 

other students across the globe, or download various educational apps for their use. With the help 

of banking apps, all financial transactions can also be done instantly. 

TABLET 

A tablet is undoubtedly an exciting and new way to interact with technology. They are touch screen 

enabled small computers that are easy to handle and maintain. Tablets are mostly used for 

downloading and accessing educational apps and interactive books, watching movies, playing games 

and connecting with people on social media. 

INTERACTIVE WHITEBOARDS 

An interactive whiteboard (lWB) also commonly known as an Interactive Board or Smart 

Whiteboard, isa large display screen (usually in white colour) that can be connected with a computer. 

In this way, presentations and other digital interactive content can be displayed and used effectively 

on the Smartboard. An interactive whiteboard in the classroom can be used by educators to write on 

and improve the presentation content as compared to chalk boards. 

E-READER 

An e-reader, also called an e-book reader, is a mobile electronic device that is designed primarily for 

the purpose of reading e-books which are available in digital form. An e-reader is capable of holding 

thousands of books while weighing less than one. Kindle is one of the most common examples of an 

e-reader. 

NEWSPAPER 

Nowadays, newspapers are printed with the latest information available by using various sources 

influenced by ICT. The cutting-edge technology helps the news agencies to collect, collate and print 

the news with greater efficiency. Various news portals are also available to provide us with online 

news, anytime and anywhere. Some of the common news websites are : www.prasarbharati.gov.in, 

www.timesofindia.indiatimes.com, www.ndtv.com, and www.indianexpress.com. 

RADIO 

Radio instructions has been widely used for information broadcasts. Radio broadcast technology has 

been used for distributing educational resources in the past. 

TV 

Unlike radio, television brings the eye and the ear together and thus makes the audio-visual 

experiences concrete, real, and immediate. We can watch a number of programmes on our TV sets 

on sports, current affairs, entertainment, education, and many other areas. It is now considered as 

the most powerful and exciting means of communication ever devised by man. TV has also been 



utilised successfully as a mechanism for reaching out-of-school youth. One-to-many broadcast technology has 

reinforced the instructional methodology. Television aids students learning by offering a unique combination of sight, 

soun, motion, and emotion, which gives students a greater understanding of the world around them. 

E-M IL 

  

E-mjI is short for electronic mail. Similarto a letter, it is sent via the Internet to a recipient. An e-mail address 

is reuired to send or receive an e-mail, and that address is unique to the user. When compared to traditional 

post, e-mails are delivered extremely fast from one computerto another. It can be sent and received from any 

computer, anywhere in the world, that has an Internet connection. E-mail is an extremely useful ICT tool that 

can be used for giving instructions, serving as documentation, providing confirmation, communicating rules and 

procedures, making recommendations, providing a status update, making an inquiry, etc. It can also be utilised as a tool 

for facilitating learning through the Internet. In an educational environment, e-mail can be used by facilitators to 

transmit much needed course related communication to students so that they all have access to the same information. 

w ASSESSMENT TIME 
Multiple Choice Questions: 

Which of these activities are related to e-commerce? 

a. Online shopping b. Watching movies 

Which of these is not an ICT tool? 

a. Mobile phone b. Television 

c. Inventory management d. Socialising 

c. E-mail d. Book 

3 ICT has improved the process of teaching and learning by providing 

a. Interactive whiteboards for training b. Online training to students 

c. Classroom training through videos d. All of these 

4 An e-reader is capable of holding thousands of: 

a. Newspapers b. E-books c. Photos d. Movies 

B. Fill in the Blanks: 

1. ICT helps to improve the quality of our lives, by giving us easy to information and services. 

2. ICT tools include as well as modern technologies. 

3. are touch screen enabled small computers that are easy to handle and mostly used for 
accessing educational apps. 

Radio and TV uses  broadcast technology. 

InRkt;II 

    

One-to-many 

 

Traditional Tablets Access 

   

    

C. Answer the Following: 

1. Mention any three ICT tools that are used in day-to-day life. 

2. How is ICT used in the field of healthcare? 

3. What is the role of ICT in various workplaces? 

     

     

For Better Concept Clarity 

  

     

+ Create a presentation about some of the tools of ICT. 

+ Collect information about the Digital India initiatives taken by the Government of India. 
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2CPU ALU 

Control 

Unit (CU) 

Arithmetic and logical operations 

on data are performed by ALU. 

 

Arithmetic and logical operations 

on data are performed by the brain. 

  

CU controls the functioning of all Brain controls the 

the components of a computer. functioning of the entire body. 

INPUT UNIT 

(Data and 
Instructions) 

OUTPUT UNIT 

(Information  - 
Result) 

UNIT - Ill: Information and Communication Technology Skills 

CHAPTER 

Components of Computer System 
A computer is an electronic device that can perform a variety of tasks, by executing a given 

set of instructions, It is a versatile device and can handle multiple tasks, such as performing 

calculations, playing music, painting, managing data and files, and developing various 

applications. It is able to execute various tasks due to its speed, accuracy, storage capacity, 

and versatility. However, a computer also has some limitations. For example, it cannot think 

on its own and needs instructions at every step to perform its operations. 

II  BASIC COMPONENTS OF COMPUTER SYSTEM 

Acomputer system hasthree important parts—Input Unit, CPU, and Output Unit, for performing differentfunctions. 

Let us compare these units with the parts of a human body. 

Sr. No. 
Computer 

Components 
Computer Human Being 

3 Output Unit 

Input is given through input 

devices, like keyboard, mouse, etc. 

Data and instructions are stored 

in memory unit. 

After processing, the output is displayed 

on the monitor. It can be in the form of soft 

copy or hard copy. 

Input is received through 

eyes, nose, ears, mouth, etc. 

Brain is used for storing all kinds of 

information. 

The output is in the form of 

voice, actions, etc. 

1. Input Unit 

T Memory Unit 

Let us understand the basic orgarlisation of a computer with the help of a block diagram. 

SECONDARY  STORAGE 
DEVICES 

)W OF DATA 

 

FLOW OF INSTRUCTIONS 

Fig.  8.1 Basic Organisaton of a Computer 
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Memory 
Unit 

The computer system are: 

+  Hardware: The physical components (electronic and mechanical) of a computer that you can touch and feel 

comprise the hardware of a computer, such as the CPU, keyboard, mouse, monitor, printer, motherboard, RAM, etc. 

+  Software: It is a collection of programs and procedures that instructs a 

computerabouthowtoperformthedifferenttypesoftasks.Asoftware Input     Output 
vCPU v  unit 

enhances the capabHity of the hardware and directs the computer to Unit 

perform operations, like input, processing, and output. Software can be 

classified into two types: 

1. System software 

2. Application software 

PARTS OF A COMPUTER 

Input Unit: These are the devices that are used to provide input to the computer. These devices are used to translate the 

user's commands into a binary code that can be recognised bythe computer. The most commonly used input devices are 

keyboard, mouse, scanner, and joystick. 

Keyboard Mouse Scanner Joystick 

Output Unit:  The devices that are used to display the output, after processing, comprise the output unit of a computer. 

Some of the commonly used output devices are, such as, monitor, printer, headphone, plotter, speakers, etc. The output 

can be in the form ofa softcopy (the output displayed on the monitor), or hard copy (printed on a paper), or a sound file 

(through a speaker). 

Monitor Printer Webcam Headphone Speakers 

Central Processing Unit (CPU):  CPU is the main unit of a computer. It controls all the internal and 

external devices of a computer and performs arithmetic and logical operations. Due to its small size, a 

CPU is referred to as a microprocessor. A microprocessor is a type of integrated circuit, built on a tiny 

piece of silicon. A microprocessor chip contains millions of transistors. The transistors worktogetherto 

store and manipulate data so that the microprocessor can perform a wide variety of functions. The speed of a CPU is 

determined by the number of instructions it executes per second, which is measured in Megahertz (MHZ). Hertz (Hz). 

Nowadays, due to technological advancements CPU speed is measured in gigahertz (GHz). 

Components of CPU 

There arethree main components in a CPU. 

1. Arithmetic and Logical Unit(ALU) 

2. Control Unit (CU) 

3. Memory Unit (MU) 
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ALU: Arithmetic Logic Unit is the component of CPU, which performs the arithmetic and logical operations on the 

operands. The arithmetic operations are — addition, subtraction, multiplication, and division. The logical operations use 

the relational operators, like greater than (>), less than (<),greaterthan equalto (>=), less than equalto (<=), not equal to 

(<>)etc. The logical operations test various conditions that are encountered during processing and allow for different 

actions to be taken, based on the results. The data and the operands act as the input for ALU and it generates the output 

asa result of computation. 

Control Unit: This unit controls the operation of every other component of a computer system. It also controls the 

transfer of data and instructions among the various units of a computer. In order to execute the instructions, the 

components of a computer receive signals from the control unit. It extracts the instructions from memory, decodes them 

and sends the necessary signals toALU to perform the required operation. It is also called the central nervous system of a 

computer system as it manages all the other units. 

Memory Unit: The memory unit is the principal storage of the computer. It stores both data and instructions. The data 

and instructions can also be stored permanently in this unit so that they are available whenever required. The memory 

unit is linked with other parts of the computer and sendsthem the data when needed. 

Computer memory is classified into two categories: 

1. Internal Memory 2. External Memory 

Registers: A register is a very small data holding place in a computer processor. It holds an instruction, storage address or 

data. There are various types of registers, each register performs a specific function. Some most commonly used 

registers are: Accumulator (AC), Data Register(DR), Address Register (AR), Program Control (PC). 

I  STORAGE UNIT/ MEMORY UNIT 

Let us discuss about the memory in more detail in this section. 

INTERNALMEMORYOR PRIMARY STORAGE 

Every computer has a certain amount of memory, usually referred to as the main memory. This is also called internal 

memory or primary memory. Primary memory is a place where data and programs are stored temporarily as long as they 

are being executed. It is veryfast and expensive but has limited storage capacity. Internal memory is of two types: 

1. RAM 2. ROM 

RAM 

RAM (Random Access Memory) is a type of computer internal memory that can be accessed randomly. 

Whatever information we enter into the computer goes into RAM and remains there as long as we are 

working on an application. It is a volatile memory as data and instructions are stored temporarily during 

its processing only and lost forever when the computer is switched off. 

Example: A blackboard is like a RAM that is constantly overwritten with the new data. The commonly used calculator is 

anotherexample of RAM. 

Types of RAM: 

+ DRAM (Dynamic Random Access Memory): It stores data temporarily as the data is lost when the power supply is 

suspended. It needs to be refreshed periodically in orderto retain data. 

4 SRAM (Static Random Access Memory): It is faster and more expensive than DRAM. It does not need to be 

refreshed, like DRAM, to retain information. It loses data when power is turned off. 
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SDRAM (Synchronous Dynamic Random  Access Memory): It uses a synchronous interface to transmit large 

amounts of data at high speed. This improves the efficiency of a computer as data is delivered in a shorter duration. 

DDR (Double Data Rate Memory): It is majorly used in Intel Pentium 4 systems. It requires less power and has a 

speed which is double thanthat of an SDRAM. 

ROM 

ROM stands for Read Only Memory. It is a type of memory from which information can only be read, whereas in a RAM, 

information can be read from and also written to. It is a non-volatile memory as it stores information permanently. Data 

stoked in ROM can neither be modified nor removed. The primary use of ROM is during the booting process. This is the 

initial program used to start a computerwhen power isturned on. 

Example: An audio-video disk resembles a ROM. Once the songs are burned on a CD, the disc contents cannot be 

changed. 

Types of ROM: 

There are several ROM variants that can be changed under certain circumstances. Following are 

the different types of ROM: 

+ PROM (Programmable Read Only Memory): The contents stored in PROM can be 

programmed, using a special device, known as PROM programmer. It can be programmed only 

once, that is at the time of manufacturing, and cannot be modified later. PROM provides a 

faster and less expensive approach for storing. 

+  EPROM (Erasable Programmable Read Only Memory): It can be erased and reprogrammed repeatedly with the 

help of a specialised software. The contents stored on the chip can be erased by exposing it to ultraviolet rays. 

+  EEPROM (Electronically Erasable  Programmable Read Only Memory): The contents on the chip can be erased and 

reprogrammed in blocks instead of one byte at a time. It also has the provision of selective removal, which means, 

we can erase the particular data byte-by-byte instead of erasing it completely. 

+ Flash Memory: It isa special type of EEPROM, which maintains the stored information even without a power source. 

The contents can be erased and reprogrammed into big sections making it faster than the regular EEPROM. Flash 

memory, being durable, is majorly used in memory cards, mobile phones, MP3 players, etc. 

Cache Memory 

Cache (pronounced as 'cash') memory is a special high speed memory which can either be inserted on a motherboard or 

made a part of the CPU. The CPU uses cache memory to store instructions that are repeatedly required to run programs, 

thus improving the overall system speed. Cache is much more expensive than RAM but it is well worth getting a CPU and 

motherboard with inbuilt cache memory in orderto maximise thesystem performance. 

EXTERNAL MEMORY OR SECONDARY STORAGE 

External memory is also known as auxiliary memory or secondary memory. Unlike since the main memory, it is provides 

permanent storage of data in huge amount. Whenever required, the data for processing gets transferred from the 

secondary memory to the primary memory. Therefore, data has to be stored separately in a secondary storage device to 

make it permanent and accessible for a longer duration of time. The speed of retrieval of data from external memory is 

much slower than that of the internal memory. Some commonly used external storage devices are: hard disks, CD/DVD, 

pen drive, etc. 

+ 

+ 



A Multiple Choice Questions: 

1. A CPU does not consist of  

a. ALU b. HDD c. CU d. MU 

2 One Tera Byte is equal to  

a. 1024 Mega Byte b. 1024 Giga Byte c. 1024 Peta Byte d. 1024 Kilo Byte 

3 Which of these is not a peripheral device? 

a. Register b. Modem c. Bluetooth d. Printer 

4 Control Unit is also called the ofa computer: 

a. Central digestive system b. Central respiratory system 

c. Central processing system d. Central nervous system 

B State True or False: 

1. A microprocessor chip contains millions of transistors. 

2. The output can only be in the form of a hardcopy. 

3. The speed of a CPU is determined by the number of instructions it executes per second. 

4. AC, DR, AR and PC are types of Registers. 

5 The printed information on the paper is called a soft copy. 

HINTS One-to-many Traditional Tablets Access 

C. Answer the Following: 

1. What is the function of a CPU? 

2. What are the components of a CPU? Explain them briefly. 

3. What is a Register? Name some of them. 

4. What is the difference between RAM and ROM? 

5 What are the various units of memory? 

 

For Better Concept Clarity 

+ Create a presentation to explain various types of primary storage devices in a computer. 

Create a presentation on basic components of a computer. 

ASSESSMENT TIME 

II  UNITSOFMEMORY 

A computer stores and processes data or information in the form of binary numbers. The smallest unit of memory is Bit 

(Binary digit) that can hold a single state - either 0 or 1. 

Some of the units of memory are: 

Nibble Group of4 bits 

Byte Group of 8 bits 

Kilo Byte 1KB = 1024 Bytes 

Mega Byte 1MB = 1024 KB 

Giga Byte 1GB = 1024 MB 

Tera Byte 1TB=1024G8 

Peta Byte 1PB = 1024 TB 

NOTE: 1024=210 
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UN! - III: Information and Communication Technolo .i Skills 

CHAPTER 9_ 
Peripheral Devices 

I PERIPHERAL DEVICES 

A cofpputer system is made up of three major units that carry out its primary functions — Input, Output, and Storage 

units! There are many other internal and external devices that connect to the computer directly and add functionalityto 

it. These devices are called Peripheral devices. The term peripheral device refers to all hardware components that are 

attached to a computer and are controlled by the computer system, but they are not the core components of the 

comuter like the CPU, motherboard, and power supply etc. Peripherals, in other words can also be defined as the 

devies which can be easily removed and plugged into a computersystem. Afew examples of peripheral devices are: 

Optical diskdrive 

+ Digital Camera 

4-  Modem 

+ Monitor 

Bluetooth Memorycardreader 

Printer CD ROM Drive 

II  TYPES OF PERIPHERAL DEVICES 

Peripheral devices can be classified into three categories: 

+ lnputDevices OutputDevices StorageDevices 

INPUT DEVICES 

Input devices are used to enter data and information into a computer. Some of the input devices are discussed below: 

Ke\.00r 

Keyboard is one of the most important input devices used to input data and instructions into a 

computer. It uses various keys to enter data to the computer. As discussed in Part-B, Unit-Il, 

Session 1. Checkthe reference. 

 

Keyboard 

lvi o use 

Mouse is the most commonly used input and pointing device that lets you select and move items on 

the screen. The left mouse button is used more frequently than the right button. A single left-click 

selects an item while double-clicking on an item activates the application. As discussed in Part-B, 

Unit-Il, Session 1. Check the reference. 

A stylus, also called as touch pen, is a small instrument shaped like a pen that is used to provide 

input to mobile devices, computer screens, and tablets. It can be used to draw or make selections 

on touchscreen devices directly on the screen. Stylus is used on game consoles like Nintendo. 

Scanner 

It is an input device that scans text, images, and objects optically. The scanned data is then 

converted into a digital image and displayed on the computer screen. 

E7:  Stylus Pen 



Fig, 9.5: Handhetd Scanner 

Fig. 9.7: Joystick 

Fki,9.'iO; Monitor 

Types of Scanner 

1. Drum Scanner:  This is the most efficient and expensive scanner. It uses a rotating glass drum 

to scan. Drum scanners are used mainly in the publishing industry to print high quality 

images in books and magazines. 

 

     

     

Fig. 9.4: Drum Scanner 
2. Flatbed Scanner:  It looks like a miniature printer with a flip-up cover 

protecting the glass window. In a flatbed scanner, the object to be scanned is placed face down on 

the glass window which is then illuminated with a bright light. The flatbed scanners are used in 

homes, schools, and medium sized offices. 
Fig. 9.5: 

Fiatbed Scanner 3. Handheld Scanner:  This is a small manual device which is dragged 

over the surface of the image to be scanned. Bar code scanner is one of the most-utilised 

handheld scanner used in shopping malls. 

Bar Code Reader 

It is an input device used for reading bar codes printed on the packing of various products. A bar code is a combination of 

dark and light stripes. It is a computer readable representation of information, present in visual format. Bar code reader 

is a very useful device commonly used for billing and inventory applications. 

Joystick 

A joystick is an input device which moves in the four directions and allows the user to move an 

object on the screen. It is normally used in gaming centres for playinggames. It has a moving stick 

(which rests on a base) with some push buttons on it. 

Microphone 

( It is an input device used to record and store voice or any other sound into a 

computer, generally as a '.wav' file. Microphone is commonly used in video conferencing, speech 

recognition programs, radio broadcasting, recording, and sound amplifyingsystems. 

Fig. 9.3: 
Microphone 

Light Pen 

It is a light-sensitive pointing device, commonly used to select or modify data on the screen. It allows 

the user to point on displayed objects or draw on the screen. 

OUTPUT DEVICES 

Fig. 9.9: Light Pen 

They are used to provide information in the form of soft copy or hard copy. Some of the common output devices are listed 

below. 

Monitor 

Monitor is the most common output device. It is also called Visual Display Unit (VDU), an 

electronic visual display for computers. Just like a television, a monitor also displays the 

output on the screen. Monitors display pictures bydividingthe display screen into thousands 

(or millions) of minute dots called pixels, arranged in rows and columns. The pixels are so 

close together that they appear connected. The output displayed on the monitor is called 

soft copy. 
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,1: 
Fig. 9.13: LED Monitor 

The most common types of monitors are: 

Cathode Ray Tube (CRT) monitors 

Liquid Crystal Display (LCD) orThin Film Transistor (TFT) monitors 

Light-Emitting Diode (LED) monitors 

Cathode RayTube (CRT) Monitors 

In these monitors, a beam of electrons lights up the pixels/phosphor dots, which form the 

inner coating of the screen. Colour is achieved by combining Red, Green, and Blue(RGB) 

shades of different intensities. CRT monitors are bulky and occupy a lot of space. They are 

available in various sizes, like 14 inches, 15 inches, 17 inches, and 21 inches. 

1.  

2.  

3.  

1. 

2. Liquid Crystal Display (LCD) Monitors
Fig. 9.11 :CRT Monitor 

LCD monitors are relatively thinner and lighter than CRT monitors. They use the light 

modulating properties of Liquid Crystals (LC's). They save a lot of space and can be mounted 

on walls. They provide a wide viewing angle and come in various sizes such as 17 inches, 19 

inches, 22 inches, etc. They displaysharp images and require less powerto run. They are used 

in a wide range of applications including computer monitors, television, instrumental panels, 

aircraft cockpit displays, etc. 

 

Fig. 9.12: LCD Monitor 

 

   

3. Light-emitting Diode (LED) Monitor 

LED display is the latest development in the field of monitors. These monitors have light 

emitting diodes that act as performance boosters in them. LED monitors offer better 

colourquality, clarity, and displaythan the LCD monitors. These monitors are flat, thinner, 

and lighter in weight. The biggest advantage of LED display is that it consumes low power, 

which is especially needed for hand held and chargeable devices, such as mobile phones, 

telephones, watches, gaming devices, tablets, laptops, etc. 

   

4. Touch Screen Monitor 

 

A touch screen is a special monitor that allows the user to input information by touching the 

icons or graphical buttons present on the screen. It is also used in ATM machines, offices, 

cineplexes, supermarkets and museums etc. 

Hg. 914: 
Touch Screen Monitor Printers 

  

   

A printer is a peripheral device used for printing the output on a paper or any other printable media. The printed 

information on a paper is called a hard copy. Printers are of two types: 

1. Impact Printer 2. Non-Impact Printer 

1. Impact Printers 

Impact printers allow physicalcontact between the printer head and paper i.e., they print by the 

impact of dot wires on paper. They are also called character printers. 

Impact printers are classified as follows: 

+ Daisy Wheel Printers:  They produce letter-quality documents. The speed of these printers varies 

from 60 cps to 120 cps (character per second). They are not in use anymore since they were very 

slow and noisy. 

Fig. 9.15: 
Dot-Matrix Printer 
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Hj. 9,16: 
Daisy Wheel Printer 

Fig. 9.18: Laser Printer 

 

0 
0 

Fig. 9.19: 

Speakers 

+ Dot-Matrix Printers: They are noisy and do not have good printing quality. As a result, they are 

losing popularity. Besides text, they are capable of printing charts and graphics. They are 

relatively economical. 

2. Non-impact Printers 

Non-impact printers do not allow physical contact between the printing head and paper i.e., they 

do not strike against the inked ribbon or the paper which is being printed. Whereas, only the ink 

used for printing, touches the paper. Non impact printers can produce better print quality and 

coloured graphics as well. The non-impact printers are categorised as thermal, inkjet, and 

laser printer. 

Thermal Printers: Thermal printers use a special heat sensitive paper. Characters are 

formed when heated elements come in contact with the heat sensitive paper, thus 

forming darkened dots. 

+ Ink-jet Printers They produce images by spraying tiny droplets of ink onto the paper. They 

have very high quality output and can also produce coloured graphics. They are cheap and 

ideal for home/office. The cartridge is quite costly and needs to be replaced more 

frequently. 

+ Laser Printers: These printers use photocopy technology to print. Laser printers use a 

laser beam and dry powdered ink called toner to produce a fine dot matrix pattern. The 

quality of output on paper is verygood. 

Speakers 

I 

Fig. 9.17: Ink-jet Printer 

Speakers are the output devices which are used to play sound. A speaker converts an alternating 

electrical current into sound. It may be built into the system unit or connected with cables. We can 

listen to music and various sound effects through them. 

Plotters 

A plotter is a vector graphic printing device which interprets commands from a computerto draw lines 

on paperwith one or more automated pens. Plotters are basically used forgraphical applications, like 

Computer Aided Designing (CAD) for printing maps and drawings. 

There are two types of plotters: Flatbed Plotters and Drum Plotters. 

1. Flatbed Plotter: A Flatbed plotter is also known as a Table Plotter. It plots on a paper that is 

spread and fixed over a rectangular flatbed table. A pen mounted on a moving carriage, 

moves in accordance with the signals received from the CPU and produces drawing on the 

paper. It isveryslow in drawing or printinggraphs. 

2. Drum Plotter: A Drum plotter is also known as a Roller Plotter. It consists of a drum on which 

a paper is placed. The drum then rotates back and forth to produce the graph on the paper. 

The pen, mounted on a fixed carriage moves horizontally across the paper to create a perfect 

drawing. They are more noisy and compact as compared to the flatbed plotters. 

Figure 9.20: 

Flatbed Plotter 

SECONDARY STORAGE DEVICES 
Fig. 921: Drum Plotter 

The primary memory due to its small capacity cannot store large amounts of data. Moreover, RAM is a volatile memory 

and cannot store the data permanently. Thus secondary storage devices are used to store information. The primary 

memory due to its small capacity cannot store large amounts of data. Moreover, RAM is a volatile memory and cannot 
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Figure 9.23: CD-ROM 

store the data permanently. Thus secondary storage until it is deleted or overwritten by the 

,ierTk ommonly used storage devices are: UJI. IIL 

Harà Disk 

It is the most common storage device for storing a large amount of data. It is also called HD or 

HOD (Hard Disk Drive) or Winchester Disk. It was introduced in 1954 by an IBM team led by Rey 

Johnson. 

Hard disk is made up of a collection of disks known as platters. Each platter requires two read/write heads one for each 

side. All the read/write heads are attached to a single access arm so that they do not move independently. Each platter 

has the same number of tracks to store data. A track location that cuts across all platters is called a Cylinder. It has the 

following properties: 

+ oated with magnetic material, it is hard and inflexible. 

+ lhas a large storage capacity. It can store up to 8TB of data. 

+ The disk rotates at a very high speed, varying from 5400 to 15,000 rpm (rotations per minute). 

CDRM 

A CD-ROM stands for Compact Disc-Read Only Memory. Read only means you cannot change 

the pre-recorded information stored on the disk. It is a type of optical disk capable of storing a 

large amount of data, information, software, etc. Today, most of the software, like audio, video, 

graphics, and multimedia presentations are found on CDs. The data from a CD can be accessed 

using a CD drive. 

CD's come in two sizes, the standard CD with 120mm diameter and mini CD with 80mm diameter. 

There are two types of CD ROMs: CD-R and CD-RW, 

+ CD-R (Compact Disk Recordable):  These disks can record data only once but can read data over and over again. 

+ CD-RW (Compact Disk Rewritable):  CD-RW is a rewritable disk. It allows us to erase the previously recorded data. 

We can write new data on a CD-RW disk multiple times. 

DVD (Digital Versatile Disk) 

Initially, it was called Digital Video Disk, the name later changed to Digital Versatile Disk. DVD can store high-quality 

video, audio, and other kinds of digital information, DVDs are available in single and double-sided versions. 

+ A DVD can store sixtimes more data than a CD. 

+ The data transmission rate ofa DVD is much fasterthan that ofa CD (approximately 15 times faster). 

+ A DVD can hold 4.7 GBto 17GB of data. Like a CD-ROM, a DVD is alsoavailable in manyversions, such as: 

+ DVD-R:  You can record data only once. 

+ DVD-RW  : You can erase and record data manytimes. 

4 DVD-R and DVDRV  have two additionalformats, which are + and-. Forexample: DVD-R and DVD+R. 

Blu-ray Disk 

Blu-ray disk is a new optical disk format that is rapidly replacing a DVD. This format was developed to enable recording, 

rewriting and playback of high-definition video (HD), as well as for storing large amount of data. The name Blu-ray disk is 

derived from the blue-violet laserwhich is used to read and write this type of disk. 

+  Largest Capacity:  It can hold upto 25 GB of data on a single layer and 50 GB of data on a dual layer disk. Blu-ray disk 

can store upto 6 times the data stored in a regular DVD. 
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A. Fill in the Blanks: 

1. A speaker converts an alternating electrical current into  

2. Laser printers use a laser beam and ink to produce fine print. 

3. A  is a vector graphic printing device. 

4. Hard disk is made up of a collection of disks known as  

5. Flash drive is plugged into the computer port. 

Ii{IRIIiJ Platters Powdered USB Plotter Sound 

B. State True or False: 

1. Ajoystick isa small instrument shaped like a pen used to provide input to mobiles, monitors and tablets. 

2. A bar code is a computer readable representation of information, present in visual format. 

3. A monitor is also called Visual Display Unit(VDU). 

4. The picture on a monitor is made up ofthousands of small coloured dots called Pixars. 

5. LED monitors offer better colourquality, clarity, and display than the LCD monitors. 

C. Answer the Following: 

1. What are peripheral devices? Give some examples. 

2. What is a Scanner? What are its types? 

3. What do you understand by a Monitor? Define pixels. 

5. What is HDD? Briefly explain its configuration. 

 

For Better Concept Clarity 

 

Create a presentation on various secondary storage devices. 

Fig. 9.24: 
Blu-Ray Disk 

+ 

ensures high quality video reproduction. Alithe latest 3D movies are now distributed only on Blu-ray. 

Maximum Picture Resolution:  Blu-ray disk delivers full 1080p high definition video support that 

+ Uncompressed Surround Sound:  Blu-ray disk ensures the highest quality audio reproduction and 

entertainment. 

+ Backward Compatibility:  Blu-ray disk players support and allow you to watch and enjoy your existing 

DVD libraries. 

+ Disk Robustness: Breakthroughs in hard-coating technologies enable Blu-ray disks to offer the 

strongest resistance to scratches and fingerprints. 

Flash Drive 

It is a small and portable flash memory data storage device, mainly used to transfer audio, video, and data 

files from the hard drive of one computerto another. It is removable and rewriteable. It is plugged into the 

computer's USB port. It consists ofa small PCB (Printed Circuit Board), which contains the circuit elements 

and a USB connector that is electrically insulated and protected inside a plastic, metal, or rubberised case. 
Hg. 9.25: 

Flash drive is also called Pen drive or Thumb drive and is available with storage capacity of up to 2TB of Flash Drive 

data. 

ASSESSMENT TIME 
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UNIT - III: Information and Communication Technology Skills

CHAPTER 10 
Basic Computer Operations 

Computer hardware and software are interdependent on each other. If any of these is not functioning properly, a 

corn uter is of no use. In this chapter, you will learn the process to start a computer and know about software and its 

type1. This chapteralso gives an overview of the commonly used operating systems. 

PROCEDURE FOR STARTING A COMPUTER 

When we start a computer, the booting process begins, which, initially checks whether all the hardware and software 

instaIed on the computer are working correctly. It also loads all the files needed to run a system. The next step in the 

booting process is called POST (Power On Self Test). This test checks the functioning of all the connected hardware, 

including primary and secondary storage devices. 

On passing POST, the contents of CMOS (Complementary Metal Oxide Semiconductor) chip are checked. It is a small 

amount of memory on the motherboard that stores BIOS (Basic Input Output System) settings. The primary function of 

BIOS is to boot up an operating system on the computer. BIOS includes the instructions to load basic computer hardware. 

It is responsible for accessing and configuringthe system settings like password, date, and time. 

Once all the steps of BIOS gets completed, the operating system is loaded into RAM. The OS then executes the pre-

configuration startup routines to define user configurations. Once the booting process gets over, you can log in to the 

computer with a username and a password. The desktop of the operating system appears, and you can start working on 

the computer using the required software applications. 

II  PROCEDURE FOR SHU1TING DOWN A COMPUTER 

When you shutdown a PC, the following things happen: 

If a program contains unsaved data, you are prompted to save it. 

All the open application programs get closed. 

The operating system shuts down by closing its programs, services and processes. 

+ Thepowermanagementhardwareturnsoffthepower. 

+ Now,youcanturnoffthecomputer'spowersupply. 

• o  OPERATING SYSTEM 

Computer being a machine cannot do anything on its own. It requires specific 

instructions on how to perform each and every task. Further, the instructions are to 

be converted in a language, which a machine understands. It means that the user 

cannot communicate with the computer directly. Thus, we require an interface 

between the user and the hardware. The Operating System acts like that interface. 

The computer interprets the instructions given by the user with the help of an 

operating system. It is the master program, which makes our PC alive and helps in 

running different applications.
Fig. 10.1:  OperatIng System 

The Operating System is just like the Principal of your school. The Principal has various responsibilities regarding the 

management of the school, like supervising students, teachers, and workers, maintaining discipline, analyzing 
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Fig. 10,2: DOS Prompt 

examination schedules, timetables, curriculum, meeting parents, and visitors. In the same way, a number of services are 

provided by an operating system. Imagine, what will happen if there is no Principal in a school. Everything will become 

unorganised. Similarly, if the operating system is not working in a computer, it will not be able to perform any operation. 

The Hardware provides the user with basic physical resources to work upon. The application/utility softwares empower 

the user to perform a variety of functions on the computer, like solving problems, creating documents, playing games, 

etc. Operating System acts as a central coordinator between hardware and software. 

Some of the popular operating systems are: 

+  WINDOWS ~  MAC OS -.-  LINUX +  DOS 

FUNCTIONS OF OPERATING SYSTEM 

+ To manage and share the hardware/software resources of a computer system. 

• To provide an interface to the users to communicate with the computer 

system. 

+  To communicate with each application or interactive user (or to a system 

operator) about the status of operation and any errors that may have occurred. 

+ To secure the system and block unauthorised access to the system. 

TYPES OF OPERATING SYSTEM 

In the past three decades, computers have taken a giant stride towards excellence and high performance. This has been 

possible due to the evolution of operating systems. Let us learn about the different types of operating systems: 

SINGLE USER OPERATING SYSTEM: These operating systems could support only one user to do one thing at a time, like 

Microsoft Windows 3.1, Microsoft Windows 95, and Microsoft DOS. 

GRAPHICAL USER INTERFACE (GUI): This operating system is graphic based and interactive in nature, like Windows 

Operating System, Mac OS, Linux, etc. 

MULTI-USER OPERATING SYSTEM: Multi-user operating systems allow more than one user to use the same computer at 

the same time, like Linux, Unix, and Microsoft Windows 2000 onwards. 

MULTITASKING OPERATING SYSTEM: The ability to perform more than one task at the same time is called Multitasking, 

like Microsoft Windows 9x, Windows 2000 onwards, Linux operatingsystems. 

MULTITHREADING OPERATING SYSTEM: These are the operating systems which allow different parts of an application 

or program to run simultaneously, like Microsoft Windows 9x, Windows 2000 onwards, Linux. 

II  DISK OPERATING SYSTEM 

Disk Operating System (DOS) isa type of system software that runs from 

a hard disk drive. It is a command line operating system where a user 

needs to type the commands for every action to be performed on the 

computer. DOS can support multiple directories, networking, enhanced 

memory management, text editing functions, disk compression, and 

fragmentation. However, its command line utility makes it difficult for 

beginners to use. DOS does not support multiple users or multitasking as 

it can run only one program at a time. DOS was most commonly found 

operating system in IBM PCs that were developed by Microsoft in 1981. 
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II  LINUX 

Linux is the operating system that is open source and free. It was developed by Linus S 

Torvalds in the year 1991. Linux has become the most popular alternative to other costly 1I1UX 
operating systems due to its amazing features given below: 

+ Portable Open Source and Free 

+ Multi-Userand Multiprogramming Hierarchical File System 

+ Shell Security 

II  WINDOWS 

Microsoft Windows is a series of Graphical User Interface (GUI) operating systems, which are developed, marketed, and 

sold by Microsoft. Windows OS was the first graphical user interface for IBM-compatible PCs, which soon dominated the 

PC market. 

II  MOBILE OPERATING SYSTEM 

Mobile Operating System is also known as Mobile OS. It is particularly designed to operate smartphones, PDAs, tablets 

and other mobile devices. Mobile Operating System is a software, which provides platform on which other programs or 

applicationscan run on mobile devices. 

There are various kind of Mobile Operating System used in smartphones such as, BlackBerry (RIM), Android (Google), 

lOS (Apple), Symbian (Nokia), and Windows Mobile (Microsoft). 

ANDROID OPERATING SYSTEM (OS) 

Android is the world's most popular Mobile Operating System. It is an open source (Linux based) platform initially 

developed byAndroid Inc. in October2003, and lateron purchased byGoogle Inc. in 2005.Thegreen robotisthelogofor 

the Android operating system. Android OS turns your phone into a powerful web browser, game console, and personal 

assistant all in one. 

SYMBIAN OPERATING SYSTEM (OS) 

Symbian is a mobile operating system which is specifically created for smartphones. Symbian was originally developed 

by Symbian Ltd and is currently maintained by Accenture. Symbian was primarily used by Nokia and was also used by 

many major mobile phone brands like Samsung, Motorola, and Sony Ericsson. Android overtook it in the end of 2010 

untilthen it wasthe most popularOSfor smartphones. 

iGS 

iOS is a mobile operating system developed by Apple. It is the world's most advanced mobile operating system. It was 

originally released in 2007 and is used to run the iPhone, iPad, and iPod Touch. Formerly it was known as iPhone OS. 

Un'ike other Mobile OS such as Android (Google) and Windows (Microsoft), Apple does not authorize iOS forinstallation 

on any non-Apple hardware. Therefore, OS devices are created exclusively for its hardware. Apple designs the lOS 

devices to maintain a high level of security without compromising the user's experience. Due to their exceptionality of 

apps, games, and features, lOS devices cost more than any other mobile OS gadgets available in the market. 

WINDOWS MOBILE OPERATING SYSTEM 

It is a mobile operating system developed by Microsoft for smartphones and mobile devices based on the Windows CE 

Kernel. It is designed to look and operate similar to desktop versions of Microsoft Windows. It has given a whole new 

dimension to e-mailing and documentation. 

Some ofthe Windows Mobile OS are: Nokia Lumia 920, SamsungATlVS, and Windows Phone 8C by HTC. 



A. Multiple Choice Questions: 

1. The name of the Edubuntu's Graphical User Interface is  

a. Unity b. Bash c. Kernel d. shell 

2. The  checks the functioning of all the connected hardware, including primary and 

secondary storage devices. 

a. Booting process b. POST c. Power on d. Input Unit 

3. operating system runs on computers which are located in different geographical areas, 

interconnected through a network. 

a. GUI b. Command line c. Real time d. Distributed 

4. The small labelled pictures orsymbols present on the desktop are called  

a. Icons b. Pixels c. Buttons d. Commands 

5. The operating system has two components and  

a. Software and Hardware b. Software and Technologies 

c. Shell and Kernel d. Files and Devices 

B. Fill in the Blanks: 

1. The  operating systems allow different parts of an application or program to run 

simultaneously. 

2. The stores the deleted files in Edubuntu. 

3. A batch file consists of a series of  to be executed by the command-line interpreter. 

4. DOS files are organised in a  or an inverted tree-like structure. 

5. Linux was developed by  in the year 1991. 

i1iliiiJ Directory .- Disk Single User Linus Torvalds Interpreter 

C. Answer the Following Questions: 

1. What is system software? 

2. What do you mean by multitasking operating system? 

3. Who wrote the original disk operating system? 

4. What do you mean by multithreading OS? 

5. What are the various categories of system software? 

6. What security measures does an operating system provide to a computer? 

7. Explain the directory structure of DOS with the help of an example. 

     

     

 

For Better Concept Clarity 

  

     

Create a presentation on the topic, 'Various types of Operating Systems'. 

Windows Mobile OS is mainly classified into three main versionsforvarious hardware devices: 

Smartphones with touchscreen are supported with Windows Mobile Professional Version, mobile phones without 

touchscreen run on Windows Mobile Standard, and the last version of Windows Mobile OS is Windows 10 mobile which 

runs on mobile phones and tablets. Microsoft will stop providing support and updates for Windows 10 mobile bythe end 

of 2019. 

ASSESSMENT TIME 
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U  I  T - III: Information and Communication Technology Skills 

CHAPTER 11 
Operating Systems 

As you know, an Operating System is the first software that gets loaded into the computer memory while booting and it 

acts as a medium between a user and the hardware. Two of the most commonly used operating systems now-a-days are 

Windows 7 and Linux. Let's discussthem. 

)EII  WINDOWS 7 

Windows 7 was produced as a part of Windows NT family of operating systems. It was made available for use on October 

22, 2009. It became very popular because of its user-friendly environment, noticeable speed improvement, and its 

modestsystem requirements. Some of itssignificantfeatures are discussed below: 

FEATURES OF WINDOWS 7 

+ EasyTo Use 

+ Multitasking 

+ Searching Made Easier 

+ PinningloTaskbar 

+ ero Peek 

+ Live Taskbar Preview 

+ JumpListOnStartMenu 

STARTING WI N DOWS 
Fig. 11.1: Windows Desktop 

When you switch on the computer, Windows starts automatically and displays a welcome message. It isfollowed by the 

first screen of Windows known as Desktop. It contains some graphic symbols called icons. 

D1SKTO 

The word 'Desktop is derived from the real life desktop (the top of our working table) where you may find pen stand, 

notepad, calculator, files, etc. The desktop of Windows also serves the same purpose. You can find various icons like 

objects, shortcut icons, document icons, disk drive icons, etc., on the desktop. 

Taskba r 

Taskbar is a long horizontal bar at the bottom of the desktop. It has the Start button 1  on the extreme left side. The 

middle section of the bar shows buttons with a label for each of the opened applications and allows us to quickly switch 

between them. You can activate the application window by clicking on its taskbar button. When an application is active, 

its button ishighlightedina lightershade. 

Quick Launch Bar is present on the right side of the Start button on the taskbar. The icons displayed on this bar help in 

quickly accessing programs/applications. 

Notification Area at the right side of the taskbar includes a clock and group of icons that provide status and notifications 

about things like updates, network connectivity, incoming mails, battery, volume, etc. 

Show Desktop  button is present on the extreme right of the taskbar. Simply placing cursor on this button minimises all 

the open windows and shows the desktop. 
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Fig. 11.2: Taskbar 
Notification Area  

Start Button 

The Start button is probably the most frequently used component of the Windows desktop. When you click on the Start 

button, a menu displaying the major applications appears. These headings provide access to the main programs of your 

computer. You can start programs, open documents, customise your system, get help, and search for items on your 

computerthrough the Start button. 

Let us have a glimpse at the menu of the Start button: 

<- Documents 

Pictures 

Music 

• Games 

+ Computer 

+ ControlPanel 

+ Devices And Printers 

+ Default Programs 

+ HelpAndSupport 

Shut Down Your Computer 

Click on the Start button and select the Shut down button at the bottom of the 

right pane. The system gets shutdown. 

Icons 

Fig. 11.3:  Shutdown 

Small graphic symbols displayed on the desktop are called icons. Windows uses many objects that have specific functions 

such as: Files, Programs, Computer, Folders, Network Neighborhood /Network, Shortcuts, and Recycle Bin. Icons play a 

very important role in Graphical User Interface. 

Some Important Icons 

Let's discuss some default icons that appear on Windows 7 desktop. 

Computer 

Double click on this icon to explore your computer. It opens the icons to explore all your hard drives and displays a sidebar 

that contains Favorites, Libraries and Computer sections. 

Favorites: By default, in Windows 7, Favorites for Internet Explorer are saved in the C:\Users\ [username]\Favorites 

folder. 

Learning 
Computers with  Kips 

 

74 

 



Ubraries: A Library isa reference to one or more folders on your computer and the files found inside those folders. When 

oening a library, Windows Explorer displays all the files and folders that are part of it, as if they are physically stored 

inside the Library. They can help users organize their files and folders efficiently in one place regardless of where they are 

stored. The default sub-folders inside Library are: Documents, Music, Pictures and Videos. 

Computer: Complete information regarding the system drives and other peripherals can be viewed under Computer. 

Usually, it displays three categories of information - Hard Disk Drives, Devices with Removable Storage, Network 

Loation. 

Network: This icon allows you to access the shared resources, such as files and printers. 

Recycle Bin 

TIe Recycle Bin is used by Windows computers to store deleted items. It temporarily stores files and folders before they 

ar! permanently deleted. You can open the Recycle Bin by double-clicking the icon on the Windows desktop. The Recycle 

Bi window allows you to delete items individually or restore them to their original location. If you want to permanently 

remove all items in the Recycle Bin, select Empty the Recycle Bin in the left sidebarof the window. 

Shortcut Files & Folders 

The Windows desktop contains shortcut icons of various files, folders and programs. These icons can be used to open it 

repectively from the ease of the desktop. 

COMMON DESKTOP OPERATIONS 

The Windows 7 desktop provides variousfeaturesto control and manage its appearance. Some of them are: 

Managing Wallpaper:The  desktop background is called the Wallpaper.To change it: 

1. Right-click a blank part of the desktop and choose Personalize. The Control Panels Personalization pane appears. 

2. Click the Desktop Background option along the windows bottom left corner. 

3. Click any ofthe pictures, and Windows 7 quickly places it onto your desktop's background. 

4. Clickthe Browse button and click a file from inside your personal Pictures folder. 

5. ClickSaveChangesand exitthe Desktop Background windowwhenyou'resatisfied with yourchoices. 

Managing Screensaver:  A screensaver is a computer application that blanks the screen of the computer when it is 

inactive orfills itwith images or patternsto avoid phosphor burn-in on plasma and CRT monitors.Toset a screensaver: 

1. Right-click a blank part of the desktop and choose Personalize. The Control Panels Personalization pane appears. 

2. Choose Screensaver icon from the bottom of the screen 

3. UnderScreen saver, in the drop-down list, clickthe screen saveryou want to use. 

4. Click Preview to see what your chosen screen saver will look like. 

5. Click OK. 

Setting up System Date/Time:  Current system Date and time is displayed on the bottom right corner of your desktop. To 

change it 

1. Click on the clock in the icon trayat the bottom right ofyourcomputerscreen. 

2. This should show the clock, date and calendar. Click on Change date and time settings... to get the Date and Time 

menu. (Alternatively, use Start >Control Panel> Date and Time.) 
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3. Click on Change time zone and select your time zone. 

4. When you have the correct time zone, check that the time displayed in the Date & Time tab is correct. If not, change 

it and click Apply. 

5. When complete, click on OK, 

Volume Control: The volume control icon icon is displayed on the bottom right corner of the Windows 7 desktop. Use it 

to controlthe volume of all types of sound output. 

Linux is the operating system that is available free of cost. Itwas developed by Linus Torvalds ' 

on 5th October 1991. Linux has become most popular because it is freely available, easy to 

use and operate and also allows usersto work on many programs atthe sametime 

COMPONENTS OF LINUX OPERATING SYSTEMS 

Ubuntu is a free open-source Linux operating systems which is especially designed to be used in the field of education. It 

has a lot of educational applications and tools which help students in their studies. 

Desktop 

The first screen that appears covering the entire screen with two bars, one on its top and other on its left, is called the 

Desktop. The image in the background is called the Desktop Wallpaper. The small labelled pictures or symbols present 

on the desktop are called Icons. These icons are used to open specific programs ordocuments. 

Let us understand each component of a desktop in detail: 

Fig. 11.4: Eduburitu Desktop 
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A. FillintheBlanks: 

1 Windows is a very popularoperating system because of its  environment. 

2   is the first screen displayed after switching-on windows. 

3,   at the right side of the taskbar includes a clock and group of icons. 

4 Small graphic symbols displayed on the desktop are called  

5. The is used by Windows computers to store deleted items. 

HINTS Notification area Desktop Recycle Bin Icons User-friendly 

B. State True or False: 

1. Start button is located on the extreme right side of the Taskbar on the Windows desktop. 

2. The desktop background is called the Wallpaper. 

3. Linux operating system was developed by Microsoft Corporation. 

4. Ubuntu is a free open-source Linux operating systems. 

C. Answer the Following: 

1. What is Linux? Discuss a few features of Linux. 

2. What is a Screensaver? 

3. What is Recycle Bin in Windows? How to empty it? 

4. How to setup system date and time in Windows? 

5. Define Icon. Mention some of the important icons present on Windows 7 desktop. 

For Better Concept Clarity 

Prepare a presentation on the components of Windows 7 desktop. 

The Menu Bar 

The Menu bar is a long horizontal bar located at the top of the desktop. It includes common functions used in Ubuntu. 

Indicator Area 

On the right side of the Menu bar liesthe IndicatorArea, which shows clock, calendar, speaker volume, etc. 

The Launcher 

Launcher is the vertical bar on the left side of the desktop. Here you can add commonly used programs, which can be 

opened easily whenever required. The Trash at the bottom, stores the deleted files. The Launcher also shows the 

applications icons that are currently running on your computer. 

The Dash 

It is the topmost icon on the Launcher and has Ubuntu logo on it. Its function is similar to the Start menu of Windows. 

When you click on the Dash icon , a window opens up towards its right. This window has a Search bar at the top and 

the icons of recently used applications, files, and downloaded items at the bottom. 

ASSESSMENT TIME 
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UNIT - Ill:  Information and Communication Technology  Skills

CHAPTER 12 
Introduction to Internet 

Internet is a global system of interconnected computer networks that enables the users to share information and 

various resources with each other. It uses common communication standards and interfaces to provide the physical 

backbone fora numberof interesting applications. 

:II  APPLICATION OF INTERNET 

Internet is a boon to the world. Almost every aspect of our life is touched by the Internet. Interestingly, Internet provides 

24x7 services. Some of the common uses of Internet are as follows: 

Education E-mail Business E-Commerce 

Media and Entertainment Social Networking Forum: Health and Fitness 

I  DISADVANTAGES OF INTERNET 

Internet has become an important and integral part of our personal and professional life today. However, it is a tool, 

which must be handled with caution, as its misuse can be very harmful. Some of the threats of Internet are as follows: 

Virus Threat Spamming CyberCrime Pornography 

Cyberlerrorism Time Wastage 

II  WORLD WIDE WEB 

The www (world wide web) or simply web is a means of accessing information over the Internet. It contains millions of 

documents or bunch of pages' called Web Pages. Each page contains text, graphics, video, audio, and is linked to other 

web pages via hyperlink. The web uses the HTTP (HyperTextTransfer Protocol) for the transmission of these documents 

over the Internet. 

1I  WEB BROWSER 

Web browser is a software that is used to view websites. It is an interface between a user and the World Wide Web. A 

web browser can have a graphical user interface, e.g., Internet Explorer, Mozilla Firefox, Google Chrome, Opera, or can 

be text-based, e.g., Lynx. The user can navigate files, folders and websites using hyperlinks. Multiple tabs and windows 

of the same browser can be opened. The features and facilities offered by a web browser include downloads, 

bookmarks, and password management. It also offers functions, like spell checking, search engine tool bars, tabbed 

browsing, advertisement filtering, HTML access keys, and pop-up blocking. 

The most popular web browsers are: 

             

     

it 

    

         

    

Google chrome Mozilla Firefox Apple Safari 

 

       

        

         

         

         

             

             

             

    

Microsoft Internet Explorer (MSIE) 

      

Microsoft Edge 
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II I  WEBSITE 

A website is a collection of related web pages containing images, videos, or other digital media set under the same 

domain name. These pages are written in Hyper Text Mark Up Language (HTML) and can be accessed via Internet. A 

website is hosted on a web server on the World Wide Web. Each site is owned and managed by an individual, a company, 

or an organization. Components of a website are: 

1. Domain Name 

3.Sie Files 

2. Web Host 

4. Content Management System (CMS) 

UI WEB PAGE 

Web page is a digital page which may contain text, hyperlink, videos, audios, images, tables, etc. It is commonly written 

by using HTML (Hypertext markup language) and is stored on a web server. Each webpage is identified by a unique web 

address called Uniform Resource Locator (URL). Basic elements of a web page are: 

1. Page Title 2. The Header area 3. The Navigation Menu 

4. Content Area 5 .Footer 

There are two types of web pages: 

1. Static web pages: The contents of static web pages remain stationary irrespective of the number of times it is 

viewed. Such web pages are suitable forthe contents that never of rarely need to be updated. 

2. Dynamic web pages: The contents of a dynamic web pages is generated for the user at the time one request for the 

page. The document you view exists only for you at that moment; if viewed by someone else at the same time, or by 

you at a slightly different time, you could get something different. 

DIFFERENCE BETWEEN WEB PAGE AND WEBSITE 

A website is a collection of web pages, connected by links. It contains information on a subject, whereas web page is a 

single page of content on a website which contains more specific information. We can compare a website with a book 

and a webpage with the particular page of that book. 

II  PROTOCOL 

It is a standard set of rules used for communicating or transferring data on internet. These rules include what type 

of data may betransmitted, what commands are used to send and receive data, and how data transfers are confirmed. 

II  H1TP 

Hpertext Transfer Protocol is an application layer protocol for transmitting hypermedia documents, such as HTML. It 

is designed to establish communication between web browsers and web servers. 

II  HOME PAGE 

It is the first web page of a website. It is the main page where visitors can find hyperlinks to other pages on the site. 



For Better Concept Clarity 

I  UNIFORM RESOURCE LOCATOR (URL) 

The Uniform Resource Locator denotes the global address of the web documents and the web resource. Internet 

communication isthe main reason for identifying a resource on the web. The URL has two parts: 

1. Protocol Identifier: It tells the Internet browser what protocol needs to be followed to access the address. 

2. Resource Name: It specifies the complete address of the resource on the Internet. 
http://www.mygov.in   

Rmource Name 

ASSESSMENT TIME 

A. Multiple Choice Questions: 

1. HTlPisanacronymfor  

a. HyperTextlransfer Protocol b. HyperText Transcript Protocol 

c. HyperTech Transfer Protocol d. HyperTech Transcript Protocol 

2. Aweb page is written using . language 

a. C++ b. Python c. HTML d. Java 

3. A set of rules used to communicate in a network is called  

a. Hyperlink b. Web page c. Satellite d. Protoco 

4. A unique name given to each website is called  

a. Domain b. TCP/IP c. Web Name d. Title 

5. Chrome and Internet Explorer are popular  

a. Websites b. Search Engines c. Web Browsers d. Internet Service Providers 

B. Fill In The Blanks: 

1. Web browser is an between a user and the World Wide Web. 

2. Web pages are written in  

3. The denotes the global address of the web documents and the web resources. 

4. The contents of a web page never of rarely needs to be updated. 

5. A  can be compared with a book and a with the particular page of that book. 

HINTS Static Website HTML URL Webpage Interface 

C. Answer The Following: 

1. What is Internet? What are its applications? 

2. What do you understand by the term Web Browser? Mention some popular web browsers. 

3. What is the difference between a Website and a Web page? 

4. Define URL. Explain with example. 

Make a list of URLs (5 each) of the e-commerce, education, social networking and news websites. 
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UNIT  -  III: Information and Communication Technology Skills 

CHAPTER  

Introduction to E-mail 
Today, in this digital communication era, e-mail (i.e., Electronic Mail) proves to be the biggest asset in sending and 

receiving messages from one computer to another. It allows us to communicate quickly with people around the world at 

any time. E-mail is an economical mode of communication. It facilitates you to send the same message to more than 100 

peopleatthecostofa local phonecall. Italso helps in reducingthewastageof paper. 

II  APPLICATIONS OF E-MAIL 

+ Cost of sending an electronic message is nominal. 

Messages are sent and received instantly. 

E-mails neverget lost and do not reach the wrong destination. 

E-mail allows usto be in touch with the people who are stayingfaraway, in no time. 

We can attach pictures, videos, soundsto oure-mails, and can send theseto anyone acrossthe globe. 

We can read, print, forward, reply, delete, or save the received messages. 

+ E-mail is usually packaged with many productivity tools, such as an address book, calendar, instant messenger and 

more for convenience. 

+ E-mail provides the customer verification, required to use other web services, like Social-networking, Online 

shopping, etc. 

+ E-mail can be accessed anywhere at anytime on anycomputeror mobile devicethat has an Internet connection. 

I  E-MAIL ACCOUNT 

E-mail Account is an electronic mailbox on a network where e-mails 
kipspublishingworld  

can be sent. An Email Account acts as a virtual address for Email 
mail .com 

V 

Messages. It is provided to you by your Email Account Provider (in Use name "At" Domain Name 

most cases your Internet Service Provider) and contains information 

about your Username, Email Account Provider, Password and Email 

Settings. To read or download these e-mails, you must supply your account name and password. 

Domain 

Extension 

E-MAIL ADDRESS 

E-mail address is a name that uniquely identifies an e-mail account on a network. To send and receive e-mails, we need 

to have an e-mail address. While sending an e-mail, we enter the e-mail address(es) of the recipient(s), so that the 

computer knows where to send it. The e-mail addresses can be written either in capital letters or in small letters. It does 

not contain spaces, e.g., abc@gmail.com. 

An e-mailaddress usually consists of two parts, separated by the @ (at) symbol. 

I  E-MAIL PROGRAM 

For using web-based e-mail, one needs to first register with an e-mail service provider in order to get a free account and 

create a login with a username and password. This username is the e-mail address which becomes operational. Using 



this e-mail address and password one can login to the web-based e-mail. After logging in, one can create, send, receive, 

forward, and delete e-mails. 

Some of the well-known free web-based e-mail services are: 

I. Gmail.com  

ii. Yahoo.com  

iii. MSN.com  

III  E-MAIL MESSAGE FORMAT 

All e-mail messages irrespective of the e-mail software have the following format: 

GMaiI 
-'xIIooI  

msrt 

E-mail Message Format 

From E-mail address of the sender. 

To E-mail address of the recipient. 

Subject The topic of the message. 

Cc Cc stands for Carbon Copy. List of e-mail addresses to whom the mail has also been sent. 

All the recipients of the mail can see all the addresses in To and Cc. 

Bcc Bcc stands for Blind carbon copy. Like Cc, this also contains a list of multiple recipients' 

address to whom the copy of the message is to be sent but the receiver cannot see the other 

recipients addresses in the Bcc list. 

Message body The actual content of the e-mail. 

III  CREATING AN E-MAIL ACCOUNT 

Let us understand how to create an e-mail account and get our e-mail address: 

Connect to the Internet. Open the website www.gmail.com. 

- Click on the Create account link and proceed to the next page. 

A registration form will appear. Fill the registration form, choose a username and 

password. 

Accept the agreement. An e-mail account gets created if all the entries have been 

filled properly. 

After creating an e-mail account, it can be used to send and receive e-mails. To use the 

e-mail account, one must login with the username and the password. 

III  INBOX 

It displays information about all the received mails. Each message header displays the 

Go o]e 

Create your Googe Account 

ro conrinr !o Ornail 

v 

Las: ri 

Usernarne @flI.COffi 

aflele nrnaflben &peeods 

Password conrirrn password 0 
uw8oredtfl,wO amx of flfl floaterS & 
raasors 

Sign a rrStoad 

Fig. 13.1: Creating an 
E-mail Account 

senders name, subject line, time, and date when the mail is received, and sometimes the size of the message too. To 

read any mail, click on it. The mail will be displayed in a new window. 

fl  COMPOSE! WRITE MAIL 

To write a mail, one has to click on the Compose option (or any other similar option provided by the website). It will 

open a new window with the following components: 
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Here, we can type the e-mail address of the person, to whom we 

wartto send the e-mail. 

Cc stands for Carbon Copy. In this field, one can specify the 

addresses of the persons to whom one wants to send a copy of the 

mail. The e-mail addresses mentioned in this field are visible to all 

the recipients of the mail. 
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FIg. 132: Inbox of gmaiLcom 

 

Bcc stands for Blind Carbon Copy. It is also used to send a copy of the mail to several people, but the e-mail addresses 

mer?tioned in this field are not visible to other recipients of the mail. 

ISUJ EC 
NI  C....I 

It is a brief description of the mail, which gives an idea about the 

content of the message. 

MESAGE 

You can type the message just like a normal letter with greetings, : . 

one or more paragraphs, and your name at the bottom. You can 

also format the text using the available features. s-I-  stJ.  - U  I  a• 5 a.  a   

a.
-I 

1I  SENDING E-MAIL Fig. 13.3: SendIng an E-mail 

After composing an e-mail, click on the Send button. The mail will be sent to its recipient/recipients. 

ATTACHING A FILE 

E-mail provides the facility to attach files for high speed delivery, anywhere in the world. Attaching a file to an e-mail is an 

easy way to send important documents or files, which can be photographs, videos, music, or text. To attach a file to an e-

mail, follow these steps: 

- Click on the Attach a file icon on the toolbar at the bottom of the Compose window. 

The Open dialog box will appear. 

Browse through your files and select the file you would like to attach. 

Click on the Open button. The file gets attached to your mail. Now click on the Send button. 

Always remember, you cannot send executable files or messages largerthan 25 MB as an attachment. 

Nowadays, the Internet provides some emerging technologies that enable us to transfer files beyond 25 MB. Some of 

the most popular services are WeTransfer and Sendspace. 

REPLYING AND FORWARDING E-MAIL 

The Reply option is displayed when we open any mail. It is used to reply to a received e-mail. Click on the Reply button, 

type in the text, and then click on the Send button. 

The Forward option is used to send any received mail to other e-mail address(es). 
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A Multiple Choice Questions: 

1. folder of an e-mailaccountcontains all the received mails. 

a. Inbox b. Drafts c. Trash d. Spam 

2. An unwanted mail or message sent to a large numberof people is called  

a. Worm b. Spam c. Virus d. Trash 

3. An E-mail address consists of two parts separated by7 the '@'symbol,  a User Name and a  

a. Address b. Domain ID c. URL d. Domain Name 

4. Which of thefollowing is not a free web-based e-mail services? 

a. Gmail.com b. Facebook.com c. Yahoo.com d. MSN.com  

5. In an E-mail message, Cc stands for 

a. Carbon copy b. Cannot copy c. Can copy d. Contains copy 

B. State True or False: 

1. E-mail is an expensive mode of communication. 

2. In an E-mail message, Bcc stands for Blind carbon copy. 

3. All the received mails are automatically stored in the Trash folder. 

4. No video, music or text file can be attached to an E-mail. 

5. In the To section of an E-mail message, we can type the e-mail address of the sender. 

C. Answer The Following. 

1. What are the two parts of an E-mail address? Briefly explain each of the. 

2 Why is E-mail so popular over conventional mails? 

3. Whatarethepartsofan E-mail? 

4. Discuss the procedure to attach a file to an E-mail message. 

For Better Concept Clarity 

Create an E-mail account on www.outlook.com  and send a mail to your friends telling them about your 
plans for the upcoming vacation. 

1 

ASSESSMENT TIME 
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UNIT - Ill: Information and Communication Technology Skills

CHAPTER 14 
Introduction to Social Media 

A Social Networking Site is an online platform that facilitates the building of social networks or social relation among 

people who, share similar interests, activities, backgrounds, or real-life connection. Social networking can be done for 

social purposes, business purposes, or both. Social, networking sites are also called Social Media. In a social networking 

website, users create profiles, which contain information about them, create a list of users with whom to share 

connections, and organise their social networks. 

Some popular social networking sites are: 

+ Twitter +  Facebook +  YouTube WhatsApp 

• Ij FEATURES AVAILABLE ON SOCIAL MEDIA 

+ BuildProfile + Simplelnterface + MediaGalleries PhotoAlbums 

+ Communities + Conversations + Tags Chat Facility 

+ ActivityRecord + E-mailAlerts + RealTimeUpdates FreeWebAddress: 

• ii MERITS OF SOCIAL MEDIA 

+  EasierToConnect +  Create New Connections Free Business Promotions 

+ Aids In Criminal Cases + Spreads Information Incredibly Fast 

DEMERITS OF SOCIAL MEDIA 

+  Cyber Bullying + Less Real Life Interaction Addiction 

+ Misleading Information + Misuse of Information Fake Profiles 

+ Peer Pressure 

•II BLOG 

A blog is an easy-to-create website that allows users to share their thoughts with the world. The topic of 

the blog can be anything from personal to professional. A blogger is someone who blogs or writes content 

for a blog. A blogger can provide links to other websites that he/she considers might interest the audience. 

Blogging can be an interactive activity. Readers can add comments to a blogger's postings, other persons 

can respond, and a conversation ensues. 

TYPES OF BLOGS 

There are various types of blogs available on the web. We can categorize them into the following categories: 

~  Personal blog .  Company blog +  Non-profit blog 

+  Politics blog News and Views blog +  Micro-blog 

II  TWITTER 

Twitter is a free social networking and microblogging service. Twitter offers a platform to share the brief information or 

the links for interesting news or topics that can benefit people. It is the 13th most visited websites worldwide. It has been 

termed as the "SMS of the Internet". 



Salient features of Twitter include: 

Twitter Handle: A Twitter handle is the term for a user's account name on Twitter. It is listed by putting 

an '@Ysymbolbeforetheusername. 

x2s: Subscribers use Twitter to communicate and broadcast short messages called Tweets. Tweets 

were initially restricted to 140 characters, which has now changed to 280 characters. Posting the messages is called 

'Tweeting' and reposting someone else's tweet is called Retweeting. Tweets are instantaneous, within seconds they can 

spread news or announcement worldwide. 

Hashtags:  People use the hashtag symbol (#) before a relevant keyword or phrase in their Tweet to highlight the 

keywords or topics. 

FcHcw:The users can search and connect with other people by 'following' them on Twiter and tweeet in them. You can 

also 'unfollow' people if you do not wish to include theirtweets in yourtwiter feed. 

Twitterfeed (orTimeline): It is an ongoing stream of tweets from the users that you follow. 

II  FACEBOOK 

It is another popular social networking website which is used to connect with people online. It also 

provides free registration and a user-friendly platform. Initially, it was only PC based, but now it is also 

available as a pre-installed app on most of the mobile phones and tablets. 

Following are a few of its most popular offerings: 

Friends List: It allows registered users to create their profiles and create a list of their contacts, called 'Friend' in the 

Facebook language. 

Walls: It is essentially a virtual bulletin board where members can post messages, pictures, or videos and share links to 

their Facebook friends. 

Virtual Photo Album: This feature allows members to upload an unlimited number of photos. The members, 

'friends' may comment and identify or 'tag' people in the photos. 

Status Update: It is a microblogging tool that helps the users to broadcast short announcements about themselves. 

Facebook Pages: This feature was initially designed for business use. It allows businesses to publish content on a 

public page and receive comments. 

News Feed: This feature constantly updates list of stories in the middle of your home page. News feed includes status 

updates, photos, videos, links, app activity and likes from people, pages, and groups that you follow on Facebook. 

Privacy Controls: Facebook provides a customisable set of privacy controls, so users can protect their information 

from getting exposed to third-party individuals. 

Ull  YOIJTUBE 

YouTube is a free video sharing website. You can find all kinds of user generated videos on 

YouTube, such as tutorials, cooking lessons, exercise tips, music, comedy, and a lot more. It 

allows you to: 

Select videos from a grid of recommended and trending videos You can watch, like, share, and comment on the 

videos. 

Manage subscriptions, replayfrom history, manage playlists, or choose videos from various categories, 

Download and Upload videosfrom yourcomputeror mobile phones. 

Choose the privacy settings of your channel. 

Edityourvideos togive them a professional look usingvarious editing tools like Combine, Trim (cut orSnip. 
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+ 

Wha 

Wha 

tsApp is one of the most popular instant messaging apps worldwide. 

tsApp now offers high-qualityvoice as well as video calling. 

The cost of using WhatsApp is significantly less than texting. 

It has a simple interface and many usefulfeatures, such as group chatting, video calling, location sharing, etc., 

Wha 

I, 

tsApp allows you to formatthe selected text of your message in Italic, Bold, Strikethrough, underscore, asterisk 

Ide (), and Monospace. 

ASSESSMENT TIME 

A. Fill in the Blanks: 

1. popular social networking website which is used to connect with people online. 

2. One can find all kinds of user generated videos on  

k isa free to download messenger app for smaphones. 

IL Social networking sites are also called as social  

5. Social networking sites are highly popular due to their simple  

YouTube Interface Media WhatsApp Facebook 

B. State True or False: 

1. YouTube is a paid video sharing website. 

2. Facebook isa social networking website used to connect with people online. 

3. Parental Control and Safety Mode features are available on YouTube. 

4. WhatsApp doesn't offer voice or video calling facility. 

5. YouTube facilitates you to download videos so that you can watch them later offline. 

C. Answer the Following: 

1. Mention names of some of the popular social networking websites. 

2. What are the demerits of social media? 

3. What do you understand by a Blog? 

4. State some of the features of YouTube. 

5. What is Facebook? Mention some of its features. 

For Better Concept Clarity 

+ Download an educational video on YouTube to watch it offline at a later time. 

+ Send a link of the same video through WhatsApp to your class WhatsApp group. 
1 
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Employ Parental Control and Safety Mode features to restrict the types of videosyour children can watch. 

WhatsAop is a freeto download messenger app for smartphones. Some interestingfacts about WhatsApp are as follows: 



Recap ,V'
Information and Communication Technology (lCT) refers to all the devices, 

networking components, applications, and systems that allow people and 

organisations to interact in the digital world. 

ICT is very helpfultovarious sectors such as workplaces, healthcare, education, governance, business, etc. 

A computer is an electronic device that can perform a variety of tasks by executing a given set of instructions. 

CPU isthe main unit ofa computerwhich consists of Memory Unit, Arithmetic and Logical Unit, and Control Unit. 

DRAM, SRAM, DDRAM and DDR are the types of Random Access Memory. 

PROM, EPROM, EEPROM and Flash Memoryaretypes of Read Only Memory. 

Peripheral devices are those hardware components that are attached to a computer and are controlled by the 

computer system, butthey are notthe core components of the computer. 

POST (Power On Self Test) checks the functioning of all the connected hardware, including primary and 

secondary storage devices during bootingthe computer system. 

The Operating System acts like an interface between the user and the computer. It is the master program, which 

makes our PC alive and helps to run different applications. 

Windows has become very popular because of its user-friendly environment, noticeable speed improvement, 

and its modest system requirements. 

BlackBerry, Android, iOS, Symbian, Windows Mobile are some of the popular mobile operating systems. 

The Windows taskbar is located at the bottom of the screen, which allows you to locate and launch programs 

through Start and the Start menu, view any program that is currently open, orto checkthe current date and time. 

The desktop of Ubuntu Linux contains Menu bar, Indicator area, Icons, Launcher, Dash and Trash. 

HTTP (HyperText Transfer Protocol) is used for transmission of data over the Internet. 

Awebsite is a collection of related web pages containing images, videos, and other digital media. 
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A. 

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  
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B. 

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

10 

BRAIN DEVELOPER 
SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

Multiple Choice Questions: 

The final output available to a user on the monitor is known as  

a. Hardcopy b. Software c. Softcopy d. Bytes 

The component which is responsible for all mathematical calculations and logical operations of a computer is 

called  

a.ALU b.CU c.MU d.ROM 

The type of ROM which can have its contents erased by ultraviolet light is called  

a. PROM b. EPROM c. EEPROM d. Flash memory 

Which of the following is not an I/O device? 

a. Printer b. CPU c. Plotter d. Scanner 

Which device scans images, documents, and saves them on a computer as a digital image? 

a. MICR b. Joystick c. Scanner d. Plotter 

The full form of Cc in E-mail is 

a. Copy cat b. Copy content c. Cannot copy d. Carbon copy 

A is the interface between a user and the World Wide Web. 

a. Web site b. Web server c. Web portal d. Web browser 

Deleted E-mails are stored in  

a. Trash b. Spam c. Inbox d. Draft 

is a free video sharing website, where videos on all subjects and topics can be found. 

a. Twitter b. Facebook c. YouTube d.WhatsApp 

Data is stored temporarily in  

a. ROM b. Hard Disk c. DVD d.RAM 

Fill in the blanks: 

A microprocessor is a type of integrated circuit, built on a tiny piece of  

Blue-violet laser beam is used to read and write a  

is a combination of dark and light stripes printed on the packing of various products. 

The picture on a monitor is made up of thousands of small coloured dots called  

devices are all hardware components that are attached to a computer and are controlled 

by the computer system. 

B in Bcc stands for  

 plotter is used to produce continuous output such as plotting earthquake activity. 

acts as the nervous system for a computer. 

The primary use of ROM is during the process. 

 is a very high speed memory which stores frequently used instructions. 
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comparison operations on the 

main components: 

The Arithmetic and Logic Unit (ALU) carries out the basic calculations and 

data. 

It stores data permanently. It is a temporary memory. 
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C. State True Or False: 

1. Operating system is a very importantapplication software. 

2. An LCD monitorallows the user to input information by touching the icons on the screen. 

3. GUI stands forGraphical Userinterface. 

4. Nibbleisagroupof8bits. 

5. Light pen is a light sensitive pointing device. 

6. Primary memory is used to store large amount of information. 

7. Subscribers use Facebook to communicate and broadcast short messages called Tweets. 

8. E-mail address isa unique identifier of your E-mail account. 

9. URL stands for Uniform Resourceful Location. 

10. iOS mobile operating system has been developed by Google. 

A. Multiple Choice Questions 

1. Ic) 2. Ia) 3. (bl 4. (b) 5. (c) 6. Id) 7. Id) 8. (a) 9. (c) 10. )d) 

B. Fill in the Blanks 

1. Silicon 2. Blu-ray disk 3. Bar code 4. Pixels 5. Peripheral 6. Blind 7. Drum 8. CU 9. Booting 10. Cache 

C. State True or False 

1.(F) 2.(F) 3(1) 4.(F) 5.lT) 6.)F) 7.(F) 8.)T) 9.(F) 10.(F) 

SECTION 2: THEORY QUESTIONS-(SOLVED) 

1. What do you mean by Social Media? What is the purpose of using a social networking website? 

Ans:A Social Media is an online platform that facilitates the building of social networks or social relations among 

people who share interests, activities, backgrounds, or real-life connections. Social networking can be done 

forsocial purposes, business purposes, or both. 

2. What is the function of CPU of a computer? Explain its three como onents, 

Ans: CPU stands for Central Processing Unit and is also known as the brain of a computer'. The CPU receives data 

from the user as input, interprets and executes it, and presents the output as information. The CPU has three 

The Control Unit (CU) controls and coordinates the functions of the various devices attached to the CPU. 

~  The memory unit (MU), is the principal storage of a computer that can store the data and instructions 

either temporarily or permanently. 

3. Differentiate between RAM and RON. 

Ans: 

RAM stands for Random Access Memory. ROM stands for Read Only Memory. 

It is vnki-ile in ntiire I e the r1t eets ercer1 if the It is r n-vnitile ie the d2t2 is not lost even when 

power supply is switched off. the power supply is turned off. 



4 What is an operating system? Discuss any two functions of operating system. 

Ans:  It is a program that acts as an interface between the software and the computer hardware. It is a specialised 

set of programs to manage the overall functioning of a computer and its resources. 

The main functions of operating system are: 

Processor Management: An operating system manages the working of the processor by allocating various 

jobs to it. 

Memory Management: An operating system manages the sharing of internal memory among multiple 

applications. 

What do you mean dy DOS? Why s ft known as a CU!? 

Ans:  Disk Operating System (DOS) is a type of system software that runs from a hard disk drive. It is known as 

a CUI (Character User Interface) because it allows a user to type the commands at its prompt(For example, 

C:\>) for every action to be performed on the computer. 

Briefly explain the application of computers in the field of banking and library. 

ns: Bankinq: In the banking sector, computers provide a lot of facilities to the customers. Using online banking, 

you can check your past transactions. Money can be transferred to any account across the globe. Internet 

banking also allows you to use ATM or debit card to shop, buy tickets, pay bills for utility services, like 

electricity, telephone, and post paid mobiles. You can even subscribe to free monthly bank account 

statements and apply online to open fixed deposits. 

Library: A computer helps to maintain the records of the issue and deposit date of books, encyclopedias, CDs 

etc. It also helps in indexing and searching for a particular book. Various magazines and journals can be read 

online. 

7. What is the difference between RAM and ROM 

Ans: 

i. Random Access Memory is volatile i.e., the 
memory is  temporary.  

2. We can read and write the data present in the RAM. 

3. P.AM stores the application programs. 

The types of RAM are SRAM, DRAM, SDRAM, and 
DDR. 

Read Only Memory is non volatile i.e., the memory 
is permanent. 

We can only read the data present in ROM. 

ROM storesthe  initial program to start a computer. 

The types of ROM are PROM, EPROM, EEPROM, and 
Masked ROM. 

8. What is the need of Secondary memory 

Ans: Secondary memory is used to store a large amount of data and instructions permanently. The main memory 

of a computer is temporary, expensive and has limited storage capacity. Therefore, data has to be stored 

separately in a secondary back up device. This will keep the information permanent and accessible for longer 

duration of time. 

9. Explain the difference between EPROM and EEPROM. 

Ans: 

1. The contents can be erased using ultraviolet InthistypeofROMthecontentscanbeerasedbyusing 
rays and then reprogrammed by an EPROM high voltage electricity. 
programmer. 

2. While erasing contents by using ultraviolet The entire contents may not be erased as it has the 
rays, the entire content  has to be erased. option to delete selective portions of memory. - 

jJThe chip needs to be physically removed from The chip does not need to be physically removed from 
the system for erasing the bits. the system for erasing the bits. 

10. What do you specify in the Cc field ofan E-mail? 

S 
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n While composing an E-mail, you specify the address of the persons to whom you want to send a copy of the 

mail. T E-mail address(es) mentioned in this field are visible to all the recipients of the mail. 

Write the full form of PROM, EPROM, EEPROM, SRAM, and DRAM. 

PROM Programmable Read-Only Memory 

EPROM Erasable Programmable Read-Only Memory 

EEPROM - Electronically Erasable Programmable Read-Only Memory 

SRAM Static Random Access Memory 

DRAM - Dynamic Random Access Memory 

12. Vriat s f3iuray aisk? Bnefiy state is features. 

Ans: Blu-ray disk is a next generation optical disk format which enables the ultimate high definition entertainment 

experience. It gets its name from the blue-violet laser which is used to read and write this disk. It has large 

storage capacity of 25 GB single layer and 50 GB dual layer. It is robust in nature and is used to record and 

playback high quality picture and audio. It has a maximum picture resolution of 1080p to provide high 

definition picture quality. It is also compatible with the existing DVD libraries. 

13. Which technoloqy is used in a Laser printer' What are its basic features? 

Ans: Laser printers use photocopy technology to print. They use a laser beam and dry powdered ink to produce a 

high quality dot matrix pattern. They can print graphic images too. They are ideally used when good quality 

and large scale printing is required. The resolution is very high, approximately 600-1200 dots per inch. 

14. What is an Operating System? Name the major functions of the Operating System. 

Ans: An Operating System is a system software that acts as an interface between the computer and the user. The 

computer interprets all the instructions given to it through the Operating System. It is the master program 

which helps to run different applications in the computer. 

Some of the major functions of an Operating System are: 

1.Processor Management 2. Memory Management 3. Device Management 

4. File Management 5. Job Scheduling 6. Error Detection and Security 

SECTION 3: APPLICATION BASED QUESTIONS—(SOLVED) 

1. Deepak wants to share some pictures of his holidays in Shimla with his Uncle who lives in Canada, through a 

computer. Which input device should he use? 

2. Suppose you have assembled a computer for the first time. After assembling all the parts successfully, which 

will be the first software to be installed into the computer? 

3. Everyday Goods super market uses an input device to sense and read the black stripes present on the items 

for billing purposes. Which device is it? 

4. While working on Windows, Reena has accidentally deleted some files from her computer. Can they be 

retrieved? If yes, where should she find them? 

1. Scanner 2. Operating system 3. Barcode reader 4. Yes, Recycle Bin 

SECTION 4: APPLICATION BASED QUESTIONS—(UNSOLVED) 

1. 1am a component of CPU which performs logical operations. Identify me. 

2. An important conference is going on in an office. During the conference, the manager wants 100 copies of 
high quality printoutofan importantcircular. Which typeof printershould he use? 

3. My Mom has phone numbers of all her friends. She wants to share her recipes along with food photos with all 
her friends. What type of messaging service should she use? 

4. Rishabh wants to explore various types of travelling videos for his travel portal. Which website should he 
use? 
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Mr. Sharma wants to send an E-mail to his boss. At the same time he wants to send a copy of the same to his 

colleague also but doesnt want his boss to know about that. What should he do now? 

SECTION 5: SHORT ANSWER TYPE QUESTIONS—(UNSOLVED) 

1 What are the three components of a CPU 

2. Define register. 

3. Name two types of primary memory. 

4. Which unit is used to measure the speed of CPU? 

5. What is DOS? 

6. Define Desktop 

7. What is Social Media? 

8. Define System software 

9. Name two types of Impact printers. 

10. What is Recycle Bin? 

SECTION 6: LONG ANSWER TYPE QUESTIONS—(UNSOLVED) 

1. Mention some of the ICT tools being used in the field of education. 

2. What is the role of ICT in governance? 

3. What is primary memory? Mention its types. 

4. What is the difference between CRT, LCD and LED monitors? 

5. What is Cache memory? What are its advantages? 

6. What is the difference between primary memory and secondary memory? 

7. Mention some of the good and bad effects of Internet. 

8. What do you understand by an E-mail? List any two advantages of E-mail. 

9. How to create an E-mail account? 

10. What do you understand by Social Networking? What are is advantages and disadvantages? 

 

For Better Concept Clarity 

 

1. Create a presentation on in put and output devices. 

2. Create a presentation on Windows 7 Operating System. 

 

GROUP DISCUSSION 

 

1. Divide the class into four groups and ask them to gather information on 

the use of ICT in the respective field: 

+ Education + Healthcare + Business + Governance 

2. Divide the class into two groups and conduct discussion among them on the topic, 'Features of CUI and 

GUI' 

3. Divide the class into two groups to discuss about the advantages and disadvantages of social media. 

5 
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UNIT - VI: Entrepreneurial Skills 

CHAPTER 15  
Types of Business Activities 

All of us possess an inherent aptitude. We need to identify our area of interest and 

inner strengths, and develop our skills. In every sphere of our life, we face tough 

competition and various challenges. To have a winning attitude, we need to be 

optimistic and think differently. 

After completing your education, what career would you like to pursue? Would you 

like to explore different job opportunities, prepare for competitions, and appear for 

competitive tests and interviews? Yes, you can think about that, but there is also a 

choice to become self-employed. Here, you can pursue your passion and be your own 

boss. Howabout becoming an entrepreneur? 

ENTREPRENEURIAL SKILLS 

Who is an entrepreneur? An entrepreneur is a person who takes the initiative of starting a 

business, bears the risk of investing money, manages at all levels, and is responsible for its 

success orfailure. A business or a company is known as an 'enterprise'. An entrepreneurcan 

be an artist, educator, professional, restaurateur, businessman, or an inventor. 

Entrepreneurs play a significant role in society because they provide goods and services to 

people and create employment opportunities in society. Entrepreneurs can be from any 

socio-economic background. Can you think of some entrepreneurs who provide different 

products or services to you? 

SOME ENTREPRENEURS IN THE LOCAL COMMUNITIES 

The shopkeepers that you see in a shopping complex are all entrepreneurs who are 

engaged in different types of business activities. The most popular business in any 

local community is of grocery items. The grocery stores deal in FMCG (Fast-Moving 

Consumer Goods) which include perishable as well as non-perishable items. These 

are packaged goods that are sold quickly and at a relatively low cost. For example, 

packaged food items, chocolates, beverages, toiletries, ration, and many other 

consu mables. 

Some entrepreneurs deal in businesses which provide daily life 

essentials, such as vegetable and fruit vendors, chemist shops, salons, 

tailoring shops, dry cleaners, doctor's clinics, restaurants, and food 

outlets. 

There are some other businesses which are very important in any 

neighbourhood, for example, photocopying and printing services, 

books and stationery shops, gift stores, electrical goods and 

appliances shops, electronic repair shops, readymade garments store, 

coaching centres, playschools, and crèche facilities. 

Learning 
Computers with  KLPS<> 



McDonald's 
I I: 

Microsoft 

If you take a look at the world around you, you will find the entrepreneurs from all 

age groups. Some entrepreneurs have been successful at a very young age, while 

others have struggled and prospered over time. For example, Facebook and 

Microsoft were started by youngsters in their twenties, whereas the founders of 

McDonald's and KFC were in the late fifties when they started their ventures! 

However, a few things common among them all are that they capitalised on their 

talent, took the initiative and the risk to start their own business, and worked hard to 

achieve their goals. 

Example 

Mark Zuckerberg became one of the youngest billionaires with his talent and skills at 

computers. So, how did a young computer programmer come to lead one of the most 

influential global companies? It is because he was determined to do something new by 

using his special talent at computers. He recognised the need of the hour, i.e., to 

connect with people. He identified a potential market for his idea and capitalised on the 

idea of connecting people using histechnological skills. 

The field of entrepreneurship is full of opportunities for those who have a dream. Now, it is your turn to start thinking 

about what you would want to do in the future. What are your talents? Explore and identify your area of interest and be 

confident and bold to take up new challenges in life. Be on a lookout for the gaps (business opportunities) in the existing 

market, and try to find out a profitable solution for it. Be innovative, so that you stand out from the others in the market. 

As Malcolm X correctly said, "The future belongs to those who prepare for it today." 

Let us understand the day-to-day activities of an entrepreneurwith the help of an example of a grocery store. 

You must have visited the grocery store near your house. Here are some activities that are a part of the business. 

The shopkeeper purchases goods for his shop. 

He sells his goods and keeps on adding fresh stocks. 

His sales and earnings may fluctuate. (During some months the sale 

may be very good, for example, during festivals, while at other times 

the sale may below.) 

At times there may be many customers and all of them may want to be 

attended immediately. 

The customers may even get angry and argue with him. 

+ He has to be calm and patient at all times. 

+ He has to handle the cash carefully without making any mistake. 

+ Hehastopaysalariestohisemployees. 

+ If it is a rented shop, he has to pay the rent of the shop. 

+ He has to pay the electricity billfor his shop. 

+ Hehastospendonthemaintenanceoftheshop. 

Thus, we see that a shopkeeper has to manage so manythings. You can see 

that a businessman needs to develop skills related to finance, sales, 

marketing, management, and accounting. One also needs to develop skills, such as being innovative, excellent 

communication skills, and a lot of patience. To understand and develop all the required entrepreneurial skills one can 

study entrepreneurship. 
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Benefits of Studying Entrepreneurship 

The benefits of studying entrepreneurship are: 

+ Ithelpstothinkaboutnewbusinessideas. 

+ It helps to cultivate skills and knowledge for starting an enterprise. 

+ It develops business skills in areas such asfinance, sales, marketing, management, and accounting. 

+ it helps in the development of other skills such as adaptability, effective communication, business discipline, and 

confidence. 

TYPES OF BUSINESSES 

What is the meaning of the term 'business'? Business is an area of work or an activity related to production, buying, and 

selling of goods or services, if you are thinking about becoming an entrepreneur, you should know about the different 

types of businesses. 

Businesses can broadly be classified into four types. 

r TYPES OF BUSINESS ACTIVITIES 

1 

Service 

 

Merchandising 

 

Manufacturing 

 

Hybrid 

SERVICE BUSINESS 

A service business provides products which do not have a physical form or cannot be touched. Such business companies 

provide professional skills, expertise, advice, and other similar services. Some examples of a service business 

are—salons, repair shops, housekeeping agencies, schools, coaching institutes, sports academies, hotels and resorts, 

accounting firms, and law firms. From such businesses you are not buying any physical product, rather you are paying for 

different types of services. 

  

[S 
Salon Sports Academy 

MERCHANDISING BUSINESS 

Accounting Firm Law Firm 

Merchandising business is also known as 'buy and sell' or 'trading' business. A merchandising business firm buys goods 

or products at 'wholesale price' and sells the same at 'retail price'. 

Wholesaler Retailer 
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Wholesale price is the price charged for goods that are sold in bulk or large quantities to a businessman or a trader. 

In other words, it is the price, a businessman or trader pays for buying a large number of goods that he will sell in his 

shop. 

Retail price is the price of goods or products when they are sold to customers for consumption, and not for resale. The 

shopkeeper makes his profit by pricingthe goods to enable him to earn profits. 

Inthis type of business activity, the businessman makes a profit by sellingthe products. Some examples of merchandising 

business are grocery stores, conveniencestores, chemists, electronic stores, automobile dealers, and otherresellers. 

MANUFACTURING BUSINESS 

A manufacturing business uses raw material, labour, and other production processes to manufacture goods. A 

manufacturing business buys raw material for making a new product. The goods that are manufactured are generally 

sold to wholesalers, who further sell them to retailers, who then sellthem to the end users orconsumers. 

A cotton/woollen textile company uses cotton yarn/wool as raw material, 

machines, power, and labourto manufacture cotton/woollen fabric. 

Example 

A mobile phone manufacturer usescircuit boards, electronic parts, LCDscreens, 

' and batteries as raw material to manufacture mobile phones. 

Example 

A furniture manufacturer uses timber, skilled labour, machinery and tools, to 

create different designs of furniture. 

Exmple 

HYBRID BUSINESS 

A hybrid companydoes not belongto any one specifictype of business, it is a mixed type of business. 

fl 
Example 

The best example is a restaurant. A restaurant uses ingredients for making a fine 

meal (manufacturing), sells bottled water or cold drinks (merchandising), and 

serves customer orders (service). All three types of business functions can be 

seen in a restaurant. 

TYPES OF BUSINESS ORGANISA11QNS IN OUR COMMUNITY 

The first step as an entrepreneur is to decide the form of business you want to choose. Businesses may be organised in 

different forms. The form of business activity depends on the type of business ownership. Ownership means 'possessing 

something'. When you own a business, it is a big responsibility of how you organise and manage it. You are responsible 

for your business in every way. Being legally responsible for a business is termed as 'liability'. All forms of business 

ownership have liabilities. 



'iiI 

a;  

Single 
Ownership 

No Sharing of 
Profit and Loss 

One Man's - 
N Capital 

Sole Proprietorship 

Four main types of business organisations, based on ownership are as follows: 

BUSINESS OWNERSHIP 

Sole Proprietorship Partnership Corporation Cooperative 

SOLE PROPRIETORSHIP 

A sole proprietorship is a business owned by a single person. It is easy to set up and is the least 

costly among all forms of ownership. Sole proprietorship is usually adopted for small 

independent businesses. We can call it the one-man business organisation. 

Starting and closing a sole proprietorship is simple and requires minimum costs. The owner 

keeps all the profits, however, he is solely liable for all the debts. Moreover, he has a limited 

capacityto raise capital. Thus, sole proprietorship is often considered as the most appropriate 

form during the early stages of a business. 

Mr Gupta has a smallgrocery store. He is the single ownerof this store. He owns, invests money, and enjoys 

the profits from his store. 

x rip o 

For these reasons, sole proprietorships are often the most appropriate during the early stages of a business, where the 

owner has little capital/resources to work with but also has a few debts to pay. 

Unlimited 
Liability 

Less Legal 
Formalities 

Onman 
Control 

PARTNERSHIP 

A partnership is a business owned by two or more persons who jointly invest money in 

the business. The partners divide (share) the profits of the business among 

themselves. They even bear the losses together. They discuss all business matters 

among themselves and take joint decisions. Both partner5 are legally responsible for 

the business. Due to the sharing of profits and the additional resources, this type of 

ownership is often expected to yield higher growth rates than a sole proprietorship. 

Partnership also offers the opportunity for income splitting and tax saving. In partnership, it is easy to change the legal 

status of the business if such a need arises. However, the liability of the partners forthe debts of the business is unlimited, 
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i.e., each partner is liable forthe partnership's debts and the consequences of each other's actions. Also, there is always a 

riskof disagreements and friction among partners. 

      

Voluntary 
Registration 

 

  

Membership 

  

       

         

 

Unlimited 
Liability 

      

     

Continuity 

Contractual 
Relationship 

       

Sharing of 
Profit & Loss 

   

       

  

Mutual 
Agency 

 

Transfer of 
interest 

Partnership 

CORPORATION 

A corporate structure is more complex than other business structures. Unlike the 

previous two business ownerships, a corporation is a business organisation that is 

considered a separate entity from its owners and pays its tax separately. The 

owners of the business are called 'shareholder'. They hold stock in a company and 

reap the benefits of the company's successes in the form of an increased value of 

stocks. The shareholders elect a board of directors who set the policy and vision 

for the corporation. The board of directors appoints corporate officers who run 

the day-to-day operations of the corporation. 

Corporations attract investors because shareholders of a corporation have limited liability, i.e., creditors can only claim 

the assets of the corporation and not the personal assets of the stockholders for the settlement of the corporation's 

debts or liabilities. Shares of the ownership are transferable, so the corporation continues to exist even if the 

management changes. However, starting a corporation is costly. Moreover, corporations are highly regulated by laws and 

dissolving such a business involves a complicated legal process. 

The Walt Disney company and Johnson and Johnson are among the five most 

successful corporations in the world. These companies have a strong financial 

history, provide products and services that benefit society, and have been able 

to survive over a long period of time. 

   

 

The rip Company 

 

   

   

on+4nn 

 

Example 

 

     

      

COOPERATIVE 

Cooperative is an enterprise or an organisation that is owned and managed jointly by those 

who are its members. It is democratically controlled and operated on a non-profit basis. 

The basic objective of such an organisation is to meet the economic, social, and cultural 

needs of its members. It should have a minimum of ten members, but there is no limit to 

the maximum number of members. They contribute capital to the organisation and reap 

the benefits. The liability of members is limited to the extent of their capital in the 

cooperative society. The managing committee is elected by the members to run the 

organisation. 
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For Better Concept Clarity 

A cooperative mainly aims at providing services in place of earning profits. They need to be registered with the Registrar 

of Cooperative Societies. 

Formation of a cooperative society is easy. A cooperative society is a separate legal entity. Hence, the death, bankruptcy, 

retirement, etc., of the members do not affect the continuity and existence of a cooperative society. It is also exempted 

from income tax. Moreover, the government offers loans and financial assistance to cooperative societies. 

On the other hand, it is quite difficult for a cooperative to maintain the secrecy of its business affairs because it has to 

report to the Registrar of Cooperative Societies. Lack of profit motive may breed inefficiency, fraud, and corruption in the 

management. 

The best example of the cooperative form of business model is Amul. It has protected the 

interests of the milk-producing farmers who are its suppliers as well as its owners. Amul is 

the largest cooperative movement in India with 2.2 million milk producers. There are 

38,000 crore successful business entities which supply products to over 40 countries and 

provide livelihood to crores of individual dairy farmers in Gujarat and the rest of India. 
Example Tho of mdi. 

Another example is the Shri Mahila Griha Udyog Lijjat Papad. It is an Indian women's 

cooperative involved in the manufacturing of various fast-moving consumer goods. The 

organisation's main objective is the empowerment of women by providing them with 

employment opportunities. It started with a loan of mere' 80, and now the cooperative 

has an annual sale of more than 301 crores ( 3.1 billion)! Example 

The choice of the type and form of your business needs a lot of consideration. It involves assessing your financial 

resources, taking inbuilt risks, and considering your preparedness. It also depends on the purpose of the business and 

who you want to involve as business partners and as beneficiaries. 

Read the story and answer the questions that follow: 

Sunita has a natural talent for dress-designing. After completing her Senior School Certificate Examination, she 

decided to start a boutique at home. She discussed with her parents and converted the guest room into a boutique. 

She took a small loan from the bank to start her business and purchased two designer sewing machines. She 

surveyed the stitching charges in the market for regular and designer clothes and decided the stitching charges for 

her boutique. She employed two girls, who had completed a course in tailoring and worked out the timings, salary, 

incentives, holidays, and leave structure for the two employees. She purchased dress material and other 
accessories from the local market. She gave an advertisement for her boutique in the local society magazine and 

informed all her friends. Within a few months, she had many clients. Her boutique became very popular. Soon she 

started putting up her stall at the nearby malls. Sunita became a successful entrepreneur ata very young age! 

1. What type of business is Sunita running? 

2. State the risks involved in Sunitas business. 

3. What are the benefits of maintaining this particulartype of business structure? 
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ASSESSMENT TIME 

  

A Multiple Choice Questions: 

1. is a person who takes a risk to produce goods and services in search of profit. 

a. Entrepreneur b. Employee c. Police d. Bureaucrat 

2. What kind of businessownership is best described by these statements? 

+ I am the only owner of my business. 

+ I take all the risks of doing business. 

+ I keep all the profits. 

a. Sole Proprietorship b. Corporation c. Partnership d. Cooperative 

3. An entrepreneur  

a. enforces government regulations b. takes risk to earn profits 

c. sets the interest rates at banks d. manages financial investments 

4. A grocery store is an example of which type of business activity? 

a. Service b. Merchandising c. Manufacturing d. Hybrid 

5. What is the advantage of a cooperative? 

a. Income tax exemption b. Minimal government regulation 

c. Short life span d. Single ownership 

B. Fill in the Blanks: 

1. The basic objective of a  is to meet the economic, social, and cultural needs of its members. 

2. A  business is a mixed type of business. 

3. A business that provides products which do not have a physical form is called  business. 

4. price is the price of goods or products when they are sold to customers for consumption, 

and notfor resale  

5. Merchandising business is also known as or business. 

I{lli1.1J Trading cooperative Hybrid Retail Service Buy and Sell 

C. Answer the Following Questions: 

1. How will you define an entrepreneur 

Ans. An entrepreneur is a person who takes the initiative of starting a business, bears the risk of investing money, 

manages at all levels, and is responsible for its success or failure. 

2. What do you understand by the term 

Ans Business is an area of work or an activity related to production, buying, and selling of goods or services. 

3. What are the four forms of business organisations based on ownership? 

Ans The four forms of business organisations based on ownership are—Sole Proprietorship, Partnership, 

Corporation, and Cooperative. 

4. In a business, what is the meaning of the term 'liability'? 

Ans. All forms of business ownership have liabilities. Being legally responsible for a business is termed as 'liability'. 



D. Answer in One or Two Sentences: 

Identify the type of business ownership based on the following description: 

1. It is a separate entity from its owners and may employ its owners. Owners have limited liability and pay 

separate tax for the business. 

2. It isa business owned by two or more people who share the profits of the business among themselves and 

bear the losses together. 

E. Answer the Following Questions: 

1. What are the benefits of learning entrepreneurial skills? 

2, Why is liability an important factor in any business? 

3. Explain the differences between sole proprietorship and partnership. 

4. What are some advantages of running a corporation form of business organisation? 

F. Application Based Questions: 

1. A group of 15 retired people in your neighbourhood wants to start an organisation to educate underprivileged 

children. Suggest them the type of organisation that they can start. 

Surabhi wants to start her own boutique. She wants to choose an option that requires minimum investment 

and business regulations. Which business ownership option should she choose and why? 

 

For Better Concept Clarity 

 

Poster Making 

Use pictures to prepare a poster on business activities found in: 

a. Cities b. Villages 

Prepare a list of service businesses in your community. 

Organise groups discussions in the class on the following topics: 

a. Various types of activities adopted by small businesses in a local community. 

b. Some ideas for a business based on 'Best out of Waste', for example, composting. Discuss the step-by-

step process to develop that idea into reality including the following points: 

i. Costing of the product made out of waste 

ii. Selling of items made from waste materials 
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UNIT - VI:  Enfrepreneurial  Skills  

CHAPTER 16 

 

Characteristics of Entrepreneurship 
An entrepreneur is a person who undertakes a new business or venture with some potential for profit and involving a 

certain amount of risk. Entrepreneurship is the act of setting up a business and taking on financial risks with the goal of 

making profit. 

Let us read about some famous entrepreneurs who have 

succeeded despite odds. They were successful because they had 

unique ideas and more importantly, they had the necessary 

talents and skills that made them legendary entrepreneurs. For 

example, Bill Gates, the founder of Microsoft, and the late Steve 

Jobs, the founder of Apple, were college dropouts but the key to 

their immense success was embedded in their innovative ideas 

and their ability to persist even during difficult times. Even Mark 

Zuckerberg, the founder of Facebook, as well as Larry Page and 

Sergey Brin of Google can be considered as truly great 

entrepreneurs. Can you guess what do all these legends have in 

common? They had the vision and the sense of mission that they 

were going to change the world with their hard work, perseverance, and sheer determination. 

The Story of Bill Gates 

We all know Bill Gates as one of the pioneers of modern computers. He is one of the richest and most 

influential people in the world today. Bill Gates along with his partner Paul Allen founded and built 

the world's largest software business, Microsoft, through technological innovation, keen business 

strategy, and aggressive business tactics. 

It will beinterestingto know a little more about his earlyyears. 

As a young boy, Bill was fond of board games, especially Monopoly and Risk. Bill developed an 

interest in computers in school and wrote his first computer program as a young teenager. While still 

in high school, Bill, along with some of his friends, wrote a payroll program for a company and a 

scheduling program for his school. Bill Gates and his friend Paul formed a venture called Traf-O-Data 

while still in high school. They created a computer program that helped to track traffic patterns in Seattle. He started his business 

from thegarage in his house. Later,alongwith Paul Allen, he established Microsoft in 1975. 

II  ENTREPRENEURSHIP DEVELOPMEN 

What do you do to perform well in school or to excel in examinations? You join 

coaching classes or institutes to score well in studies. In addition to academic 

coaching, many students join English communication courses and personality 

grooming institutes. The aim is to develop skills to enhance one's personality and 

be successful in life. In the same way, to develop and improve entrepreneurial 

abilities, an individual requires specifictraining and classroom programmes. 

Thus, we can say that entrepreneurship development refers to inculcation, 

development, and polishing of entrepreneurial skills in a person to enable him to 

establish and successfully run an enterprise. 

    



GD Birla 

Know the Fact 

The Government of India 

has many schemes to 

promote new ideas and 

support entrepreneurs. 

'Startup India' is a 

government campaign 

aimed at promoting bank 

financing for startup 

ventures to encourage 

entrepreneurship and 

startups, which will 

contribute to the 

conomy of the country. 

Market 

4 
Infrastructure Labour 

All successful entrepreneurs like Bill Gates (Microsoft), Warren Buffett 

(Hathaway), Gordon Moore (Intel), Steve Jobs (Apple Computers), GD 

Birla, and Jamsetji Tata went through the process of enhancing their skills 

through early business opportunities and later by sharpening their 

business skills, understanding the market needs and capitalising on them. 

STAGES IN ENTREPRENEURSHIP DEVELOPMENT PROCESS 

How does an entrepreneur go from the beginning stages of an idea to the construction of 

something real, functioning, and beneficial? An entrepreneur must find, evaluate, and 

develop an opportunity by overcoming the challenges or obstructions that come in the way 

of starting new business ventures. 

The entrepreneurship development process has five main stages: 

identification and evaluation of the opportunity 
/ 

Development of the business plan 7 
(Create a new venture, product, or market) 

/
Determination of the required resources 

/ 
Management of the resulting enterprise / 

/
Change/adapt with time 7 

FACTORSAFFECTING ENTREPRENEURSHIP GROWTH 

Entrepreneurial growth can be seen in areas where these followingfactors are present. 

Factors Affecting Enirepreneurship Growth 

'I, 

Let's Kniw More 

Every big business has to 

start somewhere. You will 

be surprised to know that 

some of the very 

successful global 

businesses began 

from garage! 

Find out the names of at 

least six big business 

companies in the world 

that started from garages 

and rose to be multi- 

million (or billion) dollar 

industries. 

   

Economic 
Factors 

Social 
Factors 

Psychological 
Factors 

   

Economic Factors: Economic environment has direct and immediate influence on entrepreneurship. People often think 

about entrepreneurship when jobs are not easily available or because there is an opportunity. The economic factors that 

affect the growth of entrepreneurship are: 

Economic Facto.rs 

4 4 4 4 4 4 
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Family 
Background 

Attitude of 
the Society 

Social Factors 

Social 
Mobility I' 

- Capital is one of the most important factors forthe establishment ofan enterprise. An idea remains an idea 

without capital backing. Entrepreneurship activity becomes easier when there is availability of funds for investment. 

+ Labour: Easy availability of the right type of workers helps in the growth of entrepreneurship. It is the quality rather 

than quantity of labour that influences the emergence and growth of entrepreneurship. 

+ Raw Material: It is one of the basic ingredients required for production. Without sufficient supply of raw material, no 

industry can be established or function properly. 

+ Market: Market comprises potential customers as well as competition. Knowledge of customers' needs and 

competitors' offerings help you to create a product that distinguishes you from the competition and satisfy 

Customers' needs. 

+ Infrastructure: Well developed transportation facilities help to enlarge the market and expand the horizons of 

business. For example, the establishment of post and telegraph system and construction of roads and highways in 

India considerably helped entrepreneurial activities in the 18505. 

+ Other Factors: Other factors, such as institutions, government policies, business schools, and libraries also make 

valuable contributions towards promoting and sustaining entrepreneurship in an economy. They also act as various 

forums for communication and joint action. 

Social Factors:  Social factors strongly affect the entrepreneurial behaviour of people. The social environment, in which 

peoplegrow, shapes their basic beliefs, values, and norms are as follows: 

+ Social Mobility: The term refers to the freedom to move from one caste or socio-economic strata to another. There 

are certain cultural practices and values in every society which influence the decisions of individuals. Dominance of 

certain ethnicgroups in entrepreneurship is a global phenomenon. 

There are some traditional business communities in India such as the Parsis, Marwaris, Khatris, Bhatias, 

Jams, Bohras, Chettiars, Vaishyas, and Baniyas. In these communities, business is more or less hereditary. 

Example 

+ Family Background:  Background of a family business also influences entrepreneurship. Youngsters who belong to 

businessfamilies often join their family business. They learn business skills from their elders. They often evolve their 

business accordingto the changingculture and take it to greater heights. 

TATA, Godrej,Ambani, Hinduja, Birla and Bajaj are some of the well-known business families in India. 

Example 

Learning 
Computers with  



+ Education: Education enables one to understand the outside world and equips him or her with the basic knowledge 

and skills to stand on their feet. In any society, education plays an important role in inculcating entrepreneurial skills. 

+ Attitude of the Society: Certain societies are more progressive and encourage innovations and novel ideas of earning 

a livelihood and encourage young entrepreneurs. Some others do not encourage changes in the established way of 

life. In such circumstances, entrepreneurship cannotgrow. 

+ Cultural Value: Some socio-cultural groups or business communities are more money-oriented than others. Here, 

entrepreneurship would be encouraged and praised, and wealth accumulation as a way of life would be appreciated. 

However, in some other socio-cultural groups, people are easily satisfied with what they have. People from such 

sections of society do not strive for economic gains and therefore, lack the motivation to start up a new venture. 

Many families where most of the members have been into government jobs, do not look beyond these 

Example 

jobs in spite of the financial adva 

of government jobs. 

ntages of private/corporate jobs or business. They value the job security 

Psychological Factors: Many entrepreneurial theorists have developed theories of entrepreneurship that are based on 

psychological factors. These factors are as follows: 

[ 
 Psychological Factors 

1 1 
Need for 

Achievement 
Withdrawal of 

Status Respect • . 
~ Need for Achievement: 'Need for Achievement' refers to the innate drive to aim high and achieve success. The 

presence of this factor makes individuals highly motivated to overcome obstacles, to be successful, and to excel in 

their chosen fields. This is a very important characteristic that promotes entrepreneurship among individuals. 

+  Withdrawal of Status Respect: Sometimes social groups experience a loss of status leading to changes in 

entrepreneurial behavior. People who are displaced from their native place due to conflicts or political disturbances, 

and have to migrate to new places may not continue to remain entrepreneurs and take up paid jobs to earn a living. 

Example 

Many Kashmiri Pandit families were forced to leave the Kashmir valley because of communal riots. They 

left their flourishing businesses in Kashmir. Many of them could not continue as entrepreneurs once they 

resettled in Delhi and other parts of India. 

+  Motives: Motives or goals of the entrepreneur play an important role in the development of entrepreneurship. 

Besides wealth, entrepreneurs may also seek power, prestige, security, and service to society. 
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II  CHARACTERISTICS OF ENTREPRENEURS 

There is no age limit for entrepreneurs; they can be youngsters in their teens or mature people in their fifties. They may 

be male or female, formally educated or self-educated. They can be from any country or background. But all 

entrepreneurs have some characteristics in common. They recognise business opportunities more quickly than other 

people. They can see potential business opportunities in problems and are not afraid to take risks and bold decisions, and 

they work hard. They can even foresee risks. They are problem-solvers who have excellent communication skills. They 

inspire others to follow them. 

As a young boy, Bill Gates had a dream to open a company. Many people have dreams. How was 

Bill Gates different from the others? 

Bill Gates' success came from a combination of factors. He was an 'idea man' who had a business 

idea which was new to the times. His hard work, intelligence, business sense, and right timing 

contributed to his success. Bill constantly challenged his employees to work harder and innovate, 

but he also worked as hard as or even harder than the people who worked for him. Bill used to 

stay up all night working. Once, his secretary came in on a Monday morning to find him sleeping 

on the floor. She thought he was unconscious, but he had been up at the weekend and was taking a quick catnap. 

Gates was not afraid to take risks. He took a risk when he dropped out of Harvard to 

start his own company. He also took a calculated risk when he changed Microsoft's 

operating system from MS-DOS to Windows. He had confidence in himself and his 

product. All these qualities made him one of the most successful entrepreneurs in the 

world. Besides being a brilliant tech guy, Bill is also a smart businessman. 

Although every entrepreneur has a unique story, there are a few qualities that are 

common in all of them, that have helped them to achieve success. They all trust 

themselves, work hard, remain disciplined and focused. Many of the skills shared by 

successfulentrepreneurs can be developed over a period of time, through practice and 

experience. 

Some of the key factors to become a successful entrepreneur are: 

Willingness to Take Action:  This is the most important factor required by entrepreneurs. 

Action is something that can lead you to success. Without action, you cannot expect to 

become a successful entrepreneur. 

Aptitude: Aptitudes are natural talents or inclinations for certain types of activities. For 

example, if you enjoy working on art projects more than solving math problems, then 

you may have an aptitude for creativity. In this case, you will have a good chance of 

success at an art related business, as you will be working towards your passion. 

Similarly, entrepreneurs have the natural virtue of creativity, determination, risk 

tolerance, and so on. They apply their aptitudes to their business ventures. Often their 

abilities have helped them to excel. Both Bill Gates and Steve Jobs had a special 

aptitude for computers from an early age, and they ventured their expertise into that 

field. 
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Jamsetji Tata 

Some aptitudes that could be useful in an entrepreneurialventure are asfollows: 

Artistic: Entrepreneurs can use their artistic talents in different ways. For example, they can be singers, musicians, 

producers of movies ortelevision shows, video game creators, orfashion designers. 

Perceptive: Some people may be more perceptive than others when it comes to understanding other people's needs, 

intentions, ideas, or emotions. Perceptive entrepreneurs can define the real problem that people are having in satisfying 

their needs and wants. Forexample, counsellors. 

Logical: Entrepreneurs with this aptitude have the ability to quickly apply reason to solve consumer and business 

problems. These people excel as Risk and Business Analysts. 

Mechanical:  People with this aptitude quickly understand how machines work and how they could be improved. Such 

peopletendto succeed in businesses like machinery repair and design. 

Spatial:  Entrepreneurs with this aptitude are generally architects and interior designers. They can use space in an 

attractive and economical manner. 

Intellectual:  People with this aptitude have a desire to seek knowledge, to plan ahead, and to come up with original 

ideas. 

What is your aptitude ortalent? 

Perhaps you can draw cartoons, play/sing or write exceptionally well, do mathematical calculations with ease, may 

cook well, etc. These talents just seem to be a part of who you are. With practice, hard work, and education, you can 

turn any talent into an entrepreneurial enterprise. Think about your special aptitude or talent which can turn into a 

business venture. 

Vision: Entrepreneurs can visualise their ambition and continuously work to achieve it. They 

make vision statements, take business decisions with a goal in mind, and do not get 

distracted. The vision statements help entrepreneurs or employees to remain focused on the 

business goals and encourage them to find innovative ways of increasing productivity and 

achieving company goals. 

Jamsetji Tata —A Great Visionary 

Jamsetji Nusserwanji Tata was an Indian industrialist and entrepreneur who founded the 

Tata Group, India's biggest group of industries. The success of Tata Group of industries is 

the result of his vision and mission. He is regarded as the 'Father of Indian Industry. 

He was an adventurous and ambitious ung man, who dreamt of building an iron and 

steel company. He was not only a patriot and humanist, but also had unconventional 

managerial skills, an intuitive business sense, and a sharp mind. He soon became a 

pioneering entrepreneur, and his ideas laid the foundation of steel and power industries 
Example 

in India. The company which was founded as a trading concern in 1868 presently has over 100 operating companies 

including Tata Steel, Tata Motors, Tata Consultancy Services (TCS), Tata Power, and Tata Chemicals. 

He also paved the way for the introduction of technical education, thereby bringing India to the ranks of 

industrialised nations. He donated land for a research institute in Bangalore (now Bengaluru) in 1898. He drew up a 

blueprint for the proposed institute with the support of powerful people like Lord Curzon and Swami Vivekananda to 

turn it into a reality. 
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Risk Tolerance:  Risk tolerance is the degree to which an individual can comfortably accept 

taking chances. Entrepreneurs need to have a high tolerance for risks. They take calculated 

risks. Iftheyfail, entrepreneurs are likelyto try again. 

der7 Confidence:  People who have confidence, believe in their own 

abilities. They are sure of themselves, and therefore, it is easier for 

others to believe in them. Even if they fail, they know they will 
t(D . 

o succeed the next time. This is a key characteristic of entrepreneurs. 

Creativity:  Creativity is the ability to create things. Creativity can be in 

the form of an invention, an innovation, or a marketing or problem-solving strategy. The 

successful entrepreneur is an 'idea' person. Entrepreneurs see opportunities everywhere. 

Theyfind innovative ways ofincreasingtheir productivity and achievingcompanygoals. 

Perseverance:  Have you ever been so determined to succeed at something that you just kept ./ V: 

trying until you got it right? That's a sign of perseverance. Perseverance is the determination 

that pushes the entrepreneur to keep going and keep trying. Creating and running a business is hard work. It often means 

long hours, disappointments, and setbacks. 

Initiative: Initiative is the readiness and willingness to start a new enterprise. When an 

entrepreneur sees an opportunity, he takes an appropriate action. Entrepreneurs are self-

motivated and willingto take on the leadership role and make themselves personally responsible 

for the success or failure of a decision. 

Integrity:  Integrity is the personal commitment to keep your 

promises, to do what you say you are going to do. An entrepreneur 

with integrity creates confidence in customers and investors, and is 

more successful and respected than others. 

Optimistic and Future-oriented:  Optimism means to have a positive 

outlook and not to give up in difficult situations. Optimism helps in 

bouncing back after a failure. For an entrepreneur, it is an excellent 

personal quality. For entrepreneurs, such a thought process leads to 

novel ideas for new products, services, or businesses having a greater chance of success. 

Flexible and Willing to Change Quickly:  Flexibility is the quality of changing oneself with new 

conditions. Entrepreneurs have an open mind and are always ready to adopt new things in the 

market and economy. They are prepared to change, to get the maximum benefits out of the existing opportunities and 

threats in the business environment. They always approach things with an open mind and are willingto change course, if 

they need to. 

III  ROLE OF ENTREPRENEURSHIP 

What is the importance of entrepreneurship in society? 

Entrepreneurship is beneficial for society in three ways-economic, psychological, and social. 

ECONOMIC BENEFITS 

± Generates employment + Utilises resources (e.g. human resources) 

Regional development Improves the economy of a country 
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For Better Concept clarity 

PSYCHOLOGICAL BENEFITS 

+ Instils a drive for achievement Develops confidence Increases motivation 

SOCIAL BENEFITS 

+ Helps reduce unemployment Improves socio-economic status - Satisfies consumer need 

II  REWARDS OF ENTREPRENEURSHIP 

+ Being the boss 

Having the opportunity to be creative 

You can set your own schedule 

- You become a business leader 

+ Doing what you enjoy 

Building an enterprise 

You do what you believe in 

There is excitement at work 

Entrepreneurs are a national treasure. They create wealth, jobs, opportunities, and bring prosperity to the country. 

They are the most significant people in a market economy, and there is always the need for more in any society. As 

an entrepreneur, your success is vital to the success and prosperity of many around you. 

Divide the class into four groups and ask each group to think about a novel business idea keeping the following 

points in mind: 

a. What is the new business about? 

b. What is the utility of your product and who would want to buy it(i.e., the targetcustomers)? 

c. Why do you think your business idea will be successful in the market? 

d. If there is a competitor in the market is this product better than the existing product? 

e. Any other feature of the new product/business. 

Ask each group to give a presentation before the class. 

) 

Recap -s- An entrepreneur is a person who takesthe initiative of starting a business, bearsthe 

risk of investing money, manages at all levels, and is responsible for its success or 

failure. 

Four main types of business organisations based on ownership are- Sole Proprietorship, Partnership, 

4- Businesses can broadly be classified into fourtypes - Service, Merchandising, Manufacturing, and Hybrid. 

± 

Corporation, and Cooperative. 

The entrepreneurship development process has five main stages- Identification and evaluation of the 

opportunity, Development of the business plan, Determination of the required resources, Management of the 

resulting enterprise, Change/adapt with time. 

- Entrepreneurship is beneficial for society in three ways - Economic, Psychological, and Social. 
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A Multiple Choice Questions: 

Entrepreneurship development is  

a. An institution b. A process c. A course 

 

1. 

d. A venture 

   

The first phase of the entrepreneurship development is  

a. Management of the resulting enterprise b. Development of the business plan 

c. Identification and evaluation of the opportunity d. Determination of the required resources 

 is the readiness and willingness to start a new enterprise. 

a. Business b. Initiative c. Success d. Vision 

Aptitudes are  

a. Learnt skills b. Professional qualifications 

c. Memory skills d. Natural talents orinclinations 

Entrepreneurship helps in generating  

a. Confidence b. Employment opportunities 

c. Regional development d. All of these 

Fill in the Blanks: 

1.1   is the determination that pushes the entrepreneur to keep going, and keep trying. 

2. One of the psychological benefits of entrepreneurship is that it develops  

3. is the funds for investment to start a business venture. 

4.  can be in the form of an invention, an innovation, as marketing, or problem-solving 

strategy. 

5 One of the most essential characteristics of entrepreneurs is their willingness to take  

IiIRI1IJ ' Capital confidence Perseverance Action Creativity 

C. Answer the Following Questions: 

1. How will you define entrepreneurship? 

Ans, Entrepreneurship is the act of setting up a business and taking on financial risks in the hope of making a profit. 

2. What is entrepreneurship development? 

Ans Entrepreneurship development refers to inculcation, development, and polishing of entrepreneurial skills in a 

person to enable him to establish and successfully run an enterprise. 

3. Define 'Need for Achievement'. 

Ans. Need for achievement refers to an innate drive to aim high and achieve success. The presence of this factor 

makes individuals highly motivated to overcome obstacles to be successful and to excel in their chosen field. 

4. What do you understand by the term 'risk tolerance'? 

Ansj Risk tolerance is the degree to which an individual can comfortably accept taking chances. 

B 

ASSESSMENT TIME 
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GROUP DISCUSSIO 
Organise group discussions in the class on the topic, 'Entrepreneurship vs 

Salaried jobs'. 

5. Mention the three ways which make entrepreneurship beneficial for society. 

Ans. Entrepreneurship is beneficial for society in three ways—economically, psychologically, and socially. 

D. Answer in One orTwo Sentences: 

1. Define Integrity. 

2. Make a list of some aptitudes useful in entrepreneurial ventures. 

3. What are the social benefits of entrepreneurship to the society? 

4. How is optimism an excellent personalqualityfor entrepreneurs? 

5. Explain with the help of an example that family background affects the entrepreneurial behaviour of people. 

E. Answer the Following Questions: 

1. Mention any five characteristics that you possess that can help you to become a successful entrepreneur. 

2. Think of a possible venture that you could start. Also, explain the four main phases of entrepreneur 

development process for your venture. 

3 Do you think it is essential to have big money and place to start a business? Give reasons for your answer. 

4 'Entrepreneurs are a national treasure. They create wealth, jobs, opportunities, and prosperity in the country'. 

Write your opinion on this statement. 

F Application Based Questions: 

1 Amit is good at painting. What possible careers will you suggest him to pursue? 

Sunaina runs an NGO for under-privileged children. Since it is a non-profitable organisation, what factors do 

you think motivate her to work hard? 

+ Prepare an interesting presentation on the topic, 'Factors Affecting Entrepreneurship Growth'. 

+ Make a poster in Word on the topic, 'The core skills of a successful entrepreneur'. 

(Apply formatting features to make the poster attractive). 
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Living Things Non Living Things, 

Funqus BacterM 
Light 

Minerals 

Biotic and Abiotic Components 

UNIT - V: Green Skills 

CHAPTER ___ 

Environment Protection and Conservation 
Life on Earth makes it a unique planet in comparison to other planets. It is home to millions of species of plants and 

animals. It is possible because of ourenvironmentas it involves remarkable conditions that make life possible on Earth. 

:II  ENVIRONMENT 

The word environment is derived from the French word environ which means surroundings. Our environment 

comprises our surroundings—the air we breathe, the water that covers the earth's surface, the plants and animals 

around us, and much more. 

The environment can be categorised into two types: 

1. Natural Environment 

2. Human-made Environment 

NATURAL ENVIRONMENT 

It includes all living and non-living things occurring naturally on Earth, for example, plants, animals, birds, insects, land, 

mountains, water bodies, air, sun, rain, minerals, etc. The natural environment is subdivided into two—biotic and abiotic 

components. 

Biotic Components:  These components consist of all the 

living organisms within an ecosystem, for example, plants, 

animals, birds, insects, fungi, and other living organisms. 

Abiotic Components:  These components comprise all the 

non-living things in an ecosystem, for example, water, air, 

soil, sunlight, and minerals. 

Our environment provides the platform for the interaction 

between these two factors. The biotic factors depend on 

the abiotic factors to fulfil their requirements to grow and 

survive. 

HUMAN-MADE ENVIRONMENT 

The human-made environment includes human activities and their interaction with the abiotic components. It 

comprises the structures made by humans, such as houses, buildings, parks, bridges, roads, markets, factories, dams, 

vehicles, and so on. In addition to these, the human-made environment also includes all the social institutions and 

organisations which we see in our society. Thus, human-made environment consists of physical, biological, social, and 

culturalfactors, Cities are the best example of human-made environment. 

The natural and human-made components of the environment depend on each other and interact with each other as a 

natural process. No living organism can survive alone. The natural environment provides all the resources for the 

development, growth, and survivalof human beings. 
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Food 

Water 

Air 

Sunlight Needs of Uving things 

Consider a small pond near your home. You may find 

various types of living things, from micro-organisms to 

insects and plants in it. These may depend on non-living 

components, such as water, sunlight, air, and the nutrients 

in the water for their survival. This pond is an example of 

ecosystem. A few more examples are forests, deserts, and 

grasslands. 

An ecosystem is a community of living and non-living 

components which are interdependent on each other. An 

ecosystem is formed when living things (plants, animals, 

and organisms) in an area interact with each other as well 

as with the non-living components (weather, sun, soil, 

climate, and atmosphere) that surround the living things. An Ecosystem 

In an ecosystem, each organism has its role to play. Each ecosystem is unique, but all ecosystems consist of three primary 

components: 

Autotrophs: They are the producers of energy. Plants make up the majority of the autotrophs in an ecosystem as they 

convert energy from the Sun or other sources into food. 

Heterotrophs: They are the consumers of energy. These are organisms which depend directly or indirectly upon the 

autotrophsfortheirfood. Theyare also known as consumers. Most of the heterotrophs are animals. 

Non-living matter: It is soil, sediments, leaf litter, and other organic matter found on the ground or at the bottom of an 

aquatic system. 

jfl  BASIC NEEDS OF LIVING ORGANISMS 

Every living organism on Earth needs some basic things to survive. The amount and type of these needs vary from 

organismto organism. Forexample, water is the basic need for survival, but the amount of water a frog needs to survive is 

less than the amount of water needed by an elephant. Similarly, indoor plants require almost minimal amount of sunlight 

as compared to the outdoor plants. 

Five basic needs that all living things require to survive: 

Sunlight: The sunlight is an essential requirement for all living organisms because it is the main source of energy on Earth. 

It provides heat and light to all livingthings. Life would not be possible 

on Earth withoutthe warmth of the sun. 

Water: It is considered to be the most important necessity of life. 

Water provides habitat to many living organisms. It helps to regulate 

metabolism in organisms and assists the absorption of food in the 

intestine. Water also helps in maintaining body heat. 

Air: Air is made up of several gases, but the two most important gases 

are - oxygen and carbon dioxide. Without oxygen, animals will die, 

and without carbon dioxide, plants cannot survive. 

Food (Nutrients): Food plays a vital role in overall development of all 
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Nitrogen 
fixing 

bacteria 

Denitri- 
flaction 
bacteria 

Nitrifying bacteria 

Relationship between Environment and Living Things 

Effects of Human Activities on Environment 

living beings. The food we eat contains nutrients that are required by the body to grow, move, work, reproduce, play, 

think, and learn. Moreover, it helps in maintaining proper health by protecting us from diseases. 

A habitat with the right temperature: Imagine, if you have to live in a place which is either too cold or too hot. It would be 

difficult or maybe even impossible to survive! In the same way, every living organism needs an ideal temperature to 

survive,whetheron land or in water. 

II  RELATIONSHIP BETWEEN MAN AND ENVIRONMENT 

The interrelation between the man and the environment is well 

established from the earliest times to the present day. However, 

the relationship has varied during different stages of the 

evolution of humans and their society. In this relationship, the 

environment influences thelifeofhuman beings. Humansadapt 

to their changing environment, but sometimes they also modify 

the natural environment according to their requirements. 

The early humans lived in the lap of nature. Their survival 

depended on their natural environment, so they adapted to their 

environment. Their food, shelter, and clothing, all came from 

their natural habitat. Therefore, they did not harm their natural 

environment but lived in harmony with nature and devised 

various ways of preserving it. In fact, nature was worshipped in 

different forms as a way to honour the natural environment. 

EFFECTS OF HUMAN ACTIVITIES ON ENVIRONMENT 

With the advancement in technology, the relationship between man and environment also changed. Humans are the 

only living organisms capable of modifying the environment according to their needs. Gradually, humans explored and 

exploited the natural resources forthe development and the comforts of human society.Tofulfillthe needs of increasing 

population, human beings have undertaken certain activities like rapid industrialisation, unplanned urbanisation, 

deforestation, and overexploitation of natural resources. These activities have significantly contributed to 

environmental degradation and are disrupting the environmental stability and ecological balance. 

Environmental degradation is now a global problem. More than 1.4 million people have died as a result of natural 

disasters over the past fifty years. Why are the natural disasters on the rise? Are we tampering too much with nature? 

Human-made disasters are also on the rise. Human 

beings, supposedly the most intelligent creatures 

on Earth, by the misuse of science and technology, 

are probably on the verge of threatening the very 

existence of life on Earth. 

Some of the natural events that cause 

environmental degradation are volcanic eruption, 

forest fires, earthquakes, floods, etc. Let us read 

about some human activities which are harming 

the natural environment and causing ecological 

imbalance. 
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Deforestation 

greatly affected by deforestation. 

Environmental Pollution 

     

 

For Better Concept Clarity 

   

Ask your grandparents/parents how their hometown looked 15 to 20 years ago. What changes have taken 

place over the years? Have the changes affected the natural environment of the city? 

Write down your understanding from the discussion. 

!:II  ECOLOGICAL IMBALANCE 

Anything that attempts to alter the balance of the ecosystem can threaten the existence of that ecosystem. Some of the 

threats can be resolved if the natural conditions are restored. However, others can harm its life forms and destroy 

ecosystems. Various factors cause ecological imbalance. Let us understand some of the important factors. 

OVEREXPLOITATION OF NATURAL RESOURCES 

Overexploitation refers to the overuse of natural resources to such an extent that 

it almost reaches a stage of exhaustion. We can see this phenomenon in the 

exploitation of natural vegetation and forests, medicinal plants, grazing pastures, 

wildlife, fish stocks, fossil fuels, and water aquifers. Large-scale mining of 

minerals, oil drilling, and unplanned urbanisation is leading to the loss of forest 

lands and contributingto the destruction of the ecosystem. Mining 

HABITAT DESTRUCTION 

Clearing of forests to obtain timber and provide space for eitheragricultural zones 

or urban development is called deforestation. A majority of animal and plant 

species live in the forests, and many of them have become extinct or endangered 

because of the loss of their homes due to deforestation. Economic activities such 

as logging, mining, farming, and construction often involve clearing the cover of 

the natural vegetation of places. This tampering with one factor of the ecosystem 

can have a ripple effect on many other factors in any ecosystem. 

Example 

ENVIRONMENTAL POLLUTION 

Water, land, and air play a crucial role in the health of our ecosystems. Any kind of 

pollution releases harmful chemicals (pollutants) into the environment. 

Poisonous gases released into the environment from vehicular emissions and 

factory chimneys cause air pollution and respiratory diseases. Dumping of 

industrial and city sewage wastes into lakes, rivers, and seas are causing water 

pollution. Plastics are one of the most common and persistent pollutants in the 

ocean waters and beaches worldwide, which is a hazard for marine and human 

life 

The soil that provides nutrients for vegetation in the ecosystems is 

Clearing a piece of the forest fortimber can expose the upper layers of the soil to the wind, water, and heat 

of the Sun. In the heavily deforested areas, soil erosion and nutrient run-off are common after a rainfall, 

thereby reducingthe fertility of the soil. 
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Let's Know More 

Earth Day is celebrated 

worldwide every year on 

April 22 to support 

environmental 

protection. It was 

proposed by Gaylord 

Anton Nelson lan 

American politician and 

environmentalist). Earth 

Day was 

first celebrated in 1970. 

'it'  K wMore 

CFC is an abbreviation 

for chlorofluorocarbon. 

cFcs are commonly used 

in refrigerators and air 

conditioners. They cause 

serious damage to the 

ozone layer as they 

attack and destroy 

zone_molecules. 

earch For 

Collect information on at 

least three major 

nuclear disasters. Find 

out the reasons for the 

occurrence of these 

disasters and their 

impact on living things. 
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Haardous chemicals are being used in modern agriculture to control pests and weeds. 

Thse toxic chemicals are accumulating in the environment and causing a threat of diseases 

like cancer. They also kill beneficial microbes and insects, birds, butterflies, and fishes. The 

extinction of different species affect our biodiversity and ecosystems. 

What are some common 

respiratory diseases 

caused by air pollution? 

GREENHOUSE GAS EMISSION 

Gases that trap the heat in the atmosphere are called greenhouse gases. The primary 

greenhouse gases that humans emit directly in significant quantities in the earths 

atmosphere are carbon dioxide, methane, nitrogen, nitrous oxide, and CFCs. These gases 

cause global warming of the environment. The rising temperatures could melt the polar ice 

Causes of Environmental Pollution 

The ozone layer helps to keep out harmful ultraviolet (UV) radiations that cause sunburn to 

human skin and damage to plants. The most common form of UV radiation is sunlight which 

produces three main types of UV rays: UVA, UVB, and UVC. The UVA rays help generate 

vitamin D for living things. UVB and UVC are destructive and can cause DNA and cell damage 

to plants and animals. The depletion of ozone layer exposes living things to UVB and UVC 

ray. The harmful effects of these rays can affect ecosystems and humans and can cause the 

extinction of certain species. 

NUCLEAR WEAPONS 

A single thermonuclear weapon can have a million times more destructive power than the 

largest conventional weapon. Several countries possess nuclear bombs. If a major nuclear 

conflict happens, extreme climatic and global environmental changes would occur with 

significant health implications and would destroy life on Earth. 

RADIOACTIVE WASTES 

Nuclear wastes generated in nuclear reactors are a real threat to life on Earth. Exposure to 

radioactive elements can have severe health effects on human beings, which can result in 

irreparable DNA damage leading to a life-threatening condition, tumours, cancers, etc. 

Radioactive substances can also contaminate soil, water, air, and infuse harmful substances 

in the environment, thereby affecting vegetation, wildlife, and marine life. 

caps, submerging much of low-lying 

land masses and many coastal cities 

(like London, New York, Mumbai, 

Kolkata, and Chennai) under sea 

water. According to scientists, if the 

emission of CFCs is not reduced by 

2030, there will be irreversible global 

warming and large-scale depletion of 

the ozone layer. 



Conservation of Natural Resources 

BIOTECHNOLOGICAL MISUSE 

The production of disease-producing bacteria, viruses, or fungi for biological warfare is another threat to mankind and 

environment. These super-powered pathogens, when released, will disseminate through air or water and can cause 

catastrophic epidemics to man and animal life. 

011  CONSERVATION OF NATURAL RESOURCES 

At the beginning of human civilisation, there was an abundance of natural resources 

on Earth. Since everything was available in abundance, humans did not think about 

their depletion or exhaustion. However, with increasing industrialisation and 

urbanisation, the consumption of these resources also increased. Moreover, as the 

population is continuously growing, the use of natural resources is also increasing. If 

we keep exploiting nature, there will be no more resources left forfuture generations. 

The greed for possessing more of everything and a careless attitude towards nature 

has now brought us to a stage where conservation has become the need of the time. 

Think About This 

+ Today you do not get natural pure water to drink. You have to carry your own water bottle. Imagine the scenario 

where you are extremely thirsty, and you have no water left to drink. What would you do? 

+ Deforestation and mindless cutting down of trees are reducing the sources of oxygen supply on Earth. Will we 

carry oxygen cylinders on our back in the future? 

+ Fossil fuels will get exhausted. There will be no diesel or petrol left. Your cars and other vehicles will become 

useless. Think, how will you manage without these conveyances? 

WAYS OF CONSERVING NATURAL RESOURCES 

There are several ways of conserving natural resources. Some of the methods are-to use renewable resources 

judiciously, reduce the consumption of natural resources, do not harm the natural environment, and educate 

communities to take care of the environment. 

Tips to conserve natural resources 

We can contribute towards the conservation of natural resources by adopting the three Rs in our daily life. The three Rs 

are: 

+ Reduce:  Buy only the essential things and reduce the consumption of natural resources. 

This is the best way to conserve these resources. This way, we can reduce the amount of 

waste in the environment. 

", 4 Recycle: Process old items and create something new. We can recycle some of the things 

that we use every day like paper bags, soda cans, milk cartons, plastic bottles, 

newspapers, cardboard, sheets of paper, magazines, etc. 

+ Reuse: Use the same object over and over again before recycling, composting, or 

throwing it away. Reusing things is a great way to extend the life of things, which in turn 

savesvaluable natural resources. 
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Sometipsto reusethings are: 

+ Write on both sides of the paper. 

+ Drinkfrom glass or reusable stainless steel cups instead of throwawaypaper, plastic, orthermocol products. 

+ Use cloth towels and napkins instead of papertowels and napkins. 

+ Take a cloth bagtothe grocery store instead of using a paper or plastic bag. 

+ Use the comic pages from the newspaper as wrapping paper. 

+ Use glass/stainless steel containers or reusable lunch bagsto carry lunch to school. 

+ Use coffee cans, jam bottles, and othertypes of containersto store things. 

+ Do not throw your old clothes, toys, furniture, and other things that you no longer use. Rather, donate them to a 

centre that collects donations or exchange them with yourfriends. 

We can contribute towards the conservation of natural resources by taking these three important steps - reducing 

consumption, recycling waste, and reusing old things. 

E4VRONM!T PPOTFCTION AF4) COSFRVATO! 

Conservation of environment means the proper use and management of natural resources. It includes water, air, land, 

earth deposits, wildlife, and natural vegetation. Protection of the environment has become a significant issue today, not 

only in India but all overthe world. 

Some of the essential steps forthe protection oftheenvironmentare: 

Develop environment friendly habits, such as proper handling of wastes and 

refrain from using polythene bags. (When discarded, such bags do not 

decompose in the soil). Also, do notthrowthings in the seas, rivers, and lakes. 

+ Use less electricity by making sure that lights and appliances are turned off 

hen not in use. 

Refer to the energy star ratings while buying electrical appliances like 

air conditioners and refrigerators. These appliances would consume less 

power, reduce electricity bills, and reduce the effects of global warming. 

Use LED and CFL bulbs instead of incandescent bulbs. Utilise renewable 

energy sources as much as possible. Use solar heaters, solar cookers, and 

other appliancesthatfunction on solar power. 

The emissions from cars are harmful to the environment. 

Whenever possible, walk short distances or use a cycle instead of 

driving. When required, use car pool, or use public transport. It 

reduces environmental pollution and it is healthyforyoutoo! 

Use water judiciously for daily chores like bathing, brushing teeth, 

drinking, washing, cooking, etc. 

Practise rainwater harvesting at home. Encourage the use of drip 

irrigation. 
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Practise composting. This is an effective wayto reduce greenhouse gas emissions. 

Try to educate people in your localityforthe protection and judicious use of natural resources. 

Encourage afforestation, i.e., planting and growing more trees in deforested areas. Contribute as much as you can to 

the conservation projects that happen in your locality. 

Use alternative fuels like CNG (Compressed Natural Gas) in vehicles, instead of petrol and diesel. 

Industrial wastes and sewage must be treated before they are released into 

the water bodies. 

Use biogas and biofuels at home. 

It is not the responsibility of governments and big companies only to take steps to 

conserve the environment. Every one of us should participate in protecting and 

preservingthe planetfor ourselves and ourfuture generations. 

g 

For Implementation 

Recycle, Reuse, and Reduce, is one of the best ways to conserve the natural resources and the environment. 

Prepare a plan of action based on the Three Rs strategy for your home, which can be practised by all the family 

members. Share your plan with the class. 

J 1L 
TIME 

A. Multiple Choice Questions: 

1. Biotic factors include all the  

a. Non-living things b. Living things 

c. Both living and non-living things d, Natural resources 

2. Examples of abiotic factors are  

a. All the waterbodies b. All the landforms 

c. Water, soil, air, light d. All the human-made things 

3. Human environment refers to the  

a. The natural surroundings of humans b. The surroundings made by humans 

c. All the social institutions and organisations d. Both band c 

4. An ecosystem is any community of living and non-living things that  

a. Work together b. Interact with each other 

c. Are independent of each other d. All of these 
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All natural resources need to be conserved because  

a. They will soon decay 

c. They are very costly 

I. Fill in the Blanks: 

b. They will soon get exhausted 

d. None of the these 

An  is a community of living and non-living components which are interdependent 

on each other. 

In an ecosystem, the components include all the living organisms of the ecosystem. 

Human-made environment includes human activities and their interaction with the  

components. 

Living organisms which depend directly or indirectly on autotrophs for their food are called  

Air is made up of several gases but the two most important gases for living beings are  

and  

iiiiI Ecosystem Oxygen. Carbon dioxide Heterotrophs Abiotic - Biotic 

Answer the Following Questions: 

Vhat is environment? 

Environment comprises our surroundings—the air we breathe, the water that covers the earths surface, the 

plants and animals around us, and much more. 

Define the term ecosystem. 

ns. An ecosystem is any community of living and non-living things that function together. 

Why is it important to conserve ndLural f(5UU1LLS 

ins. It is important to conserve natural resources because as we continue to overuse the natural resources, a 

serious natural imbalance will be caused in the environment and many natural resources may soon get 

exhausted. 

What are some of the most dangerous effects of the depletion of ozone layer? 

ins. The depletion of ozone layer exposes living things to UVB and UVC rays. The harmful effects of these rays can 

affect ecosystems and humans, and can cause the extinction of certain species. 

What does the term conservation of environment imply? 

ins. Conservation of environment implies the proper use and management of natural resources. 

). Answer in One or Two Sentences: 

What do you understand by overexploitation of natural resources? 

When is Earth Day celebrated? 

Define greenhouse gases. 

What is the full form of three Rs? 

What do you mean by conservation of environment? 
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Conduct a Group discussion in your class on the topics 

a. 'Hazards of deteriorating environment' 

b. 'Various factors that influence our environment' 

E. Answer the Following Questions: 

1. Explain the composition of biotic and abiotic factors in the environment. Give suitable examples to distinguish 

between the two factors. 

2. 'Each ecosystem is unique, but all ecosystems consist of three primary components. Comment. 

3. Can development and conservation of environment go hand-in-hand? Explain your point of view. 

4. What are some of the factors that cause imbalance in an ecosystem? 

5. Protection of the environment has become an important issue today. Suppose you start a new venture as an 

entrepreneur, how will you contribute towards protecting the environment? 

F. Application Based Questions: 

1. Renu lives in a society where the residents are facing an acute water crisis. Suggest some ways to the 

residents to conserve water. 

2. Swati uses wood and cow-dung cakes as fuel in her kitchen. She is not aware that these fuels pollute the 

environment. Suggest some alternative eco-friendly fuels to her to avoid air pollution. 

       

For Better Concept Clarity 

  

  

       

Prepare posters showing environment conservation in the neighbourhood, school, or public places. 

Learning 
Computers with  Kips  



The Need for Green Economy 

UNIT - V: Green Skills 

CHAPTER 18 

  

Importance of Green Economy 
Life on Earth is possible because of the natural environment, but today our natural environment is at risk. To fulfil the 

demands of the growing population, natural resources are being consumed at a 

much faster rate than ever before. Trees are being cut down for making new roads, 

expressways, shopping complexes, and for constructing housing societies. Such 

human activities have various adverse effects on the natural environment. 

Rapid industrialisation, commercialisation, and the growing needs of the people has 

led to an increase in the number of industries, power plants, vehicles, and use of 

chemical fertilisers. All this is leading to environmental pollution (air, land, and 

water). Increased pollution and greenhouse gas emissions and depletion of natural 

resources contribute to global climate change. 

II  HUMAN ACTIVITIES AND ENVIRONMENT 

Environment and human activities are closely linked to each other, one impacts the other. Therefore, by gradually 

damaging the natural environment and depleting the natural resources by their activities, humans are threatening their 

very own existence. 

The environment affects people People affect the environment 

+ Climate 

+ Water availability 

+ Shelter availability 

+ Soil for plant growth 

   

+ Burning fossil fuels 

+ Creating urban areas 

+ Cutting forests for wood 

+ Flushing waste into rivers 
() 

People 211 
The future of this planet is in our hands. There is a need to develop an attitude to care and preserve the quality of the 

environment. This can be achieved by developing green skills, which deal with protecting the environment for the 

future, creating jobs that protect the environment, reducing energy consumption, and minimisingwaste and pollution. 

Green skills refer to the knowledge, abilities, values, and attitudes needed to live in, develop, and support a society 

which reduces the negative impact of human activity on the environment. 

Our life depends on natural resources present in the environment like air, freshwater, and soil. By emitting pollutants, 

greenhouse gases, and waste, we cause drastic and irreversible damage to the environment. For a longtime, we humans 

believed that natural resources are unlimited. Therefore, we exploited the resources available to us with a little thought 

of their replenishment. The economic prosperity we are enjoying right now will not last forever because natural 

resources are getting consumed at a much faster rate than before. There is already a scarcity of food, water, fuel, and 

pure air in many parts of the world. What is the solution to these problems? Environmental scientists believe that 

transition towards green economy will help in counteringthese ecological problems. 

II  GREEN ECONOMY 

In order to understand green economy, it is essential to first understand the term 'economy'. An economy is a system of 

organisations and institutions that either facilitate or play a role in the production and distribution of goods and services 

among the members of a society. 
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Ecosystem 
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Economy 
anufactured and (natural capital) 
financial capital) 

goal: meintain 
goel: lrnprovo rewurco ecologlceiljej 

Human well-being 
(social and human capital) 

\ goal: enhenca aoclitl equity and 
Ncalar burden aharlog 

P10+20 

What was the main 

aim/agenda of 2012 

Rio+20 conference? 

Melting Glaciers 

Green economy is an economy that results in improved human 

well-being and social equity, while significantly reducing 

environmental risks and ecological scarcities. 

Green economy can be seen as a mean to achieve better quality 

of life on this planet by balancing environmental, economic, and 

social elements. It leads to sustainable development, which 

fulfills the needs of the present generation without exhausting 

the resources for future generations. 

Over the past decade, many scientific studies have highlighted 

the problem of environmental degradation and climate change. As a result, the concept of 

the green economy has become a global agenda. Some important global events over the last 

few decades focusing on green economy include: 

1972 Stockholm Conference 1987 Brundtland Report 

1992 Earth Summit and Agenda 21 2012 Rio+20 Conference 

AIMS OF GREEN ECONOM' 

The United Nations Environment Programme (UNEP) has proposed a three-pronged approach for the attainment of the 

green economy: Low carbon growth, Resource efficiency, and Social inclusion. 

LOW CARBON GROWTH 

Human activities like burning of fossil fuels (coal and oil) have increased the concentration of CO2  and other greenhouse 

gases (GHG) like Nitrogen Oxide and Methane in the atmosphere. This prevents Earth from cooling at night, thus causing 

global warming and climate change. The term Low Carbon' means reduction of all greenhouse gas emissions. Low 

Carbon Growth is now generally expressed using the term Low Emission Development Strategies (LEDS). LEDS are 

generally used to describe the national economic development plans or strategies that include low-emission and 

climate-resilient economic growth, which means, economic development that does not harm the environment. 

Consequences of carbon growth 

+ The greenhouse effect has warmed up oceans and caused melting of glaciers, 

which in turn are resulting in rising sea levels and changes in the amount and 

pattern of precipitation. Rising sea levels flood coastal areas and influence 

shipping industry. 

+ Globalwarming is causing morewildfires, droughts, and tropical storms. 

+ Climate change is causing tremendous loss of property and human life. The 

destruction of infrastructure from hurricanes, tsunamis, and other disasters 

take years to recover. Moreover, these disasters cause chronic waterborne 

diseases and lasting psychological traumas. 

Carbon dioxide also contributes to air pollution creating acid rains. Acid rains damage trees and other plant life and 

further pollute water and soil. 

Polluted water and soil contaminate vegetation that we eventually consume. 

Carbon dioxide emissions displace oxygen in the atmosphere, thus impacting human health. There has been a rapid 

rise in health issues like breathing problems, skin diseases, headaches, etc., due to the increase in atmospheric 

carbon dioxide levels. 
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Thus, a low-carbon economy is essential for environmental sustainability and future prosperity. To achieve low carbon 

growth, green economy develops economic activity which has minimal output of greenhouse gas emissions into the 

biosphere. In other words, the green economy controls carbon emission in the environment by using fuels more 

efficiently, restoring carbon in soil and biomass, and using low carbon technologies to generate energy-efficient products 

and services. 

RESOURCE EFFICIENCY 

As discussed, earlier, we are depleting our natural resources by overusing and exploiting them. Green economy 

conserves these resources as it involves increasing prosperity by using the resources economically and without affecting 

the environment. In other words, the green economy emphasises becoming more resource efficient. 

Resource efficiency involves efforts at three levels - government, corporate, and individual. Apart from environment 

friendly technological innovations, it requires changes in almost all aspects of our life—clean transportation, efficient 

and cleaner energy production, water management, land management, greener buildings, waste management and 

disposal, and so on. 

Clean 
Transportation  

More 
efficient and 

cleaner 
energy 

production 

Better water 
usage and 

management 

Greener 
bwldings 

Clean and 
efhcient 

waste 
management 

Improved land 
usage through 

sustainable 
farming and 

forestry 

SOCIAL INCLUSION 

Social inclusion essentially means sharing the responsibility as well as the benefits of 

economic growth across all sections of society. The shift towards green practices require 

investments by both, private and public sectors leading to the growth in income and 

employment through green jobs. 

Accordirigto the United Nations Environment Programme (UNEP), a Green Job is defined as a 

work in agricultural, manufacturing, research and development, administrative, and service 

activitiesthat contribute towards preserving or restoring the quality of the environment. 

Green jobs involve greater efficiency in the use of energy, water, and material. These jobs help 

to protect ecosystems and biodiversity, de-carbonise the economy, and minimise all forms of 

waste and pollution. 

Let's Know More 

What is a green building? 

It is a building which in its 

design, construction, and 

operation, reduces or 

eliminates negative 

impacts, and can create 

positive impact on our 

climate and natural 

environment. Green 

buildings preserve precious 

natural resources and 

\
improve the quality of life. 

Green jobs span a wide range of skills, educational backgrounds, and occupational profiles.Theyoccur in almostall fields. For 

example, people employed in setting up a solar panel or operating a wind turbine are involved in a green job because they 

are working towards generating wind energy, which is an alternative to burning fossil fuels. Even the industries that supply 

raw material for building wind turbine towers are also contributing to the green economy. 

III  GLOBAL IMPACT OF MOVING TOWARDS GREEN ECONOMY 

Given below are some of the main global impacts of moving towards green economy: 

Contribution in preventing melting of glaciers and resulting rise of sea level 

Contribution in preventing climate changes such as variations in rainfall, 

temperature and crop production, and climate disasterslike droughts and floods 

Contribution to fight against global warming, desertification (fertile land becoming 

infertile), and loss of biodiversity (the variety of plant and animal life in a particular 

habitat) 
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Improvement in air,water, and soil quality 

Reduction in disease and deaths of living beings 

Reduction in money spent on conservation of environment, relief, and rehabilitation of people 

+ Increase in new areas of manufacturing such as biofuelsand renewable energysources 

4 Investment in alternative energy sources and becoming more energy efficient 

.4 Improving resource efficiencyand thus increasing industrialand agricultural production 

Increase in new areas of employment 

Ull  GREEN ECONOMYfN INDIA 

India has led by example in moving towards green economy. It has taken gradual 

steps towards a green economy in the last decade and has tried to balance it with 

continuous development. 

India aims to addressthe following three issues through green economy initiatives: 

Issues of energy scarcity 

Issues of environmental pollution 

Issues of unemployment or underemployment 

GREEN SKILL DEVELOPMENT PROGRAMME (GSDP) IN INDIA 

The Skill India Mission of the Government of India, Ministry of Environment, Forest and 
1ODAY 10 

Climate Change, has started the Green Skill Development Programme (GSDP). It aimsto 

target a large number of people who will betrained as perthe needs of the green sector. 

Aims of the Green Skills Development Programme (GSDP): 

0 1. To train green skilled workers with technical knowledge and commitment to 

conserve and preserve the environment. 

2. To generate new jobsfor green skilled workers who will help to protect ecosystems 

and biodiversity, reduce energy consumption, and minimise waste and pollution. 

3. To preserve or restore environmentalqualityso that it lasts forfuture generations. 

Some of the fields covered under Green Skill Development Program are: 

Sewage Treatment Plant 

Waste Management 

Water Budgeting 

Forest Management 

Pollution Monitoring (Air/Water/Soil) 

Sewage Treatment Plants (SIP), Effluent Treatment Plants (ETP), and Common EffluentTreatment Plants (CETP) 

Bamboo Management 
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Computers with  KIP 

0 

z 
Lii 

s 



JOB OPPORTUNITIES INVOLVING GREEN SKILLS 

The Indian economy is expected to generate many jobs in the green sector. Youths 

completing the GSD Course(s) can be employed in the following fields: 

Wildlife (zoos, wildlife sanctuaries, national parks, biosphere reserves, botanical 

gardens, nurseries, wetland sites, State Biodiversity Boards, Biodiversity Management 

Committees, and Wildlife Crime Control Bureau) 

Industries (involved in production or manufacturing of green products) 

Tourism (as eco-tourist gu ides) 

Agriculture (as organicfarmers orgreen practitioners) 

Education and research sectors 

Waste management (in Municipal Corporations, Councils, urban local bodies to advise 

on howto improve sewage, sanitation, land use services, and tackle pollution) 

- Water management 

Construction related areas  

Lets Know,More 

Bamboo Management 

Bamboo is a common 

tropical perennial grass, 

which grows widely in 

Asia. It grows rapidly and 

many raw materials are 

obtained from it. It is a 

source of raw material for 

building paper. Young 

shoots are used as food. It 

is a very important plant 

to control soil erosion. Its 

cultivation is being 

encouraged as a 

commercial crop. 

LeEs  Know Mor 
According to a recent 

WHO (World Health 

Organization) survey, 13 of 

the 20 most polluted cities 

are in India. 

Climate change and pollution are posing 

an alarming and fast approaching threats 

to us and for our future generations. The 

world needs to take drastic and immediate 

actions to protect our planet for our 

continual existence. Governments, 

private sector, NGOs, and groups of 

awakened citizens worldwide are working 

diligentlytowards an efficient and inclusive green economy. However, there is a dire need to 

bring awareness to the citizens of the world to adapt to an eco-friendly lifestyle. 

Green skills refer to the knowledge, abilities, values, and attitudes needed to live in, 

develop, and support a society which reduces the negative impact of human activity 

on the environment. 

Our environment comprises our surroundings—the air we breathe, the water that covers the earths surface, 

the plants and animals around us, and much more. 

An ecosystem is a community of living and non-living components which are interdependent on each other. 

Several ways of conserving natural resources are - to use renewable resources judiciously, reduce the 

consumption of natural resources, do not harm the natural environment, and educate communities to take care 

 

of the environment. 
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Let's Know More 
Skill Council for Green 

Jobs is one of the most 

recently launched 

initiatives of the 

Government of India 

aligned to the National 

Skill Development 

Mission. It is promoted by 

the Ministry of New and 

Renewable Energy (MN RE) 

and Confederation of 

Indian Industry (CII). 



ASSESSMENT TIME 

A. Multiple Choice Questions: 

1. Green skill is the ability to  

a. Planttrees b. Protecttrees c. Identifytrees d. Conservetheenvironment 

2. Setting up solar panels is an example of  

a. Green job b. Social job c. Traffic job d. Hydel work 

3. Green economy can lead to  

a. New job opportunities b. Low carbon economy 

c. Better quality of life on this planet d. All of these 

4. Imparting green skill sets will generate  

a. More nurseries b. New species of trees 

c. Renewal of fossil fuels d. New employment opportunities 

5. Manufacturing diesel generator sets is an example of green job. 

a.True b.PartiallyTrue c.False d.PartiallyFalse 

B. Fill in the Blanks: 

1. Green economy emphasises on becoming more efficient. 

2. buildings preserve precious natural resources and improve the quality of life. 

3. is a tropical commercial grass which controls soil erosion. 

4. A green economy is essentialfor sustainability and future prosperity. 

5. Transition towards a can help us in countering the ecological problems. 

Iuiiij Green economy Bamboo Green Environmental Resource 

C. Answer the Following Questions: 

1. Define green skills. 

An. Green skills are the knowledge, abilities, values and attitudes needed to live in, develop and support a society 

which reduces the negative impact of human activity on the environment. 

2. Define green economy. 

An, Green economy is an economy that results in improved human well-being and social equity while significantly 

reducing environmental risks and ecological scarcities. 

3. What do you understand by the term green job? 

Ans. Green job is defined as a work in agriculture, manufacturing, research and development, administrative, and 

service activities that contributes towards preserving or restoring the quality of environment. 

4. What are the aims of green economy? 

Ans. Green economy has three aims: Low carbon growth, Resource efficiency, and Social inclusion. 

5. VVhat are the six key points on which green economy is baseci 

Ans. Green economy is based on the following key points: Clean Transportation, Efficient and Cleaner Energy 

Production, Water Management, Land Management, Greener Buildings, and Waste Management and 

Disposal. 

6. Explain the term sustainable development. 

Ans. Sustainable development means the development that fulfills the needs of the present generation without 

exhausting the resources for future generations. 

D. Answer in One or Two Sentences 

1. Enlist any three human activities that cause damage to the environment. 
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Computers with 

 

128 

 



2. List any two job opportunities in the green sector. 

3. How do greenhouse gasses affect our environment? 

4. How do green jobs help in restoring the quality ofthe environment? 

5, What issues does India aims to address through green economy initiatives? 

E. Answer the Following Questions: 

1. What is green skill and what is its importance in the present times? 

2. Explain the relationship between man and environment. How does one impact the other? 

3 Explain the concept of social inclusion. 

4. How can the youth benefit from the Green Skills Development Programme (GSDP) of the government of India? 

5. What are the benefits of moving towards green economy? 

6 Why is low carbon growth the chief aim of green economy? How do the increased carbon emissions impact the 

environment? 

F Application Based Questions: 

1. Imagine you are involved in Green Skill Development Programme. Some students have come to your office to 

know about some of the fields covered under this programme. Suggest them some job opportunities involving 

green skills. 

• Bahadur LaP is working as a junior officer in the National Park. How is he contributing towards green economy? 

Justify your answer. 

 

For better concept Clarity 

 

A. Take a trip of your city (along with an elder or your teacher) and list down the different sources of 

environmental pollution. Prepare a table under the following headings: 

~  Types of Pollution (Air, Land, Water, etc.) 

+  Sources 

4  Effects of the pollution 

Suggestions for controlling pollution 

B. Refer to the Internet and prepare a PowerPoint presentation on the topic, Benefits of Green Buildings. 

C. Prepare a poster showing the importance of green economy with the help of newspaper/magazine cuttings. 

Also, write a slogan on the green economy. 

Organise a debate in the class on the following topics: 

+ Banning diesel vehicles will help in reducing environmental pollution 

+  Green skills are not as important as technical skills 

+  Global impact of moving towards green economy 
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- Introduction to IT and ITeS Industry 

CHAPTER  

Applications of IT in lieS Industry 
Technological development has revolutionised our everyday life to a great extent. It has led to the emergence of a new 

global economy. Technology has virtually transformed the world into a globalvillage, With a click ofa button, you can find 

any information you want. 

Let us consider a few situations: 

+ You are out on a family vacation and have lost your way to your hotel. What 

would you do? 'Google Maps comes to the rescue. You can launch the 

3oogle Maps app on your phone, and navigate easily through the unfamiliar 

location. 

You want the latest information for your project 

on health and nutrition. From where would you 

get it? In this situation, Internet will help you 

gatherthe required information. 

+ You wish to buy binoculars to go for birdwatching with your friends; a few clicks on an 

onlineshoppingwebsite, and you get them deliveredatyour doorstep. 

Can you imagine life without networking, where there is no phone, no radio, and no television? No, you cannot. Today, 

being in the information era, technology has a great impact on our daily lives — from working to socialising and learning 

to playing. The digital age has transformed the way young people communicate, seek help, access information, and 

learn. Nowadays,technology has become an integral part ofoureverydaylife. 

ICT is an acronym forinformation and Communication Technology. It refersto allthedevices, networkingcomponents, 

applications, and systems that allow people and organisations to interact with the digital world. ICT comprises all 

communicationtechnologies, such as the Internet, mobile phones, satellite communication, wireless networks, etc. 

UNESCO (2009) defined the term "ICT" as "The system of technologies, tools, and devices that are used to transmit, 

process, store, create, display, share, or exchange information by electronic means". 

• INFORMATION TECHNOLOGY 

Information Technology (IT) has changed everything over the years. Nowadays, IT 

refers to the use of computers and other resources to create, store, manage, and 

exchange all kinds of information. It is an essential and tightly integrated part of 

every business today. 

IT has multiple benefits for a business, such as: 

Helps to reach more potential customers 

Provides better service to customers 

Allows customers to provide feedback to improve the business 
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Reduces costs and improves efficiency 

Streamlines and reorganises operations 

Maximises profit and minimises waste 

Sustains better relations with key associates 

INFORMATION TECHNOLOGY ENABLED RV!S (lieS) 

As the name suggests, the services enabled by the use of 

Information Technology can be termed as ITeS. These services 

improve the efficiency of an organisation and help in reducing 

cost. 

Project Application 

Management Development 

In simple terms, ITeS is a type of outsource service that involves 

the use of IT. These can be Human Resource, Insurance, Finance 

and Banking, or Telecommunication services, etc. The most 

common examples of lieS that you come across in your day-to-

day life are call centres, back-offices, content development, and 

logistics management. Localisation 
Testing and 

For each ITeS service, there are two things involved: Translation 

Technologythat enables the service 

A communication device 

The combination of the correct technology and communication channel results into very high degrees of improvement 

in the service quality. 

Let us discuss a few most common IT enabled services: 

CALL CENTRE 

 

IT IT 
and and 

IT enabled Bilingual 

Services Staffing 

Infrastructure 
Management 

 

It is a service centre to provide information and support to a 

customer. It has trained consultants, high-quality telecom facilities, 

access to the Internet, and other online information. 

A large number of telephone calls are received and transmitted 

bytrained customerservice representatives. Atypical call centre 

functions as follows: 

+ A customer uses a contact number (usually a toll-free 

number) that is connected to a customer support centre. 

4- When a call reaches the call centre, a trained customer 

service representative answers the customer. 

- To make sure that the highest standards of customer service are delivered, the IT experts create the technology to 

support the call centre. 

+ With the increase in world-wide connectivity, it makes no difference whether the call centre is located in the local 

city of the customer or anywhere else in the world. 

Learning 
Computers  Kips  <€> 



THIRO 

PAR1Y 

FICATION 

BPM 

Life-Cycle 

Optimiition Monitoring 

BUSINESS PROCESS OUTSOURCING (BPO) 

Business Process Outsourcing (BPO) is a practice of outsourcing a part of a business to another organisation that is an 

expert in handling such kind of processes. The two organizations can be in entirely different parts of the world. In India, 

BPOindustry is highly organised and hence various kinds of jobs are outsourced here. BPO is often divided into two main 

types of services - back office and front office. Back office services include processes, such as billing or purchasing. Front 

office services pertain to the support provided to its customers, such as marketing and technical support. Other BPO 

services are as follows: 

Transaction and Payment Processing services 

Document Management services 

+  OrderMariagementservices 

~ Accounts Management services 

+  TechnicalSupportservices 

Tele-ma rketing services 

+  CustomerSupportservices 

+ Healthcare services 

+ Legal Process Outsourcing services 

+ E-publishing and Web Promotion services 

BUSINESS PROCESS MANAGEMENT(BPM) 

BPM is a discipline in operations management. It is used as an ongoing process that focuses on developing new processes 

and improving corporate performance by managing business 

processes. A combination of methods used to manage a company's 

business processes is BPM. BPM is considered the bridge between 

information technology (IT) and business. 

lT-BPM sector is contributing 8% to India's GDP and exports. The growth 

of this sector has provided India huge economic and social benefits 

including employment, raising income levels, and promoting exports. It 

has placed India on the world map with an image of a technologically 

advanced and knowledge-based economy. In the last decade, this 

industry has doubled in terms of its revenue. BPM service industry is 

doing outstandingly well in India because of the following advantages: 

Finest and high-quality services are delivered through the state-of-

the-art hardware and software. It requires a huge amount of 

investment to ensure superior grade service delivery. 

It guarantees flawless and excellent service byfollowing repeated quality checks. 

Government of India is also boosting the BPM industry by providing the required infrastructure and logistical 

support. 
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Structure of the IT-B PM Industry 

The companies within the IT-BPM industry are classified on the basis of the following parameters: 

+ Theareatowhichthecompanyisserving 

+ Thetypeofservicesthecompanyisproviding 

+ The geographical reach of the company 

+ Scope of operations and profit earned bythe company 

Multinational Companies (MNCs):  A multinational corporation is a corporate organisation that owns or controls the 

production of goods or services in at least one country other than its home country. They operate in multiple locations 

worldwide. The two main characteristics of MNCs are: 

- Theirlargesize 

+ Theirworldwide activities are centrally controlled bythe parent companies 

Indian Service Providers (ISPs):  lSPs initially began their operations in India. Most of these companies have their control 

centres in India while having workplaces at many international locations. 

Global In-house Centres (GIC):GIC  organisations work fortheir parent organisation only and do not function for external 

clients. The Indian Global In-house Centre, or GIC, has evolved significantly over the last 20 years. These organisations 

were originally known as captive centres. GICs are offshore centres that perform specific functions for large 

organisations. There are about 1,100 GICs in India that employ at least 9,00,000 individuals. Further hiring in GICs is 

expected in areas, like cyber security, analytics, and digital innovations. 

PPL!CAT!ONS OF r 

Every aspect of our daily routine has altered with the advent of IT. It helps to improve the quality of our lives, by giving us 

easy access to information as well as a large number of products and services. IT has transformed the way we live, the 

way we work, the way we conduct business, and the way we communicate with each other. Although, these services 

provide us with innumerable benefits, it also makes us susceptible to various cyber threats. Thus, it is our responsibility 

to take precautions while using these services to keep ourselves safe from cybercrimes. 

IT IN HOME AND EVERYDAY LIFE 

ITfacilitates access to various services and technologies in our day-to-day lives. With its increasing importance, ITliteracy 

has become a functional requirement to ease our lives. The World Wide Web has made it possible to search for 

information on varied issues, such as education, health and nutrition, current affairs, social aspects, finance, and many 

other important issues. Some of the ways we use IT in our everyday lives are: 

We use online services to pay our utility bills, like the telephone bill, electricity bill, gas bill, water bill, mobile bill, etc. 

We read online newspapers and stay updated. Now, we do not have to wait for the next dayto know what happened 

a day before. Online news services provide news that is instantly and continuously updated. 

We watch entertainment programs on the Internet. 
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We play online and offline games on our smartphones and Pcs. 

We get connected with our family, relatives, and friends even if we are geographically at distant locations using 

e-mail, social media, video calling, etc. 

We do online shopping to buy products, such as vegetables, groceries, cosmetics, clothes, medicines, electronic 

devices like air conditioners, laptops, etc. You can buyalmost everything online. 

We can book hotels, flights, railways tickets, and movie tickets online. 

+ We can get any type of information instantly by searching on the Internet. Some commonly used search engines are 

Google, Bing, Yahoo, etc. 

+ Information technology plays a pivotal role in education and learning. It allows students to obtain resources and 

information with the click of a button. Students also access various educational videos available on the Internet for 

the clarity of concept. 

ITIN EDUCATION SECTOR 

Information technology has the ability of speeding up information delivery, and this ability can be used in improving our 

education environment. With the implementation of information technology, costs of accessing educational material are 

cut down, and it makes it easy for students to learn from anywhere. To reduce the level of illiteracy, it is very important to 

make educationaccessible at anytime to anyone. 

New technologies are changing the way of teaching and learning. Computers and information technology are extensively 

used in education for teaching-learning and assessment. Both teachers and students are using these new educational 

technologies to achieve specific academic goals. The software and hardware technology is used for designing and 

broadcasting information to the learners in various forms including audio, video, still pictures, and animation. 

Some of the uses of information technology in education sector are: 

Educational Resources 

Information technology makes it easy to access academic information at any time. A variety of teaching resources are 

available for teachers to teach in a better way. Both students and teachers use information technology to acquire and 

exchange educational material. Online assessments help to evaluate the students without bias. Teachers can easily 

prdvide visual and audio classes to their students using computers and the Internet. This breaks the boundaries of 

acessing information, for example, a student can attend a lecture while not being physically present in the classroom. 

Alsb, teachers can assign tasks to students via e-mails or campus educational forums. There is a collection of free and paid 

online services and apps, like Youlube, Kindle books, G Suite for Education, Khan Academy, and Code.org  available for 

teachers as well as students, which provide a lot of useful study material. 

Online Learning 

In the past, learning was limited to a physical classroom; students and teachers could only access academic information 

while at school. Today, all that has changed and a student can access information at anygiven time of theday. You can also 

contact a teacher or a trainer via Internet to use WBT (Web-based Training). Various educational videos can also be 

accessed through YouTube and other platforms. The geographical location of a student is not at all a matter of concern 

now. Information technology has facilitated online education, so a student in India can study the same course as a 

student in USA or Europe. Moreover, when it comes to getting employment, all these students will have the chance to 

compete for the same job. 
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Application in Classroom 

There are manyways in which IT is used for education in the classroom, such as: 

Collecting educational information from the Internet 

+  Online group discussions with students/educators present in another physical location via video conferencing 

+  Smart board presentations 

+ Using Audio-Visual aids for teaching 

+ Education by means of educational games 

Use of Audio—Visualleaching Aids 

Information technology has changed the way we learn and interpret 

information. The use of audio-visual aids helps students learn faster and 

easily. When an educator explains a subject through pictures, animations, 

and audio-visuals, it makes students understand the topic easily. Visual 

presentations using projectors help the students remember the concept 

better. Our brain tends to remember visual illustrations more easily than 

text. 

Learning Management System (LMS) 

A Learning Management System (LMS) is a software application or Web-

based technology used to plan, implement, and assess a specific learning process. 

~ Learning—It is used to deliver education courses ortraining programs. 

+ Management - It helps to organise these courses (create them, change them, assign them to students, grade them, 

etc.). 

+ System—It refers to the software. 

LMS lets you create E-learning content (lessons), organise it into courses, delivers the content to the students through an 

interface, and enrolls them to the said courses. It finally monitors and assesses their performance (attendance, grades, 

etc.) upon completion of the course. 

An LMS is the engine that powers E-learning. It consists of two separate parts: 

+ A server component that performs the core functionality (creating, managing, and delivering courses, authenticating 

users, serving data and notifications, etc.) 

+  A user interface that runs inside your browser as a web (like Gmail or Facebook), that is used by administrators, 

instructors, and students. 

IT AT WORKPLACE 

IT facilitates innovation, creative expression, time management, work efficiency, and effective management at 

workplace. IT has become an integral part of every workplace because it provides cost effectiveness, enhanced 

satisfaction, faster and simpler execution of work, rapid responses, and easier operational procedures. Some of the 

benefits of IT at offices are: 
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It improves communication within the workplace and 

with the customers. 

~  It makes every employees job easier and more 

efficient. 

+ It helps employers by increasing productivity. 

It increases speed and accuracy of many work 

processes, which improves overall work efficiency. 

Documents can be written and edited more quickly 

using a word processing program. 

+  Recording, calculations, comparison, and analysis of data can be easily and accurately done using a spreadsheet 

program. 

+  Databases are used to store large quantities of data related to personnel, inventory, customers, sales, accounts, 

logistics, etc. 

+ The process of screening, recruiting, and hiring new employees has become highly improved with the use of IT. 

IT IN LIBRARY 

IT is used in libraries to record library activities, operations and various other library services. The functioning of a library 

is majorly benefited by the use of IT for collection, processing, storage, retrieval, and dissemination of recorded 

information. The use of new technologies like, Word Processing, Text Editing, Character Recognition, Voice Recognition, 

Electronic Publishing, CD-ROM, Electronic Data Processing, Database Management System, E-mail, etc. have rapidly 

transformed the libraries from conventional methods. 

IT IN BUSINESS AND MARKETING 

IT facilitates E-commerce which includes marketing, product browsing, shopping, and processing orders. Business 

communications through e-mail, video conferencing, and mobiles enable people to work from anywhere. Documents 

can be shared instantly, and decisions can also be taken quickly. 

Some information technology tools that are used to reach out to people across the world are: 

Blogging 

+  Computerised presentations 

+ Customer Relationship Management (CRM) systems 

+ E-mail communication 

+ Graphic Design software 

+  Websites 

+  Social media 
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E-commerce refers to the activity of buying or selling of products through the Internet. E-commerce or online shopping 

allows users to search and compare various products and services, which they can buy at competitive prices. The 

products are delivered right at their doorstep, thus saving time and money. E-commerce offers a range of products from 

home appliances, apparel, toys, and electronics. 
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ITIN BANKING 

E-banking refers to a method of banking in which a customer conducts transactions through 

the Internet. It has enabled people to conveniently and quickly conduct their financial 

transactions online. These days, every traditional service that a local bank directly provides 

is available online. Online banking has facilitated the networking of banks and other 

financial institutions, resulting in saving time, effort, and money. Transferring money 

between accounts using IMPS, RIGS, and NEFT, viewing account details, opening fixed 

deposit accounts as well as making online payments for products and services can be done 

at a click of the mouse. Withdrawing money at any time through ATMs (Automated Teller 

Machine) is also possible because of the use of IT. 

The use of technology in banking is the backbone of societytoday. Millions make use of this 

service daily to manage their finances. Most businesses also use this feature to pay their 

employees and to transfer money. Additionally, banking systems do their best to ensure 

there are firewalls and limits in place, to reject any curious 

hacker. The following are the examples where IT is used in the 

banking sector: 

+ Online Banking 

+ ATMs 

+ Bankingapps 

+ Tele-banking 

+ DebitandCreditCards 

ITIN INSURANCE 

Lets Know More 

IMPS: Immediate 

Payment Service 

RTGS: Real Time Gross 

Settlement System 

NEFT: National Electronic 

Funds Transfer 

With the help of a computer database, the insurance companies can keep all their records up-to-date. Starting date of 

policies, processes for continuation, date of next installment, date of policy maturity, interest dues and bonus, survival 

benefits, etc. are stored using computers. Nowadays, insurance policies can be purchased online through the respective 

company's website. The policy premiums can also be paid online at regular intervals from the comfort of your home. 

IT IN COMMUNICATION AND SOCIAL MEDIA 

Today, we cannot imagine our life without mobile phones, e-mail, or social media networks, like WhatsApp, Facebook, 

Instagram, Twitter, or Snapchat. These services help us to keep in touch with our family and friends, connect with like-

minded people, access information regarding current issues, and use Internet-based services on the go. 

ITIN ENTERTAINMENT AND ARTS 

IT has revolutionised the entire entertainment industry by providing a variety of leisure activities, such as online games, 

music, and videos, etc. Internet is used as a medium for the distribution of music, videos, and other content on mobile 

phones as well as smart TVs. Digital transmissions are used to broadcast programmes on TV and radio. Live TV streaming 

services— Netflix and Amazon Prime Video, and mobile phone apps, all use ITto provide content for entertainment. 

IT has also encouraged artists to explore their creativity by providing digital tools for photography,videography, drawing, 

painting, designing, etc. ITcan also enable trainings and presentations of performing artslike music, drama, and dance. 
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CAT Machine 
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ITIN HEALTH CARE 

Use of IT in medical science is also known as Health Information Technology (HIT). Records of patients as well as various 

activities pertaining to hospital administration are maintained using Hospital Management System. A wide variety of 

technologies and tools are involved in the diagnostic process. Health IT covers a broad range of technologies used in 

health care, including: 

+ Electronic Health Records(EHRs) 

+ Clinical decision support using up-to-date clinicalguidelines 

+ Patientengagementtools 

+ Computerised appointments with doctors 

~ Laboratory and medical imaging information systems 

+ Health information exchanges 

+ Medical devices 

IT in health care plays key roles in various aspects of the diagnostic process, such as: 

+ Capturing information about a patient's diagnostic process 

+ lncludingthe clinical history and interview 

+ Physical examination and diagnostictesting results 

+ Shaping a clinician's workflow and decision making in the diagnostic process 

+ Facilitating information exchange 

Advances in medical technology continues with new sophisticated devices being developed. Nowadays, computerised 

machines are used for ECG, EEG, Ultrasound, CT scan and various other diagnoses. A variety of measuring instruments 

and surgical equipments are used to monitor conditions of patients during surgeries. Computers have become an 

integral part of laboratories and dispensaries. They are used in scanning and diagnosing different diseases. IT enabled 

special applications and wearable gadgets, like Fitbit helps to monitor heart rate and provide personalised information 

onphysical fitness. One can search for and learn about diseases, their symptoms, cure, and precautionary measures on 

the Internet. 

Use of IT in Diagnosis 

Several sophisticated software and hardware are used in the diagnosis and treatment of life-threatening diseases. The 

technologically advanced machines help in the diagnosis of diseases at the initial stages, which results into providing 

bettertreatmentto the patients accordingly. Some of these machines are: 

+ Computerised Axial Tomography (CAT) Machine: This machine 

performs a series of cross-sectional scans made along a single axis of a 

bodily structure or tissue and is used to construct a three-dimensional 

image of that structure. Diseases can be successfully diagnosed using 

these images. 

+ Magnetic Resonance Imaging (MRl) Machine: MRI machines use a 

magnetic field, radio waves, and a computer to detect the properties of 

living tissue. MRI software creates an image using the signals recorded 

by sensors. 
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ECG Machine 

+ Electrocardiogram (ECG) Machine:  An 

electrocardiogram (ECG) is a test which 

measures the electrical activity of your heart to 

show whether it is working normally or not. An 

ECG records the hearts rhythm and activity on a 

moving strip of paper or a line on a screen. 

MRI Machine 

 

+ Cardiac Screening Machine: A cardiac screening machine 

performs Echocardiography, which uses ultrasound to 

create moving pictures of the heart. A special camera takes 

pictures of the heart while the patient is at rest and 

following exercise to determine the effect of physical 

stress on the flow of blood through the coronary arteries 

and to the heart muscle. It helps in displaying the 

movements inside the heart and displays its physiology. 

This machine performs tests to find diseases, like thinning 

of veins and then recommends the treatment. 
Cardiac Screening Machine 

+ EEG (Electroencephalography) Machine:  An electroencephalogram (EEG) is a noninvasive test 

that records electrical patterns in your brain. The test is used to help diagnose conditions, such 

as seizures, epilepsy, head injuries, dizziness, headaches, brain tumors, and sleeping problems. 

It can also be used to confirm brain death. 

+ Blood Sugar Testing Machine:  A blood sugar testing machine is a medical device for 

determining the approximate concentration of glucose in the blood. It is also called as glucose 

meter or Glucometer. 
EEG machine 

Blood Pressure Measuring Machine:  A blood pressure measuring machine is 

simply a way to measure the performance of the heart and the rate at which it 

pumps blood. When the physician puts the cuff around your arm and pumps it 

up, the flow of blood cuts off with the pressure exerted by the cuff. As the 

pressure in the cuff is released, blood starts flowing again and the physician can 

hear the flow in the stethoscope. High or low blood pressure is harmful for our 

body and can result into many other severe health issues. The blood pressure 

measuring machine, also called as Sphygmomanometer, helps in keeping a 

constant check on our heart health. 

Blood Pressure measuring 

machine or Sphygmomanometer 
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ii IN SCIENTIFIC RESEARCH AND ENGINEERING 

Though people tend to think of science, engineering, and technology as three separate things, they are actually closely 

connected. Engineering and the development of new technologies are closely related to science. We use many 

technologies in scientific studies that help engineers to build new 

technologies. Some of the applications of IT in the field of scientific 

research are large computations, calculation of speed, cost and 

distance, new avenues of science exploration, and real-time record of 

observations, analysis, and collaboration. 

Apartfrom the uncountable uses, computers are also used for: 

+ Storing large amount of data used for research work 

+ Performingcomplexcalculations 

+ Computer Aided Design (CAD) applications 

+ ComputerAided Manufacturing (CAM) applications 

+ Simulating and testing the designs 

+ Visualising3-D objects 

IT IN THE GOVERNMENTAND PUBLIC SERVICES 

The government uses large-scale computer applications in its daily operations. Digital 

India and e-governance initiative of government have resulted in providing many 

government services online, such as document processing for driving licenses, collection 

of taxes, exchange of information with citizens, and other government departments. 

Government and Non-Governmental Organisations (NGOs) as well as International Government Agencies use IT 

applications to communicate and provide various services to the people. This is called as e-governa nce. 

IT also provides a platform for interaction through government websites and apps. It helps the government to improve 

the efficiency of service delivery and the exchange of information, thus strengthening the democracy. Some examples of 

the apps launched by government of India for 

digital empowerment of Indian citizens are Bharat 

Interface for Money (BHIM). Swachh Bharat 

Abhiyan, GST Rate Finder, UMANG, and MyGov. 

The government departments use computer 

systems for preparingthe electoral lists, PAN cards, 

etc. Computers are also used in the income tax and _____ 
sales tax departments. Electricity bills also can now 

be paid online. The government is now using 

Electronic Voting Machines (EVMs) for elections, _____ 

replacing the traditional voting slips and ballot 

boxes. 
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Answer the Following Questions: 

1. How does IT help a business organisation? 

2. What is BPO? Mention any five BPO services. 

3. What steps have been taken by the Government of India to improve the efficiency of government services 

being delivered? 

4. List any four social media services that help you to keep in touch with your family and friends. 

 

For Better Concept Clarity 

 

Create a presentation to represent the role of IT in the government and public services. 

ASSESSMENT  TIME 

ITC refers to all the devices, networking components, applications, and systems 

that allow people and organisations to interact in the digital world. 

IT refers to the use of computers and other resources to create, store, manage and exchange all kinds of 

information. 

The services enabled by the use of information Technology can be termed as ITeS. 

The most common examples of lieS that you come across in your day-to-day life are call centres, back-offices, 

content development, and logistics management. 

Call centre is a service centre to provide information and support to a customer. 

Business Process Outsourcing (BPO) is a practice of outsourcing a part of a business to another organisation 

that is an expert in handling such kind of processes. 

Business Process Management (BPM) is a discipline in operations management. It is used as an ongoing 

process that focuses on developing new processes and improving corporate performance by managing 

business processes. 

A Multinational Corporation (MNC) is a corporate organisation that owns or controls the production of goods 

or services in at least one country otherthan its home country. 

Indian Service Providers (ISPs) are companies that have their control centres in India while having workplaces 

at many international locations. 

Global In-house Centre (GIC) organisations work for their parent organisation only and do not function for 

external clients. 

A Learning Management System (LMS) is a software application or web-based technology used to plan, 

implement, and assess a specific learning process. 

E-commerce refers to the activity of buying or selling of products through the Internet. 
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BRAIN DEVELOPER 

b. Information Technology Enabled Services 

d. Information Technology Evolved Solution 

SECTION 1: OBJECTIVE TYPE QUESTIONS - (SOLVED) 

Multiple Choice Questions: 

What is the full form of ITeS? 

a. Information Technology Enterprise Solution 

c. Information Technology Engaged Services 

a. Educational games 

c. Ordering food online 

What does WBT stand for? 

a. Web based Training 

c. Webpage based Training 

E-commerce refers to  

b. Videography of experiments 

d. Smart board presentations 

b. Website based Training 

d. None of these 

c. E-learning d. None of these 

b. Any Time Money 

d. Automated Teller Machine 

a. E-commerce b. E-banking 

What is the full form of ATM? 

. All Time Money 

c. Automatic Transaction Machine 

c.EEG d.MRI a. CAT b. Fitbit 

A 

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

'C 

1; 

It is a servicecentre to provide information and support to a customer. 

a. 8PM b. MNC 

What is the full form of 8PM? 

a. Business Power Management 

c. Basic Process Management 

Which of the following is a BPO service? 

a. Technical support service 

c. Order management service 

Which of the following is a learning platform? 

a. Facebook b. G Suite 

c. ISP d. Call centre 

b. Business Process Management 

d. Basic Power Management 

b. Customer support service 

d. All of these 

c. Snapchat d. Khan Academy 

Which of these activities is not an application of IT in education sector? 

a. Opening bank accounts b. Buying and selling products online 

c. Calculating huge data using spreadsheets d. Making jobs easier at workplace 

Which of these activities are related to E-commerce? 

a. Online shopping b. Socialising c. Chatting d. Photography 

It refers to a method of banking in which a customer conducts transactions through the Internet. 

Which of the following IT enabled healthcare gadgets is used to monitor heartbeat rate? 
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13. Which of the following is not an equipment used for diagnosis of diseases? 

a. BHIM b. Sphygmomanometer c. EEG d.Glucometer 

14. What does CAD stand for? 

a. Computer Aided Department b. Computerised Aixal Design 

c. ComputerAided Design d. None of these 

15.  initiative of the government has resulted in providing many government services 
online. 

a. Swatch Bharat b. Digital India c. Literate India d. Online India 

B. Fill in the Blanks: 

1. Use of IT in business yields in profit and  waste. 

2. ICT is an acronym for Information and Technology. 

3. BPO is often divided into two main types of services and  

4. BPM is considered the bridge between information technology and  

5. and are social media plafforms used for digital marketing. 

6. is a popular website for accessing educational videos. 

7. LMS is the abbreviation of  

8. The use of aids helps students learn faster and easily. 

9. is used to determine the approximate concentration of glucose in the blood. 

10. IT facilitates  which includes marketing, product browsing, shopping, and processing 
orders. 

11.  has enabled people to conveniently and quickly conduct their financial transactions 
online. 

12. Use of IT in medical science is also known as  

C. State True or False: 

1. ITeS services improve the efficiency of an organisation but lead to increase in cost. 

2. It makes no difference to the customer whether the call centre is located in his local city or 
anywhere else in the world. 

3. GIC organisations work for their parent organisation and for their external clients as well. 

4. Facebook and Twitter are popular search engines. 

5. LMS helps to create, organise, and deliver E-learning courses. L 
6. IT facilitates an effective management at workplace. 

7. Technological advancements in the field of medical science have helped in the diagnosis of 
diseases at the initial stages. 

8. Glucometer is a very useful device for diabetic patients to monitor their blood pressure.
] 

9. E-governance has helped in providing public services online so that they reach people easily and 
effectively. 

10. Electronic Voting Machines (EVMs) forelections use voting slips and ballot boxes. 
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4: ANSWERS '1 

A. Multiple Choice Questions 

L.(b) 2.(d) 3.(b} 4.(d) 5.(d) 6.(c) 7.(a) 8.(b) 9.(a) 1O.(b) 11.(d) 12.(b) 13.(a) 14.(c) 

L5. (b) 

B. Fill in the Blanks 

L. Maximising, Minimising 2. Communication 3. Back office, Front office 4. Business 5. Facebook, Instagram 6. Khan Academy 

. Learning Management System 8. Audio-Visual 9. Glucometer 10. E-commerce 11. E-banking 12. Health Information Technology (HIT) 

C. State True or False 

L.(F) 2.(T) 3.(F) 4.(F) 5.(T) 6.(T) 7.(T) 8.(F) 9.(T) 10.(F) 

SECTION 2: THEORY QUESTIONS (SOLVED) 

1. What is a BPO? 

Ar is: Business Process Outsourcing(BPO) is a practice of outsourcing a part of a business to another organisation 

that is an expert in handling such kind of processes. The organisations can be in two entirely different parts of 

the world. In India, the BPO industry is highly organised and hence various kinds of jobs are outsourced here. 

BPO is often divided into two main types of services - back office and front office. Back office services include 

processes, such as billing or purchasing. Front office services pertain to the support provided to its customers, 

such as marketing and technical support. 

2. Briefly explain the role of IT in business today. 

Ar is: Information Technology refers to the use of computers and other resources to create, store, manage, and 

exchange all kinds of information. It is an essential and tightly integrated part of every business today. 

IT has multiple benefits fora business, such as: 

~ Helps to reach more potential customers 

+  Provides better service to customers 

+  Allows customers to provide feedback to improve the business 

+  Reduces costs and improving efficiency 

3, What do you understand by BPM? 

is: BPM stands for Business Process Management. It is a discipline in operations management. It is used as an 

ongoing process that focuses on developing new processes and improving corporate performance by 

managing business processes. A combination of methods used to manage a company's business processes is 

BPM. BPM is considered the bridge between information technology (IT) and business. 

4 Why is the BPM service industry doing well in India? 

A is: BPM service industry is doing outstandingly well in India because of the following advantages: 

+  Finest and high-quality services are delivered through the state-of-the-art hardware and software. It 

requires a huge amount of investment to ensure superior grade service delivery. 

+  It guarantees flawless and excellent service, by following repeated quality checks. 

+  Government of India is also boosting the BPM Industry by providing the required infrastructure and 

logistical support.. 

5 How does a call centre work? 

A is: A typical call centre functions as follows: 

~ A customer uses a contact number (usually a toll-free number) that is connected to a customer support 

centre. 

+  When a call reaches the call centre, a trained customer service representative answers the customer. 
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To make sure that the highest standards of customer service are delivered, the IT experts create the 

technology to support the call centre. 

6. What is Health Information Technology? 

Ans Health Information Technology (HIT) is the information technology applied to health and health care. It 

supports health information management across computerised systems and the secure exchange of health 

information between consumers, providers, payers, and quality monitors. 

7. Briefly explain the concept of F-hankinp, 

Ans: E-banking refers to a method of banking in which a customer conducts transactions through the Internet. 

It has enabled people to conveniently and quickly conduct their financial transactions online. These days, 

every traditional service that a local bank directly provides is available online. Online banking has facilitated 

the networking of banks and other financial institutions, resulting in saving time, effort, and money. 

Transferring money between accounts using IMPS, RTGS, and NEF1 viewing account details, opening fixed 

deposit accounts as well as making online payments for products and services can be done at a click of the 

mouse. Withdrawing money at any time through AIMs is also possible because of the use of IT. 

8. What do you understand by E-commerce? 

Ans: E-commerce refers to the activity of buying or selling of products through the Internet. It allows users to 

search and compare various products and services, which they can buy at competitive prices. The products 

are delivered right at their doorstep, thus saving time and money. 

9. Explain the concept of E-qovernance in India, 

Arc  Government and Non-Governmental Organisations (NGOs) as well as International Government Agencies 

use IT applications to communicate and provide various services to the people. This is called as 

e-governance. Some examples of apps launched by government of India for digital empowerment of Indian 

citizens are BHIM, Swachh BharatAbhiyan, and MyGov. 

SECTION 3: APPLICATION BASED QUESTIONS -  (SOLVED) 

1. Mention any three services taken by your ami1y through a BPO. 

An 1. Renewal of insurance policy. 

2. Filing complaint to power supply board regarding power cut-off. 

3. Seeking technical support for washing machine. 

2. Ashish is preparing a schoolprojecton GlobalLeaders. How can he use ITforthistask? 

Ar Ashish should use a Word Processor Application for preparing his project report. He can use the Internet for 

searching through various websites and collect information about global leaders. 

3. Nenuon aoout any two iT GIiVCfl health diagnostic cevices tnat you have seen a nome. 

Ans: 1. Glucometer 

2. Sphygmomanometer 

4. Mention some of the apps launched by the Government of India under e-governance that you or your famit, 

members have used. 

Ans:1. BHIM 2. GSTRate Finder 3. MyGov 

5. Your uncle and aunt stay in another country. How do you stay connected to them? 

An: Through e-mail, video calling, or social networking. 

SECTION 4: APPLICATION BASED QUESTIONS -  (UNSOLVED) 

1. Rahul wants to share his birthday pictures with his aunt in the USA. Which apps or platforms can he use? 

2. Manishas mother always visits service centres regarding the problems in her home appliances. Mention any 
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1.  

2.  

3.  

4.  

5.  

1.  

2.  

3.  

4.  

5.  

6.  

three services that can be easily resolved using call centres. 

Rohan's father is a cardiologist who uses different types of machines to diagnose ailments related to heart. 

Name any two such machines. 

SECTION 5: SHORT ANSWER TYPE QUESTIONS - (UNSOLVED) 

Define ITeS. 

What is the structure of an IT-BPM industry? 

Give an example of the use of IT in the following areas: 

What do you understand by LMS? 

Briefly describe the impact of IT in your everyday life. 

SECTION 6: LONG ANSWER TYPE QUESTIONS — (UNSOLVED) 

What do you understand by the working ofa call centre? 

What is the basic requirement of IT enabled services? 

How is IT beneficial in the insurance sector? Mention any three factors. 

Mention the role of E-commerce in your life. 

Mention various features of E-banking. 

Discuss the use of information technology in the field of science and engineering. 

For Better Concept Clarity 

+ Prepare a collage to depict the Importance of ITeS in our daily life'. 

+ Prepare a PowerPoint presentation on the topic, 'Importance of IT in Education'. 

j 

____ F I ..l..I 
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Online Banking 

E-learning 

Library management 

Hospital management system 

+ Discuss few instances when we seek help from a call centre. 

+ Talk to a cardiologist and discuss about the machines that are used to diagnose ailments related to 

heart. 

+ Talk to the librarian and try to find out the use of IT in your school library. 
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UNIT - II: Data Entry and Keyboarding Skills 

CHAPTER2  

Using Data Entry Tools 
We all need a medium to communicate our thoughts to others. The primitive way of expressing or communicating our 

thoughts includes writing, drawing, painting, sketching, dancing, conversing, and much more. But with the advent of the 

computer system, the medium to communicate has changed tremendouslyfrom writingto typing. 

A computer system is a smart machine but lacks its own brain and thus works on the instructions provided to it by the 

user. These instructions are given through some input device to get the desired result as an output. This process is known 

as Input-Process-Output (IPO). There are many input devices available in the market such as the mouse, keyboard, 

touchscreen, light pen, etc., butthe most commonly used isthe keyboard. 

Keyboard is the basic input device that is used to enter data by pressing keys. It has different sets of keys for letters, 

numbers, characters, and functions. OWERTY keyboard is the most commonly used keyboard to enter data. Computer 

keyboards are similar to electronic typewriter keyboards with some additional keys. A standard keyboard generally has 

104 keys. In desktop computer, a keyboard comes separately whereas in a laptop and notebook, it is embedded within 

the main unit. 

Touch typing is a method of typing without the use of the sense of sight, or simply by feeling the keyboard. However, the 

sense of touch is a little involved since this typing method utilises muscle memorythrough rigorous training. In this way, a 

user can type on the keyboard spontaneously by placing his or her hands on the keyboard without looking at any of the 

keys. It significantly improves the typing speed and eliminates errors. Touch typing simply makes you more productive 

and it is a skill worth learning. 

Learning about the computer keyboard and its layout enables you to use it effectively when you work on any type of 

computer application. The combinations of keys are used to access, run programs, or used as shortcuts. They depend 

upon the application being used. Let us have a look at the keyboard and its keys. 
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KEYS OF KEYBOARD 

Any standard computer keyboard is divided into the following categories: 

+ Alphanumeric Keys:  There are 26 alphabet keys from A to Z. These are not present in the alphabetical order, instead 

they are placed in such a manner so that a user can work fast. The number keys are placed on the top most row of the 

alphanumeric keypad. 

+ Numeric Pad: The numeric keypad consists of number keys from 0 to 9, the arithmetic operators, directional keys, 

Num Lock, Insert, Delete, Enter, and the decimal point. It is placed on the right side of a keyboard and is used for 

entering numbers at a faster pace. This keypad is just like a simple calculator. Numeric keypad works in dual mode. 

Num Lock is provided to switch between the two modes. When Num Lock is ON/enabled (the corresponding LED 

turns on), you can use the numbers on the keypad. When Num Lock is OFF/disabled, the alternate functions of the 

keys can be used. Usually, some of the keyboards of laptops do not have a numeric keypad. 

+ Punctuation Keys I Special Character Keys: All of the keys associated with punctuation, such as the comma (,), period  (.), 

semicolon (;), brackets ([J), parenthesis ({ }), and so on are known as punctuation keys or special character keys. These 

also include the mathematical operators, such as the plus sign (+), minus sign (-), equal sign (=), etc. 

These keys are used to perform specific tasks. These keys are placed on the top row of the keyboard 

and are labeled as Fl to F12. These keys have different functions in different programs. 

+ Special Keys: There are some special keys to provide additional control over a document. Enter/Return, Spacebar, 

Esc, Print Screen, Pause/Break, Insert, Tab, Delete, Windows, and Menu are some special keys. 

+ avgation l<ey The navigation keys are used to navigate through a document. These include the arrow keys, Home, 

PageUp, PageDown, and End keys. 

+ combination Keys: These keys are used in combination with other keys to perform an action. Ctrl, Alt, and Shift are 

known as combination keys. 

+ Toggle Keys:  They are used to turn computer features ON or OFF. The Caps Lock, Num Lock, and Scroll Lock keys are 

the toggle keys. Each toggle key has its own LED indicator on the keyboard. 

FUNCTIONS OF SOME IMPORTANT KEYS 

The followingtable depicts the functions of some important keys on the keyboard. 

Key/Symbol Explanation 

  

It looks like a four-pane window. It opens the Start menu. 

It looks like a cursor pointing to a menu. It performs the functions, such as right-click to open 

shortcut menus, etc. 

It is used to interrupt or cancel the current process. 

It is used to give five blank spaces, by default. 

It is used to give a space to separate words. It is the longest key on the keyboard. 

It used for removing text on the left side of the cursor. 

Delete key is used for deleting text on the right side of the cursor or deleting an object. 

It is used to send the cursor to the next line or to insert a new line. It is also used to complete a 
process. 

Windows 

 

Menu 

Esc 

Tab 

Spacebar 

Backspace 1—

Delete 

Enter f__i 

Print Screen It is used for taking a screenshot of your monitor display. 



Pause It is used to halt an ongoing process. 

Break It enables the user to halt the execution of a running process. 

Insert It is used to switch between overtype mode and overwrite mode. 

Home It returns the cursor to the beginning of a line, document, page or screen. 

Page Up It helps to move one page which is currently viewed. 

Page Down It helps to move one page up or down from the page being currently viewed. 

End It moves the cursor to the end of the line, document, or screen. 

Arrow Keys They are used to move the cursor up, down, left, and right. 

Shift It is used as a keyboard shortcut key in combination with other keys. 

Ctrl It is used as a keyboard shortcut key in combination with other keys. 

Alt It is used as a keyboard shortcut key in combination with other keys. 

Num Lock It enables or disables the numeric keypad. 

Scroll Lock It enables the arrow keys to scroll the contents of a text window instead of moving the 

cursor. 

Caps Lock It is used to type in uppercase. 

HOME ROW KEYS 

The home row keys (also called as Home Keys) are the row of keys 

on the computer keyboard your fingers rest on when not typing. 

For example, on the standard QWERTY keyboard, the home row 

keys foryour left hand are A, S, D, and F and your right hand are J, 

K, I, and ; (semicolon). For both hands, the thumbs rest on the 

spacebar. By positioning your hands correctly on the home row 

keys, you can memorise where all other keys on the keyboard are 

located. 

GUIDE KEYS 

   

  

  

  

  

c,I 

N 
On a computer keyboard, keys F and i are called guide keys for left and right hands, respectively. Both contain a small 

raised tangible mark, with the help of which the touch typist can place the fingers correctly on the home keys. 

GUIDE FORTYPING 

The cursor is used as a guide for typing. It is a small vertical line that flickers in the document while typing. To move the 

position ofthe cursor, you can usethe respective arrow keys or click the mouse where the cursor needs to be positioned. 
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KEYS z ShVt V P4 N 

FINGERS IF RF ME IF IF IF IF ME RE IF 

LEFT HAND RIG HI HAND 

P0 ITIONING OF FINGERS ON THE KEYBOARD 

The'fingers of each hand should sit on four keys each. At rest, the fingers sit on the home row keys. Thumbs hover over the 

spacebar which can be hit with either hand, depending on the typist's preference. Each finger is responsible for a certain 

group of keys. 

Let us learn about the allocation of keys to fingers. The labelled diagram of the hand shows the names given to each finger 

of your hand. 

+ 

Nurpber Row 

UpPer 

Home Row 

Bottom Row 

1fl1a](  
JLJ  )[o )J[JJ 

i1!JJ 
JjJJ{j[J 

Middle Finger 

Index Finger (MF) 

(IF) 

Uttle Finger 
(LF) 

4— 

Ring Finger 
(RF) 

I cm J [1  j 
CI, J 1*] 

Thumb 

Left Hand Right Hand 

Allocation of keys to fingers on the Upper Row 

KEYS Q W E R I Y U I 0 P 
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LEFT HAND RIGHT HAND 

Allocation of keys to fingers on the Home Row 

S D F GH K I. 
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__  _J  '\__ _ 
LEFT HAND RIGHTHAND 

Allocation of keys to fingers on the Bottom Row  Allocation of keys to fingers on the Number Row 

$ S 7 8 9 0 

F F F ME RE IF 

LEFT HAND RIGHTHAND 

RNGERS  I.E 

KEYS 1 

RE 

2 

ME 

3 4 

F 

TYPING AND DELETING TEXT 

For typing text in a document 

+ Place the cursorwhere you wantto type. 

Press the letters on the keyboard accordingto the textto betyped. 

+ Use the Spacebar keyto separate the words. 

For deleting text in a document 

If you make a mistake while typing, there is a wayto rectify iteasily.To delete a letter: 

Place the cursorjust after the letter. 
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+ Press the Backspace key once. 

+ Alternatively, place the cursor just before the letter and press the Delete key. 

+ For deleting a word orsentence, select the text and press the Delete or Backspace key. 

TYPING CAPITAL LETTERS 

To type in capital letters or uppercase, switch ON the Caps Lock key before typing the text. Switch it OFF to type in small 

letters or lowercase. One can also press the Shift key and simultaneously press the alphabet key which you want to type in 

uppercase. 

TYPING NUMBERS 

Numbers are typed using the Number keys present above the Alphabet keys on the keyboard. One can also use the 

Numeric Keypad to type numbers. Switch ON the Num Lock key and use the Numeric Keypad to type numbers. When the 

Num Lock key is switched OFF, the Numeric Keypad works forthe alternate actions presenton it. 

TYPING SYMBOLS /PUNCTUATION MARKS /SPECIAL CHARACTERS 

Press and hold the Shift key and then press the key with the required symbol. For example, press the Shift+ Number 8 key, 

to type an asterisk (*). 

TYPING SENTENCES! PARAGRAPHS 

+ Use the Spacebar key to insert space between two words. 

+ Press Enter key to begin the next paragraph, create new lines, and add space between paragraphs. 

RULES TO LEARN TYPING 

Use All Fingers: While learning touch typing, try to use all the ten fingers of both hands and be sure to use the thumbs for 

the spacebar key. 

Proper Positioning: Placing fingers on the correct keys is the key feature of a good typist. Keep your hands, and fingers 

close to the base position. This improves typing speed and reduces stress on the hands and also helps you to maintain 

correct posture and avoid health issues. 

Typing Exercise or Practice:Typing skills can be improved by typing the exercises provided within the software regularly. 

Practice of typing will not only increase the speed, but also improve accuracy. 

Proper Posture: While typing, it is important for the user to maintain the correct posture as the ideal typing posture 

minimizes both static and dynamic muscle loads. Correct position of the body helps to make you avoid health 

complications. The few points mentioned below can help the user to maintain correct posture while typing: 

+ Always remember to keep your back straight. 

4 Keep your elbows bent at the right angle. 

+ Face the screen with your head slightly tilted forward. 

4  There should be at least 20-30 inches of distance between your eyes and the screen. In other words, your 

outstretched arm should barely touch the screen. 

+ The optimum height ofthetabletop or under-desk keyboard drawer is 28to 30 inchesfrom the floor. 

+ The chair and table height should be chosen so as to expose the shoulder, arm, and wrist muscles to the least possible 

strain. The wrists can touch the tabletop in front of the keyboard. Never shift even a portion of your body weight to 

the wrists by resting on them. 
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Fig. 2.1:  Proper Posture Fig. 2.2:  Wrong Posture 

  

II  POINTING DEVICES 

A pointing device is an input device used to point at an object on the computer screen. You can point, select, open, and 

even drag an item on the screen. The pointing devices are also used to draw and play games on the computer. 

The commonly used pointing devices are mouse, trackball, joystick, light pen, touchpad, touchscreen, etc. Among these 

devices, the mouse is the most popular pointing device. 

MOUSE 

Mouse is the most commonly used input and pointing device that lets you select and move items on the screen. It usually 

has two buttons and a scroll wheel. A single-click of the left mouse button is used 

to select an object while double-clicking on an icon opens the application. The 

right-click often displays a Context menu that contains list of commands. You 

can also access 'Property' setting and various other options with the right-

click. 

You can easily move an item from one location to another by using drag and drop 

action of the mouse. Mouse is also used in drawing programs to draw free-hand 

lines, circles, boxes, and other images.
Fig. 2.3:  Mouse Buttons 

The movement of the cursor on the screen is controlled by the movement of the mouse on the mouse pad. These days, 

the mouse comes with a scroll wheel on the top to easily scroll up and down. 

By default, the mouse is conFig.d to work using the right hand. A left-handed person can change the settings of the 

mouse accordingly. 

MOUSE POINTER 

The mouse pointer allows pointing on the screen; it appears as you move it around the screen. 

TYPES OF MOUSE 

The mouse is of three types: 

+ Mechanical Mouse:The mechanical mouse has a rolling rubber ball under the case of the 

mouse. The movement of the pointer is controlled by the ball. 

+ Opto-mechanical Mouse:  It works similarto a mechanical mouse, but uses optical sensors to 

detect motion of the ball. 

+ Optical Mouse:  The optical mouse uses laser to control the movement of the pointer. It does not have a ball. You can 

see the light by tilting the mouse. 
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Lets Know More 

Wireless mouse 

It is not physically attached 
to a computer. It uses 

infrared or radio waves to 
communicate with the 
computer. A wireless 

mouse is more expensive 
than other types of 

mouse. 



Answer the Following Questions: 

1. What are Home Row keys? 

2. Why is it important to maintain a proper posture while working on a computer? 

3. What is a pointing device? What is it used for? 

4. What is the difference between a mechanical mouse and an optical mouse? 

     

     

 

For Better Concept Clarity 

 

     

Type the following as instructed. 

     

Sad deed wed deer red reed read feed café seed see zed wax car race 

vase sac dew faq cage rage age face safe sage case was tea tag gate 

cat ease zee sea fee gas rave eave 

the be to of and a in that have lit for not on 
with lie as you do at this but his by from they 
we say her she or an will my one all would 
there their what so up out if about who 

Using your left hand: 

Using your right hand: 

Using both your hands: Nil lop mnk ujojhp lopk Ijuop mink ulphn I;pojkl; 

COMMON MOUSE ACTIONS 

+ Click or left-click:  It is used to select an item. Place the mouse pointer on the item to be selected, then press the left 

mouse button once with your index finger. The desired item gets selected. 

Double-click: It is used to start a program, open a file, or trigger an action. You have to click the left mouse button 

twice quickly. 

Right-click: It is used to display the Context menu or properties. Move the mouse pointer to the desired position and 

press the right button of the mouse. The Context menu will open. 

Drag and Drop: It allows you to select and move an item from one location to another. Position the mouse on an 

object, hold down the left mouse button of the mouse, and drag the object to the position where you want to place it 

and release the button. You can see the item at a new location. 

Scroll: You can use the scroll wheel on the mouse to move the page up or down instead of using the Page Up and Page 

Down keys or the Arrow keys. 

Selecting/Blocking: Blocking is another way of selecting text. It is used to select text that needs to be edited or 

formatted. Click at the beginning of the word or sentence and hold down the left mouse button and drag along the 

text. The text will be highlighted. Atthe end of the text release the button. 

ASSESSMENT TIME 
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UNIT -  H:  Data Entry and Keyboarding Skills  

CHAPTER  

Getting Started with Typing Software 

With the advent of a computer in education, it has become utmost important for students to learn and master the typing 

skills. Typing involves the use of correct finger placement to build speed for optimal typing accuracy. So, it is 

recommended that all students begin to learn correct placement of fingers on the keyboard as soon as they begin to use 

the computer. This helps them to master typing skills. When students develop typing proficiency, it helps them to 

improve their writing skills. 

II  TOUCH 1YPIN( 

You have already learnt about touch typing in the previous chapter. Touch typing is a method of typing without the use of 

the sense of sight, or simply by feeling the keyboard. However, the sense of touch is a little involved since this typing 

method utilizes muscle memory through rigorous training. This way, a user can type spontaneously by placing his or her 

hands on the keyboard and does not have to look at any of the keys. 

BENEFITS OF TOUCH TYPING 

Touch typing is a wonderful technique which provides a variety of customized exercises that help you to improve your 

professional keyboard skills in a step-by-step way. Some of them are listed below: 

speed: One of the most attractive reasons to learn the touch typing skill is the significant increase in speed and efficiency. 

Touch typing is certain to offer the most productive method for working on the wide-ranging data-entry projects. 

Accuracy: The second most important benefit of learning touch typing comes with typing correctly and with accuracy. If 

you are typing with good speed but are not typing accurately, no one would understand whatyou are trying to convey. 

Time: Another benefit of touch typing is accomplishing the work within a given time frame. The more the typing speed is, 

the less will be the time taken to type and accomplish the task. 

Focus: When you type with two fingers, the focus gets diverted between finding the keys on the keyboard and the work 

you are doing on the computer system. Learning touch typing allows you to focus on one thing instead of two and thus 

increases the productivity. 

REQUIREMENTOF TOUCHTYPING 

To achieve maximum benefitfrom touch typing, you are required to install thefollowing: 

Hfrdware: A computer system with physical keyboard, mouse, and speakers. 

Operating System Software: Windows XP, Windows 7, Windows 8, or Windows 10. 

Application Software: RapidTyping Software 5.2. 



tI  RAPIDTYPINGSOFTWARE 

RapidTyping Tutor is designed to teach adults and kids to use their computer keyboard more efficiently than ever, It 

basically helps them to learn the typing skills and checktheirtyping speed progress. 

With its quick training sessions along with tailor-made exercises, RapidTyping helps the user to sharpen up his skills and 

overcome his problem areas in a short time with persistent efforts. 

RapidTyping provides various courses according to the difficulty level, which are: 

S. No. Course Description 

5. Advanced 

The Introduction course covers all characterstyped on your keyboard. 

Beginner course helps the user to learn the position of the keys on the 

keyboard. After completing this course, you will know which finger to use 

to hit each key without looking at the keyboard. The course covers usage of 

the uppercase letters, special symbols and Numeric Pad. 

The Experienced course will help the user to improve the typing speed by 

memorizing the frequently used syllables and words. 

The Advanced course helps the userstoimprovetheirtyping skills acquired 

by typing an actual text. 

1. Introduction 

2. Beginner 

3. Experienced 

This course helps the user to measure his current typing speed and 

5. Testing accuracy with advanced typing tests. One can even take a printout of his 

typing skills report. 

II  STARTING RAPIDTYPING SOFTWARE 

Once you have downloaded the software, you can open the RapidTyping software by performingthe following steps: 

Windows 7 Windows 10 

+ ClickontheStartbutton. 

+ Select All Programs. 

Choose RapidTyping5. 

A submenu will appear. Select the RapidTyping 5 

option. 

Click on the Start button. 

Type RapidTyping in the Search bar and press the 

Enter key. 

Select Rapidlyping 5 and press Enter to launch it. 

The RapidTyping software opens on the desktop screen. 

II  GETTING FAMILIAR WITH RAPIDTYPING INTERFACE 

The main window of Rapidlyping consists of the following components: 
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EN 1. Introduction - IBMics-Lessoni 00:19 

Status Bar 

Current Course 

Select Course 

j dkfj dk 

Put your flnger In the base position: F J. Start by pressing any key Speaker 
Volume 

S  $ 'a a I - 
2 3 4 5 6 7 8; 0 .9 - 

0 W 6 N I V U 0 P 

Virtual 

Keyboard 

Student Statistics]  I  Lesson  Edrj  Select Lesson 
Th!__  

Loptions  
'Minimize, Maximize' 

and Ciose Buttons Current Lesson Time 

Toolbar Commands Description 

The three buttons — Current Lesson, Student Statistics, and Lesson 

present on the top-left corner, help you switch between three program 

modes.To check the current lesson, click on the Current Lesson button. To 

check the statistics of the student's typing skills, click on the Student 

Statistics and to edit the lesson settings, click on the Lesson editor. 

The Option button is present on the top-right corner of the Title bar, 

which helps the user to change settings such as language, background, 

and text colour, themes, sound, font, help, update, and logout of the 

RapidTyping software. 

The three control buttons, present on the extreme right corner of the 

RapidTypingwindoware: Minimize, Maximize, and Close. 

Title Bar 

Program Modes, 

Option button, and 

three control buttons 

The Toolbar helps the user to select the current course options like 

Introduction, Beginner, Experienced, Advance, orTesting Modes. 

Lesson control section includes several controls to pause/resume the 

Current lesson, go back to the beginning and check the current speed, 

accuracy, remaining time, elapsed lesson time in realtime. 

Tool bar 
Current Course, Current 

Lesson Control 

The Text Area is a place where the text that is to be typed by the user, is 

displayed. 
Text Area 

Tex 

Fig 3.1:  interface of RapidTyping Software 

Let us discuss some of the components in detail. 
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You can also install the Lesson control tool on a local server in a classroom so that it can be easily run on each 

workstation via network. 

The Status Bar present in the bottom of the Text Area provides 

tips/instructionsforthe userto followwhiletyping. 

The Progress bar contains the Lesson Length and Metronome to help the 

user to know about the lesson details. 

The Volume control is used to increase or decrease the sound of the 

keyboard keys pressed by the user. 

RapidTyping includes a virtual keyboard that helps the user to learn 

touch typing with all ten fingers and prompts which keys are to be 

pressed while you are making yourwaythrough the typing lessons. 

Status Bar 
Tips, Progress bar, and 

Volume control 

Virtual 

Keyboard 

+ 

C $ % & 'TH ) - 
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7 

4 

2 

9 

6 

USING THE RAPIDTYPING APPLICATION 

Once you have successfully configured the required settings in RapidTyping software, the main window of the program 

appears. 

To start practising on the Rapidlyping software, followthe steps as provided below: 

To start your first lesson, click on the Current lesson tab. You can select the course and lesson on the Toolbar. 

There are two drop-down lists on the left side. 

II ;ii h Swa,aj .  R3pitypg !' 2 _Qx 

EN 1. Introduction 1, Basics- tesson 1 • 0037 • 

• EN 1. Introduction 

EN 2. Beginner 

EN 3. Experienced 

EN 4. Advanced 

EN 5. Testing 

Add mOre courses... 

      

( 
Select the course 

  

      

   

f j dkfj dkfj 

    

    

Put your fingers in the base position: F J . Start by pressirng any key 

Choosing Course 
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Select the Lesson 
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Fig 3.3:  ChoosIng Lesson 
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Placing fingers on keyboard 

.4 .1= • a. 

Virtual Keyboard 

IJi7i. iI 

Text area 
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-4 

Reflects the acceptable tIme 
for typing a single character 

Fig 3.5: lime and Pause Option on the Toolbar Fig 3.6: Progress Bar 
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Lets Know More 

QWERTY 

Qwerty is the most 

commonly used computer 

keyboard. It was designed 

by Sholes and Glidden and 

sold to Remington in 

1873. Its layout was based 

on the typewriter. 

DVORAK 

The Dvorak keyboard, 

named after its inventor, 

Dr. August Dvorak, was 

designed with the goal of 

maximizing typing 

efficiency. It had a unique 

layout that required less 

finger motion. This helped 

in reducing errors 

compared to the Qwerty 

Keyboard. 

Know the Fact 

WPM stands for Words Per 
Minute, which is the 

number of words that you 
can type in 1 minute. 

Computer ergonomics is 

the science of refining the 
design of products to 

optimise the workspace 

"fit" between each worker 
and his or her work 

environment. This helps in 

increasing performance 
and reducing the risk of 

strain injuries. 

Choose the lesson you would like to work on. 

Lessons are categorised by the types. For example, Introduction and Beginner courses 

have: Basics, Shift keys, Digits keys, and Numeric pad sections. 

To begin with, firstselect the course, Introduction and then select the lesson. 

Fig 3.4: Placing Fingers on Virtual Keyboard 

While you are typing, the Current lesson time buttonj on the toolbar displays the 

current lesson time. If you would like to stop the typing in between you can press the 

Pause the lesson button ii present on the toolbar. You can choose to restart the lesson 

again either by pressing the F8 key orthe Restart the lesson button a-' from the toolbar. 

+ The Status bar will show you the instructions along with the two progress bars. The green 

progress bar displays the percentage of the completion forthe current lesson and yellow 

progress bar reflects the acceptable time fortyping a single character. 

+ 

+ 

+ Place your fingers on 

the virtual keyboard as 

shown in the figure and 

start typing. Now, type 

the text or alphabet 

which are displayed on 

the Text Area of the 

RapidTyping Software 

window from the 

keyboard. 
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In Terms of Typing Speed Example 

Gross Speed Net Speed Supposition Gross Speed Net Speed 

Words WPM = (Words without Net WPM = WPM — A person typed 50 Gross Speed = 50/2 Net Speed = 25 - 

errors + Words with (words with errors words per 2 mins. (6/2) 

errors) / Time spent in / Time spent in with errors in 6 =>25 wpm 

minutes minutes) words. => 22 wpm 

Characters CPM = (Characters 

without errors + 

Characters with errors) / 

Time spent in minutes 

Net CPM = CPM — 

(characters with 

errors / Time spent 

in minutes) 

A person typed 250 

characters per 2 

mins. with errors in 

30 characters. 

 

Gross Speed = 250/2 Net Speed = 125 - 

(3 0/2) 

=> 110 cpm 

 

=>125 cpm 

Keystrokes KPM = (Keystrokes 

without errors + 

Keystrokes with errors) / 

Time spent in minutes 

Net KPM = KPM — 

(keystrokes with 

errors / Time spent 

in minutes) 

A person typed 200 

keystrokes per 2 

mins. with errors in =>100 kpm 

40 keystrokes. 

Gross Speed = 200/2 Net Speed = 100 - 

(40/2) 

=> 80 kpm 

Once, you have completed the lesson, the result window will appearto analyze and displayyour progress report. 

tflMtn9  icy 

          

Sp.d% W?IY 

0 

 

          

         

0 

         

            

             

Cc = ,. ,*t - 

          

1 

            

Fig 3.7:  Interpreting the Result 

TYPING MEASUREMENTS OF SPEED RATES 

CPM : Characters Per Minute cPS Characters Per Second 

WPM WordsPerMinute wPS Words Per Second 

KPM : KeystrokesPerMinute KPS Keystrokes Per Second 

II  TYPING SPEED 

The typing speed of an operator is calculated in the form of Gross Speed and Net Speed. 

Gross, or Raw speed is a calculation of exactly how fast you type with no error penalties. The Gross typing speed is 

calculated by taking all words typed and dividing it bythe time it tookto type the words. 

Net speed is a calculation of exactly how fast you can type error-free. It is arguably the most useful tool in gauging 

typing abilities. Since errors play a part in its calculation, it is more a measure of typing productivitythan ofjust typing 

speed. 

Typing speed can be calculated in three ways, by counting 

1. Words Per Minute (WPM) 

2. CharactersPerMinute(CPM) 

3. KeystrokesPerMinute(KPM) 

The following table lists the variousformulas to calculate theTyping Speed with example: 
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Error % = (words with errors * A person typed 50 words per 2 Error = (6 * 100)/SO 
100%)/Total number of words mins. with errors in 6 words. 

=> 12% 

Words 

TYPING ACCURACY 

Accuracy in typing means that you type the words accurately and correctly. Typing accuracy is defined as the percentage 

of correct entries out of the total entries typed. So, if you typed 90 out of 100 characters correctly, you typed with 90% 

acciiracy. 

Thefollowing table liststhe various formulas to calculate theTyping Accuracy percentage with example: 

In Terms of 

Words 

Characters 

Keystrokes 

Example Typing Accuracy 

Accuracy % = 100% - ((words with 
errors x 100%)/Total number of 
words) 

Accuracy % = 100% - ((characters 
with errors * 100%)/Total number 
of characters) 

Accuracy % = 100% - ((keystrokes 
with errors * 100%)/Total number 
of keystrokes) 

Supposition 

A person typed 50 words per 2 
mins. with errors in 6 words. 

A person typed 250 characters per 
2 mins. with errors in 30 
characters. 

A person typed 200 keystrokes per 
2 mins. with errors in 40 
keystrokes. 

Net Speed 

Accuracy = 100 - ((6 * 100)/SO) 

=> 88% 

Accuracy = 100 - ((30 * 100)/250) 

=> 88% 

Accuracy = 100- ((40 * 100)/200) 

=> 80% 

TYPING ERROR 

Errr in typing means that you type the words incorrectly. Typing inaccuracy is the percentage of wrong entries out of the 

totl entries typed. So, if you typed 10 out of 100 characters incorrectly, you typed with 10% inaccuracy. 

The followingtable liststhe various formulas to calculate the Typing Error percentage with example: 

n Terms of Typing Error 

Supposition 

Example 

Net Speed 

Characters Error % = (characters with errors * 
100%)/Total number of characters 

  

A person typed 250 characters per 
2 mins. with errors in 30 
characters. 

  

Error (30 * 100)/250 

=>12% 

Error = (40 * 100)/200 

=> 20% 

     

      

Keystrokes Error % = (keystrokes with errors * 
100%)/Total number of keystrokes 

 

A person typed 200 keystrokes per 
2 mins. with errors in 40 

keystrokes. 

 

    

     

TYPING RHYTHM 

This methodology correlates the manner and rhythm in which an individual presses and releases keys on a keyboard. 

Fol a proper typing rhythm, the keystrokes should come at equal intervals. Slowdown indicator is used to control the 

constant typing rhythm. The following table lists the various formulas to calculate the Slowdown percentage: 
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Example 

In Terms of Slowdown Formula 

Supposition Slowdown 

Words 
Slowdown % = (words with delay * 
100%)/Total number of words 

A person typed 60 words per 2 mins. Slowdown = (12 * 100)/60 
with delay in 12 words. =>20% 

Characters 
Slowdown % = (characters with delay * 
100%)/Total number of characters 

A person typed 250 characters per 2 Slowdown (20 * 100)/250 
mins. with delay in 20 characters. =>8% 

Keystrokes 
Slowdown % = (keystrokes with delay * 
100%)/Tota I number of keystrokes 

A person typed 200 keystrokes per 2 Slowdown = (40 * 100)/200 
mins. with delay in 16 keystrokes. => 8% 

Keyboard Activity: As you progress through the typing lessons, you will learn the correct finger position 

forall keys. Look at the figure and place yourfingers in the same manner. 

red deer; teed freddie; i ie; free reed; rcd deer; 

[I 
eddie died; free ride; eddie fired  fred; did eddie die; 

edifier rider dude freed red fur deer; kidder eddie rudder fed red deer; 

Place your left hand 
over these keys 

4 3 2 1 

A 

Place your nght hand 
over these keys 

1 2 3 4 

I 

freed fed red deer died; fred  fuji  fried freed fed red deer;  

duke jeered rude referee jed; did irked kirk fire rude jerk; D F J 

2. Abhay was preparing his science lesson on Wordpad. He typed 120 words in 6 minutes and made mistakes 

in 6 words. Calculate the following for Abhay: 

a. Gross and Net typing speed. 

b. Accuracy percentage. 

C. Error percentage.
•1 

II  INTERPRE1ING THE RESULT 

Interpreting the result on the completion of a course is an important task as it helpsto know your overall performance. 

Each time you complete a lesson, the Results window displays your achievements. 

The Results window is divided into two parts: Rating Pane and Three tabs: Next step, Detailed statistics, and Errors 

overview. It tracksyour progress, and allows you to evaluate your own performance at anytime. 

The statistics shown in Figure reflect your typing speed, accuracy, and slowdown keystrokes, complete with a summary 

atthe end of each lesson. 
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Fig 3.8: Interpreting the Result 

NE
STE  P 

Bydlicking on the Next step tab, you can go to the next lesson if speed, accuracy, and time-out are performed well or start 

thecurrent lesson again to achieve a better score next time. 

Good 

lorod 11W 
0 

10% 
lOt - 

Next Step Tab It - 

FIg 3.9: Next Step Tab 

DETAILED STATISTICS 

The Detailed statistics screen shows the lesson statistics, which displays the details like typing speed, errors, and 

slowdown for each character/keystroke. In the text area, you can check the mistakes you made, in different colours. The 

colour indication isasfollows: 

The green dashed line, shown above depicts the good result. The bad result is depicted in red colour and yellow colour 

depicts the time frame which was exceeded by the user. The orange colour depicts the incorrect character and time for 

typing a character which has been exceeded by the user. 

Fig 3.10:  Displaying the Detailed Statistics 
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ERRORS OVERVIEW 

On clickingthethird tab, in the text area, you can checkthe errors that occurred during the lesson. 

Clicking on the Goon tab at the bottom of the window, transfers the control to the new lesson. 

Fig 3.11: Displaying the Errors Overview 

ANALYZE STU DENT STATISTICS IN RAPIDTYPI NG SOFTWARE 

This feature describes how to add students or student groups and previewtheir statistics. 

To open the Student statistics section, choose the Student statistics tab present on the top-left corner of the main 

window.The Student statistics screen will open. This window is compose he following controls: 

+ StudentsAccounts/Groups 

+ Statistics Panel/Session Statistics 

StudentAccount Windows: The Student accounts area consist of three part: 

+ StudentsToolbar:This area is for adding, removing, inserting (import) and, savingthe existing student accounts and 

groups and downloadingthe statistics of the student in a variety of formats, such as PDF, HTML, and CSV. 

+ Students  Accounts: It is the area forselecting the current student account orgroup. 

+ Property Panel: It is the area where you can edit a group or student properties of the selected items in the Navigation 

Tree. 

Statistics Panei:This area consists of the following parts: 

+ StatisticsToolbar:Statisticstoolbar has buttons forchoosingcourses, removingthe selected statistics, and 

customizing the statistics display options. 

+ Course Diagram/Statistics: It shows the common statistics for all lessons of the current course. 

+ Lesson Diagrams/Statistics: It shows the statistics for each character or keystroke of the selected lesson in the 

course diagram. 

+ Lesson Statistics Table: It showsthe full statistics of the selected lesson in the course diagram. 
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Fg 312:  Student Statistics Screen 
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II  BEGINING WITH A LESSON EDITOR 

Lesson Editor offers flexibility to the users to make all the lessons fully customized. You can add, insert, change, and 

delete lessons, group them in courses, and review the corresponding metrics. You can import an existing lesson from the 

RapidTyping software in Text and RTF (Rich Text Format) file format and export lessons in theTextformat. 

USI G THE LESSON EDITOR 0 - x 

To open Lesson Editor, click on the Lesson 
• SIMS b0 
S 0. 

editor tab  b  present in the top-left corner of 

the Main window. The screen will appear as 

1 

a . - 

• -- —(-I- 

shown in the picture. 
- •- .- - 

Use the command buttons to create, Add New • 

Course, Modify Existing Courses and Deleting a 

CoUrse/Lesson. 

INTERFACE OF THE LESSON EDITOR 
- _. 

[I 

Course and Lesson List Fq 3.13:  Lesson Editor Window 

Title bar: ltdisplaysthe Lesson Editor tab button along with the title and the control buttons. 

Toolbar: Itcontainscommandsforadding, removing, inserting, and savingthe existing Lessons and Courses. 

Navigation Tree: It shows a list of the current keyboard layout chosen, current course, section, and lesson. 

+ Properties: It is the area which lets you modify the course, section, and properties of the current lesson such as the 

Lesson name along with section. 

Editing Panel is the area where you can make changes in the existing course options or text of the selected lesson in the 

NavigationTree. For example, if you want to create a lesson forthe Numeric pad and change the lesson type in the Lesson 

type menu on the Toolbar. 

If a long text is inserted into the lesson from a file, you can split such a lesson into many smaller lessons using a Split 

lesson dialog box. 

Table Analysis text displays the number and percentage of words, characters, spaces, and specific characters in the 

lesson. 

Virtual Keyboard gives constant feedback, showing you which fingers and keys to press, to keep you from looking down 

at your hands while typing and highlightsthe characters used in the selected lesson. 

You can easily hide/show: 

' The Course and lesson list by pressing the Ctrl+K shortcut keys. 

- Properties by pressing the Ctrl+L shortcut keys. 

+ The Virtual keyboard by pressing the F9 shortcut key. 

CREATING A NEW LESSON PLAN 

To create a new lesson of your choice, use the following steps: 

Click on the Lesson menu option from RapidTypingToolbar. 
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Answer the Following Questions: 

1. Mention any two advantages of touch typing. 

2. Whatiscomputerergonomics? 

3. What is the difference between gross typing speed and net typing speed? 

4. Define typing accuracy with an example. 

I ACTIVITY ZONE 
Instructions: 

 

For Better Concept Clarity 

Click on the Lesson editor icon and choose the Course options from the Toolbar. 

Under Lesson editor Tab, select the Course Level (such as, Introduction, Beginners, etc.,) and then 

choose its sub category (Basic, Shift keys, etc.,) that you require. 

Let us say, we have selected the Shift keys course. Now, double-click on this sub category course and 

select the Lesson from its drop-down list. The selected lesson appears on the right pane. Now, make the 

required changes in it by inserting your choice of patterns/words/sentences. 

x Course options About course 

Create new course 

Add courses 

Sa'e selected courses. 

Fig 3.14: Creating a New Course 

Do you really want to remove the selected counts? 

Yes 

Fig 3.15: Remove the Selected Courses 

1 

Course goals 

 

 

Speed isnt leSs than 

Enors arent more than 

- Nowselectthe course level in which you wantto add a new lesson. 

- In the next step, you can either choose Create new lesson option from the Lesson menu or right-click on any course 

level and select the Create new lesson option from the pop up menu that appears. 

Now, give a suitable name and title in thegiven box. 

DELETING A LESSON 

+ The user can remove the lesson from the RapidTyping software by selecting it in the Navigation Tree and click on the 

Delete button X on the Toolbaror by simply pressingthe Delete keyon the keyboard. 

CREATING A NEW COURSE 

We can add and delete a course in Rapidlyping software through the 

followingsteps: 

Select the Lesson editor option present on Title bar or Press (Ctrl+3). 

Click on the Course menu button located on the Toolbar. A drop-

down menu will appear. 

- Now, select the Create new course option. You will notice that a new 

course has been added in the Navigation Tree. 

+ Type a name and title of your course and press Enter. 

To delete the newly created course, select the course and click on the 

delete X button. 

ASSESSMENT TIME 
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T Now, right-click on the selected lesson and choose the Save selected lessons option from the po 

menu. The Save As dialog box will appear. Specify the name and click on the Save button. 

Click on the Current Lesson tab on the Title 

bar. 

You will notice the same set of patterns on the 

RapidTyping screen, which you have saved in the 

selected lesson. 

+ At last click on the Student statistics tab to 

measure your overall performance, i.e., speed, 

accuracy, keystrokes, time spent, words typed, 

etc. 

Keyboard is the basic input device that has different sets of keys for letters, 

numbers, characters, and functions. OWERTY is the most commonly used keyboard. 

p-up 

+ A,S,D,andFforyourlefthand,andi,K,l,and;foryourrighthandareHomeRowkeys. 

4 'F' and i are called guide keysfor left and right hands. 

* Some commonly used pointing devices are mouse, trackball, joystick, light pen, touchpad, touchscreen, etc. 

+ Mouse isthe mostcommonly used inputand pointing devicethat lets you selectand move items on the screen. 

4 Touch Typing is a method of typing without looking atthe keys. 

Touch Typing software is usefulto increase the typingspeed and accuracy. 

+ Touch typing enables onetofocus on work and not ontyping. 

+ RapidTyping software is a keyboard trainer, used for improving the typing skills. 

+ The Introduction and the Beginners courses help to learn the proper position of keys on the keyboard. 

The Experienced course improves typing by making a user memorizethe commonly used words and syll ables. 

+ The usertypes an actualtext in the Advanced course in orderto improvetyping. 

+ Testing course is used to test the user's typing skills. 

+ The Title bar of the RapidTyping software contains Program modes, Option button, and Control buttons. 

+ Current course and current lesson controls are found on the toolbar. 

+ Text area is a place where the user can type the text. 

+ Tips, Progress bar, and Volume control is present on the Status bar. 

+ The virtual keyboard of the RapidTyping software supports alltypes of keyboards. 

+ Proper posture must be maintained while typing. 

+ The Detailed statistics screen shows the typing speed and errors. 

+ The green dashed line showsthe good result and the red line shows the bad result. 
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BRAIN DEVELOPER 

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

A. Multiple Choice Questions: 

1. Each  key has its own LED indicator on the keyboard. 

a.Toggle b. Function c. Combination d. Numeric 

2. One can easily move an item from one location to another by using  action. 

a.Double-click b. Click c. Drag and drop d. Right-click 

3. There should be at least  inches of distance between your eyes and the screen. 

a.5-10 b. 20-30 c. 0-5 d. 50-60 

4. While touch typing, make use of fingers. 

a.10 b.5 c.4 d.2 

5. While typing, keep your elbows at  

a. Left angle b. Right angle c. Straight d. Curved 

6. is not a part of the Title bar. 

a. Program Mode b. Option Button c. Control Buttons d. Tips 

7. The third level of the RapidTyping software is the  level. 

a. Experienced b. Beginner c. Advanced d. Testing 

8. While typing, the toolbar dIsplays  buttons. 

a. Reset b. Pause c. Continue d. Restart 

9. is the area where you can make changes in the existing course options or text of the selected 

lesson in the Navigation Tree. 

a. Properties b. Editing Panel c.TableAnalysisText d. None of these 

10. The Students statistics cannot be downloaded in the format. 

a.PDF b.CSV c.XML d.HTML 

11. Statistics toolbar has buttons for  

a. Choosing courses b  Removing statistics 

c. Customizing statistics displays d  All of these 

12. Commands for adding lessons are present in the  

a. Toolbar b. Navigation Panel c. Title Bar d. Text Panel 

13. Control buttons are present in the  

a. Navigation Panel b. Toolbar c. Text Panel d. Title Bar 

B Fill in the Blanks: 

1. is the longest key on the keyboard. 

2. F and 3 are called as  keys. 
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SECTION 2: THEORY QUESTIONS-(SOLVED) 

1 What is a pointing device? 

ins. A pointing device is an input device used to point at an object on the computer screen. You can point, select, 

open, and even drag an item on the screen. The pointing devices are also used to draw and play games on the 

computer. The commonly used pointing devices are mouse, trackball, joystick, light pen, touchpad, 

touchscreen, etc. 

Learning 
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Mouse, trackball, joystick, light pen, touchpad, touchscreen are various types of 

devices. 

4 The selected lessons can be edited in the  

5. The buttons can be used to create and add new courses. 

6. The bad result is depicted by the colour. 

7. The panels in the Lesson editor are text and  

8. The dashed lines colour in the Statistics screen is  

9. The Statistics panel has parts. 

10. The Status bar in the Rapidlyping software has progress bars. 

11. In RapidTyping software, once the lesson is completed, the window will appear. 

12. The course helps users to test the touch typing skills. 

13. RapidTyping includes a keyboard. 

C. StateTrueorFalse: 

1. Touch typing is a method of typing without the use of the sense of feel. 

2. Print Screen is used for taking a screenshot of your monitor display. 

3. The scroll wheel present on top of a mouse helps to easily scroll up and down. 

4 Typing speed by memorizing is improved in the Experienced course. 

5. The window which appears after the lesson completion in RapidTyping is called the Output window. 

6. While typing in RapidTyping lesson, the toolbar displays the accuracy also. 

7. The green progress bar displays completion of the current lesson in RapidTyping. 

8. The Students Toolbar is used to select the current student account or group. 

9. You can restart the lesson by using the F8 key. 

10. Only course diagrams and statistics are available in the Statistics panel. 

11. Deletion of the selected lessons option is available in the Navigation pane. 

12. In the Detailed statistics screen, the green dashed line shows a good result. 

13. The Title bar in the Rapidlyping software has three command buttons. 

A. Multiple Choice Questions 
1.(a) 2.(c) 3.(b) 4.(a) 5.(b) 6.(dl 7.(al 8.(b) 9.(bl 10(c) 11.(dl 12.(al 13.(d) 

B. Fill in the Blanks 
1.Spacebar 2.Guide 3.Pointing 4.lextPanel 5.command 6.Red 7.Navigation 8.Green 
9.Three 10.Two 11.Result 12.Teing 13.Virtual 

C. State True or False 

1.lF) 2.(T) 3.(T) 4.(T) 5.(F) 6.(T) 7.lrl 8.(Fl 9.(T) 1O.(F) 11.(T) 12.(T) 13.lT) 



2. What is the use of numeric keypad on your keyboard? 

Ans: Numeric Keypad resembles the display of a calculator. Switch ON the Num Lock key and use the Numeric 

Keypad to type numbers. When the Num Lock key is switched OFF, the Numeric Keypad works for the 
alternate actions present on it. 

3. What do you understand by the term Toggle keys? 

Ans: Toggle keys are used to turn computer features ON or OFF. The Caps Lock, Num Lock, and Scroll Lock keys 

are the toggle keys. Each toggle key has its own LED indicator on the keyboard. 

4. What is the use of the Option button of the Title bar of the Rapidlyping software? 

Ans: The Option button is present on the top-right corner of the Title bar which helps the user to change settings 

such as language, background, and text colour, themes, sound, font, help, update, and logout of the 
RapidTyping software. 

5. What does theyellowcolourdepict in the Detailed statistics screen? 

Ans: Yellow colour depicts the time frame which was exceeded by the user. 

6. What are the current courses that the toolbar helps you to select in RapidTyping software? 

Ans: The Toolbar helps a user to select the current course like Introduction, Beginneç Experienced, Advance, or 
Testing Modes. 

7. What can be done in the text panel of the lesson editor? 

Ans: The Text Panel is an area where you can edit, modify, insert, and delete the selected lesson. 

8. What are the 3 parts of the Students account window? 

Ans: The3partsare: 

a. Students Toolbar 

b. Students Account 

c. Property Pane 

9. What information is displayed in the Table Analysis? 

Ans: This displays the number and percentage of words, characters, spaces, and specific characters that appear. 

10. What does the yellow progress bar in the RapidTyping software display? 

Ans: The yellow progress bar reflects the acceptable time fortyping a single character. 

11. What information is shown by the lesson diagram/statistics? 

Ans: It shows the statistics for each character or keystroke of the selected lesson in the course diagram. 

12. What is the purpose of the volume control in the status bar of RapidTyping software? 

Ans: The volume control is to increase and decrease the sound of the keyboard keys pressed by the user. 

13. What is the use of the virtual keyboard in the RapidTyping software? 

Ans: Virtual Keyboard helps a user to learn touch typing with all the ten fingers by maintaining the current position 

of the fingers. The virtual keyboard of RapidTyping software supports all types of keyboards. 

SECTION 3: APPLICATION BASED QUESTIONS-(SOLVED) 

1. You want to import a lesson from another file. In what formats can you send the imported lessons from the 
RapidTyping software? 

2. A person wants to try the RapidTyping software. Which level will you recommend? 

3. In what forms can you send the student statistics to an examiner or evaluator? 

4. You want the admin to edit group or student properties. Where will you suggest him to go? 

5. A new user wants to delete a lesson using the Lesson Editor. Where should he go? 
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6. Ashish needs to prepare an article on Indian History. He typed 150 words per 5 minutes with errors in 10 

words. Find the Gross speed, Net speed, and Accuracy percentage of his typing. 

- -, .1 YYAL. 

   

4. Propertypanel 5.ToolBarofthe LessonEditor 1. RTF and PDF 2. First level - Introduction 

6. GS: 30wpm, NS: 28wpm, Accuracy: 93.3% 

3. PDF, HTML, and CSV 

 

   

SECTION 4: APPLICATION BASED QUESTIONS-(UNSOLVED) 

1. A supervisor wants to train new data entry operators. Which tool or software will you suggest? 

2. An examiner wants to know the level of typing of students. Help him to judge and give grades. 

While analysing your results in Touch Typing, how will you identify the following speed rates — WPM, CPM, 

KPM, WPS, CPS, KPS? 

4. You want to start a new course for your RapidTyping Software class. What steps will you take? 

5. Students have taken the advanced course in the RapidTyping Software. What should they do to test their 

skills? 

6. While helping his father in preparing a report, Swaraj typed 80 words per 4 minutes with errors in 12 words. 

Find the Gross speed, Net speed, and Accuracy percentage of his typing. 

SECTION 5: SHORT ANSWER TYPE QUESTIONS-(UNSOLVED) 

1. What are Home Row keys? 

2. Which keys are used for deleting the text? How are they used? 

3j Write any four common mouse actions. 

4. What do you understand by combination keys? 

5. Mention any two points that can help the user to maintain correct posture while typing. 

6. What is the formula to calculate typing error percentage? 

7. Name an easy to use keyboard trainer. 

What are the Operating Systems which support RapidTyping software? 

9 When does a New Lesson dialog box open? 

ib What information is shown in the Lesson statistics table? 

SECTION 6: LONG ANSWER TYPE QUESTIONS-(UNSOLVED) 

1. What do you understand by typing accuracy? Explain with example. 

2. What is the difference between gross speed and net speed of typing? Explain with example. 

3. What is the importance of typing rhythm? 

4. What does the Detailed Statistics screen display? 

5. What is touch typing? Mention its benefits. 

6. List all of the system requirements for installing touch typing software. 

7. What are the sequential steps involved in inserting a new lesson plan? 

8. Write a note on how to analyse student statistics in RapidTyping software. 

9. Describe all the courses available in RapidTyping software. 

10. Describe all the commands in the interface of the Lesson editor. 

3. 
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For Better Concept Clarity 

   

1. Divide the class into two groups. Ask one group to prepare a presentation on the RapidTyping software. 

The other should prepare a specific presentation on the Lesson editor. 

2. Ask the students to teach the RapidTyping any person in their house, neighbourhood, or friend circle, 

and report his progress by sharing statistics. 

3. Ask students to discuss the functions of the Lesson editor. 

Type the first page of this chapter in Notepad (or any other text editor). Keep an account of the total 

number of words typed, total time taken (in minutes) to type and the total number of words that contain 

errors. Calculate the following on the basis of your data: 

Gross typing speed 

Net typing speed 

Accuracy percentage 

Error percentage 

Divide the class into four groups. Compare the accuracy and error percentage among the students of each 

group. 
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Know the Fact 

In the beginning, 

WordStar was the most 

widely used word 

processing software. 

Know the Fact 

LibreOffice is a Free and 

Open Source Software 

(FOSS). Nowadays, many 

versions of LibreOffice are 

available such as 

LibreOffice 6.0 and above 

than it. You can easily 

download the LibreOffice 

from the website, 

w.w.libreoffic.org  

Ease and Speed 

Editing Features 

Formatting Features 

Storage Features 

UNIT - III:  Digital Documentation

CHAPTER 4 
Getting Started with a Word Processor Application 

II  INTRODUCTION TO WORD PROCESSING 

Knowledge is Power. All of us gain knowledge by reading newspapers, books, novels, blogs, 

mails, and imbibing new information every day. Have you ever thought how such a huge 

content on various topics is created and updated, minute by minute across the world? The 

answer is writing. Many people across the globe have a passion for writing. Generally, we 

use pen and paper to write something. But what will you do if you need to write a document 

of more than one page? 

Earlier people were used typewriters for typing documents. However, now trend has been 

changed. People use different word processing applications on computers to create, edit, 

format the documents, and share the created documents using the Internet on different 

platforms. 

A document refers to a set of written pages. The process of creating a document is called 

documentation. A document can be created by using pen or paper, typewriters, or word 

processors. We create documents to keep them for future use or to use them as evidence. 

Documents can be letters, reports, manuscripts, books, etc. 

We face certain issues with a handwritten document. For example, it might be difficult to 

understand specific handwriting, or sometimes it does not look too appealing, so reading 

the document becomes a boring task. With the advancement in computer hardware and 

software technology, the process of handwritten documentation consequently automated 

to computer word processing. Word processing is the use of computer software (a word 

processor) to enter, edit, format, store, retrieve, and print the document. Every single piece 

ofnformation is touched by a word processor directly or indirectly. 

IMPORTANT FEATURES OF A WORD PROCESSOR 

A word processor has overcome all the limitations of a typewriter, thus leading to the ultimate extinction of the latter. Let 

us know about the various features of a word processor: 

A word processor provides an easier and faster method to type the text. 

Using a word processor, you can applythe editing features like copying, moving, and deleting 

text. You can overwrite or insert a sentence, paragraph or word. Page numbers, headers, 

and footers can also be inserted. Tabular data can also be presented in documents. 

It provides various formatting feature for text, such as Bold, Italics, Underline, Font Name, 

FontColor,WordArt, etc. 

It stores all your documents forfuture use, which can be retrieved whenever you want. 
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You can add pictures, drawings, and charts, etc., to your documents. This enhances the 

overall presentation of a document. 

You can easily take printouts of your documents. Most word processors have the feature 

of WYSIWYG (What You See Is What You Get), i.e., a document on your screen will look 

exactly similar to its printed version. 

A word processor helps in keeping your document error free as it has a spell check feature, 

which not only corrects the misspelt words but also suggests the possible synonyms. It is 

also capable of rectifying grammatical errors. 

This feature allows you to send a piece of text to multiple addresses. For example, if you 

want to send your birthday invitation to 100 friends, the Mail Merge feature will keep the 

same invitation text for all, and will change only the names and addresses of invited guests. 

Hence, this feature saves a lot of time and effort. 

The Object Linking and Embedding feature allows a word processor to interact with other 

programs by embedding objects in a document. For example, if you have linked an equation 

written in the spreadsheet software to some charts in a word processor, and if you change the 

equation values, the charts will change automatically because an object of the same 

equation is present with the word processor also. 

Graphic Features 

Printing Features 

Vocabulary and 

Spell Check Feature 

L 
Mail Merge Feature 

OLE Feature 

• WORD PROCESSING APPLICATIONS 

A word processor is application software, which is capable of creating, editing, saving, and printing documents. Notepad 

and WordPad are basic word processors, and known as text editors. These are used to create and edit plain text. 

Whereas, while using Word and Writer, you can make changes in text styles, insert decorative text, and insert graphic 

objects as well. The following are some popular word processing applications: 

MS-Word: Desktop utility 

Notepad and WordPad: Desktop utilities 

OpenOffice: Desktop utility 

LibreOffice Writer: Desktop utility 

Google Docs: Internet based utility 

INIRODUCTION TO LIBREOFFICE WRITER 

LibreOffice Writer is the word processorapplication of the LibreOffice Suite. Writer has the power and flexibilityto: 

Produce letters, reports, notices, newsletters, etc. quickly and in a presentable manner 

Modify the text, both while typing and after typing. Beautify the text using colours, styles, fonts, borders, shadings, 

and various other effects 

Insert graphics and make use of various drawing tools to draw pictures. Copy and move the text from one location to 

another 

Previewthetext before printing it, and take multiple printouts 

Integrate with objects from other files and applications 
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Computers with  KIPS  <7) 



-, . 4...' 7 '- i: 

. ASJ L1' 

P.S.: .4: I - i + :p.. 

Document Area 

!. -' 1,,,S.1 S,P,.t $:1.. Tbi Fo. 1o:, I 

4iions F1uF] B I U x2 x  AA 

StdrTdai TUOtU... 
[rmattlng Toolbar 

Ruler  

[View Buttons  I L  Zoom Slider  

- J oor  I 4  .4- 1C. I .41 . S 0 .54,.d. D.1,,0 SII. 
Status Bar 

Verticall 
Scroilbar 

I!I  STARTiNG LIBREOFFICE WRITER 

You can open LibreOffice Writer on your computer using any of the following ways: 

f Open the Start menu on your computer and select the LibreOff ice 6.2> LibreOff ice Writer from the Programs list. Or 

+ Type Writer or LibreOffice Writer in the Search bar, and press the Enter key. Or 

+ Double-click on the LibreOffice Writer shortcut icon, if it is available on the desktop. Or 

+ Open the LibreOff ice suite using the Start menu or Search bar. The LibreOffice suite window appears. Select Writer 

Document under Create. 

The LibreOffice Writer window appears with a blank document. 

Fig. 4.1: LibreOffice Writer Window 

• II  PARTS OF LIBREOFFICE WRITER 

The Writer application opens a blank document with the temporary name Untitled 1. It displays a vertical blinking line, 

called cursor at the top-left side of the Document Area. The larger window is called the Application window and the 

smaller window, which is inside the application window, is called the Document window. The Application window helps 

theuserto communicate with the LibreOffice Writer program. The Document window is used for typing, editing, and 

fornatting the text. The LibreOffice Writer window has various components as shown: 

            

 

[Titie Bar  

         

          

 

i Minimize Button 

  

Qose Button 
Menu Bar 

           

           

+ 

Fig. 4.2: Components of LibreOffice Writer Window 

Sldebar 
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Title Bar 
The Title bar appears on the top of the screen. It displays the name of the current document and 

application. On the extreme right, you willfind Minimize, Maximize, and Close buttons. 

Menu Bar 

This bar contains all the menu options present in the Writer application. The drop-down menus allow the 

user to interact with the Writer application in various ways. To open a menu, click on the menu name or 

press the Alt key and the menu-specific hotkey (which appears as an underlined letter in the menu). When 

you select a menu, a submenu appears. Some submenu items show right hand side arrow next to the 

submenu name, which indicatesthatthere is anothersubmenu. 

Standard 

Toolbar 

This bar is present below the Menu bar. It displays the icons of the commonly used commands. By default, 

Save, Undo, Redo, New, Open, Cut, Copy, Paste, etc., icons appearon the Standard toolbar. 

Formatting 

Toolbar 

It is present below the Standard toolbar. It contains the commonly used commands to format and beautify 

the text. It displays Font Name, Font Size, Font Color, Alignment icons, Bullets and Numbering icons, 
. 

Indents and Highlighting icons on it. 

Rulers 

Rulers are present on both top and left side of the document. The horizontal ruler measures the width of 

the document page. It displays margin settings, tab settings and indentation. The vertical ruler allows 

you to format the vertical alignment of text. The numbers present on vertical ruler indicate the 

position of text on that page. 

Document Area It is thelargeareawhereyou can type, edit, and formatthe text. 

Scrolibars 

There are vertical and horizontal scrollbars on the right side and bottom of the Writer window, 

respectively. You can move the screen display towards up and down with the help of vertical scrollbar, 

and shift it right or left using the horizontal scrollbar. 

Status Bar 

It displays the page number, number of words and characters, active working mode, current dictionary in 

use, a button to save the current document, view buttons, and zoom slider. It is located at the bottom of 

the document window. 

B View uttons 

LibreOffice Writer provides different views. Three views are available on the Status bar, such as Single-
page view, Multiple-page view and Book view, and other three views are available in the View menu, 

such as Normal, Web, and Full Screen.To change theview, select the menu and click on the required view 

option, or click on the required view available on the Status bar. 

Zoom Slider By moving slider handle in or out you can adjust the zoom percentage of the workspace displayed. 

Sidebar 

It contains six buttons — Sidebar Settings, Properties, Page, Animation, Master Slides, Styles, Gallery. 

and Navigator. These buttons enable you to make changes in settings of Sidebar, and allow you to format 

the document. 

II  CREATING A NEW DOCUMENT 

In Writer, you can create a new blank document in several ways. Ifa document is already open, the new document opens 

in a new window. The various ways to create a new document are discussed below: 

CREATINGADOCUMENTUSING LIBREOFFICESUITE WINDOW 

When you open LibreOffice Suite, it displays documents of different applications. Here, click on the Writer Document 

option under Create to open the Writer application with a new blank document. 
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The Normal view is the 

default view of LibreOffice 

Writer. The Web view 

shows how the document 

will look if viewed in a 

web browser. 

The Full Screen view is 

used to read or review a 

document. 

Fig. 4.3: Selecting Writer Document option in LibreOffice Suite window 

CREATING A DOCUMENT USING KEYBOARD, MENU BAR ORTOOLBAR 

When you are in LibreOffice Writer, you can also start a new Writer document in using any of 

these ways: 

PresstheCtrl+Nkeys. Or 

From the Menu bar choose File> New >Text Document. Or 

+ Click on the New icon on the Standard toolbar. 

CREATING A DOCUMENT USING A TEMPLATE 

A template is a set of predefined styles and settings that is used to create a new document. 

Templates enable the easy creation of multiple documents with the same default settings. 

For example, you write a few formal letters on the same template. As a result, all the letters 

look alike; they have the same headers and footers, use the same fonts, style, formatting, 

and so on. To createyourdocument using a template, do one ofthefollowing: 

Press the Ctrl+Shift+N keys to open the Template dialog box. Or 

Under the File menu, choose Templates> Manage or choose New> Templates. Or 

Fig. 4.4: Creating Document from a Template 

Click the arrow next to the 

New icon on the Standard 

toolbar and select Templates 

from the drop-down list. Or 

Choose Template from the 

LibreOffice main startup 

window. 

The Templates dialog box 

appears. Here, double-click 

the desired template to 

create a new document 

based on thattemptate. 

- - 

Let's Know More 

Toolbars are small 

graphical icons created for 

easier access to computer 

commands. They are 

typically located at the 

top of an application and 

can be customized to 

show the most used 

,
functions of the softwar 

Quick View 

Quick View 

To select the menus using 

keyboard, press Alt and 

the Hotkey (the 

underlined character) of 

the Menu name. 

H 

To view or hide a toolbar, 

click on the View 

>Toolbars and select the 

required toolbar 
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To create a document, right-click on the desktop and select the New> OpenDocumentText 

UII  SAVING A DOCUMENT 

You can save a document by using either the Save command or the 

Save As command. 

SAVING A NEW FILE ORA PREVIOUSLY SAVED FILE 

To save a file, do one of the following: 

+ Press Ctrl+S. Or 

+ Underthe File menu, choose Save. Or 

+ Click on the Save icon on the Standard toolbar. 

+ If the file is new, the Save As dialog appears. Enter the file name, 

verify the file type and location, and click on Save. The file will be 

saved with the extension .odt. 

+ If the file has already been saved then nothing else needs to be done. The file gets re-saved with the same name and 

settings. 

~ If you have done some changes in a saved file and want to save it with a new name, then click on the Save As option 

underthe File menu. Thiswill askyou to save the existingfile with a new name, and will keepthe originalfile as it is. 

SAVING A FILE TO A REMOTE SERVER 

If your document is already stored on a remote server or you want to store it on a remote server, then follow the steps 

mentioned below: 

+ Choose File>Saveto Remote Server. 

+ The Save As dialog appears, enter orverifythe name, type, and location of the file. 

+ ClickonSave. 

SAVING A COPY OF FILE 

If you want to keep the document open for more editing and also save a separate copy of the current version, then do the 

following: 

+ Choose File> Save a Copy. 

+ The Save As dialog appears, enter or verify the 

name, type, and location of the file. 

+ ClickonSave. 

SAVING ALL FILES 

To save all the files open in the current session, do the 

following: 

+ Choose File>Save All. 

All open files will be saved without making any changes 

to their name, type, or location. 
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FJg 4.7: Closing a Document 

If you want to open a recently opened document, then click on the small triangle to the right of the Open icon on the 

Standard toolbar, and select from a list of recently opened documents. 
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SAVING A DOCUMENT AUTOMATICALLY 

Writer can save your document automatically in a temporary file at regular intervals. To set up automatic file saving, 

follow these steps: 

Select Tools> Options> Load/Save> General. 

Click on Save AutoRecovery information every and setthe time interval. 

The defaultvalue is 10 minutes. Enterthevalue you want. 

You may also wish to select Always create backup copy. 

Click on OKto save the changes. 

III  CLOSING A DOCUMENT 

There are two ways to close a Writer document: 

Click on the File menu and select Close. Or 

Click on the Close button present on the top-right corner of Application window. 

If you have saved all the changes made in the document, then the Writer 

document closes immediately. 

But,if the document has some unsaved changes, a message box appears that 

prompts you to save the file. 

Click on the Save button to save the file. Click on the Don't Save button, if you do 

not want to save the changes made by you, or click on the Cancel button to cancel 

the currentaction. 

rn  OPENING AN EXISTING DOCUMENT 

+ 

+ 

Once a document is saved on your computer, it can be 

retrieved anytime it is required. When no document is open, 

then follow any one of the below mentioned steps to open 
N anexistingdocument. 

Db.d 

Click on Open File or Remote Files in the main startup 
j Coed 

windowofLibreOffice. Or '-' 

FileName 
Choose File > Open /Open Remote File from the Menu Text BOX 

bar. Or 

Press Ctrl+O on the keyboard. Or 

If a document is already open, the second document opens
Hg 45: Opening a Document 

ma newwindow.Toopenanotherdocument: 

ClicktheOpeniconontheStandardtoolbar. Or 

Use File >Open /Recent Documents to select the file you want and then click on Open. The Open dialog 

appears. Here, locate yourfile and select it. 

Click on the Open button. The selected file will open immediately in existing window or new window (ifa document 

is already open). 

box 
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Home key 

Ctrl+ Home keys 

End 

Ctr$ + End keys 

Page Up key 

Page Down key 

It moves the cursorto the beginning of the current line. 

This combination of keys movesthe cursortothe beginning of the document. 

It movesthe cursorto the end of the current line. 

It moves the cursor to the end of the document. 

It scrolls up one page. 

It scrolls down one page. 

Navigator 

K > L'_I-  - 
11 Hv 

Heading 

Tables 
[u-: Text frames 

Images 

OLE OLE objects 

I Bookmarks 

Sections 

Hyperlinks 

References 

[ Indexes 

Comments 

',  Drawinq obiects 

Untitled 1 (active) 

a.. a.. 

-a 

Fig. 4.9: Navigator Options 

II  USE OF NAVIGATOR 

Navigator in Writer is a useful tool which is used for working 

with large and complex documents. A large document has 

multiple objects like tables, headings, sections, hyperlinks and 

comments associated with it. The Navigator facilitates easy 

access and navigation between these objects. In the Navigator 

window, all the objects are displayed in the form of a list. To 

access an object, simply double-click on the object name. 

To access Navigator, choose View> Navigator or simply press 

F5 key, or press Navigator button on the right Sidebar. 

The following are the basic functions of the Navigatorwindow: 

~ Next Page>  : In case there are multiple pages in a document, 

the Next Page button is used to move to the succeeding pages. 

+ Previous Page  < :This option is used to move to the preceding pages from the current page in a document. 

+ Header, Footer :This option is used to jump between document text and Header/Footer. 

+ ContentView7  This option is used to toggle between alithe objects in the Navigator or any single selected object. 

CURSOR AND MOUSE POINTER 

TEXT CURSOR MOVEMENT 

The vertical blinking line in the Document window is called Cursor. You can move the cursor in a document by using the 

Cursor Control Keys (Arrow keys). There are four Arrow keys - Left, Right, Up and Down on the keyboard. Apart from 

Arrow keys, there are some other keys on the keyboard that help you to navigatethe document easily. 
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For Better Concept Clarity 
To exit LibreOffice Writer, 

click on the File>Exit 

LibreOffice or press 

Ctrl +Q. 

Quick View 

Answer the Following Questions: 

What is a word processor? 

Name the three popular word processors. 

• What are the four major operations possible with LibreOffice Writer? 

1. What are the options to save a document? 

What is cursor? Mention different keys that are used to move cursor in a document. 

6. Whatisl-beam? 

7. List different LibreOffice Writer menus. 

8. Explain the use of Navigator. 

For Better Concept Clarity 

Create a document, write few lines about yourself, save the document with your name.odt, close the document, 

and reopen it. 

MOUSE POINTER 

A small arrow on the computer screen is called the Mouse Pointer. It generally changes shape into I-beam when 

you bring it over the text. In this situation, it is referred to as a Text Select cursor. You can edit the text by moving the Text 

Select cursor over the text and clicking on the desired text to edit it. Thus, the mouse is used to control the Text Cursor 

location. 

'+ Open LibreOffice Writer. A new document will open, by default. 

•+f Type the given text. Save this file with the name "God—The Creator". 

Our daily lives can easily be influenced by stress, pressure, and confusion. But, we can stop any moment and sup away 

intothe presence of God's spirit through prayer and meditation to find peace. 

Faith in God is the best insurance when you are faced with a personal tragedy or a natural disaster. An insurance 

company can reimburse your financial loss, repair your home orcar, and help you start again in business, but only God 

can mend your broken heart. 

Do you have troubles? Has some unexpected problem come up? Ask God to come to your aid. Put Him on the spot and 

test Him. He can do the impossible. 

Taketime once in a whiletowatch sunrise orsunset. See and feel the powerand majestyoftheGreatcreator. 

+ After saving the file, click on File>Save As to assign a new name to the saved tile. 

+ Close the document and exit LibreOffice Writer. 

ASSESSMENT TIME 
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Non-consecutive 

Text 

A vertical block 

of text 
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UNIT - III:  Digital Documentation  

CHAPTER 

Editing a Document 
Editing text means making corrections to it, and manipulating text in 

a manner that would lead to the desired end result. This process 

may include inserting, deleting, copying, moving, finding, and 

replacing a particulartext in a document. 

TEXT EDITING — UNDO AND REDO 

The Undo command allows you to cancel the last action performed. 

This is useful if you have made changes in the document by mistake, 

and want to cancel the last change done. To perform undo action, 

click on Edit>Undo or press Ctrl+Z. 
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Fig. 5.1:  Editing In LibreOffice Writer 

The Redo command is highlighted when you have performed the Undo operation somewhere in the document. This 

reverses the action which is performed by the Undo command. That is, if you want to go back after performing undo, use 

the Redo command. To perform Redo operation, click on the Edit>Redo or press Ctrl+Y. 

You can access the Undo c4  - and Redo commands from the Standard toolbar. 

fl 
 SELECTING THE TEXT 

To perform some editing action, you need to select the desired text or a block of text. The selected text appears in a 

highlighted bar. Let us learn various methods to select the text in a document. 

Selection 

 

Method 

  

A word Double-click on the word. 

 

Hold down the Ctrl key and triple, click anvhere in the sentence or triple-click on 

the left margin beside the sentence. 
A sentence 

 

A paragraph Triple-click anywhere in the left margin of the paragraph. 

A large block of text  Click at the beginning of the text. Press the Shift key and without releasing it, click at the end of the text. 

Entire document Use the shortcut key combination Ctrl+A to select the entire document. 

Bring the mouse pointer to the desired location and click. Hold down the Shift key and click at the end of 
Consecutive Text 

the requiredtext. 

Bring the mouse pointer to the desired location. Hold down the Ctrl key and drag to select the word. Then 

select some other piece of text usingthedrag option while holding down the Ctrl key. 

To select a vertical block or a column of text that is separated by spaces or tabs, click on Edit>Selection 

Mode>Block Area or press Alt+Shift+F8. Now, drag the mouse to select a text. You will observe vertical 

selection. To stop selecting text vertically, click on the Edit>Selection Mode>Standard. 
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COPYING AND PASTING THE TEXT 

Copying text means to keep the text at the original location as well as copy it to another location. This feature helps to 

save your time and effort in typing. Sometimes, you wish to create multiple copies of the desired text. In such cases, you 

can simply select the text, copy it and paste it in multiple locations. 

There are fourways of performing this operation: 

-  Right-click on the selected text and select the Copy option from the Shortcut menu. Now, bring the pointer at the 

ewlocation where you wantto paste the text, right-click on that location and select the Paste option. 
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Fig. 5.2: Copying the Text Using Shortcut Menu 
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Figure 5.3:  Pasting the Text Using Shortcut Menu 

Select the desired text and click on the Copy button present on the Standard toolbar. Bring the pointer at the desired 

location and click on the Paste button located on the Standard toolbar. The pointer shifts after the last character of 

the pasted text 
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Fig. 5.4: Copying the Text Using Toolbar Figure 5.5: Pasting the Text Using Toolbar 

Select the desired text. Now, click on the Edit menu and select the Copy option. Now, bring the pointer at the desired 

location. Click on the Edit menu and select the Paste option. The selected text is pasted and the cursor moves to the 

end of the pasted text. 
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Figure 5.6: Copying the Text Using Edit Menu 
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Let's Know More 

Clipboard is a temporary 

storage location that can 
be used for short-term 

data storage and/or data 

transfer operations 

between documents or 

applications, via Copy- 

Paste or Cut-Paste 

method. 

Let's Know More 

The Automatic Spell 

Checking tool is present in 

the form of a toggle 

button in the Tools menu. 
If you click on it, it gets 

activated and 

automatically checks for 

errors in the document. If 
you click on it again, it 

gets deactivated. 

Quick View 

The shortcut key to 

activate the Check 

Spelling tool is F?. 

~ Select the desired text and press Ctrl+C. Now, bring the pointer at the desired location 

and press Ctrl+V. 

• fl MOV$NGTHETEXT 

This feature allows you to change the position of the selected text from one place to 

another. To move a piece of text, use the Cut option rather than the Copy option. There are 

four ways of moving the text: 

4 Right-click on the selected text and select the Cut option from the context menu. Now, 

bring the pointer at the new location where you want to paste the text. Right-click on 

that location and select the Paste option. 

+  Select the desired text and click on the Cut button present on the Standard toolbar. 

Bring the mouse pointer at the desired location and click on the Paste button located on 

the Standard toolbar. The pointer shifts after the last character of the pasted text. 

+ Select the desired text. Now, click on the Edit menu and select the Cut option. Bring the 

pointer at the desired location. Again click on the Edit menu and select the Paste option. 

The selected text is pasted and the cursor appears at the end of the pasted text. 

+ Select the desired text and press the Ctrl+X key combination. Now, bring the pointer at 

the desired location and press the Ctrl+V key combination. 

While moving the text from one place to another, the selected text disappears when you use 

the Cut option. Where does this text go? 

Almost every application has a temporary storage place called the Clipboard. The text which 

you have cut stays on the clipboard until the paste operation is completed. 

Similarly, if you are doing the Copy-Paste operation, then the selected text remains on the 

clipboard until you copy or cut a new piece of text from the document. 

Jfl  FIND AND REPLACE 

While looking for certain words in a large document, it is very inconvenient to go through 

the entire text. The LibreOffice Writer has a Find and Replace feature that automates the 

process of search as well as replacement of the text. 

FINDING TEXT 

+ Write the given text in your document. 

Without the ability to c ucentrate. a hilt and complete 111e is nut 
possille. If you lack the mental Focus t stay with one activity For any 
length oltime, you will never be able to achieve your goals, build your 

dreams or dnloy Ilts process. 

Without a disciplined mind, trivial thoughts and worries will ziag at you 
and you will never have the capacity to immerse you rself in inure 
meaningful pursuits. Without deep concentration, your mind will be 
your master rather than your servant. 

FIg. 5.8: Sample Text 
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Fig. 5.10: Replacing the Text 

Let us see howto use this feature. 

lick on the Edit menu and selectthe Find option. 
Find F,nd 

Previous Next 

These are additional 
which is ,,ced if tp(t,itted  

Find Priaus ln4 Nq J epIac. 

Othetpbon 

Peptace kackwi,ds 

-- Rperssio4n Paragraph Sties 

SfmIanty seiich 

/ 

clp 

Close 

lihe Find toolbar appears at the bottom of Writer Fnd Bar 

!W10"1 

ype the keyword goals in the Find text field and 

click on Find All. 

The keyword, 'goals gets highlighted in the entire 

text. 

Click on the Match Case check box, if you want to 

search the text with similar case that you have 

typed in Find text box. 

Use Find Previous or Find Next button to find the 

text above or below the cursor. 

Use Previous Page or Next Page button to find the 

text in previous or next pages. 

flnd&Repface 

r--- 

H- M*hC1I 

aler the Keword 
to be seached here 

U 

Click on the Navigate By drop-down arrow to 

choose between various areas of the document to 

find the text. 

Click on the Close Find Bar button to close the Find toolbar. 

REPLACING TEXT 

Fig. 5.9:  Find and Replace Dialog Box 

Once you have found a particular keyword in your 

document, you can replace it with a new word. Let us 

find the word 'goals' and replace it with a new word, 

'aim' in the whole document. To start replacing text, do 

the following: 

+ Open the Find & Replace dialog box in any one of 

the following ways: 

Open Edit menu and choose the Find & Replace 

option. Or 

Click on the Find & Replace tool on the Find toolbar. 

Or 

Press Ctrl+H. 

The Find & Replace dialog box opens. Type the 

keyword 'goals' in the Find section and 'aim' in the 

Replace section. 

Choose Match case and/or Whole word only options as per your requirement. 

Click on Replace button to replace the found text one by one, or choose Replace button to replace current 

occurrence of the searched text. 

Click on the Close button, once completed. 

Learning 
Computers with 



If you click on Find All, Writer selects all instances of the searched text in the document. 

Similarly, if you click on Replace All button, Writer replaces all matches. 

Go to Page 

Eage: of 25 

OK Cancel 

Fig. 5.11:  Go to Page 
Dialog Box 
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Know the Fact 

The Find and Replace 
utility in Writer preserves 
the case. If the found text 

begins with a capital 
letter, the text 

replacement will begin 
with a capital letter. 

clicking on the Match 
case checkbox will search 
the text with similar case 
that you have typed in the 

Find text box. 

Quick View 

Ctrl + H is the shortcut key 
to open the Find & 
Replace dialog box. 

Caution:  Use the option of Replace All with caution; otherwise, you may end up with 

some hilarious (and highly embarrassing) mistakes. A mistake with the Replace All 

option might require a manual, word-by-word search to fix, if not discovered in time 

to Undo. 

• 

When you are working in a large document, it becomes 

difficult to scroll down the pages to reach on a particular 

page. For example, if you have a document of 200 pages, 

and you want to go to page 50 from page 150, it will be a 

task. In such situation, the Go to Page command is used. By 

using this command, you can directly jump from one page 

to another easily and quickly. To jump on a particular page 

number, follow these steps: 

Click on the Edit menu and then click on Go to Page command. Or 

Press Ctrl+G. 

The Go to Page dialog box appears. 

- Enterthe page number on which you wantto move and click on OK. 

You will reach on the page number entered by you. 

fl  NON-PR!NTVNG CHARACTERS 

Non-printing characters arethe charactersthat do not appear in a printed document. These 

are basically used for formatting the document that is why also known as Formatting marks. 

The most common non-printable characters in word processors are space (.), non-breaking 

space (o), tab character (-), Line break (i),  and paragraph mark (1]).  By default, these 

characters also not visible on the computer screen. To show or hide the non-printing 

characters, click on the Toggle Formatting Marks on the Standard toolbar or press Ctrl+F1O. 

You can also the Formatting Marks command from the View menu. 

dt -t,b,twW,.se 

The Writer application opens a bLink document-with the temporary-narne-Untitled-1.-11 
displays a blinldng-cursor at-thesop-left dde of the Document Ama ' 

The larger window tscalled the Application window and the smaller window- 
which is inside theapplication window, is called th Document window. - 

Thp Application window-helpsthe user tocoenmunicae'with-the LibreOffice Writer 

program-The Document-witidow is used-for- yping.-editing.-and-formatting the text. Cl 

You-can also perfo.m-the fofowing tasks-1 

Create-document- 'Edit-document rormat text1 

Fig. 5.12: FIgure: Non.printing Characters 
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SPELLINGANDGRAMMAR 

What does your teacher do when you submit your homework to her? She checks the content of your answer, and 

spellings and grammatical mistakes. 

Similarly, the LibreOffice Writer checks the content you type, and sometimes, displays red, green and blue wavy lines 

under a few words. The red wavy lines indicate the spelling errors, green wavy lines indicate grammatical errors, and blue 

wavy lines indicatecontextualspelling errors. The LibreOffice Writer has a built-in dictionary and setgrammatical rules to 

checkthe spellings and grammatical errors of any text document. 

If your document reporting errors by indicating red, green and/or blue way lines, follow any of these methods to check 

and fix the errors: 

METHOD 1 

LAI 
Using Right-click Menu: The wavy red lines below the certain words mark the presence of spelling mistakes. You 

can either review the spellings and correct them manually or right-click on the word, and choose the correct 

matching word from the computer dictionary. 

This dialog box di,lays the spelling mistakes in red color and stiggests the possible corTecdonsin the 

tg wctloa. noose the desired word and click on the Correct button. 

dick on Ignore Once Ignore All bonon. is xclr cases, you can 

dictionajy by dickkrg on the Add to Dlcdozrary butOn. 
Sxggest xx 

,llthg m zalces,you will gee the following notifIcation as sbown in the 

Suggeslrb4e 

FIg. 5.13: Using Right-click Menu 

eel, 

METHOD 2 

[] Using Check Spelling Tool: Click on the Check Spelling 

buttonLon the Standard toolbar, or click on the Tools 

menu and select the Spelling option to correct the 

next two mistakes. You will find the Spelling dialog box. 

This dialog box displays the spelling mistakes in red 

color and suggests the possible corrections in the 

Suggestions section. 

+ Choose the desired word and click on the Correct 

button. 

+ If you wish to keep the word unchanged, click on Ignore 

Once/Ignore All button. In such cases, you can add this 

new word into computer's dictionary by clicking on the 

Add to Dictionary button. 
FIg. 5.14: using Check SpellingTool 

+ Once you have corrected all the spelling mistakes, you will get a notification. 

* ClickonOKtoreturntoyourdocument. 

C ution:  Sometimes, you feel that there are no spelling mistakes in your document but there might be a case E 

thatthe Spellingand Grammarfeature is notworking. Howwould you rectifythis problem? 

The LibreOff ice Writer has some built-in dictionaries using which it checks your document. You should be aware of the 

current dictionary in use. You can check it by looking at the Status bar. 
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Fig. 5.15:  Changing the Dictionary 

AJ French (Luxembourg) 
French (Monaco) 

'! French (Switzerland) 

This shows that the 

English (lndi 
 ngIish (India) dictionary 

is in use. 

The English (India) dictionary allows you to write many regional words. Hence, 

it may not underline a misspelled word at all. In this case, click on the 

English(lndia)  E and change the dictionary to English (USA). 

You will now be able to see the mista kes that you have committed while typing. 

fl  USING THESAURUS 

The Thesaurus feature is a built-in dictionary that enables you to look up synonyms, antonyms, word substitutes, and 

alternative spellings. This feature increases your writing abilities and vocabulary, and helps you to better understand the 

text. When you look up a word in thesaurus, it will provide you a list of alternative words in which you can choose a word 

and use it in place of an existing word. Let us learn how to usethe Thesaurus feature. 

Write a few line: 

In 2011, Gandhiari rights activist Anna Hazare started a Satyagraha movement by commencing a fast unto death in New 

Delhi to demand the passing of the Jan Lokpal Bill. The movement attracted attention of the media, and thousands of 

supporters. The Jan Lokpal Bill (Hindi: 41 ), also referred to as the citizensombudsma bill, is a proposed 

anti-corruption law in India. 

FIgure 5.16:  Sample Text 

Let us find the synonym of the word, ombudsman. 

Select this word. 

Click on the Tools >Thesaurus or press Ctrl+F7. 

You willfind the synonym of the selected word in the opened dialog box. 

Selectthe required word, and click on the Replace button to replace the word. 

ASSESSMENT TIME 

Pig. Pi7:  Thesaurus 
Dialog Box 

Answer the Following Questions: 

1. What do you mean by editing text? 

2. How can you select an entire paragraph? 

3. What is the difference between copy-paste and cut-paste? 

4. What is the use of Find & Replace dialog box? 

5. How do you jump from one page to another in a document? 

6. What are non-printing characters? 

7. What is a thesaurus? 

What is the shortcut key to activate the Spelling and Grammar tool? 
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For Better Concept Clarity 

1. Create an Invitation letter for the wedding of your brother. Edit the letter by selecting and deleting the text 
and then save the document. Open the existing document and make some modifications in it. Save the 
document again. 

2. Open any existing document which has multiple paragraphs. Copy the first sentence of the first paragraph 
and paste it at the end. Cut the second sentence and paste it at the end of the paragraph. 

3. Remove the spelling and grammatical errors from the following text: 

Dearr Ashwinn 

Hopes that letter find you in bests of heiths ans spirits. We have not meet for many day. 

Wether in Delhi is beter now. Come do visits us. My scool are opening after Diwali. 

Give regards to elder. 

Your freind 

Ree ma 

4. Find and replace all the occurrences of'Kngs with 'Rings' in the following passage: 

Kings have been around since ancient times. We have Kings from Europe, Asia, South America, and 
Africa. Some kings are good while some are bad. We even have some kings, nowadays. 

I 

r] 
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UNIT - III:  Digital Documentation

CHAPTER 6 
Formatting a Docu men 

In any profession, it is important to keep documents presentable and beautiful. This can be achieved by adding the 

effects that beautify the text. Formatting means changing the overall look of a document. In LibreOffice Writer, you can 

apply differenttypes of formatting — text formatting, paragraph formatting, and page formatting. 

Let us first learn how to setup a page, and then you will learn how to apply different types of formatting in a document. 

II  PAGE STYLE DIALOG BOX 

While creating a new document you need to define the 

page settings, if you do not want to continue with the 

default page settings. For this, you use the Page Style 

dialog box. To open the Page Style dialog box and 

customize page settings, follow these steps: 

Click on the Format menu and choose the Page option. 

The Page Style dialog box appears. 

Select the Page tab, if not selected by default. You will 

see different options related to the page, such as 

Paper Format, Margins, Layout Settings, etc. 

Choose the size of page by selecting the desired page 

size in Format drop-down box. Forexample,selectA4.
6pp'y  j 

Set the orientation of the document by selecting Fig. 6.1: Page Style Dialog Box 

Portrait or Landscape. 

Click on OK. The changes done by you will be applied immediately. 

NOTE 
To get the default settings of page, click on the Reset button in the Page Style dialog box. 

II  TEXt FORMA111NG 

Text formatting is applied in a document to enhance the appearance of text and individual characters. It increases the 

readability of the document. From font sizes to font styles, text positioning to text attributes, text formatting includes all 

attributes that can be used to define the arrangement and visual display of text. To apply formatting, you first select the 

text and then applythe required textformatting. 

In LibreOffice Writer, text formatting can be done in severalways: 

Usingthe Format menu 

Usingthe Formatting toolbar 

Computers with  IPS 
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Quick View 

Ctrl + B: To make text bold 

Ctrl + I: To italicize text 

Ctri + U: To underline text 

I " 
Dthu E  c• - 

BIA 

- x2 x2 

"Panaph 

* Using the context menu 

+ psingthe Characterdialog box 

UsingthePropertiespane 

Using the keyboard shortcuts 

REMOVING MANUAL FORMATI1NG 

In LibreOffice Writer, when you copy a segment of text and paste it at the new location, its formatting also copied there. 

In such situation, you first remove theformatting to applythe newformatting. To remove formatting, followthese steps: 

Select the text from which formatting is to be removed. 

Clickonthe Format menu and select the Clear Direct Formatting option. Or 

Press Ctrl+M. Or 

Click on the Clear Direct Formatting .] on the Formatting toolbar. 

COMMAN TEXT FORMATFING 

LibreOffice Writer provides the Formatting toolbar that contains common text formatting commands. Let us learn the 

use of some commonly used text formatting commands. 

+ Changing Font:  To change font, select the text and click on the Font Name drop-down 

Formattingtoolbar. Selectthe required font. 

Liberation Serif Lj arrow on the 

+ iChanging Font Size:  To change font size, select the text and click on the Font Size 12 . drop-down arrow on the 

Formattingtoolbar. Selectthe required font size. 

+ Making  text Bold, Italic and Underline:  You can easily make the text Bold B , Italic I and/or Underline by 

selectingthetext and clicking on the corresponding buttons on the Formattingtoolbar. 

+ Changing Font Color:  To change the font color, select the text and click on the Font Color button on the 

Formattingtoolbar. The color palette appears. Selectthe required color. 

Untited 1- LibfteWrit 

Ele Lat ie.e ni.t mat Ses Table orr, Io &drw p 

(- . 

DtfaoStyIe jj f2E B I x2 x2 r 

Chonging Font 

Changing Font Size 
Making Tt Bold 

Text in Italic 

Underlinel Text 

Changing Font color 

I. 

- piong irdert 

4  jr   I • 

Fig. 6.2: Common Text Formatting 
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Let us write the following text and try to change its Font Family, Font Style, and Font Size. 

Habits are routines of behaviour that are repeated regularly and tend to occur subconsciously. Habitual 

behaviour often goes unnoticed in persons exhibiting it, because a person does not need to engage in 

self-analysis when undertaking routine tasks. 

Habituation is an extremely simple form of learning, in which an organism, after a period of exposure to a 

stimulus, stops responding to that stimulus in varied manners. Habits are sometimes compulsory. 

Sample text 

4 Select the first words from both the paragraphs. 

4 Use the Formattingtoolbarto applythe followingtextformatting: 

Click on the Font Name drop-down button and select Verdana as a font. 

Click on the Font size drop-down button and select 12 point as font size. 

Click on the Bold and Italic buttons to apply bold and italic effects, respectively. 

+ You will see the following output 

Habits are routines of behaviour that are repeated regularly and tend to occur subconsciously. Habitual 

behaviour often goes unnoticed in persons exhibiting it, because a person does not need to engage in self-

analysis when undertaking routine tasks. 

Habituation is an extremely simple form of learning, in which an organism, after a period of exposure to a 

stimulus, stops responding to that stimulus in varied manners. Habits are sometimes compulsory. 

CHANGING TEXT CASE 
PERCAS 

When you type text in LibreOffice Writer, it appears in lowercase if the Caps Lock key is 

not ON. You can change the case of the typed text easily byfollowing these steps: 

Select the text which case is to be changed. 

Click on the Format menu and then click on Text. 

Asubmenu appears. Select anyof the followingtext cases: 

t*e.ce 

IOGQI AS€ 

A 

 

Hj. .::  Text Cases 

Text Case Description 

UPPERCASE It converts the selected text to uppercase. 

lowercase It converts the selected text to lowercase. 

Cycle Case It allows you to cycle through three different case scenarios: ALL CAPS, all lowercase, and AliTitle Case. 

Sentence Case It capitalizes the first letter of a selected sentence and keeps rest of the letters as lowercase, for example, 

this isa test document. 

Capitalize Each Word It changes the first character of each selected word to uppercase. 

tOGGLE cASE 

 

This option converts the case of every selected character in the reverse way i.e., a capital character will 

convert into lower case and vice versa. 

Small capitals It converts the selected text to uppercase, and keeps the first character of each sentence slightly taller or 

biggerthan rest of thecharacters. 
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You can apply Cycle Case 
to the selected text by 

pressing Shift+ F3. 

Quick View '2;' 

Quick View 

Ctrl+Shift+P: To write text 
in Superscript 

Ctrl~Shift+B: To write text 
in Subscript 

H20 
444 

a2+b2  

FIg. 6.4:  Superscript 
and Subscript 

#aa 
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APPLYING SUPERSCRIPT AND SUBSCRIPT 

Sometimes, it is required to change the position of the selected text slightly above or below 

the normal line of text. For this, LibreOffice Writer provides Superscript and Subscript 

commands. 

Superscript:  It places the selected text slightly above the line of text. 

Subscript: It places the selected text slightly belowthe text baseline. 

Let us write 44 raised to the power of 8. You need to raise the position of 8 with respect to 44, 

so that it looks like the exponent such as 448.To do so, follow these steps: 

+  Selectthetext,forexampleselectdigit8. 

+ Click on the Format menu and selecttheTextoption. 

+ Asubmenu appears. Selectthe Superscript option. Selected text appears as448. 

+  Similarly, choose the Subscript option to apply subscript on a selected text to make it 

appear lowerthan the rest ofthe text. Forexample, H20, where 2 is a subscripted text. 

PARAGRAPH FORMATIING 

Paragraph formatting is the most important factor in the overall appearance of a document. It includes paragraph 

alignments, paragraph indentation, paragraph spacing, borders and shading effects. Paragraph Formatting contributes 

the mostto the final appearance of the document. 

IN DENTING A PARAGRAPH 

The distance between the text boundaries and the page margins is called Indent. The indenting feature is used to move 

the complete paragraph or the first line to a specific number of places between the left or right margins. A well indented 

document always catches the readers attention as it looks organized and structured. To indent a paragraph, follow these 

steps: 

Selectthe paragraph to be indented, or place the cursor before the paragraph 

+ Click on the Increase Indent button on the Formatting toolbar. The selected text will shift 1/2  inch away from the 

left margin. 

Click on the Decrease Indent button on the Formattingtoolbar to move the text 1/2  inch closerto the left margin. 

Each time when you click on the Increase indent or Decrease 

Indent button, the current paragraph's indent will increase or 

decrease, respectively. 

Or 

You can set the indent by using the paragraph dialog box. Click on 

Format > Paragraph. The Paragraph dialog box appears. In the 

dialog box, the Indents & Spacing tab is selected, by default. Here, 

select the required indentation under Indent: 

+  Before text: This is also called the left indent. A positive value 

will leave the corresponding space from the left margin and 

vice versa. Fig. 6.5:  Paragraph Dialog Box 
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+ After text: This is also called the right indent. A positive value will leave the corresponding space from the right 

margin and vice versa. 

+ First line:This option is used to specify indent values forthe first line of the document. 

+ Automatic:This option indents the first line of every paragraph automatically. 
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The dimaoce between the text bonndaiies ad the page margins is called Indent. 

The indenting feature Is useel to move the complete paragraph or the first line to a spedllc number 
of places between the left or right margins. 

Awell indented document always catches the readers attention as it looks organized aEd 
situ ctnred. 

Fig. 6.6:  Indented Paragraphs 

ALIGNING PARAGRAPHS 

Text alignment or or paragraph alignment refers to the position of text with respect to the margins of the page. You can 

set the alignment before typing. You can also select the entire document, or a segment of text, and then change its 

alignment. 

There are two categories of text alignment — horizontal and vertical. 

Horizontal Text Alignment 

When you align the text with respect to left and right margins, it is called horizontal text alignment. The text alignments 

that you genera Ily  use, fall under this category. 

There are fourtypes of horizontal text alignment: 

1. Left Alignment: This is the default alignment of text in a document. The text is aligned along the left margin while 

leaving a little space towards the right margin. 

2. Right Alignment:  The text is aligned along the right margin while leaving a little space towards the left margin. This 

alignment is mostly used to put dates on letter heads. 

3. CenterAlignment:The text is aligned centrally between the left and right margins. It is mostly used for titles. 

Fig. 6.7: Alignment Buttons on the Formatting Toolbar 

4. Justified Alignment:The  text is aligned evenly between the left and right margins. 
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Let us type the following text and applysome text alignment effects to it. 

pig. 3.S: Sample Text 

Method 1: 

+ Select the first paragraph. Click on the Format menu and select the Paragraph 

option. 

The Paragraph dialog box will open. Select the Alignment tab and you will find 

four different text alignment options. 

Clickon the Center radio button from the given options. You can also previewthe 

selected alignment in the Preview box located on the right hand side. 

Fig. 6.10: Alignment Tab 

Method 2: 

Select the paragraph and click on the Format menu. 

Choose Align, a sub-menu appears. 

Select an alignment option — Left(Ctrl+L), Centered (Ctrl+E), Right(Ctrl+R), or 

Justified(Ctrl+J). For example, selectCentered and thetextwill be aligned in centerwith 

respect to the margins. 

You can apply the feature of 

Drop caps using the Drop 

Caps tab under the 

Paragraph dialog box. Drop 

Caps is a text formatting 

feature which enlarges the 

first character of a line to 

an extent that it drops 

down by two or more lines. 

Fig. 6.9:  Alignment Options 

Now, click on OK. 

Paragraph ;. 

Inderts &Sp1cnJ Aignment Tfxt FiowlOuthne & Nun befingIT1bzIDrop CpitBqrciesIAr jJr4r:parencyI 

Alignment 
Preview Box 
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Quick Quiz 

What is the difference 

between Margins and 

Indents? 

The golden thread of a highly successful and meaningful life is self-discipline. Discipline 

allowsyou to doallthose thingsyou know in your heart thatyou should do but neverfeel 

likedoing. 

Without self-discipline, you will not set clear goals, manage your time effectively, treat 

people well, persist through the tough times, care for your health or think positive 

thoughts. 

recttotct 

jignmenti 

Propenten 

Iext direction: 

Types of Text 
AlIgnment 

Jstoe H 
0 £xpand single word 

}nap to tent grid (if active) 

Optroais 

t tght 

center 

t ustified_ 

(ast lrne 

(AutornaticEj 

Ure rupevordinate object rettings 



 

1he selected text has been" 
center aligned with 

respect to the margins. 

 

You will get the following output: 

 

 

 

The golden thread of a highly successful and meaningful life is self-discipflui e. 

Discipline allow you to do all those things you know in your heart you should do 

but never feel like doing. 

Without self-discipline, you will not set clear goals, manage your time effectively, treat 

people well, persist through the tough times, care for your health or think positive 

thoughts. 

  

       

       

Vertical Text Alignment 

It aligns the text with respect to the top and bottom margins of a frame. To align the text 

vertica fly, follow the given steps: 

LeVs Know More 

r N\'FiC)NMLNf 

A , 

Insert a text box and write text in it. 
C.L 

Select the text. 

Click on the Format menu. 
£4 OO9 

"p 
,, 
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Choose Align, the sub-menu appears. FIg. 6.11: Choose Vertical Alignment 

ii you want to start a new 

line without 

bullet/number, then use 

Shift+Enter key 

combination. 

ENV1RONMENI1 

Click on Top, Center or Bottom. For example, select the Center option. 

+ Thetext will align vertically centered inside the text box. 
Vertically Aligned Text 

BULLETS AND NUMBERING 

A list is defined as the number of connected items: names, or sentences, written or printed 

consecutively, one belowthe other. A bullet is a smallgraphic symbol that marks an item in 

a list. You can format lists in a document by using Bullets and Numbering commands. 

Let us learn howto create a bulleted or numbered list. 

WritethetitleasSEVEN HABITSOFGOODSTUDENTS. 

'- Now, click on the Toggle Bulleted .j  button or the Toggle Numbered List button 

present on the Formattingtoolbar. 

A bullet or a number appears in the document. Write the first habit as Be Proactive and 

then press the Enter key. 

+ The bullet or numberwill automaticallyappearon the next line. 

.c- Compile the whole list as shown below: 

You can highlight some 

words, phrases or 

paragraphs in your 

document, if required. To 

highlight text, first select 

it. Then, click on the 

Highlight Color EiI drop- 

down arrow on the 

Formatting toolbar, and 

select the required 

highlighter. Selected text 

will be highlighted 

immediately. 
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FIg. 6.12: Sample Text 

Let Us Recall 

To move a bulleted list 

down by one outline level, 

click at the beginning of 

the paragraph and then 

ess the Tab button/key. 

    

 

SEVEN HABITS OF GOOD STUDENTS 

   

• Be AactIve 

• Be'n With The Ejid Ej  Mid 

• PtRrstThieg RisE 

Thric WEs.w 

• Seek RisE b 1kdsEstsd. Thee b Be 1eecstoce 

• SyneiZe 

Searpa The Saw 
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Lets Know More 

 

To stop entering bulleted 
or numbering list, click on 

the Toggle Bullets List 

button or the Toggled 

Numbered List on the 
Formatting toolbar. 

• • . 
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NOTE 
You can use the indent markers present on the Horizontal ruler to increase/decrease the spacing between a bullet 

and text. 

Uslrg the Bullets and Numbering Toolbar 

In Writer, whenever, you apply a bulleted or numbering list to a paragraph, the Bullets and 

Numbering toolbar appears automatically at the bottom of the window. You can also access 

the toolbar by selecting View>Toolbars>Bullets and Numbering, if it is not visible. The 

Bullets and Numberingtoolbarcontainsthefollowing options: 

1. Demote One Level 

2. Promote One Level 

3. Demote One Level With 

Subpoints 

4. Promote One Level With 

Subpoints 

5. Move Down (Ctrl+Alt+Down) 10. Restart Numbering 

6. Move Up (Ctrl+Alt+Up) 11. Bullets and Numbering 

7. Move Down with Subpoints 

8. Move Up with Subpoints 

9. Insert Unnumbered Entry 

Fig. 6.13: Bullets and Numbering Toolbar 

NOTE 

Whenever, you apply the Bullets/Numbering to a paragraph, the Bullets and Numbering toolbar automatically 

appears on the bottom left corner of the Work Area. 

Using the Bullets and Numbering Dialog Box 

+ Bring the pointer in the Document Area and click where you want to insert a list or 

select a list which style is to be changed. 

+ Click on the Format menu and choose the Bullets and Numbering option. You will 

see the Bullets and Numbering dialog box. 

Choose any option of your choice and click on OK. + 

FIg. 6.14: Bullets and 
Numbering dialog Box The Bullets and Numbering dialog box contains the following six different tabs. Lets us learn 

about them: 

Bullets 

Numbering 

Outline 

Image 

Position 

Customize 

It is used for selecting different type of bullets. 

It is used forselecting differenttypes of numbering. 

It is used to selecting a mixture of numbers bullets and letters in hierarchicalform. 

It is used to select different graphics style bullets. 

It is used to set indents, spacing, and alignment for bullets and numbers. 

It is used to define a custom bulleted or numbering list. 
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Fig. 6.16: Assigning Background 

ASSIGNING BORDERAND BACKGROUND TO A PARAGRAPH 

Different borders and background color can be easily applied to paragraphs 

in LibreOffice Writer. The borders can be added to any or all sides of a 

paragraph. Follow these steps to apply a border and background to a 

paragraph: 

- Select a paragraph to apply borderand background. 

+ Click on the Format menu and select the Paragraph option. 

+ The Paragraph dialog box appears. 

- Click on the Borders tab, and select the required border under Line 

Arrangement. 

+ Select the borderline style in Style drop-down box. 

+ Select the border width in Width drop-down box. 

-- Select the border color in Color drop-down box. 

+ Now, click on the Area tab in the Paragraph dialog box. 

+ Click on the Color button to getthe color palette. 

+ Select the required background color. 

+ Click on OK. The changes done by you will be applied immediately to 

the selected paragraph. 

Fig. 615: Assigning Border 

Habits are routines of behavior that are repeated regularly and tend to occur subconsciously. 1-labitual  1 
Ibehavior often goes unnoticed in persons exhibiting it, because a person does not need to engage in 

ell-ana1ysic when undertaking routine tasks. 
Fig. 6.17: Assigned Border and Background to a Paragraph 

PRACTICE TIME 
Type the given text. Let us apply  some of the formatting features of LibreOff ice Writer. 

Mark Zuckerberg is the youngest billionaire. He is the founder of Facebook — a social networking site, which he started 

in 2004 with his room-mates Dustin Moskovitz and Chris Hughes. He was born on 14 May 1984 in New York, USA. His 

father Edward Zuckerberg is a dentist and mother Karen Zuckerberg works as a psychiatrist. 

Mark always enjoyed developing computer programs, especially communication tools and games. In one such 

program, since his fathers dental practice was operated from their home, he built a software program called 

"Zucknet" that allowed the computers between the house and dental clinic to communicate with each other. It is 

considered a "primitive" version of AOL's Instant Messenger. 

At Harvard, he was quite popular for developing new software. He was popular as a programming prodigy. By the end 

of 2004, Facebook had one million users. This number increased to 5.5 million users by the end of 2005. Later, he 

dropped out of his college for making Facebook his fuiltime activity. 

ACHIEVEMENTS OF ZUCKERBERG 

Year Award 

2011 The Jerusalem Post ranked him first in the list of"Most InfIueritiaIJews of the world". 

2010 Times Magazine awarded him with the title, "Time's Person of the Year". 
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FE, 6.1: Making changes in default settings of page 

I NSTRUCTIONS 

+ Selectthetext, 'MarkZuckerberg' in thefirst paragraph. 

+ Click on the Font Name drop-down arrow on the Formatting toolbar and select a font. For example, select Anal 

Black font. 

+ Click on the Font Size drop-down arrow on the Formattingtoolbar and select a font size. For example, select 18. 

+ Now, select the word 'Facebook' in the second sentence of the first paragraph. Apply bold, Italic, and underline 

effects to it by using the Bold, Italic, and Underline commands on the Formattingtoolbar. 

+ Select first two paragraphs and align them in center by clicking on the Align Center button on the Formatting 

toolbar. 

- Select the words Times magazine' and Time's Person of the Year' in the last line of the document. Convert the 

case into uppercase by clicking on Format>Text>UPPERCASE. 

- Select the 'Achievements of Zuckerberg and assign a border and background color to it by using the Paragraph 

dialog box. 

II  PAGE FORMA1TING 

Page formatting means making changes in default settings of page. It includes settings of page layout, size, orientation, 

margins, etc. Page formatting is performed, if the default page settings do not meet your requirement. LibreOffice Writer 

allows provides different options using that you can format your document easily. 

SETTING UPTHE BASIC PAGE LAYOUT USING STYLES 

-J 

When you launch the LibreOffice Writer on your computer, it opens 

with a blank document that has some default settings and styles 

such as page size, margins, header and footer, border, background 

number of columns, etc. To make changes in these default settings 

to setup your own page layout, follow these steps: 

+ OpentheLibreOfficeWriteronyourcomputer. 

Click on the Format menu and choose the Page option. 

+ [The Page Style dialog box appears. 

+ Select the Page tab, if not selected by default. 

+ Here, make changes in default paper format, margins, layout 

settings, background settings, etc. 

+ Click on OK. The changes done by you will be applied immediately. 

INSERTING A PAGE BREAK 

Page break is an important feature of LibreOffice Writer. It allows you to insert a break in the page, and moves the cursor 

on the new page. 

When you fill a page with text orgraphics, LibreOffice Writer inserts an automatic page break and starts the new page. 

But, if you want to move to the next page forcefully, you can insert a page break. 

Even if you have a large document and you want to move some text to the beginning of the next page, then you can insert 

a page break. 

L . 
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Lets Know More 

The distance between the 

written text and the edge 

of the paper is called 

margin. Rulers display the 

position of the margins. 

Margins are important 

elements of a document 

as they set the boundaries 

of a page. 
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CoputexAçplicitlon 

[Header (Def6ult Style) 

JFooter (Default Style) 

I 

Follow these steps to insert a page break: 

+ Position the cursor in the document where you wantto insert a page break. 

+ Click on the Insert menu and select the Page Break option. Or 

+ Press Ctrl+Enter. The text from the cursors position will move to the beginning of the 

next page automatically. 

INSERTING HEADER/FOOTER AND PAGE NUMBERS 

You must have noticed that usually the title of the chapter is present at the top of the page 

and the page numbers appear at the bottom. In literary terms, they are called header and 

footer, since they appear atthe top and bottom of the page, respectively. 

Header and Footer are the identifiers that respectively run across the top and bottom of the 

document. They include information like, page numbers, date, title of a book or chapter, 

author's name, and slide show theme, etc. They can also be modified later. Whenever you 

need to repeat certain text or graphics on each page, you can use a header or footer. It is a 

time savingtechnique. 

To insert header/footer and page numbers, follow these steps: 

+ Click on the Insert menu and selectthe Header and Footer option. 

+ A submenu appears. Select Header> Default. 

+ The cursor will be in the header area. Type the required header. For 

example, type 'ComputerApplications. 

+ Click outside the header area to complete your entry. 

+ Now, to inset a footer, click on Insert>Header and Footer>Footer> 

Defa u It. 

+ The cursorwill be in the footer area. 

+ Type the required footer. 

+ To insert the Page number in footer area, click on Insert>Page 

Number. 

+ Click outside the footer area to complete your entry. 

Fig. 6.19: Inserting Header/Footer 

and Page Numbers 

NOTE 

Double-click at the top or bottom of any page to insert a header or footer. 

DEFINING BORDERS AND BACKGROUNDS IN A DOCUMENT 

In LibreOffice Writer, you can assign borders and backgrounds forthe entire document as well. 

Follow these steps to assign a borderand background to a document: 

+ Openthedocument. 

+ Click onthe Format menu and selectthe Page option. The Page Style dialog box appears. 

+ Click on the Borders tab, and select the required border under Line Arrangement. 

+ Selectthe borderline style in Style drop-down box. 

Learning j.  
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Fig. 6.22: Columns Dialog Box 

Select the border width in Width drop-down box. 

Select the border color in Color drop-down box. 

ow, click on the Area tab in the Page dialog box. 

Click on the Color button to get the color palette. 

Select the required background color. Or 

Click on the Gradient button to get the gradient options. Select the required gradient; define type of gradient, such 

as Liner, Radial, etc. Or 

Click on the Bitmap button, you will get the different bitmap images. Select the required image or add a bitmap of 

your choice by clicking on the Add/Import button. 

Click on the Pattern button or Hatch button, you will get different pattern or hatch. Select the required pattern or 

hatch. 

Click on OK. The changes done by you will be applied immediately to the entire document. 

Fig. 6.20: Defining Page Border Figure 6.21:  Defining Page Background 

DIVIDING A PAGE INTO COLUMNS 

You may have seen newspapers, magazines and some other documents that contain text in form of columns. Generally, 

coImns are included in a document to improve its readability. The Columns feature of LibreOffice Writer lets you divide 

the page vertically into two or more columns. The text you type runs down the first column until it is full and then it starts 

at he top of the second column. When second column is full, the 

text beginstofillthe third column, and so on. 

To divide a page into columns, follow these steps: 

+ Openthedocument. 

+ Click on the Format menu and then click on Columns. 

+ The Columns dialog box appears. 

+ Select the required number of columns in Columns box. 

+ Enter the value for spacing in the Spacing box to set spacing 

between columns. 

+ Click on OK. Now,type the text. Itwillappear in form of columns. 



U1 4SERTING IMAGES, SHAPES, AND SPECIAL CHARACTERS 

When you create a document, you may need to include some graphic 

illustrations. Graphics are added in documents for a variety of 

reasons. For example, to support the description provided in the text 

orto provide an immediate visual impact of the contents. 

INSERTING IMAGES 

You may save pictures on your computer from a variety of sources. 

For example, they may be downloaded from the internet, scanned, 

or created with a graphics program, or they may be photos taken 

with a digital camera. So, the pictures available on your computer can 

easily be inserted in the LibreOffice Writer document. 

To insert an image in your document, followthese steps: 

Click on the Insert tab and select the Image option. 

The Insert Image dialog box appears. 

Browse the picture you wish to insert. 

'i Choosethe desired file and click on the Open button. 

+ Theslectedimagewillbeinsertedinthedocument. 

INSERTING SHAPES 

In LibreOffice Writer, shapes is a drawing feature that helps you to 

draw different shapes like stars, banners, callouts, connectors, etc. 

With the help of these shapes, you can draw attention and provide _____ 
impactto your message.To insert a shape,followthese steps: 

- Click on the Inserttab and selectthe Shape option. 

A submenu appears that shows you a list of options such as Lines, Basic, Arrow, Symbol, Star, 

Callout and Flowchart. 

Select the required option and further select a shape. For example, select Smiley Face under 

Symbol. 

' The pointer changes to '+' cross hairsymbol. Drag it on the working area to draw the shape. 

2 

F 6.25: 

Inserted Shape 

INSERTING SPECIAL CHARACTERS 

At times, you must have seen some special characters in documents, 

which are not available on a standard keyboard. In computer 

terminology, such special characters are called symbols. A particular 

mark that represents some piece of information is called a symbol. 

To insert a symbol, followthese steps: 

Place the cursor at the position where you want to insert a symbol. 

Click on the Insert menu and selectthe SpecialCharacter option. 
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Fig. 6,23:  Insert Image Dialog Box 
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Fig. 6.24: Inserting a Shape 

Fig. 6.26: Special Character Dialog Box 

To maintain the height and width ratio of a shape, hold down the Shift 

key while you drag the shape. 1J 
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Side handle  1 

Corner handle 

Fig. 6.27: Resizing an Image Diagonally Fig. 6.28:  Resizing an Image in a Direction 

Fig, 6.29: Rotating image 

thswer the Following Questions: 

1. Whatisformatting? 

2. List the different types of formatting. 

3. What is the use of Page Style dialog box? 

4. What are the shortcuts for bold, italics, and underline. 

5. What is the difference between bulleted and numbered lists? 

6. Name the different categories of text alignments. 

7. What are the different types of horizontal text alignments? 

8. Whatisindent? 

9. How is a page break useful? 

10. What are header and footers? 

+ The Special Characterdialog box appears. 

+ Choose the desired symbol and click on the Insert button. Selected symbol will appear at the cursors position. 

FORMATTING THE SHAPE OR IMAGE 

In LibreOffice Writer, you can format an inserted image or shape. For example, you can resize and rotate it, and add 

artistic effects or change the shape of a picture anytime. 

Resizing an image or a shape: To resize an image or a shape, select the image or shape. Now, bring the pointer on any 

corner handle and drag it in or out to make the selected object smaller or bigger, respectively. Corner handles help to 

increase and decrease the size diagonally. Apart from the corner handles, an image or a shape also has four side handles. 

Drag any side handle in or out to shrink or stretch the selected object in a direction. 

Rotating an image or a shape: To rotate an image or a shape, select the image or 

shape. Click on the rotate button on the Image toolbar. Four rotation handles 

appear. Now, bring the pointer on the rotation handle and drag it clock-wise or anti-

clockwise to rotate the image or shape. 

In 
When you insert or select an image or shape, two toolbars appear — Frame 

toolbar and Image toolbar. Make use of these toolbar to perform the required 

changes 

    

  

4 

ASSESSMENT TIME 
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For Better Concept Clarity 

 

Open a document, select the text and make the first sentence bold, second underlined, and third italicized. 

Make the font color blue. Capitalize each word in the last sentence. Try to apply more of the effects that you 

have learnt in the chapter and save the document. 

2 Write down five ways to save water. Transform it to a numbered list. Then convert it into a bulleted list. 

Finally, select the list and remove the bullets. 

3. Type a paragraph and first align the text left, then right, and then center. Then, apply first-line indent. 

4. Select a paragraph in yourdocument. Make a border around it with thick solid line style and width of 3/4pt. 

Also, assign a background color to it. 

 

Word processing is the use of computer software (a word processor) to enter, edit, 

format, store, retrieve and print the document. 

+ A word processor provides an easier and faster method to type the text. 

- LibreOffice Writer is a popular word processor. It is the part of LibreOffice Suite which is free and open source 

software. 

+ By default, the LibreOffice Writer application opens a blank document with the temporary name Untitled 1. 

LibreOffice Writer window has many parts, such as Title bar, Menu bar, Standard Toolbar, Formatting Toolbar, 

Rulers, Scrollbar, Sidebar and Status bar. 

• A template is a set of predefined styles and settings that is used to create a new document. 

+ To save a file in Writer, click on the File>Save or File>Save As or press Ctrl + S. 

+ The Save command saves the changes done by you in the existing document. It shows a dialog box to assign 

name to the file, if you are saving it first time. 

+ The Save As command shows the dialog box to savethe existingfile with a new name, and it keepsthe originalfile 

as it is. 

+ The default file extension of LibreOffice Writer is .odt. 

• The vertical blinking line in the Document window is called Cursor. 

+ The Mouse Pointer changes its shape into I-beam when you bring it over the text, and referred a Text Select 

cursor. 

• Formatting means changing the overall lookofa document. 

• Textformatting is applied in a document to enhance the appearance of text and individual character. 

The Formatting toolbar holds the common text formatting options such as Font Name, Font Size, Bold, Italic, 

Underline, Font Colorand so on. 

Learning 
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BRAIN 

+ Superscript places the text slightly above the line of text whereas subscript places the texts slightly below the 

text baseline. 

+ The distance between thetext boundaries and the page margins is called Indent. 

+ The Page break feature allows you to insert a break in the page, and moves the cursorto the new page. 

Header and Footer are the identifiers that respectively run across the top and bottom of the document. 

The Columns feature of LibreOffice Writer lets you divide the page vertically into two or more columns. 

+ Usingthe Columns dialog box, you can insertcolumns in your document. 

A particular markthat represents some piece of information is called a symbol. 

Editing text means making corrections to it, and manipulating text in a manner that would lead to the desired 

end result. 

The Undo command allows you to cancel the last action performed. 

The Redo command reverses the action which is performed bythe Undo command. 

+ The Find & Replace feature of LibreOffice Writer automates the process of search as well as replacement of the 

text. 

+ By using the Go to Page command of Edit menu, you can directly jump from one page to another easily and 

quickly. 

+ Non-printing characters arethe charactersthat do notappear in a printed document. 

DEVELOPER 

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

Multiple Choice Questions: 

LibreOffice Writer is a popular  application. 

a. Database b. Presentation c. Word processing d. Graphic 

9. The LibreOffice Writer application opens a new document with the temporary name  

A 

1.  

a. Document b. Book c. Untitled 1 d. Book 1 

2. The larger window of the Writer program is called  window. 

a. Application b. Document c. Image d.None of these 

3. Where do you type the text in LibreOffice Writer? 

a. Text box b. Document window 

c. Application window d. None of these 

4. The vertical ruler formats the  alignment of text. 

a. Top b. Right c. Vertical d. Horizontal 

Learning 
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6. The status bar is located at the  of the LibreOffice Writer window. 

a. Top b. Centre c. Left d. Bottom 

7. Which menu contains the New option? 

a. Edit b. File c. Format d. Tools 

8. Which option allows you to save an existing file with a new name? 

a. Save b. Save As c. Save a Copy d. All of these 

9. What is the file extension of LibreOffice Writer document? 

a. .odt b. odp c. .odd d. .odw 

10. Which of the following is a keyboard shortcut to open an existing document? 

a. Ctrl+O b. Ctrl+F c. Ctrl+ N d. Ctrl+S 

11. Which of the following is a keyboard shortcut to perform undo? 

a. Ctrl+C b. Ctrl+Y c. Ctrl+X d. Ctrl+Z 

12. This key is pressed when you select non-consecutive text. 

a. Ctrl b. Alt c. Shift d. Tab 

13.  is a temporary storage location. 

a. Clipboard b. Rulers c. Menu bar d. Toolbar 

14, On which toolbar do you find the Check Spelling button? 

a. Formatting b. Standard c. Drawing d. Tools 

15. Which of the following keyboard shortcut is used to remove the formatting? 

a. Ctrl+L b. Ctrl+M c. Ctrl+N d. Ctrl+Z 

16. Which of the following is not available on the formatting toolbar? 

a. Copy button b. Bold button c. Underline button d. Font Color button 

17. This case converts every selected character in the reverse way? 

a. lowercase b. tOGGLE cASE c. UPPERCASE d. Small Capitals 

18. This is a keyboard shortcut to open the Go to Page dialog box. 

a. Ctrl+U b. Ctrl+G c. Ctrl+P d. Alt+G 

19. These characters do not appear in a printed document. 

a. Non-printing characters b. Symbols 

c. Letters d. None of these 

20. Which of the following is a correct way to access the Image dialog box? 

a. Insert>image> Picture b. Insert>Shape 

c. Format>Picture d. Insert>Image 

B. Fill in the Blanks: 

1. LibreOffice Suite which is  and software. 

2. A    refers to a set of written pages. 

3. The term WYSIWYG stands for  

4. Writer is a part of  

5. The    menu holds different views for document. 

6. A    is a set of predefined styles and settings that is used to create a new document. 
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7. You can move the cursor in a document by using the  Keys. 

8. The I-beam mouse pointer is referred to as a cursor. 

9. The .facilitates easy access and navigation between pages and different objects. 

10. You press the  keys to open the Template dialog box. 

11. The  command is highlighted when you have performed the Undo operation 

12. The lines indicate the spelling errors. 

13. A paragraph mark (i)  is an example of  mark. 

14. The distance between the text boundaries and the page margins is called  

15. To maintain the height and width ratio of a shape, hold down the key 

A. Multiple Choice Questions 

1.(c) 2.(c) 3.(a) 4.lb)  5.(c) 6.(dl 7.(b) 8.(bl 9.(a) 10.(a) 11.(d) 12.(al 13.(a) 14.(bl 15.(dl 16.(a) 17.lb) 18.(b) 19.(a) 20.(d) 

B. Fill in the Blanks 

1.Free,OpenSource 2.Document 3. WhatYouSeelsWhatYouGet 4.LibreOfficeSuite 5,View 6.Template 7.CursorControl 

8. Text Select 9. Navigator 10. Ctrl + Shift + N 11. Redo 12. Red wavy 13. Formatting 14. Indent 15. Shift 

SECTION 2: THEORY QUESTIONS-(SOLVED) 

What is word processing? 

Aps: Word processing is the use of computer software (a word processor) to enter, edit, format, store, retrieve, and 

print the document. 

What is word processor? 

Ans: A word processor is application software, which is capable of creating, editing, saving, and printing 
documents. 

3. Write names of any two word processor applications? 

Microsoft Word and LibreOffice Writer 

41. What is menu bar in LibreOffice Writer7  

s: This bar contains all the menu options present in the LibreOffice Writer application. When you select a menu, 

a submenu appears. Some submenu items show right hand side arrow next to the submenu name, which 

indicates that there is another submenu. 

Distinguish between Standard toolbar and Formatting toolbar. 

s: Standard toolbar: The Standard toolbar displays the icons of the commonly used commands such Save, 

Undo, Redo, New, Open, Cut, Copy, Paste, etc. 

Formatting toolbar: The Formatting toolbar contains the commonly used commands to format and beautify 

the text. It displays Font Name, Font Size, Font Color, Alignment icons, Bullets and Numbering icons, Indents 

and Highlighting icons on it. 

6. List the three different ways of creating a blank document in LibreOffice Writer. 

Ans: You can create a blank document in Writer in three ways: 

Click on the menu. Selectthe: option.The submenu appears. Selectthe submenu document 

option, Or 

Press key combination. Or 

Click on the button located on the Standard toolbar. The new document appears. 
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7. F-low a toolbar is different from a menu bar? 

Ans: The main difference between a toolbar and a menu bar is that a toolbar contains graphical icons that can be 
used to access the commands directly and quickly. Clicking on a toolbar icon immediately executes the 
command. 

On the other hand, a menu bar contains all the menus present in the application. Clicking on a menu opens up 
a submenu. For example, in LibreOffice Writer, when we click on File menu, a submenu appears that displays 

a list of options, such as New, Save, Print, etc. 

8. Describe the File menu of Writer. 

Ans: By clicking on the File menu, we can create a new file, open an existing file, save a file, print a file, and 
perform othertasks, 

9. Describe Undo and Redo commands. 

Ans: The Undo command allows you to cancel the last action performed whereas the Redo command reverses the 
action which is performed by the Undo command. 

10. How do you select a vertical block of text? 

Ans: To select a vertical block or a column of text that is separated by spaces or tabs, click on Edit>Selection 

Mode>Block Area or press Alt+Shift+F8. Now, drag the mouse to select a text. You will observe vertical 
selection. 

11. How do you copy text? 

Ans: Copying text means to keep the text at the original location as well as copy it to another location. To copy text, 
right-click on the selected text and select Copy. Now, place the pointer at the new position. Right-click and 
select Paste. 

12. What is the use of Cut and Paste commands? 

Ans: The Cut and Paste commands are used to move selected text at the new location. 

13. How do you move text at the new location in your document? 

Ans: To move the selected text at the new location, right-click on the selected text and select the Cut option. Bring 

the pointer at the location where you want to paste the text. Right-click on that location and select the 
option 

14. What is clipboard? 

Ans: Clipboard is a temporary storage location that can be used for short-term data storage and/or data transfer 
operations between documents or applications, using copy-paste or cut-paste operations. 

15, Explain Find and Replace. 

Ans: The LibreOffice Writer has a  Hci ? Peplace feature that automates the process of search as well as 
replacement of the text. This feature proves beneficial while looking for specific words in a large document. 

16. What are formatting marks? Why are they used? 

Ans: Non-printing characters are also known as formatting marks. These are basically used for formatting the 
document. The most common non-printable characters in word processors are space (.), non-breaking space 

(o), tab character (-), Line break (4i),  and paragraph mark (1) 

17. How does LibreOffice Writer help you to keep your document error free? 

Ans: LibreOffice Writer has a built-in dictionary and a set of grammatical rules to check the spellings and grammar 

of the text document. Thus, it reduces the chances of errors in a document. LibreOffice Writer uses the 
following wavy lines to indicate the errors: 

+ A red wavy line under a word signifies the misspelled word. 

+ A green wavy line under any word or sentence indicates a grammatical error. 

+ A blue wavy line under a word refers to a contextual spelling error. 

LearnIng 
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18. What do you understand by Thesaurus? Explain any one method to replace a word with its synonym. 

Ans: Thesaurus is a built-in dictionary that enables you to look up synonyms, antonyms, word substitutes, and 
alternative spellings. This feature increases your writing abilities and vocabulary that helps you to 

understand the text better. When you look up a word in the thesaurus, it will provide you a list of alternative 

words which you can use in place of an existing word. 

+ Right-click on the word whose synonym you would like to find. 

+ The shortcut menu appears. Choose a Synonym option from the list. 

+ A submenu appears displaying the list of words with similar meaning. 

+ Select the suitable synonym. 

+ You will find that the word in the document is replaced with the selected one. 

19. What is formatting? Explain different types of formatting that you can apply in your document? 

skns: Formatting means changing the overall look of a document. In LibreOffice Writer, you can apply different 

types of formatting — text formatting, paragraph formatting, and page formatting. 

20. How can you change case of selected text in your document? 

Ans: To change case of selected text, follow these steps: 

+ Select the text which case is to be changed. 

+ Click on the Format menu and then click on Text. 

+ A submenu appears. Select the required case. 

21. Which toolbar contains the common text formatting commands? 

Ans:  The formatting toolbar contains the common text formatting commands such as Font Name, Font Size, Font 

Color, Bold, Italic, underline, and so on. 

22. How can you assign a border to a paragraph? 

Ans: To assign a border to a paragraph, select a paragraph, click on Format> Paragraph. The Paragraph dialog 
box appears. Click on the Borders tab, and select the required border, border style, width, and color. Click 

on OK. 

23. What is Page break? How do you insert in a document? 

Ans: Page break is an important feature of LibreOffice Writer. It allows you to insert a break in the page, and 

moves the cursor on the new page. To insert a page break, position the cursor where you want to insert a 

page break, and then click on Insert> Page Break. 

24. What are headers and footers? How do you insert them in your document? 

kns: Header and Footer are the little identifiers that respectively run across the top and bottom of the document. 

They include such information, like page numbers, date, title of a book or chapters, author's name and 

slide show theme, etc. To insert header/footer, click on Insert> Header and Footer> Header/Footer > 

Default. Type required header or footer and click outside, once completed. 

25. What are columns? How do you divide a page into columns? 

Ans: The Columns feature allows you divide the page vertically into two or more columns. To divide a page into 

columns, click on Format> Columns. The Columns dialog box appears. Select the required number of 

columns, give spacing, and click on OK. 

SECTION 3: THEORY QUESTIONS-(UNSOLVED) 

1. What is LibreOffice Suite? 

2. What are the different components of the LibreOffice Writerwindow? 

3. Explain the Application and Document windows of the LibreOffice Writer. 
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Ctrl+C 

Ctrl+V 

Ctrl+O 

HABITS 

Habits are routines of behaviour that are repeated tend to occur subconsciously. Habitual behaviour 

often goes unnoticed in persons exhibiting it, because a person does not need to engage in self-analysis when 

undertaking routine tasks. Harbituation is an extrem,ç,mple form of lerning, in which an organism, after a 

period of exposure to a stimulus, stops responding to that stimulus in varied manners. Habits are sometimes 

corn pu isa ry. 

4. How can you save a document in LibreOffice Writer? 

5. How do you open an existing file in LibreOffice Writer? 

6. Describe the use of Navigator. 

7. Describe I-beam mouse pointer. 

8. What is the difference between Find, and Find & Replace option? 

9. What is the difference between Replace and Replace All? 

10. Describe text formatting. 

11. What is the difference between superscript and subscript? 

12. What is indent? How do you insert indent in your document. 

13. How do you open the Page Style dialog box? 

14. What is Page break? 

15. How can you insert symbols in your document? 

SECTION 4: APPLICATION BASED QUESTIONS-(SOLVED) 

1. Rajan is confused about the functions of all the shortcut key combinations, he has learnt till now. So, help him 

to fill the following table? 

Shortcut Key Functions 

Ctrl+A 

Ctrl+N 

Ctrl+S 

Ctll+x 

Shortcut Key Functions 

Ctrl+A Select the entire document. 

Ctrl+N Create a new blank document. 

Ctrl+S Save your document. 

Ctrl+X Cut the selected text.  

Ctrl+C Copy the selected text. 

Ctrl+V Paste the selected text.  

Ctrl+O Open an existing document. 

Ans: 

2. Emma was asked to write a few lines on the topic 'Habits' in notebook. While checking, her teacher found a 

few spelling mistakes. The teacher asked her to type the same text in Word and also asked her to correct the 

spelling mistakes and then submit the hard copy. Help Emma to complete the assignment by guiding her 

with relevant steps. 

1 n. Emma has typed the following text in Writer: 
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HABITS 

Habits are routines of behaviour that are repeated regularly and tend to occur subconsciously. Habitual 

behaviour often goes unnoticed in persons exhibiting it, because a person does not need to engage in self-

analysis when undertaking routine tasks. Habituation is an extremely simple form of learning, in which an 

organism, after a period of exposure to a stimulus, stops responding to that stimulus in varied manners. 

Habits are sometimes compulsory. 

+ The red wavy lines mark the presence of spelling mistakes. 

+ Open the Spelling dialog box by pressing the function key. 

+ From the Suggestions box, select the correct word that fits in place of the misspelled word and click on 

the Change button. 

Your teacher has asked you to write two paragraphs on the topic 'Habits'. After completing this task, the 

teacher wants you to find all the keywords matching the word, 'Habits' and replace them by the keyword, 

'Daily Actions'. Support your answer with the relevant screen shots. 

Is. You have written the following text on Habits. 

+ On the Standard toolbar, click on the nd & Replace button 

+ The Find and Replac dialog box appears. 

+ In the Find field, enter the keyword Habits, 

+ In the Replace section, enter the keyword Daily Actions and click on the Replace AH button. Observe 

the change. 

Rahui was asked to compose an essay on Good Manners. He forgot about this assignment and copied the 

following essay from the Internet. However, there were some errors in the essay. The conclusion was in the 

beginning and the introduction was immediately after the conclusion. How will Rahul fix this issue? 

Ptn4 p,4a. naaNy k. ry ,d .t.. n 

rs. Select the conclusion paragraph and cut it using keys Ctrl+X. Move the cursor to the end of the essay and 

paste it using Ctrl+V. In this way the conclusion paragraph will shift to the end. 

Saumya has prepared a small algorithm to copy and paste a piece of text to a new location. She has made 

some mistakes in the order of steps. Use the Editing features of Cut and Paste to rectify the order. 

a) Select the desired text. 

b) Paste it in the new location. 

c) Copy the selected text. 

The mistake lies in step (b) and (C). Select step (c). Now press Ctrl+X. Bring it to the position of step (b). Now 

press Ctrl+V to paste that step. Step (b) automatically moves to the next line. Hence, the correct 

algorithm is: 

a) Select the desired text. 

b) Copytheselectedtext. 

c) Paste it in the new location. 

j 
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b. The computer teacher found Kabir talking in the class. As a punishment, his teacher asked him to write "I am 

Sorry" five times in a Word processor. Suggest him a shortcut so that he does not have to write the text again 

and again. 

Ans: Write once, "I am Sorry". Select the entire sentence and press Ctrl+C. Now, press Ctrl+V four times and you 

will see the output as: I am Sorry. lam Sorry. Jam Sorry. lam Sorry. lam Sorry. 

SECTION 5: APPLICATION BASED QUESTIONS-(UNSOLVED) 

1. The teacher has asked Ramya to create and save a new document in LibreOffice Writer using the Shortcut 

key combination. Help her in finishing this task. 

2. Subodh's teacher has given him a task to type a slogan 'Keep Your School Clean' for 50 times. Suggest him a 

shortcut, so that he could finish his assignment quickly. 

3. Anamika has written an essay on 'Festivals of India' in LibreOffice Writer. She has discussed Christmas 

before Diwali. Her teacher has asked her to change the order of the paragraphs. Suggest her the method to 

move a paragraph and paste it at the end by using the shortcut keys. 

4. Ashish has downloaded an article on Plight of Women in India from the Internet. The article has a lot of 

spelling errors and the points within the article have not been marked properly. Which features will you 

suggest him to use in order to make the article error free and presentable? 

5. Abhijeet is a poet. He wants to write a poem on 'India'using Writer. He wishes to write every single line in a 

different font style. Can you suggest him some features of the Writer using which he can write his poem with 

different font styles? 

6. Hotel 'The Marriott' is hosting a seminar which emphasizes on the growing needs of Hospitality business. 

This seminar will be attended only by the male owners of different hotels. But by mistake, the receptionist of 

the hotel typed the title 'Mrs' in place of 'Mr' before the names of all the invitees. What method will you 

suggest to the receptionist to rectify the mistake without wasting much time? 

 

For Better Concept Clarity 

 

1. Let us write three paragraphs on the topic "Life is an Action, Not Contemplation". 

Life offers many opportunities to us, to succeed, if seen closely. But action is required for it. Goethe, a 
German philosopher rightly remarked that 'life is action, not contemplation'. Even Charles Darwin proved 
that life is a continuous struggle for the 'survival of the fittest'. 

One who is not suitable perishes-this is the nature's law. Action is necessary to adjust ourselves in any possible 
circumstance. Dreams are the necessary propellers but life itself is not merely dreams or a reverie. Sitting on a 
chair and brooding; man would never have been able to reach the moon. But man thought, imagined, and 
strove. 

A life of thought and reflection will be futile if man does not try to make it come true in real life. That does 
not mean contemplation is futile and vain. No! in fact all great ideals and philosophies are the outcome of 
great men's contemplation. But these philosophies and ideals would have easily been forgotten, if they had 
not been applied to real life. 

+ Swap the positions of paragraph 2 and 3. 

+ Copy the first paragraph and paste it in the end. 

+ Insert two new lines between Line 1 and Line 2 of second paragraph. Make sure your text does not 
overwrite the existing text. 

+ Apply the formatting effects as needed that you have learned in Writer. 

+ Save the document with the same name as that of the topic. 

Close the document as well as the Writer application. 
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2. Type the followingtext and replace the keyword 'SmboI' with 'Sign' in the entire document. Make use of 

all the options discussed in the Find and Replace topic. 

The Indian rupee has now got a unique symbol, a blend of the Devanagri 'Ra' and Roman 'R'- thus joining 

the elite currencies, like US dollar, Euro, British Pound, andJapanese yen in having a distinct identity. 

The new symbol, designed by lIT Bombay post-graduate D Udaya Kumar, was approved by the cabinet-

reflecting that the Indian currency, backed by an over-trillion dollar economy, was finally making its 

presence felt on the international scene. 

Though the symbol will not be printed or embossed on currency notes or coins, it would be included in the 

'Unicode Standard' and major scripts of the world to ensure that it is easily displayed and printed in the 

electronic and print media. Among currencies with distinctive identities, only the pound sterling has its 

symbol printed on the notes. 



¶ 

2 ATable X X2_L.mu..m.0  

'1• A 

bore Options... I 

Acaden'c 
Box List Blue 
Box List Green 
Box List Red 
Box List Yellow 

.eq8nt 

Options Specify the number of rows 

and columns In a table. 

Defines the first row of the table as Its Heading] 

Heading rows 1  

L] DontwItabfepages 

Sty$ Prevents the table from 
spanning more than one page. None 

'Repeats the row 
headings on 

subsequent 
pages If the table 
spans more than 

one page 

j P.b Mg Sscn 

NoOb 6 7 8 21. 

Mid 1.1 12 13 36 

So.th 1$ 1.7 18 51. 

.33 36 ioa 

UNIT - HI:  Digital Documentation 

CHAPTER 

Creating and Using Table 
A table is an organized arrangement of text in the form of rows and columns. Table is a useful wayto organize and present 

large amount of information, for example: 

Technical, Financial or Statistical reports 

Product catalogues showing descriptions, prices, characteristics, and photographs of products 

Bills or Invoices 

Lists of names with address, age, profession, and other 

information 

Tables can often be used as an alternative to spreadsheets to organize 

data. A well designed table conveys information in a more meaningful 

way ratherthan the text written in the form of a paragraph. 

CREATING A TABLE 

Using Grid 

To directly insert a table with the default properties, follow these 

steps: 

+ Click on the Table icon on the Standard toolbar. 
FIg. 7.1:  CreatIng Table through Toolbar 

Insert Table 

Gerai 

ame: Thblel 

olurTy1s 2 

f
iPec1fva name for 

the table in this field. 

  

 

+ A grid of rows and columns will visible. Drag the 

mouse over the grid to select the required number of 

rows and columns. Using this option, you can insert 

maximum 10 columns and 15 rows. 

         

         

   

Rows 2 

    

           

           

Using Insert Table Dialog Box 

To insert a new table using the Insert Table dialog, follow 

these steps: 

+ SelectlnsertTablefromtheTablemenu.Or 

+ Press Ctrl+F12. 

+ The Insert Table dialog box opens where you can 

specifythe properties forthe table. 

+ Specify the number of columns and rows under the 

General section. 

help 

   

cancel + Choose your preferred Options and Style, if required. 

     

Fig. 7.2; Insert Table Dialog Box 
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+ Click on Insert to insert a table with the mentioned 

properties. 
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Fig. 7.3: Inserting Table 

ENTERING DATA IN A TABLE 

+ lick inside a cell and type the text. To move to the next adjoining cell, either press 

the Tab key or the Right Arrow key. 

+ To move to the previous cell, either press the Shift +Tab key combination or the Left 

Arrow key. 

+ The Up and Down Arrow keys will move the insertion point above or below its 

current location. 

To selecttext in a Table: 

To Select Action Do Like This 

A cell Triple-click inside cell. 

A row 
Move the mouse to the left of the row 

margin and click the left mouse button. 

A column 

Place the mouse pointer over the top of 

the column and click the left mouse 

button. 

An entire 

table 

Place the mouse pointer over the top left 

corner of a table and click. 

F. 71:  Selecting Different Parts of a Table 

1II  MODIFYING A TABLE 

After entering data in a table, you can make changes in the data as needed. You can insert rows, columns or cells in a table 

to accommodate new contents. Similarly, you can delete unwanted rows, columns or cells from a table. 

INSERTING COLUMNS/ROWS IN ATABLE 

While creating and making entry in a table, you might need to add rows/columns in between. LibreOffice Writer provides 

thefacilityto add columns to right or left ofthe existing column and insert rows above or belowthe selected row. 

To insert a row/column, followthese steps: 

Click anywhere in the row/column, adjacent to which you wantto add the new row(s)/column(s). 

+ TheTable toolbar appears. Click on any of the following buttons as per requirement: 

+ RowsAbove:  Click on the RowsAbove button to insert a new row above the selected row. 

+ Rows Below:  Click on the Rows Below button to 

insert a new row below theselected row. 

+ Columns Before:  Click on the Columns Before 

button to insert a new column before the selected 

column. 

+ Columns After:  Click on the Columns After button 

to insert a new column aftertheselected column. 
FIg. 7.5: Insert Buttons for Rows and 

Columns on the Table Toolbar 
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To insert rows/columns: 

+  Click anywhere in the row/column and then click on Table>lnsert. Select a command, such as Rows Above, Rows Below, 

Columns Before, and ColumnsAfteras peryour requirement. Or 

+ Right-click on the selected rows or columns. Select the Insert option and choose the desired option. 

DELETING COLUMNS/Rows IN A TABLE 

To delete row(s)/column(S), followthese steps: 

+ Select row(s) or column(s) which is/are to be deleted. 

~ The Table toolbar appears. Click on any of the following buttons as per requirement: 

+ Rows: Click on the Rows button to delete selected rows. 

+ Columns: Click on the Columns button to deleted selected columns. 

Fig. 7.6: Delete buttons 
on the Table Toolbar 

 

-ir' i  

   

   

To delete selected rows/columns: 

+ Click on Table>Delete. Select a command, such as Rows or Columns as per your requirement. Or 

+ Right-click on the selected rows or columns. Selectthe Delete option and click on either Rows or Columns. 

SPLITTING AND MERGINGTABLES 

Splitting a table means dividing a table into two tables, and merging two tables 

provide a way to consolidate two tables into one table. 

Splitting Tables 

To split a table into two, follow these steps: 

+ Place the cursor inside a celifrom where you want spiltthe table. 

+  ClickontheTablemenu. 

+  SelecttheSplitTableoption. 

+  TheSplitTabledialogboxappears. 

+  Select the Copy heading option, if you want headings on the split table, or No heading 

option, if you do not want any headings on the table. 

+ Click on OK. Table will be split into two tables. 

Tables can be split in horizontal manner. 

MergingTables 

To merge two tables to make it one, follow these steps: 

Pr.ae th. O.I.t.k.y 

- Place the pointer in between two tables and press the Delete key to remove the Ne (Class ISabjeci Cit) 

Peel. IX Jcasc.as Dl 

spacing. 
Km IX Ceepuas P..e 

+ Selectanycellinthetable. au IX Cpii Na 
S,i IX Ce. 

+ Click on the Table menu and select the Merge Table option. Both the tables will be 
Fig. 7.9: 

merged. Merging Two Tables 
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DELETING A TABLE 

If you want to delete the entire table from your document, followthese steps: 

+ Clickanywhereinatable. 

+ ClickonTablemenu. 

+ Select the Delete option then the Table option. 

COPYING A TABLE 

In LibreOffice Writer, you can easily create a copy of table and paste it into another part. To copy a table, follow these 

steps: 

+  Clickanywhereinatable. 

+ ClickonTablemenu. 

+ ChoosetheSelectoptionthentheTableoption. 

+ Click on the Edit menu and selectthe Copyoption or press Ctrl+C. Selected table will be copied into the clipboard. 

+ Place the cursor where you want to insert a copied table. 

+ Click on the Edit menu and select the Paste option or press Ctrl + P. Selected table will be inserted at the cursors 

position. 

MOVING A TABLE 

To move a table from once location to another, follow these steps: 

+  Clickanywhereinatable. 

~  Clickonlablemenu. 

+,  ChoosetheSelectoptionthentheTableoption. 

+ Click on the Edit menu and select the Cut option or press Ctrl + X. Selected table will be disappeared from its original 

location. 

+ Place the cursorwhere you want to insert the table. 

~ Click on the Edit menu and select the Paste option or press Ctrl+ P. Table will be displayed at the cursor's position. 

 

ASSESSMENT TIME 

  

Answer the Following Questions: 

1. What is a table? 

2. What is the difference between a row and a column? 

What is a cell? 

4 What are the different ways of inserting a table? 

5 How can you delete a row? 

6 How do you split a table? 

 

For Better Concept Clarity 

 

1. Insert a table of three columns and five rows in a document, using the different insertion options available. 

Then insert a column to the left of the first column and to the right of the last column. Now insert a row 

above the first row and a row below the last row. 

2. Create a list of addresses of your friends along with their date of birth. 
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Quick View 

The shortcut to switch to 

the Full Screen mode is 

Ctrl + Shift +J. 

I 
UNIT  -3:  Digital Documentation  

Printing a Document 

A printed output of a document or an image is called a hard copy. From time to time, you 

need hard copies of your work. Just like any other word processor, the LibreOffice Writer 

provides the options to print a document, analyse its preview, and control the printing 

properties. 

II  PRINTING A DOCUMENT USING PRINTOPTION 

CHAPTER 

After approving the document's appearance using the Print Preview mode, you are ready to print the active document. 

Assuming that you have installed a printer, so to take a print out of the current document, click on the Print button 

tM]  present on the Standard toolbar. 

PRINT PREVIEW 

What do you do in the final hour before appearing for an exam? Do you study new topics or revise the topics which you 

have studied till now? 

Obviously, you want to review and revise whatever you have learnt till now. 

Similarly, LibreOffice Writer provides you a feature to preview a document before you send it for printing. This feature 

has many advantages: 

• It helps you to check whether the written 

text falls within the page margins or not. 

+ It helps you to preview the overall 

formatting ofyour document. 

Let us learn how to use this feature: 

Type some pages of text. 

Click on the Toggle Print Preview button 

: present on the Standard toolbar. You 

can also select the Print Preview 

(Ctrl+Shift+O) option from the File menu. 

You will see the preview of your document. 

This is howthe final printout will look. 

FIq.8.1: Previewing the Document 

Just above the Print Preview, you willfind the Print Previewtoolbar. You can also select the options from here as peryour 

convenience. Let us discuss the Print Preview toolbar. 
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Fig. 8.2: PrInt Preview Toolbar 

III  CONTROLLING PRINTING 

If you want to change the default Print settings, click on the File menu and select the Print option. You will see the Print 

dialog box. 

+ Choose the desired number of copies and page settings. 

+ Select the name of the printer under Printer. 

+ Once you have finished, click on OK. 

+ The printerwill print a copy of your current document. 

t.b..Oø.o. 

H]1 J 

Fig. 8.3: Print Dialog Box 

PRINTING ALL PAGES, SINGLE PAGES AND MULTIPLE PAGES 

The Print dialog box lets you select the pages you want to print and the number of copies you want. 

+ Click on the File menu and then select the Print (Ctrl+P) option. The Print dialog box will appear. 

Under the Range and Copies section, select All pages to print alithe pages of a document. 

Fig. 8. Print Dialog Box 

U-
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Fig. 8.6: 
File Menu 

Select the Pages option to print the 

specified range of pages from the 

document (like 5-10). 

Selecting the Selection option will print 

only the selected text from the 

document. 

You cn select the "Print in reverse page 

order" option, if you want to print from 

the last page to first page. This leads to 

easy arrangement of hard copies of the 

pages. 
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ASSESSMENT TIME 

Answer the Following Questions: 

1, What do you understand by the term hard copy? 

2. Why should you preview your document before printing? 

3. What is Print Preview? 

4. From which toolbar can you access the Toggle Print Preview button? 

5. How do you open the Print dialog box? 

 

For Better Concept Clarity 

 

Preview a 5-page document and view each page by zooming them to 150%. Take the printout of the odd 

numbered pages i.e., 1, 3, 5. 
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UNIT -  III: Digital Documentation

CHAPTER 9 
Using Mail Merge 

nb usiness or any official matters, it is often required to send letters with similar information to different people. The 

letters require the name and address of each recipient to be printed on the top. So, changing the address each time 

would be a very long process and a wastage of time and effort. 

In such case, you can use Mail Merge feature of LibreOffice Writer. Let us learn to use mail merge to print letters. 

fl  CONCEPT OF MAIL MERGE 

The Mail Merge feature is used to combine a data source with the main document. It saves our time and energy to send 

letters at multiple addresses. It primarily enables automatingthe process of sending bulk mailto customers, subscribers 

or general individuals. To perform mail merge, a Writer document is required. Either you can create a new document or 

use an existing one. The following are some benefits of mail merge: 

Produce mass mail 

Make changes in letters easily 

Much easierto proof readjust one letter as compared to thousands of letters 

+ Astandard letter can be saved and reused multiple times 

+ 

DATA SOURCE 

Data source consists of mailing list. For example, name, address, city, PIN, 

telephone number, etc. The data is organised in a tabular form along with 

the field names. The data source is associated with the main document, so 

its field names can be used in the main document, and it becomes easy to 

mege addresses along with the main document. 

MAIN DOCUMENT 

Itithe documentthat containsthe textthat you wish to send to alithe recipients. 

MERGED FIELD 

It is a data item, such as NAME, ADDRESS, CITY, PIN, etc., which instructs LibreOffice Writer where to insert the data 

source (names, addresses) in the main document. 

• fl  MAIL MERGE IN LIBREOFFICE WRITER 

Mail merge involves in the following steps: 

Creating a main document 

- Creating a data source 

Entering data in fields 
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Merging the data source with the main document 

Editing individualdocument 

Printing and saving the merged letter 

To start the Mail Merge Wizard eitherto create form, letters or send e-mail messages to many recipients, do the following 

steps: 

Choose Tools menu and select the Mail Merge Wizard option. 

The Mail Merge Wizard opens. 

Now followthe given steps. 

LI CREATING A MAIN DOCUMENT 

STEP 1: SELECTSTARTING DOCUMENT 

In the Mail Merge Wizard, specify the document that you want to use 

asa base forthe mail merge document. Forexample, 

Select Use the current document radio button. This option uses 

the current Writer document as the base to merge the document 

with data source. 

+  ClickontheNextbutton. 

STEP 2: SELECT DOCUMENTTYPE 

In this step, you have to specify the type of mail merge document to 

create. 

~ Select the 'Letter radio button. 

This option creates a printable mail merge document. 

FIg. 9.3: Selecting Document Type 

CREATING THE DATA SOURCE 

STEP 3: ENTERING DATA IN THE FIELDS 

As the name suggests, in this step, you have to specify 

the recipients for the mail merge document as well as 

the layout of the address block. Observe, by default the 

Second checkbox under the Insert address block 

section is selected. 

Click on the Select Address List button. 

• The SelectAddress List dialog box appears. 
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Let's Know More 

Field is a column in a data 
source that contains one 
type of information. For 

example, Name, Address, 
City, etc. 

Select an address hst. Cbck Add... to select recipeots from a different list. If you do not 

have an address list you cart create one by clicking (tease..?. 

Your recipients are Currently selected from 

Name Table 
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Now, click on the Create button to create a new address list. 

The NewAddress List dialog box appears. 

+ 

+ 

stht 

Fig. 9.5: Select Address List Dialog Box Fig. 9.6:  New Address List Dialog Box 

+ Click on the Customize tab to add or remove fields. 

+ Now, enter the data in the respective fields, and click on the New button. 

+ Clicking on theAdd tab opens the Open dialog box to insert an already existing address list. 

+ Pressing the Tab key you can move between fields, while typing the information. 

Enter records of yourfriends and relatives. Click on OK. 

You will get the Save dialog box. Specify a name in the Name box and click on the Save 

button. 

The Select Address List dialog box will appear. 

The dialog box displays the address file added by you. Select it and click OK. Now, click on 

the Next button. 
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Select Address list 

Fig. 9.7:  Added Address File 
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Fig. 9.8:  Creating a Salutation 
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Fig. 9.9: Adjusting Layout 
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MERGING THE DATA SOURCE WITH MAIN DOCUMENT 

STEP 4: CREATE A SALUTATION 

In this step, specify the properties for the salutation to be added in 

the mail merge document. 

+ Deselectthe Insert personalized salutation checkbox. 

Click on the drop-down arrow of the General Salutation and 

select any one of them from the displayed list. 

The selected salutation will be displayed in the Preview pane. 

+ Now, click on the Next button. 

If you want to create your own layout of Address, then you have to deselect the second checkbox under the Insert address 

block section in Step 3. Then, click on the Next button. 

In Step 4, select the Insert personalized salutation checkbox. Under this section, you can specify different salutations based 

on the geriderof the recipient. Here, you will find various fields as described below: 

+ Female: It lets you define the personalized greeting for a female recipient. Click on the Newtab. The Custom Salutation 

(Female Recipients) dialog box opens. Define the salutation. For example, Text (Hello/Hi/Dear) First Name, Last Name, 

Address, City, State, Telephone Number etc. Click OK. 

Similarly, you can define the personalized greeting fora male in the Male text box. 

+ Field name: Select the field name Gender. 

+ Field value: Type the field value Female. 

+ While doingthese steps, do not add anysalutation in the General Salutation text box. 

+ Preview: The selected salutation will be displayed inthe Preview pane. 

STEPS: ADJUST LAYOUT OF ADDRESS BLOCK AND SALUTATION 

In this step, you can specifythe position of the address blocks 

and salutations on the documents. 

In the Address block position section: 

§ Select the Align to text body checkbox. The address 

block will be left aligned. 

IntheSalutation position section: 

+ Press either Up or Down button as per your 

requirement. 

Using the Zoom spin box, you can increase or decrease the 

view of page preview. 

Now, click on the Finish button. 



Recap
Atable is an organized arrangement of text in theform of rows and columns. 

After entering data in a table, you can make changes in the data as needed. 

+ Splitting a table means dividing a table into two tables. 

+ Mergingtwo tables provides a wayto consolidate two tables into one table. 

+ A printed output of a document oran image is called a hard copy. 

+ To print a single copy of the current document, click on the Print button present on the Standard toolbar. 

+ Mail Merge primarily enables automating the process of sending bulk mail to customers, subscribers or 

general individuals. 

+ Data source consists of mailing list. For example, name, address, city, PIN, telephone number, etc. 

+ Main document isthe document that contains the textthat you wish to send to alithe recipients. 

+ Merged field is a data item that instructs LibreOffice Writer where to insert the data source (names, 

addresses) in the main document. 

+ To perform mail merge, a word document is required. Either you can create a new document or use an 

existing one. 

You should always save the main document itself so that it can be used for another mail merge. 

EDITING INDIVIDUAL DOCUMENT 

STEP 6: PREVIEW AND EDITTHE DOCUMENT 

Once you have finished with the Mail Merge Wizard, the Mail Merge toolbar appears. Using the Mail Merge toolbar, do 

thefollowing: 

+ ro preview the document of a particular recipient, enter the record number of a recipient in Current Mail Merge 

Entry box. 

+ Ifyou want to exclude the current recipient from this mail merge, select the Exclude recipient  ) ] checkbox. 

+ Click on the Edit Individual Documents button, and editthe document individually if required. Once you are done 

with the editing, save the letters. 

Jj  SAVING AND PRINTING THE MERGED LE1TERS 

You can save, print, or mail the merged document. You should always save the main document itself so that it can be used 

for another mail merge. To save and print merged documents, follow these steps: 

Click on the Save Merged Document button on the Mail Merge toolbar. 

The Save merged document dialog box appears. Selectthe required option. 

Click on the Save Documents button. 

After saving the document, click on the Print Merged Documents button. 

The Print merged document dialog box appears. 

Select printer name in Printer box. 

Select the Print all documents option if you want to take printouts of all the merged letters, or select a range of 

documents in From box. 

Click on Print Documents button. 
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ASSESSMENT TIME 

  

Answer the Following Questions: 

1. What is Mail Merge? 

2. List any two benefits of Mail Merge. 

3. Distinguish between main document and data source. 

4. Which menu do you select to execute the Mail Merge option? 

5 How will you create a Recipient list for the main document? 

For Better Concept Clarity 

Your school is organising an Inter-School Computer Quiz. You are a member of the School Quiz Club. 

Hence, your teacher has asked you to create an invitation letter to seek participation of various schools in 

the contest. Use the Mail Merge wizard to create letter and merged with the recipient list. 

Prepare a list (Data Source) of your friends. Using Mail Merge feature, create an invitation letter and invite 

them on your Brothers marriage. 

BRAIk DEVELOPER 

 

SECTION 1: OBJECTIVE TYPE QUESTIONS - (SOLVED) 

A. Multiple Choice Questions: 

1. Which of the following toolbars has the Table command? 

a. Standard Toolbar b. Formatting Toolbar 

c. Drawing Toolbar c. None of these 

2. Which shortcut key is used to insert table? 

a. AIt+F12 b. Ctrl+F12 

c. Shift+F12 d. Shift+Ctrl+F12 

3. This key is used to move to the next adjoining cell in a table. 

 

a. Tab key b. Right Arrow key 

c. Shift + Tab d. Both a and b 

4. On which button do you click to insert a new row below the selected row in a table? 

a. Rows Below b. RowsAbove c. Rows Previous ci. Rows Next 

5. Which of the following is a correct way to split a table? 

a. Table>SplitTable b. Table> Split 

c. Split>Table d. None of these 
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6. A printed output of a document or an image is called: 

a. Soft copy b. Hard copy c. Both a and b 

7. It is a keyboard shortcut to take printouts of a document in LibreOffice Writer. 

a. Ctrl+A b. Ctrl+P c. Shift+P 

8. Which keyboard shortcut is used to view the print preview of a document? 

d. None of these 

d. None of these 

a. Ctrl+Shift+O 

c. Ctrl+Shift+V 

b. Ctrl+Shift+P 

d. Ctrl+Shift+M 

9. It lets you select the number of copies and the pages you want to print. 

a. Save As dialog box b. Paragraph dialog box 

c. Print dialog box d. None of these 

10. Mail merge allows sending same letter or mail to  recipients at same time. 

11.  

a.Two b.Three 

 consists of mailing list. 

a. Main document b. Data Source 

c. Multiple d. None of these 

c. Fields d. All of these 

12. It is the document that contains the text that you wish to send to all the recipients. 

a. Main document b. Data Source c. Fields 

13. This command is used to start the Mail Merge Wizard. 

d. None of these 

a. Mail Merge>Tools 

c. Tool>Mail Merge 

b. Tools>Mail Merge Wizard 

d. None of these 

14. It instructs LibreOffice Writer where to insert the data source (names, addresses) in the main document. 

a. Merged field 

c. Merged document 

b. Merged cell 

d. None of these 

15. Which of the following can be done using the Mail Merge toolbar? 

a. Preview document b. Edit document individually 

c. Print merged document d. All of these 

B. State True or False: 

1. A table is an organised arrangement of text in the form of rows and columns. 

2. You cannot insert a table in a Writer document. 

3 The Tab key moves the cursor to the previous cell in a table. 

4j Tables can be split in horizontal manner only. 

5. You can change the default print settings in LibreOffice Writer. 

6. You cannot edit a document in the Print preview mode. 

7. You cannot take prints in reverse order, i.e., print from the last page to first page. 

8. Data source contains the text you wish to send to all the recipients. 

9. Field is a column in a data source that contains one type of information. 

10. Merge field is the feature that is used to combine a recipient list with a main document. 

A. Multiple Choice Questions 

1. (a) 2. IbI 3. (d) 4. (a) 5. (a) 6. (b) 7. (b) 8. Ia) 9. (c) 10. (ci 11. (b) 12. (a) 13. )b) 14. (a) 

15.(d) 

B. State True or False 

1.(T) 2.(F) 3.)F) 4.(T) 5.(T) 6(T) 7.(F) 8.(F) 9.(Tl 10.(T) 
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SECTION 2: THEORY QUESTIONS - (SOLVED) 

1. Define the term table. Explain the use of a table in a document. 

Ans: A table is an organised arrangement of text in the form of rows and columns. Table is a useful way to organise 

and present large amount of information. For example: 

+ Technical, Financial, or Statistical reports 

+ Product catalogues showing descriptions, prices, characteristics, and photographs of products 

+ Bilisorinvoices 

Lists of names with addresses, age, professions, and other information. 

Tables can often be used as an alternative to spreadsheets to organise data. A well-designed table conveys 

information in a more meaningful way rather than the text written in the form of paragraph. 

2. How can you create a table in LibreOffice Writer? 

Ans: To create a table in LibreOffice Writer, follow these steps: 

+ Click on theTable option on the Standard toolbar and select the required number of rows and columns. Or 

+ Click on the Table menu and click on the InsertTable option. The Insert Table dialog box appears. Specify 

number of rows and columns and click on OK. 

3. How do you insert a row in a table? 

Ans: Click anywhere in the row and then click on Table>inserL. Select Rows Above or Rows elov. command as per 

your requirement. 

4. How do you spUt a table in LibreOffice Writer? 

Ans: To split a table, place the cursor inside a cell and click on Table> Split Table. The Split Table dialog box appears. 

Select the required option and click on OK. 

5. How can you print a document? 

Ans: To print a document in Writer, click on the File>Print or press Ctrl + P. 

6. What is the use of Print PreviewT 

Ans:  The Print Preview feature helps us to preview the overall formatting of our document. 

7. What is Mail Merge? 

Ans: The Mail Merge feature is used to combine a data source with the main document. 

8. Write any three benefits of Mail Merge. 

Ans: The following are some benefits of Mail Merge: 

+ It is used to produce mass mail. 

We can easily make changes in letters. 

It is much easier to proof one letter than thousands of letters. 

SECTION 3: APPLICATION BASED QUESTIONS - (SOLVED) 

1. Sharmishtha is preparing a list of clothes which have to be bought for Durga Puja for her entire family. 

She has a rough list with data, help her organize the rough information below in tabular form. 

Father - 2 shirts, 2 trousers 

Mother - 3 Sarees 

Sharmishtha - 2 Jeans, 3 tops 

Ar Click the Table icon on the Standard toolbar. A grid of rows and columns will visible. Drag the mouse over 

the grid to select 3 columns and 6 rows and fill the following information: 
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Family Member Items Quantity 

  

Father Shirts 2 

Father Trousers 2 

Mother Sarees 3 

Sharmishtha Jeans 2 

Sharmishtha Tops 3 

2, Soniya wants to preview a 5-page document and view each page by zooming them to 150%.  Also, she 

wants to take the printout of the odd numbered pages i.e., 1, 3, 5. 

Ans: The following are the steps to preview and print a document: 

Click on the Toggle Print Preview button on the Standard  toolbar. 

Enter I O%  in  Preview Zoom box available on the Print Preview  toolbar. 

Click on the File>Print. 

The Print dialog box appears. Enter page numbers 1, 3, 5 in Pages box. 

Click on OK. 

SECTION 4: APPLICATION BASED QUESTIONS - (UNSOLVED) 

1. Swati has a puppy named Ricky. Since she keeps on forgetting its daily diet, so she wants to prepare a 

weekly diet calendar for Ricky. She does not know how to organise it. Suggest a feature of LibreOffice 

Writer using which she can design the calendar. 

2. Raghav has designed a table of chemical formulae of various substances. He wants to add some more 

chemical formulae in the same table. Suggest how he could modifiy the table. 

3. Radhika has purchased a brand new luxury car. She wants to celebrate her happiness with her friends 

and relatives. She wants to extend a personal invitation to each one of them without typing their names 

and addresses time and again. Which method could she use do this? 

4. Suchitra is an office assistant and handles all the correspondence work of the company. In the current 

month her company has made five new clients. Where will she add the contact details of these new 

clients while using the mail merge feature? 

SECTION 5: SHORT ANSWER TYPE QUESTIONS - (UNSOLVED) 

1. What is table? 

2. How do you merge tables? 

3. What is data source? 

4. How do you open the Print dialog box? 

5. What is mail merge? 

SECTION 6: LONG ANSWER TYPE QUESTIONS -  (UNSOLVED) 

1. Discuss any one method to create a table in LibreOffice Writer. Prepare your report card of class IX in 

table format. 

2. Explain the method of adding rows and columns in an existing table as described: 

a. A row above the second row 

b. A column to the left of the first column 

3. How can you copy a table in LibreOffice Writer? 

4. How do you create a new recipient list? 

5. Explain the general options of the Print dialog box available in LibreOffice Writer. 

Learning 
Computers with 



fiVIt4  I  • For Better Concept Clarity 

Create a table which contains the following fields. Enter the records of any five of your friends and save the 
table. 

a. Name b. Gender c. Date of Birth d. Postal Address e. E-mail Address 

+ Create a table of 5 x 5. 

+ Enter the records of your five friends. 

+ Add the title at the top: Friends Database. Use the font styles to beautify the title. 

+ Insert two columns after the column Date of Birth in the table and add the fields — Age and Hobbies, 
respectively. 

+ Insert three rows before last row. 

+ Split the table from 4th row. 

+ Save the table. 

Divide the class into four groups and allocate different topics to each group from the following options: 

+ Uses of tables in Writer document 

+ Use of Pint preview 

+ Benefits of Mail Merge 
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UNIT - IV: Electronic Spreadsheet 

CHAPTER 10 

  

Creating a Spreadsheet 

ISII  INTRODUC11ON TO SPREADSHEET 

The term 'spreadsheet" is used widely in accounting and business today. Earlier, the accounting records were 

maintained manually on oversized sheets of papers called ledgers. These ledgers were used to record and calculate the 

monetary transactions of a company. The transaction data used to be arranged in the form of a table with rows and 

columns. Later on, the need arose to maintain a large numberof records, which was difficult to fit onto a page. This led to 

the concept of spreading the data across pages and thus, the concept of a spreadsheet came into being. 

Caic is the spreadsheet component of LibreOffice. It is one of the most professional and advanced spreadsheet software 

and is used by a large number of people across the world. It allows you to store, organise, calculate, and manipulate the 

available data in a tabularformat, consisting of rows and columns. It provides inbuilt features and data analysis tools that 

make it easier to work with a large amount of data. It has an additional feature of representing data in a chart form that 

helps us to analyse data quickly. You can enter data (usually numerical) in a spreadsheet and then manipulate this data to 

produce certain results. 

• IMPORTANT FEATURES OF SPREADSHEETS 

Some important features of LibreOffice Caic are listed below: 

Functions and Formulas: Functions are the built-in formulas which are used for making calculations such as 

calculating percentage, interest, average, etc., in Calc. Formulas are mainly used for performing simple and complex 

calculations. 

Formatting Features: These features are used for improvingthe appearance of data. 

Auto-calculation: The data is automatically recalculated in the whole worksheet, if any change is made in a single 

cell. 

Auto Fill: Entering data in series usingthe automatic filling option. 

Charts: Data can be viewed in a graphical form such as charts. This helps the users to understand, analyse, and 

compare data in an effective manner. 

Sorting: Data can be arranged (sorted) either in an ascendingordescendingorder. 

+  Imports and Exports: Import and export of spreadsheets in multiple formats, including HTML, CSV, PDF, and 

Postscript. 

• II  SOME POPULAR SPREADSHEET SOFTWARE 

+ Microsoft Excel + LibreOffice Calc 

+ Gnu me nc OpenOfficeCalc 

+ Calligra Sheets WikiCalc 

+ Google Sheets 
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III  STARTING LIBREOFFICE CALC 

METHOD 1 

+ ClickontheStartmenu. 

+ Type Caic or LibreOffice Caic in the Search bar. 

+ Press Enter or choose LibreOffice Caic option from the 

Program list. 

+ The LibreOffice Calc program opens. 

METHOD 2 

+ Open the LibreOff ice suite from the Start menu. 

+ Select LibreOffice Caic from the list. 
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Fig. 10.1:Starting Caic Fig. 10.2: Starting Caic 
through Search Bar from the Start Menu 

COMPONENTS OF CALC WINDOW 

The LibreOffice Calc window that appears on the screen is called Workbook. By default, it is assigned a temporary name 

Untitledi. Each workbook resembles a notebook and consists of several worksheets. These look like pages of a 

notebook. 

Fig. 10.3: LibreOffice Caic Window 

WORKBOOK 

A workbook is a collection of one or more worksheets, in a single file. Each workbook has a single theme and contains, at 

least, one worksheet. The workbook is designed to hold together multiple worksheets in order to organise and 

consolidate data efficiently. 

iJf: R KS H F FT 

A worksheet is composed of a very large number of cells, which are the basic storage unit for data in a file or workbook. 

Each sheet contains cells arranged in grid pattern using rows and columns. Rows run horizontally from left to right and 

columns run vertically from top to bottom. By default, a Calc workbook displays only one sheet at the bottom, with the 

name Sheeti. 
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The first electronic 

spreadsheet was Visicalc, 

which was created by 

Daniel Bricklin (R) and 

Bob Frankston (L) in the 

early 1980s. 

Know The Fact 

Calc is the spreadsheet 

component of LibreOffice 

software. Caic is capable 

of opening and saving 

most spreadsheets in 

Microsoft Excel file 

format. It can also save 

spreadsheets as PDF files. 

Let's Know More 

The Navigation buttons to 

the left of Sheet tabs, 

allow you to move through 

the Sheets quickly. 

Quick View 

+  Ctrl+ F2 key combination 

opens the function 

wizard. 

F7 key is pressed to 

check the spellings in the 

current sheet. 

Quick View 

+ Press CtrI+- to move to 

the last column of the 

worksheet, i.e., AMJ. 

Press Ctrl+.J, to move to 

the last row of the 

worksheet, i.e., 1048576. 

In Calc, each sheet can have 220=1,048,576  rows and a maximum of 210=1024  columns. 

LibreOff ice Calc can hold up to 10,000 sheets in a workbook. Columns are represented by 

alphabets on the top and rows by numbers on the left side of the sheet. The components of 

a worksheet are: 

Cell:A cell is an intersection of a column and a row in a worksheet. It is rectangular in shape. 

Each cell is identified by its column letter and row number, which is known as Cell Address, 

for example, Al, G2, etc. The address of the first cell of a worksheet is Al and last cell is 

AMJ1048576. There are 1,073,741,824 number of cells in a worksheet. A cell is used to store 

data, such as text, numbers, formulas, functions, etc. A cell can contain up to 32,767 

characters. 

Row:  A row is the horizontal arrangement of cells in a worksheet. Rows are identified by 

numbers like 1, 2, 3, 4  In Calc, the first row number of a worksheet is 1 and the last row 

number is 1,048,576. 

Column:  The vertical arrangement of cells in a worksheet is known as a column. Columns 

are identified by alphabets, such as A, B, C....AA.....AZ, BA, BB, BC,  In Calc, the name of 

the first column of a worksheet is A and that of the last column is AMJ. 

Scroll bars: In Calc, there are two scroll bars — horizontal and vertical. We can use these 

scroll bars to navigatethrough the body and content of the Calcworksheets. 

Active  Cell: When you click on a cell on the worksheet, a thick black-coloured border 

appears around it, which differentiates the active cell from the other cells. Data can be 

entered only in the active cell.You can activate a cell by 

pressing the Tab key, clickingon the cell or by pressing an arrow key. 

Range:  A range is a group of contiguous cells, which are selected or denoted collectively. It 

can be as small as a single cell or as big as an entire worksheet. You can specify a range by 

writing the starting cell address followed by the ending cell address, both separated by a 

colon (:). For example, a range starting from C3 and ending inJl0 would be written as C3:J10. 

ROW HEADER 

Each row in Calc is represented by a specific number, which is present on the left hand side 

of a worksheet. This number is known as a Row Header. Row headers are numbered from 1 

to 1048576. 

COLUMN HEADER 

Alphabets across the top border of a worksheet represent column headings, starting with A 

to AMJ. Every worksheet in Calc contains 16,384 columns. 

NAME BOX 

Name box is located on the left side in the Formula bar. This area displays the location of the 

cell pointer by displaying its address. For example, Al, B6, etc. 

FUNCTION WIZARD 

The Function Wizard (fx) opens the Function Wizard dialog box, which allows you to search 

through the list of available functions. 



S U 

The SUM function () calculates the sum ofa range of numeric values and shows the result in the selected cell. 

FUNCTION 

Clicking on the Function icon inserts an equal to (=) sign in the selected cell and also in the input line, that makes it ready 

for a formula or function to begin. 

FORMULA BAR 

The Formula bar is located atthe top of the sheet in the Caic workspace. It is located to the right of the Name box. This bar 

shows the characters and formulas that you enter in an active cell. It shows the actual content of the cell. In Calc, if a 

function or formula is written in a cell, the cell displays the result or value, and the formula bar displays the function or 

formula applied. 

Function Wizard 

;-. 
Name Box SLm 

Function Input line 

FIg. 10.4: Formula Bar 

NOTE 

When you enter newdata into a cell, theSum and Function fti. icons change to Cancel X and Accept icons 

SHEETTABS 

Sheet tabs appear at the bottom left of the Calc window, just above the Status bar. Every new workbook which you open, 

contains only one blank sheet. You can add more worksheets in a workbook accordingto your need. You can also rename 

the sheet tabs, insert new sheets, and delete sheets as per your requirement. When you click on a particular sheet tab, 

that worksheet becomes active. 

STATUS BAR 

The Status bar is located at the bottom of the Calc window. It gives us information about the current status. It includes the 

count of the currently selected rows and columns, current sheet number, language of the current dictionary, average and 

sum of the selected numeric cells and a button to quickly save the workbook. It also displays warning messages. 

    

Selection Mode 

   

Cell Information (Zoom Percentage) 

Sum0 -:---+ 100% Sheet 1/I 

Sheet Number  ) 

OetajLt 

  

1:4 

   

     

           

    

Unsaved Change [Zoom Slider 

  

           

            

FIg. 10.5: Status Bar 

SIDE BAR 

The sidebar window is located on the right side of the Calc window. It contains one or more decks. Atab bar on the right 

side of the sidebar allows switching between different decks, such as, Sidebar Settings, Properties, Styles, Gallery, 

Navigator, and Functions. 
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TITLE BAR 

It shows the name of the current workbook along with the name of the application. For example, practice.ods - 

LibreOffice Caic, where 'practice' is the name of the current workbook, '.ods' is the extension given to a Calc workbook, 

and 'LibreOfuice Caic' isthe name of the application. The title bar ofan unsaved workbook shows 'Untitledi'. 

MENU BAR 

Menu bar is displayed under the Title bar. When you choose one of the below mentioned menus, its corresponding 

submenu appears with other options. 

File: This menu includes options, such as Open, Save, Wizards, Export as PDF, and Digital Signatures. 

Edit: This menu includes options for editing the document, such as Undo, Redo, Cut, Copy, Paste, and Find & Replace. 

View:  This menu has options like Toolbars, FullScreen, and Zoom. These are used for viewing the file in different ways. 

Insert: This menu has options for inserting elements such as Image, Media, Chart, Object, Function, and Field into a 

spreadsheet. 

Format: This menu has options such as Text, Cells, Rows, Columns, Align, Image, Chart and Merge Cells, for formatting 

the layout of a spreadsheet. 

Styles: This menu includes options for managing the style of the worksheet. 

Sheet: This menu contains the options to insert and delete rows, columns, cells, sheets, etc. 

Tools: It contains functions, such as Spelling, Share Spreadsheet, Language, Customize, and Options. 

Data:  This menu has options such as Define Range, Sort, AutoFilter, and Consolidate, for manipulating data in the 

spreadsheet. 

Window:  This menu has options, such as New Window, Close Window, and a list of open windows for switching between 

them. 

Help: This menu provides options for help on anytopic while using Calc. 

STANDARD TOOLBAR 

The standard toolbar in Calc contains a variety of command buttons for doing things, like opening, closing, and saving a 

workbook; printing worksheets; cut, copy, and paste selected items; inserting charts, images, header and footer; sorting 

data; etc. 

FORMATFING TOOLBAR 

The Formatting toolbar contains a collection of commands that allows the user to access various formatting options, 

such as changing the font format, aligning data vertically and horizontally, applying various data formats, and cell 

formatting. 

II  RANGEOFCELL 

In general, a range refers to a series of values between two othervalues. For example, the range between landS includes 

2,3, and 4. When referring to a spreadsheet, the range or cell range is a collection of cells within a row or column. A range 

can be two or more contiguous cells, which are selected or denoted collectively. You can specify a range by writing the 

starting cell address followed bythe ending cell address, both separated by a colon (:). A range can be of three types: 
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0   

COLUMN RANGE 

Column range refers to the range of cells spread across a column. In this type of range, the column letter is constant 

whereas the row number varies. For example, a column range that included rows ito 5 of column B would be written as 

B i : B5. 

ROW RANGE 

Row range refers to the range of cells spread across a row. In this type of range, the row number is constant whereas the 

column lettervaries. For example, a row range that included columns Bto F of row 5 would be written as B5:F5. 

ROW AND COLUMN RANGE 

This type of range is in the form of a matrix referring to multiple rows and columns. For example, a range consisting of all 

cells of rows 3 to lOthat lie in column Bto F would be written as B3:F1O. 

1. Click on the cells B20, F9, El, A24, G13 one after the other and observe the display of cell address on 

the Name box. 

2. Write the cell addresses of the following: 

a. Firstrowandfirstcolumn  

b. First row and last column  

c. First column and last row  

3. Write the range for the following: 

a. All cells of row 6 from column C to H. 

b. All cells of column D from rows 3 to 15. 

c. All cells from column F row 4 to column L row 9. 

'II  CREATING A NEW WORKBOOK 

When you start Calc, you will get a blank workbook. You can also open a new workbook in one of the followings ways: 

Select the File> New> Spreadsheet option. Or 

Click on the New button located on the Standard toolbar. Or 

Press the Ctrl+ N. 
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Click on OK. Fig. 10.9: Insert Sheet Dialog Box 

L.b.n . 

Sheetlofl 1 I Ddault English (USA) 

INSERTING A WORKSHEET 

To iÔsert a new worksheet, follow any of these methods: 

METHOD 1 

+ Click the '+' sign adjacent to the Sheet tabs. 

+ In the Sheet section, specify the 

number of sheets to be inserted, name 

of the sheet (if single sheet is to be 

inserted), and also the location of the 

file source if the worksheets are to be inserted from anotherfile. 

METHOD 2 

+ Select the desired Position of this 

worksheet. 

4 Right-click on the empty space next to Sheet 1 tab and select the insert 

Sheet option. The Insert Sheet dialog box appears. 

Fig. 10.7:  Inserting a New Worksheet 

ri 

SAVING A WORKBOOK 

You can save your document in three ways: 

ClickontheFile>Save. Or 

Click on the Save button on the Standard toolbar. Or 

Press Ctrl+S. 

In all the above cases, you will get the Save As dialog box. 

Give a suitable file name in the Name File name box and 

click on Save. The file will be saved with an extension .ods. 

fi  RENAMING A WORKSHEET 

We can rename a worksheet in order to make it more relevant 

for the users. Usually, we name a worksheet considering the 

type of data it is holding. Let us learn how to rename a 

worksheet. 

Right-click on the Sheet tab which you want to rename. 

Choose the Rename Sheet option. You will see the 

Rename Sheet dialog box. 

Assign a new nameforthe worksheet and click on OK. 

Clickon the Save 
button to save your 

file. 
file with) 

password option! 
is available. 

Fig. 10.10:  Save As Dialog Box 
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Fig. 10.11: Renaming a Worksheet 
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Conf,rmatioi 

Ae you lure you want to dette the selected sheet(s)? 

No 

10  
11 
12 
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Fig, 10.12: Deleting a Worksheet 
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Fig. 1014: Selecting 
Move or Copy Sheet option 
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Fig. 10.15 
Move/Copy Sheet Dialog Box 

Copy 

wdo.e. 

-  

Fig. 10.16: Moving a Worksheet 

I  DELETINGAWORKSHEET 

At any point of time, you can delete the unwanted worksheet(s) from the 

workbook. If the workbook contains only a single worksheet, then it cannot be 

deleted. To delete a worksheet, the workbook must contain more than one sheet. 

To delete a worksheet, follow the given steps: 

Right-click on the desired worksheet and choose the Delete Sheet option. 

+ You will get a dialog box asking for 

confirmation to delete. 

To delete the selected worksheet, 

click on Yes. 

FIg. 10.13: Delete Worksheet Message Box 

Jj  MOVING AND COPYING A WORKSHEET 

We can move a worksheet either from one position to another within a workbook or 

from its parent workbook to another file. Right-click on the desired worksheet tab and 

choose the Move or Copy Sheet option. You will get the Move/Copy Sheet dialog box. 

From here, we can either move the worksheet at some other location within the same 

workbook or move it to a new workbook. Let us try both the methods. 

METHOD 1 

Moving the Worksheet within the Same Workbook 

+ In the Move/Copy Sheet dialog box, from the Insert 

before list, select the worksheet above which you 

want to move the current worksheet and click on OK. 

You can also opt to move this worksheet to the end of 

the list. 

+ You will see that the desired worksheet has moved to 

its new place. 

+ You can also drag the Sheet tab and drop it in its new 

location. 

METHOD 2 

MovingtheWorksheettoa New Workbook 

+ In the Move/Copy Sheet dialog box, choose the new document option from the 

'To document' drop-down list and click on OK. 

+ You will see that a new workbook has been created with the name Untitled 2, 

which contains only one worksheet, i.e., the same worksheet that has been 

moved. 
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OPENING AN EXISTING WORKBOOK 

You can open an existing document in one ofthefollowingways: 

SelectFile>Open. Or 

Click on the Open button present on the Standard toolbar. 

Or 

Press Ctrl + 0 on the keyboard. 

Using any of the three methods mentioned above, the Open 

dialog box appears. Select the file which you want to open 

and then click on Open button or press Enter. 

Select File> Recent Documents. This method works if the 

file was opened in the recent past. 

Fiq, 1017:  Opening a Spreadsheet 

CLOSING A WORKBOOK 

A workbook can be closed by using the 

followingtwo methods: 

Select the File menu and then click on 

Close. Or 

By clicking on the ix] cross button on the top 

right hand corner of the workbook. 

Fig. 10.18:  Closing a Workbook 

ASSESSMENT TIME 

4nswer the Following Questions: 

1. What is the difference between a workbook and a worksheet? 

2. How many rows, columns and cells are there in a Caic Worksheet? 

3. What is a range? How will you specify a range of cells in Caic? 

4. How will you insert a new worksheet between Sheeti and Sheet2? 

5. Write the steps you will follow to move a worksheet to a new workbook? 

Create a new workbook, insert a new worksheet in it. Now, rename the worksheet with your name. Save the 
workbook with a different name and delete the worksheet which was renamed. 
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To increase or decrease 

the height or width of a 

cell, press one of the four 

arrow keys along with 

Alt Key. 

There are four types of 

operators in calc: 

Arithmetical, 

comparative, Text, and 

Reference. 

If you begin a formula 

with + or- 'sign, caic 

automatically adds the 

sign before it. 

Lets Know More 

Let's Know More 

click on Insert > Special 

Character to insert a 

special character in the 

cell. 

UNIT - IV: Electronic Spreadsheet 

CHAPTER 11 

    

Editing Data in a Spreadsheet 

• II  ENTERING DATA IN WORKSHEETS 

Anytype of data, be it numeric, alphanumeric, non-numeric or formula, can be entered in a 

worksheet by typing. To enter data in a cell, bring the cell pointer on the desired cell and 

then type the data. You can enter types of data in a worksheet. 

LABEL 

Lets Know More  :- 

In LibreOffice calc you 
can save a document as 

Excel file with xIs or .xlsx 

extension. 

The text entered in a cell by using the keyboard is called a label. A label can be a combination 

of both numeric and non-numeric data along with spaces. For example, 98Hello42, A2Z, 14-

3, are the examples of labels. By default, the labels are left-aligned in a cell and are never 

used for calculation purposes. 

VALUE 

The numeric data is called value in Caic and can contain the digits 0-9. To enter a negative 

number, either type a minus (-) sign in front of it or enclose it in parentheses (brackets), for 

example, (6789). Calc would recognise this value as -6789. Calc ignores the leading plus sign 

(+)and takes the number as a positive value. By default, thevalues are right-aligned in a cell. 

ENTERING FORMULAS 

A formula is a symbolic expression that can include numbers, cell addresses, arithmetic 

operators, and parenthesis. Formulas establish a relationship between two or more cells. 

Formulas in Calc must begin with '=', symbol followed by the cell references and operators. 

When a formula is entered in a cell, the result of the equation is displayed on the cell 

whereas the formula is shown in the Formula bar. 

ENTERING NUMBERS AS TEXT 

If a number is entered in the format 01481, Calc will drop the leading 0. To preserve the 

leading zero, in case of telephone area codes, roll nos., etc., type an apostrophe before the 

number, '01481. 

The data is now treated as text and displayed in the same form as it has been entered. 

ENTERING DATE/TIME 

Select the cell and type the date or time. You can separate the date elements with a slash (I) 
or a hyphen (-) or use text such as 12Apr16. Calc recognises a variety of date formats. You 

can separate time elements with colons, such as 12:23:51. 
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Fig. 11.1:  Data Validation 
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H  Cd  

V&.d,y 
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FJ  
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e.t. 4d '.ns 
-1 

100  

In a worksheet, write the addresses of your friends, stating their First Name, Last Name, and complete 

Postal Address. 

A B I C D 

Title F_Name Last Name Address 

Astik Sahan #414, 32-A I 2 Mr. 

3 Ms. Sar'a Mohan #44. 12-A 

4 Ms. Reena Mahajan #45. 25-A 

Mr. Sanflak Taluja #48. 35-A 

Mr. Bharat I Bhushan #258, 22-A 

Chandigarh 

E-laryana 

ciiaid9ath Cliandi 

Chandigarh 

PancBkula 

E F 

City State 

Mohali - Punjab 

Derabassi Punjab 

II 
 DATA VALIDATION 

Calc provides various ways of applying data validation in worksheets — numeric validation, range validation, etc. When a 

worksheet is used to receive input data from users, data validation can be used to restrict user from invalid data input. To 

apply data validation on yourworksheet cells, followthe below mentioned steps: 

Select the cells on which data validation is to be applied. 

Choose Data >Validity. 

The Validity dialog box opens. 

In the Criteria tab, clickthe Allowdrop-down listand choose the type of data you wantto allow in the selected cells. 

Choose the Data and Value criteria accordingly. 

In the Input Heiptab, a help message can be entered thatwill be displayed while entering data in the cells. 

In the ErrorAlert tab, an Error message along with an Action can be entered that will take place if an invalid entry is 

made in the cells. 

C'r The below figure shows the various tabs of Validity dialog box, where data validation is applied on Student's Marks 

which should be a whole number between ito 100. 

Example 
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erna ca 
Operator 

Addition + 

/ 
Exponentlation (Power) A 

Subtraction 
Multiplication 

Division 

FIg. 11.3: Operators and their Precedence 

First  
Second 
Third 

Fourth  

+ Save the file with the name, Address.ods. 

+ In column G, write the Roll Numbers of these friends of yours. 

+  All Roll Numbers must start with the digit '0 (zero). Type apostrophe (') before the numbers so that Calc 

should not drop the leading zero in Roll Numbers. 

+ Move this worksheet to a new file and observe the location of this worksheet in the new file. 

+  Save the worksheet after making modifications in it. 

au  WORKING WITH FORMULAS AND FUNC 

Calc has a powerful feature to perform calculations on the data. We can perform addition, subtraction, multiplication 

and division of numbers either using formulas or using functions. 

WORKING WITH FORMULAS 

Formulas are used to perform calculations involving addition, subtraction, division, and multiplication. It establishes a 

relationship between two or more cells. A formula is an expression that can include cell addresses, numbers, arithmetic 

operators, and parenthesis. We can perform simple as well as complex calculations usingformulas. 

Formula, must begin with an equal to (=) symbol followed by cell references and mathematical operators. It may contain 

a few or allthe mentioned elements. 

References: A cell or range of cells that you want to use in your calculation 

Mathematical Operators: Symbols (~, -, '1', 
I, A,) that specify the calculation to be performed 

Constants: Numbers ortext values that do not change 

Functions: Predefinedformulas in Calc 

1 

CellAddress 

4, 4, 4, 4,4, 

=A2+B2*C4SUM(E3:E5)4 Range 

f t ft  
Mathematical operators 

Equal to symbol Function 

Fig. .2: ELEMENTS OF FORMULAS IN CALC 

Using Mathematical Operators Spreadsheet software uses standard mathematical operators to calculate addition, 

subtraction, multiplication, division, and exponentiation. Any number of mathematical operators can be used in a 

formula, but they are evaluated according to their precedence. The following tables show the arithmetic operators and 

their precedence while using in a formula: 

For example: The formula =(4+8*2)I\2  willshow the result 400. 
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Fig. 11.5:  Using Compound Formula 
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Fig. 11.6:  Using Text Formula 

A basic formula involves only one operator in a formula. Enter data as shown in Figure. Let us 

calculate the sum of the numbers entered in the cells B4, B5, ... B9 and displaythe result in Bll. Follow these steps: 

Clickon the cell Bll whereyou wantto displaythe total, and type  

equal to (=) sign. 
SUM - El 

A 

f x  J . 

C I D E 
Incentive Peceniage - - - 

2 Chauty Arnunt - - - 
Incentive Actual Click on the cell B4. The address will appear in cell Bil. Type plus 

Month Enpensen AmountEpws 

(+) sign after that. 4 -Jinuay 
Fthuoiy 

1000 
S 2000 
6 Match 15000 

+ Further, repeat the steps till B9 or type: =B4+B5+B6+B7+B8+B9 7 April 3000 
8May 1900 

in cell Bli. 9 June f 200 
10 

TotaI 84+85+B6tB?+88+89 

Press the Enter key. 12 
13 

The total of all the values from B4 to B9 will be displayed in cell Fig. 11.4:  Using Basic Formula 

Bil. 

Using Compound Formula:  Compound formulas are used when you need more than one operator to perform 

calculation. Let us calculate the Simple Interest using the formula P*R*T/100.  Enter the data as shown in Figure. Follow 

the given steps: 

Clickon the cell B6andtype=sign. 

Clickonthe cell B2.The cell address B2 appears in the cell B6. 

Type * sign and click on the cell B3. 

Again type * sign in B6 and click on the cell B4. Type / sign and 

100 in the cell B6. Press the Enter key. The cell B6 displays the 

calculated result of Simple Interest. 

Note that the result appears in the cell, but the actual formula 

appears in the Formula bar. 

UsingText Formula: You cannot perform any mathematical operation on text data. However, you can add two text values 

together to join them. Joining two or more text values together is called Concatenation. You can use the ampersand 

symbol (&) for addition. Follow the steps to concatenate the text 

values: 

Enter two string type values in cell Al and Bi, say Kips in Al and 

India in Bi. 

Enterthe formula = "Kips"&"India" in cell Cl and press Enter key. 

twill display Kipslndia in the cell Cl. 

1i 
Enter the text I, Love, Computer in separate cells. Place the cursor on the cell where you want to display formula. Now, type the 

formula either irs the Formula bar or cell. If you want to leave a blank space after each word, then leave a space before closing the 

double inverted commas. 

For example: II  &, Love &Computer.J 

I Lo ye Computer 
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Sum function adds all the 
numbers in a range of cells 

and returns their total as a 

result. 

U,dl - 
LAx 7 xFAS F SF., 3M  3m. J.AS Wxm.. 3mx 

rta (4 4-• 

b,e$x.x El{JJ  B  I 1.! ?, 
i. = 

Al •  C  
Sxd Pon IeI  

O.Ij1 AF,e., (3  
Ky AS 73 
L3r., 97 AS 

AS AS  
73 *3 

3 0  )  
Knxm. O 

Ag. 11.8: SuM Function 

l I 
A range spans a cell or a 

group of cells adjacent to 

each other on a 
spreadsheet. The range 

can be used in formulas. 

AS 
*0 

Using a Range in a Formul You can assign multiple cells to formula by creating a reference 

ora range. Use of a range saves a lot of time. For example, if you wantto calculate the sum of 

columns or rows, it is always better to define a range. 

Type the data as shown. Click on the cell 

Bil and type the formula =SUM (B4:B9). 

Press the Enter key. The Sum value will 

be displayed in the cell Bli. 

Similarly, calculate the sum of cells C4 to C9 

in the cell Cli. 

Fig. 11.7: Using a Range In Formula 
L 

' Range basically shortens the length of the formula. For example, if you wish to find the 

average of the values from 84 to 89, then instead of typing =AVERAGE (B4,BS,86,B7, 

B8,B9), simply use range in your formula, such as =AVERAGE (84:B9). 

II  USING FUNCTIONS 

Functions are pre-designed formulas to perform simple and complex calculations. They 

eliminate the chance to write wrong formulas. The functions are made up of two parts — 

Arguments and Structure. 

Formulas in LibreOffice 

Calc are not case sensitive. 

For example, B5 is treated 

same as b5. 

Calc includes over 350 

functions to help you 

analyse data. 

ARGUMENTS 

Arguments are input values to functions. These can be numbers, text, logical values (such as 

True or False), range of cells, constants, formulas or even other functions. 

STRUCTURE 

The Structure of a function defines its basic skeleton, which forms the basis of writing the 

general syntax of functions. The structure begins with the function name followed by a list 

of arguments separated by commas (semicolon in case of range of cells) within the 

parenthesis. A function must begin with the '=' sign. 

=FUNCTION NAME (argumenti, argument2, argument3  

IMPORTANT FUNCTIONS 

Using the SUMIF functions 

we can add the cell values 

specified by a given 

criteria. 

  

Formulas and Functions 

    

The SUM function adds all the numbers in a given 

range of cells. Let us learn how to use it. 

Click on the cell where you want to place the sum 

of values (for example, ES). 

Type sign. 

Type the function name, i.e., SUM. 

Now,type the open parenthesis symbol ( 
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+ Sincewewantto calculate the sum of values of C5 and D5, we can write the formula in two ways: 

=SUM(C5,D5)  Or 

= SUM (C5:D5) 

4- Typetheclosingparenthesissymbol). 

4- Pressthe Enter key and you will see the result in the cell ES. 

Let us see some more examples of the SUMfunction. 

=SUM (1,2,3) Returns 6, i.e., 1+2+3 

=SUM (Al: A4) Returns the sum of range of cells from Alto A4, i.e.,A1 +A2~A3+A4 

=SUM (1,2,3, TRUE) Returns the result as 7.The logical value of TRUE is 1. Hence, it is manipulated as 1+2+3+1=7 

=SUM (Al, B2, C3) Returns the sum of values present in the cells Al, B2, and C3 

'rr{  The AVERAGE function returns the average (arithmetic mean) of the arguments. The arguments can be a 

range of cells, simply numbers or numbers alongwith cell references. In the worksheet shown in the Figure, let us 

calculate the average of marksobtained by Kavyansh. 

Tofind the average of numbers in cells CS and DS, you can write the formula in two ways: 

=AVERAGE (C5,D5) Or 

AVERAGE (C5;D5) 

We can also find the AVERAGE of two or more ranges of 

cells as discussed below. 

=AVERAGE(C5:D5; C6:D6) 

This formula will find the average of marks obtained by 

Kavyansh and Dinesh. Now, bring the pointer at the 

bottom-right corner of the cell. You will notice the Fill 

Handle tool. Drag it down to fill the rest of the cells to 

implementtheformula. 

Let us see some more examples of the AVERAGE( 

function. 

I 

ube5ic fl.9I 
 fx i 

B I 

A B C j 0 £ 
Studenb Prores Rod 

2 
3 . Nne Maks ToI Avccqe 
4 Ov 1QQ Wriftw (1O0 

1 K.ya 60 75 15 775 
61 2 £i 97 68 
7 3 70 
81 4 P 90 
9 5 73 

10 6 77 60 
U 7 10 60 
12 

FIg. 11.9:  AVERAGE Function 

=ASjERAGE(l. 2) Returns the result as 1,5, i.e., (1+2)/2 

=AVERAGE (A1:A4) Returns the average of range of cells from Al to A4, i.e., (A1~A2+A3+A4)/4 

=AVERAGE(2, 3,TRUE) Returnsthe resultas 2.The logical value ofTRUE is 1. Hence, it is interpreted as (2+3+1)/3 = 2 

=AVERAGE (Al, B2, C3) Returns the average of values present in the cells Al, B2, and C3. 

This function counts the number of values such as numeric entries, logical values, formulas, and date entries in 

a given range of cells. 



4  TRUE and FALSE are 
logical entries. 

Blank space is 
ignored. 

 The double 
make it quotes The COUNT() function 

UI 
U 
U 

has been applied. 

U TRUE FALSE 0 A HELLO 11/1684 

5 has been taken as a = 
direct argument. L 

TRUE FALSE 0 MFIIfl 11.fld  

result changes with a' 
5[ slight modification 

in the argument of 
 \ COUNT function. _j 

At 

The MAX function has 
— been applied within a 

2 1' specified range. 

3 10 
Maximum value 

4 within the range 
is displayed. 

9 
5 

10 

Fig. 11.12:  MAX Function 

Min( ): The MIN function returns the smallest value among the set of 

values in a given range of cells. This function only considers numeric 

entries and logical values as its arguments. If there are no valid 

arguments within the MIN function, it returns a value of 0. 

Let us learn how to use it. 

Typethe values as shown in the worksheet. 

Apply the MIN function from A4: F4 

in ceIlA6. 

The result will be 2. 

lf( ): This is a conditional function. It returns first value succeeding the condition, if the 

condition evaluatesto TRUE; and second value if it evaluates to FALSE. 

Fig. 11.13:  MIN Function 

= 

 

  

7 

10 
9 

2 
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Let us enter some data in a worksheet and understand the practical use of this function. 

Type in different types of data values in cells A4:G4. Now, click on the cell C6 and type the formula: 

=COU NT(A4:G4) 

You will see the result as 4 because the COUNT function considered only values present in B4, C4, D4 and G4. The Count 

function does not count the Label entries. 

Fig. 11.10: COUNT Function Fg. 11.11:  COUNT Function with a Modification 

NOTE 
If a numberenclosed in double inverted commas istaken as a directargumenttothe COUNTfunction, then itwill be considered 

as a normal numeric entry. 

Max( ): The MAX function returns the largest value among the set of values 

in a given range of cells. This function only considers numeric entries and 

logical values as its arguments. If there are no valid arguments within the 

MAX function, it returns a value 0. 

Let us learn how to use it. 

Type the values as shown in the worksheet. 

Apply the MAX function from A1:A5 in cell A6. 

+ The result will be 10. 

Fig. 11.14: IF Function 
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ignores empty cells as well 

as cells that contain text 

entries. 

Know The Fact 
The AVERAGE() functi "  

Syntax: IF(Logical_Test; Value_If_True; Value _lf_ False) 

Logical Test Logical expression which returns a logical value (TRUE/FALSE) 

Vlue_ If_True Value returned bythe function if the logical test results in a TRUE value. 

Vlue_lf_ False Value returned bythe function if the logical test results in a FALSE value. 

Let us see some examples: 

=IF(Al>100,250,200): 

This means that if the value in the cell Al is greater than 100, the function will return 250, 

else it will return 200. 

=IF(2>20; 'Good Value'): 

This will return FALSE(by default) since the second value has not been specified and the 

condition results in a FALSEvalue. 

=IF(l>O) 

This will return TRUE (by default) since we have neither mentioned the true nor the false 

value. The condition returns a TRUE value, hence, the text TRUE will be printed. 

=lF(100<200; 1/0; "Hello"): 

The specified condition is true. Hence, the calculation of 1/0 will be processed. Since 

division by zero results in error; the result will be #DlV/0! 

MINA 0  and MAXA 0  are 

functions which return the 

minimum and maximum 

value in a list of arguments 
respectively, unlike MIN () 
and MAX 0 we can enter 

text in these functions 

whose value is taken as 0. 

 

NOTE 

   

Which function runs a 

logical test on numeric 

values? 

    

 

Fill Handle is the small dot aligned at the bottom right edge of the active cell. It is used to drag and 

filla range of cells with the same formula or data. 

 

  

  

      

For Better Concept Clarity 

1. Let us calculate the Total points and Grade secured by every House in various competitions: 

4 

2 

A 

Ho(es 

8 

Ccmp. Quiz 

C 

Declaamation 

° L G 

HOUSE ACTIVITY RESIA.T 

Recitation Contest Rangoli Caption Contest lotal Grade 
3 Points 100 100 100 100 100 

4 Vivekanand 80 90 85 12 74 

5 Shankra charya 92 75 85 85 

6 Meerabau 15 85 82 85 79 

7 RaviDas 89 92 /5 87 

+ Houses getting more than or equal to 450 points, should be awarded A grade, while those getting less than 

450 and greater than equal to 350 should be awarded B+ grade. The houses getting points between 300 

and 350 should get C grade and less than this should get D grade. 

Display the name of the house which has obtained the maximum points overall. 

Display the name of the house which has obtained minimum points. 

Find the total points of Shankaracharya House for the activities: Comp. Quiz, Recitation Contest, and 

Caption Contest. 

If the number in cell D5 is greaterthan 90, then display"Excellent", otherwise display "Well Done". 

If the total of the range B4 to F4 is less than equal to 360, then display "Put More Efforts". 

• Save the Worksheet. 
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+ Calculate the HRA of every employee by using the formula =Basic Salary*1O/100. To do this, click on the 

cell C2 and calculate the HRA by applying the formula =B2*10/ 100 and press the Enter key. 

+ Similarly, calculate the HRA of every employee by copying the same formula In rest of the cells. Use Fill 

Handle to copy the formula to a series of cells. 

+ Apply the formula =B2+C2 (Basic Salary + HRA) in the cell D2 and calculate the Gross Salary ofAshish. 

+ Similarly, calculate the Gross Salary of each one by dragging the Fill Handle. 

+ Click on the cell E2 and apply the formula =B2*2/100  to find out the ESI. Apply the same formula to 

calculate the ESI of every employee by copying it in rest of the cells. 

+ Now, click on the cell F2 to calculate the Net Salary by 

using the formula, =D2-E2 (i.e., Gross Salary - ESI). ______ 

+ Similarly, apply the formula to calculate Net Salary of 2  

the rest of the employees. 
S 

+ Savetheworksheet. 

A 7 
. ic sy *61* ____ (SI Nst SIIMV 

&th,1J S 500 5500 100 5400 

Swi, 6000 I uoo uo s 
oinell% 4500 I 450 4960 90 4*60 

R&(q 4800 1 4*0 52*0 96 5114 

— Fn loo'. 

sEJ[io 1 B  Iritc* 
0.103 - ( fii = 

X  0ø.t,Ccfl, 

PINo 
DCO 
Dr. p.3. 5,n 

lh,d .t tnd, 
In..t SOe4 I,o,,, 7,1,.. 
1.,k to Eot..n.I 0.1... 

1111 
Ro ..,'i i.p..',,on,  

2. Let us calculate the HRA, Gross Salary, ESI and Net Salary of employees by using the formulas which you 
have learnt till now. 

+ Create a table as shown here. 

J 

• INSERTING CELLS, COLUMNS, AND ROWS IN A WORKSHEET 

At times, while entering data in a file, we may miss some data entrtj or record of a person. In such situations, we may have 

to insert a cellorsome rows or columns in the worksheet. Let us learn this procedure. 

INSERTING BLANK CELLS 

To insert some blank cells in a worksheet, we must follow these steps: 

+ Select the range of cells where you want to insert the blank cells. You should select the same number of cells as you 

want to insert in the spreadsheet. 

Follow any one methods to insert blank cell(s): 

+ Right-click on the range and select the Insert option. Or 

+ ClickontheSheet menu and selectthe Insert Cells option, Or 

+ PressCtrl++. 

FIg. 11.15: Inserting Blank Cells 
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As you can see, only the selected range of cells moved 

down ratherthan the entire row. 

Also, only four blank cells were inserted because we 

selected only four cells initially. 

Hg. 1116:  Insert Cells Dialog Box 

Case-2: Entire row FIg. 11.18: Inserting a Row 

In this case, the entire row shifts down. Since, the selected range contained cells from 

one row, a totalof one new row was inserted in the worksheet. 

FIg. 11.17: Inserting a Cell 

FIg. 11.19: Using Context Menu 

• 9.   
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Fig. 11,22: Using Insert 
Rows Option 

+  In both the cases, you will get the Insert Cells dialog box. There are four different 

options to choose within the dialog box. Select the desired option and click on OK. 

Let us have a glimpse of some of these mentioned options and understand the difference 

practically: 

Case-i: Shift cells down 

INSERTING BLANK COLUMNS 

You can insert blank column(s) between any 

existing columns or even before the first 

column. Let us learn howtodoit. 

Method 1 

Right-click on the column headerwhere you want to insertthe new column. 

From the Context menu, select the option Insert Columns Before. 

+ A new column will be added to the left of the selected column. 

Naffle Clam Roil Grade 

X 23 A 

AMa IX 4 c 

I

SI 

K,ma IX 12 

Nia 1 7 A 

K*oita X 
___L,..____.  

28 
. 

B 

) 

FIg. 11.20: InsertIng a Column 

Selectthe column headerwhere you want to insert the new column. 

Click on the Sheet menu and select the option Insert Columns. Then, from the 

submenu choose Columns Before. 

In both the cases, a new column will be added to the left of the selected column. 

INSERTING BLANK ROWS 

You can insert blank row(s) between any existing 

rows or even above the first row. Let us learn how to 

do it: FIg. 11.21: UsIng Sheet Menu 

Mthod 1 

Right-click on the row header, where you want to insert a new row. 

From the Context menu, select the Insert Rows Above option. 

A new rowwill be inserted just abovethe selected row. 

Method 2 

+ Click on the row header, where you want to insert a new row. 
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Fig. 11.2 Selecting Rows from Insert Menu Fig. 11.24: Inserting a Row 

ASSESSMENT TIME 

- Employees Information 

Alame. Desgna1oc Oparren'i, 

Asna Manager Marketing 20000 

Arshia Sales Executive Marketing 10000 

Kiran Store Keeper Production 7000 

Sonali Worker Marketing 5000 

Mithu IAsst.  Manager Marketing 15000 

Rachel Worker Production 5000 

Chandan Typist Computer 6000 

Jai Comp. Operator Computer 6000 

Arica Sates Executive Marketing 11000 

Payal lsales Executive 
columns or rows at once 

instead of deleting them 

one by one. 

Click on the Sheet menu and select the Insert Rows option. Then, select Rows Above 

from the submenu. You cannot define a Name 

Range which points to an 

actual cell reference in 

calc. For example: Ql, 

which denotes the 0th 

column and 1st row, 

cannot be the name of a 

range. 

In both the cases, a new row will be inserted just above the selected row. 

ae Rod No G,ade 

23 A 2 Srn-t 

Ix 4 C 

Ix 12 B Knthna 
MMSM1f*$O*-. 

6j 5 A 

I 25 7 

Answer the Following Questions: 

1. What is the difference between Label and Value in calc? 

2. What is data validation? How to apply it on a selected column of data? 

3. How to insert a blank row above row 5 in a Caic spreadsheet? 

4. What is the purpose of If function in Caic? Explain with suitable example. 

5. Write a short note on Functions in Calc, 

For Better Concept Clarity 

Open LibreOffice Calc. Enter the given data in a worksheet. 

+ Save the file by specifying a file name for it. 

+ Insert a row after row 12 and enter the following data, "Payal'ç "Sales 
Executive' Marketing, 12000 in the newly inserted row. 

+ Insert a column before the "Salary" field and enter the heading - "Phone No". 
Enter the phone numbers of the people in the newly added column. 

+ Click on cell A6 and change its content 
to"Rohit". 1 

2 

3 

4 

S 

6 

7 

8 

9 

10 

11 

12 

13 

+ Save the file using Ctrl + S key combination. 
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+ Click on cell C7 and change its content 
to "Production" 

+ Copy the contents of cell Bli, and 
paste in cell 58 using Ctrl+C and 
Ctrl+V key combinations. 

+ Insert a column before column A. 
Type the heading "Sr. No". 

+ Type land 2incellA1 andA2. Fill rest 
of the entries using the Fill Handle. 

While using the option of 

Shift Cells down, you 

should be careful enough 

not to move any numeric 

entries up or down. If 

those numbers are a part 

of a formula, the final 

value will change, thus 

giving the undesirable 

results. 



Recap 

 

Caic is the spreadsheet component of LibreOff ice. It allows you to store, organise, 

calculate, and manipulatethe available data in a tabular format. 

  

+ The LibreOffice Calc windowthat appears on the screen is called Workbook. 

+ A cell is an intersection of a column and row in a worksheet. 

+ A Calc worksheet consists of 1024 (i.e. 210)  columns and 1,048,576 (i.e. 220)  rows. 

+ There are 1,073,741,824 (i.e. 2°) cells in a Calc worksheet. 

+ The address of the first cell of a Calc worksheet is Al and that of the last cell is AMJ1048576. 

+ A cell can contain up to 32767 characters. 

+ A Calc workbook can contain a maximum of 10,000 worksheets. By default, a new workbook contains only one 

worksheet. 

+ A range is a group of contiguous cells, which are selected or denoted collectively. To specify a range, the cell 

addresses of the first and last cell of the range is separated by a colon (:). 

+ You can insert blank row(s) between any existing rows or even above the first row. 

+ The Status bar is located at the bottom of the window, that gives us information aboutthe current status. 

s In Calc, a worksheet can be renamed, moved, copied, and deleted. 

* The type, of data that can be entered in a Calc worksheet are numeric, alphanumeric, non-numeric, orformula. 

+ Aformula is an expression that can include cell addresses, numbers, arithmetic operators, and parenthesis. 

+ The basic formulas involve one operator, whereas compound formulas involve more than one operators. 

+ Functions are pre-designed formulas to perform simple and complex calculations. The functions are made up 

of two parts — Argumentsand Structure. 

+ Arguments are input values to the function, whereas structure defines its basic skeleton that forms the basis of 

writing its general syntax. 

+ Some importantfunctions in Calc are, SUM, AVERAGE, COUNT, MAX, MIN, and IF. 

+ Thetext or non-numeric data entered in a cell is called a label. 

+ The numeric data iscalled value in Calc and can contain the digits 0-9. 
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a. Calc b. Writer c. Impress 

a. Cell b. Column c. Row 

a. Cell b. Spreadsheet c. Range 

a. Semicolon b. Colon c. Full Stop 

a. Task Bar b. Status Bar c. Formula Bar 

c. Current Cell 

c. AZ 

c. Untitled 1 

a. Passive Cell b. Active Cell 

7. Which is the last valid column header in Caic? 

a.AMJ bk] 

8. What is the default name ofa workbook in Calc? 

a. Booki b. Sheetl 

a. Ctrl+X b. Ctrl+Z c. Ctrl+C 

b. Curly Brackets c. Square Brackets a. Parenthesis 

a. Left b. Right c. Center 

c.3 d.4 a.1 b.2 
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BRAIN  DLVELOPER- 

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

A. Multiple Choice Questions: 

1 Which software lets you perform calculations and manipulate the numeric data? 

Name the elementthat is identified by its row numberand column letter. 

3. What do you call a group of contiguous cells which forms the shape ofa rectangle? 

d. Paint 

d. Worksheet 

d. Sheet Tab 

4. Which symbol separates the address of the starting cell address from the ending cell address in a range? 

5. Which of the following component lies at the top of the document window in Calc? 

6. What is the name of the current cell which has a cell boundary around it? 

9. Which shortcut key combination is used to save a workbook in Calc? 

10. Which pair of brackets are used to denote a negative value in Calc? 

11. What is the default alignment for numbers in Calc? 

d. None of these 

d. Title Bar 

d. New Cell 

d. AJM 

d. All of these 

d. Ctrl+S 

d. All of these 

d. None of these 

12. Name the expression which includes numbers, cell addresses, operators, and parenthesis. 

a. Symbol b. Equation c. Formula 

13. Which symbol marks the beginning of a formula? 

a. Equal (=) b. Plus (+) c. Asterik () 

14. Which type of element cannot be used in a formula? 

a. Reference b. Mathematical Operator c. Function 

15. By default, how many worksheets does a Calc workbook display? 

d. None of these 

d. Division (/) 

d. Time 



State True or False: 

If you type the apostrophe symbol beforea number, Calcassumes it as a text entry. 

2. The date entries in Calc are separated by the colon (:) symbol. 

3. The F3 function key is used to edit the contents of the active cell. 

4. The Clear All option clears all the contents from the selected range of cells. 

5. The shortcut key combination to cut a specific range of cells is Ctrl+X. 

6. The name given to a range of cells is added in the drop-down list of the Name Box. 

7. The small black square present in the bottom right corner of the active cell is called the Cell 

Handle. 

8. Only values can be used for calculations in formulas. 

9. The number of blank cells inserted in a worksheet will be same as the number of cells selected 

initially. 

10. A range is specified using semi-colon (;)symbol. 

11. Formulas always begin with the symbol followed by cell references and operators. 

12. You use the Compound Formulas when you need more than one operator. 

13. When a range of cells is used in a formula, all the cells that fall inside the range are included in 

that formula. 

14. In Calc, each worksheet consists of 10,48576 rows and 16,384 columns. 

15. Alphanumeric data cannot be entered in a worksheet. 

C Fill in the Blanks: 

1. Each Caic file is called a   because it can contain many sheets in it. 

2. key combination is used to create a new workbook. 

3. The cell has a dark highlighted border. 

4. key combination is used to insert a new cell. 

5. A     is a symbolic expression that can include numbers, cell addresses, arithmetic 

operators, and parenthesis. 

6. If you forget to put the = symbol before a formula, then the data is assumed to be a  entry. 

7. Calc will recognise the value (2305) as  

8. TheextensionofaCalcFileis  

9. key combination closes the workbook window. 

10. By default, values are    aligned in a cell. 

A. Multiple Choice Questions 

1. (a) 2. (a) 3. (c) 4. (b) 5. IdI 6. (bI 
15. (al 

1. (T) 2. (F) 3. (F) 4. (T) 5. (T) 6. (TI 

15. (F) 

1. Workbook 2. ctrl+N 3. Active 

8. .ods 9.ctrl+W 10. Right 

7. (a) 8. (c) 9. (dl 10. (a) 11. (b) 12. (c) 13. (c) 

B. State True or False 

7. (F) 8. (T) 9. (T) 10. (F) 11. (TI 12. (TI 13. (TI 

C. Fill in the Blanks 

4. ctrl+~ 5. Formula 6. Label 7. -2305 

14(d) 
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SECTION 2: THEORY QLJESTIONS-(SOLVED) 

What is a spreadsheet? 

A spreadsheet is like a table in which data can be spread in a tabular form consisting of rows and columns. 

Using spreadsheet data can be organised easily. A spreadsheet is also called a worksheet. 

What is a cell? What does it contair 

A Cell is an intersection of a column and row in a worksheet. It is rectangular in shape. Each cell is identified 

by its column letter, and row number, which is known as Cell Address. A cell is used to store data, such as 

text, numbers, formulas, functions, etc. A cell can contain upto 32,767 characters. 

. VlIaLdreneetbs 

Sheet tabs appear at the bottom left of the Calc window, just above the Status bar. Every new workbook 

which you open, contains one blank sheet named as Sheeti. You can add more worksheets in a workbook 

according to your need. When you click on a particular Sheet tab, that worksheet becomes active. 

4. How cn you change  the data in a cell using mouse in Caic? 

An Using the Mouse: 

Double-click on the cell to edit it, and then move the mouse pointer up to the required place. The 

insertion point will blink within the cell. 

Make the changes and press the Enter key. The changes will appear in the current cell. 

5. ''" re thc nr 1ffnrin nruv rrnon -e T'sert dialog box? Explain them briefly. 

An The four available options in the Insert dialog box are: 

Shift cells down Moves the selected cell(s) down by 1 row. 

Shift cells right : Moves the selected cell(s) towards right. 

Entire row : Moves the complete row down by 1 row. 

Entire column : Moves the entire column towards right. 

. Ex!an the term FormuIc fl CThlc 

An. Formulas are used to perform calculations involving addition, subtraction, division, and multiplication. A 

formula is an expression that can include cell addresses, numbers, arithmetic operators, and parenthesis. 

You can perform simple calculations as well as complex calculations using functions, like, SUM, IF, AVERAGE, 

COUNT, etc. Formulas must begin with = 'symbol followed by cell references and operators. 

k 0 r -nFandCompn1ndFormulas? 

Basic Formulas involve only one operator in a formula. For example, if you want to calculate the sum of a 

range of cells, you will use only the '+' operator. Compound Formulas are used when you need more than one 

operator. For example, while calculating the Simple Interest, you use the formula, P*R*TI100.  Since more 

than one operator is involved in the above formula, it is called a Compound Formula. 

What do you understand by the terms: Row Header and Column Header? 

Row Header: Each row in Calc is represented by a specific number which is present on the left hand side of a 

worksheet. This number is known as a Row Header. Row headers are numbered from 1 to 1,048,576. 

Column Header: Alphabets across the top border of a worksheet represent column headings, starting with A 

to Z, AA. .AZ, BA... BZ, . . .XAA. . .AMJ. Every worksheet in Caic contains 1024 columns. 
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Explain Lhe difference between a worksi cet and a workbook with the help of on exan 

s: A worksheet denotes a single spreadsheet page. On the other hand, a workbook is a collection of all such 

worksheets in a single file. For example, your textbook is like a workbook and each page acts like an 

individual worksheet. 

Explain the method of enterinq numbers as text in Caic. 

To enter number as text in Catc, type an apostrophe sign () before the number. For example, write 2341 in a 

cell and pressthe Enterkey, twill leftalign itselfastext. 

SECTION 3: APPLICATION BASED QUESTIONS-(SOLVED) 

Shashi was assigned the task to insert a new row in the given file. Every time he tried to perform the action, 

only one cell was inserted rather than a whole new row. What was his mistake? 

A B - I C 0 E r 
1 Title First Name Lad Name Address City Stats/UT 

2  Sahani 41414/32-A Chandigarh Chandigarh 

3 Mrs. Sanya Mohan #313/36-D chandigarh Chandigarh 

4 Mrs. Reena Mahajan #975/4 Panchkuia Haryana 

5 Mrs. Sarthak Taluja #303/Phase-I Mohali Purrjab 

6 Mr. Bharat Bhushan #865/17 Derabasi Punjab 

While attempting to add a new row, Shashi was selecting the wrong option as shown in 

the Insert dialog box. 

The Shift cells down option will only move the selected cell down by one cell and not the 

entire row. To add a new record, he needs to select the Entire row option, which will move 

the contents of the current cell and its corresponding row down by one level. After 

choosing the correct option, the correct output will be: 

A 

I Title First Name 

C P 

Last Name Address 

E 

City State/UT 

2 

3 Mr. Astik Sahani #414/32-A chandlgarh Chandigarh 

4 Mrs. 5anya Mohan #313/36-D Chandigarh chandigai-h 

S Mrs. sna Mahajan #975/4 Panchkula Haryana 

5 Mrs. Sarthak Taluja #303/Phase-I Mohali Punjab 

7 Mr. 6harat Bhushan #865/17 Derabasi Punjab 

Shagun has been asked by her Leocher to find the mistakes ii the followu 0  statements. Help her to identik 

the mistakes and correct them as well. 

Incorrect Statement Mistakes Corrected Statements 

Formula SUM (B5:B1O) 

Formula =SUM (1;2;3) 

Incorrect Statement Mistakes Corrected Statements 

Formula SUM (B5:B1O) A formula must begin with the 
Sign =SUM(B5: B1O) 

Formula =SUM (1;2;3) The arguments must be 
separated by a colon (:) orcomma (,) 

=SUM(1:3) 

=SUM(1,2,3) 

or 

'S. 

-j 

2. 

A 
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SECTION 4: THEORY QUESTIONS-(UNSOLVED) 

1. What are functions? Explain the different parts of a function. 

2. What is the significance of COUNTO function? Whattype of data entries does the COUNTO function recognize? 

3. Suggest the Calc functions which can be used forthe following: 

+ To calculate the average marks obtained by a student in SAl assuming that his/her marks of individual 

subjects are given. 

• To find the highest marks of Hindi in yourclass, if marks of all students are given. 

• To calculate the quarterly sales of a sales executive, if the sales data of all months is given. 

To find out the minimum quoted tender rates submitted by various companies. 

4. Name three important features of a spreadsheet. Mention the names of any four spreadsheet software. 

5. Definethefollowing: 

a. Cell 

b. Workbook 

c. Worksheet 

6. How many rows and columns are there in a Caic worksheet? What are the cell addresses of the first and last cell 

of a Calc worksheet? 

7. What is Formula bar? How is it different from Name box? 

8. How will you move, copy, rename, and delete a worksheet? 

9. What is the difference between labels and values? Explain with an example. 

10. What are the four basic mathematical operations supported by Calc? 

11. Explain the use of If function with the help of an example. 

12. What do you understand by Range? Explain with a brief example. 

13. Write the formulas to calculate Sum and Average ofall the values that lie between cells C7 and F15. 

14. What is concatenation? How is it used on text data? Explain with example. 

SECTION 5: APPLICATION BASED QUESTIONS-(UNSOLVED) 

1. An assignment was given to Sanjiv and Vibha by their teacher. They were shown the screenshot given below 

and were asked to answer the following questions: 

(i) What happens when the formula 52+C, is entered in L)2? 

(ii) What happens when the formula ofD2 Is copied over to D6? 

(iii) What will happens you modify the formula in the cell D6 to =$B6+$C6? 

(iv) What happens when you copy the formula of D6 to D3? 
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(v) If you delete the value of C3, what will be the new value of 

C 

D2 'v 

A B 

1 Flight No. Base Fare Tax 

2 S2-112 130 2300 

3 9W-325 490 2190 

4 Al- 778 395 2250 

5 IT-118 
_ 

660 400c 

6 SG-894a 295 3040 

Mayur could not complete the assignment given by his teacher which is shown below. Help him to fill the blank 
cells marked with yellow colour by using the appropriate formulas. 

R. No. Name 
Theory 

50 

Practical 

50 

Total 

100 
Percentage 

1 Aaryan 48 49 

2 Manas 35 40 

3 Swati 40 42 

4 Kabeer 42 40 

5 Shradha 39 41 

The class teacher asked Ravi to observe the following worksheet carefully and answer the questions based 
on it: 

(i) Identify the nature of formula in the cell 

(ii) Copy the formula applied in cell to all the cells from E5 to Eli. 

(iii) Find the maximum and minimum value among the cells E5  to  Eli. 

(iv) Calculate the average of both Oral and Written marks. 

D 

Total 

I  

A 

Sr. No. 

B C 

Student Progress Report 

Name Marks 

Oral (100) Written (100) 

1 Anju 80 70 

2 Manju 96 

3 Ranjana 65 17 

4 Kirti 87 67 

5 Hernant 73 65 

6 Kunal 59 74 

7 Sparash 0 83 

L2  
3 

4 

5 

6 

7 

8 

9 

10 

11 

69 
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SCIENCE TEST SCORE CARD 

Roll No. Name Practical Theory 
Total 

Grade 
Percentage 

3 1 Veena S 6 

4 2 Ashlsh 6 8 

5 3 Surbhi 7 9 

6 4 Harry q 8 

7 5 Shubh 8 9 

Avg. Marks Avg. Marks 

9 
Max Marks Max Practical Max Theory 

Practical Theory 

10 Practical 10 

11 Theory 10 

12 

Sahil has been given the hard copy of the following worksheet by his teacher. 

His teacher has asked him to: 

(i) Calculate the total percentage of each student. 

(ii) Find the Grade of each student; The students scoring above 90% will get A+ and those getting below 

9Q% will get B. 

(iii) Also, find the Maximum marks and calculate the Average marks of both Practical and Theory. 

 

For Better Concept Clarity 

Design the worksheet as shown and answer the following questions: 

(,. E3 

A L 13 C D E F G 

1 EmpiD Name Salary DA TA HRA Total Salary 

2 10488149 Ayush 11500 

3 1048.8167 Smram 9600 

4 10488151 Geetli 
U 

10700 

5 104.88.142 Mitali 12750 

6 10488175 Aarush 11050 

(i) Calculate the DA of all the employees as 10% of their salary. 

(ii) Calculate theTA of all the employees as 15% oftheirsalary. 

(iii) Calculate the HRA of all the employees as 25% oftheir salary. 

(iv) Calculate the Total Salary by using the formula Salary+DA+TA+HRA. 

(v) Find the maximum, minimum, and averagesalaries being dispensed by this company. 

(vi) The employee getting the least salary must receive Rs. 500 as bonus. Find the Total Salary of this 
employee. 
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Fig. 12.1: Sample Worksheet 
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CHAPTER 12 UNIT  IV: Electronic Spreadsheet 

Formatting Data in a Spreadsheet 

FORMA1TING A WORKSHEET 

Caic provides various formatting features to beautify the data and make the worksheet presentable. Formatting helps to 

enhance the overall look of the workbook. First we need to select the appropriate cell or range of cells and then 

formatting can be applied through the following ways: 

Select the desired range and apply formatting using the tools present on the Formatting toolbar. 

Right-click on the selected range of cells and select the Format Cells option. 

Select the desired range of cells. Click on the Format menu and select the Cells option. 

Let us studythe differentformatting effects that can be applied on a worksheet. 

FORMA1TING NUMBERS 

Numbers in Calc can be presented in different formats. By default, numbers are expressed in General format, which 

allows us to display them with as many decimal digits as required. It is important to note that changing the format of 

numbers modifies its appearance onlyand not the actualcell value. Let us learn the process of formatting numbers using 

the sample worksheet shown below. 

Select the cell or range of cells to be formatted. 

+ Click on Format > Cells. The Format Cells dialog 

box appears on the screen. 

Click on the Numberstab and select any data type 

from the Category list. 

Select the Format which is to be applied on the 

data. 

In the Decimal places option, select the number of 

decimal places you want to display in the data. 

Enter a suitable value in the box of Leading zeroes 

option to denote the number of leading zeroes. 

+ To use comma asthe separator between thousand 

values, click on the checkbox of Thousands 

separator. This command is optional. 

Click on the OK button. You can now see the following change in format. 
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Fg. 12.5: Formatting a 
Range as Scientific 

'S 
Formatted 

as Scientific 

Fig. 12.6: Formatting a 
Range as DatelTime 

Fig. 12.2: Format Cells Dialog Box 

FORMATTING A RANGE OF CELLS AS LABELS 

Sometimes, there is some numeric data that does not require being stored as numbers, for 

example, roll number, house number, pin code, telephone number, etc. These data values 

contain such numeric data that do not undergo anytype of calculation. Therefore, this type of 

data can be formatted as text or labels.Todo that: 

Select the range of cells to be formatted as labels. 

Click on Format>Cells. The Format Cells dialog box will appear on the screen. 

Click on the Numbertab. 

Selectlext underthe Category section. 

Click on OK. 

Observe that the data formatted as labels appear left-aligned. 

FORMATTING A RANGE OF CELLS AS SCIENTIFIC 

The Scientific format (also referred to as Standard or Standard Index Form) is a compact way to 

display very large or very small numbers. It is commonly used by mathematicians, engineers, 

and scientists. When using the Scientific format in Calc, the only option that you can set is the 

number of decimal places. 

For example, instead of writing 0.0000000014, you can write 1.4 x 10-9. And if you apply the 

Scientific notation format to the cell containing 0.0000000014, the number will be displayed as 

1.4E-09. 

FORMATTING A RANGE OF CELLS AS DATE AND TIME 

Calc provides a variety of predefined Date and Time formats for different locales. Calc stores 

dates and times as decimal numbers that comprise an integer representing the date and a 

decimal portion representingthe time. 

All dates are stored as integers representing the number of days since January 1, 1900. 

Time entries are stored in Calc as decimals, between .0 and .99999, that represent a proportion 

of the day where .0 is 00:00:00 and .99999 is 23:59:59. 

Fig. 12.3: Changing Number Formats 

Formatted 
as Labels 

NA RoL,NO. MARKS 
Arun * 

Vasim ° 99.1 
Ashish : 82 
Rat. 6 95 

63 

Fig. 12.4: Formatting a 
Range as Label 
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FIg. 12.8: SettIng Horizontal TextAllgnment 

(enter 

Right 

Justified 

Filled 

Distribut 
fere 

— ABCD • 
[o 

eference edge: 

w 

ri 

Incentive Percentage 
Charity Amount 

Month Sales -- Expenses 

lot, 
50 

Incentive Amount Total Expenses 

CaIcoffers various formatting features to improve the appearance of the text. We can change the text alignment, font, 

colour, size, style, etc., through these formatting effects. Let us learn them one by one. 

TEXT ALIGNMENT 

lheAlignmenttab is used to set the horizontal and vertical alignment of data in cells. To set a particularalignment, follow 

the given steps: 

+ Select the cellar range of cells to be aligned. 

+ Click on Format> Cells. The Format Cells dialog box will appear on the screen. 

+ Select the Alignment tab from the dialog box. 

+ Select the desired horizontal alignment from the Horizontal drop-down list. 

FIg. 12.7: Changing Text Alignment 

+ Select the desired vertical alignment from the Vertical drop-down list. 

Text Alignment 

H  C rizc nta I 

Text Orientation 

S • 

Aligns the contents 
with the default 

setting (at the bottom 
of the cell 

Vertical 

Vertically centreethe 
contents of the cell 

the contents 
at the top of the cell 

BCttCmgns the contents at the 
Justified bottom of the cell edge 

Dktributecl 

Fig. 12.9: Setting Vertical Text Alignment 

Click on OK. You can now notice the change in the alignment of the text. 

FIg. 12.10: Aligning Text in Centre 
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Tact OrIatatIofl Ouick View 
Pegrees 

eference edge: 

The shortcut key 

combination to open the 

Format Cells dialog box is 

Ctrl+1. 

Vertically stacked 

Fig. i2.11: Changing Text Orientation 

a 
a 

4 Select the cell or range of cells 

to be formatted. 

ep 

Text Extension from Upper Cell Border : It displays the rotated text from the top cell 

edge upwards. 

Text Extension Inside CeIl-  liii  It displaysthe text onlywithin the cell. 

FORMA111NG FONTS 

We can change the Font Family, 

Font Style and Font Size of the 

text contained in the worksheet. 

Follow the steps given below to 

applytheseformattingeffects: 

Click on Format > Cells. The 

Format Cells dialog box 

appearsonthe screen. 

Select the Font tab from the 

dialog box. 

Select a Font family of your 

choice from the scroll list. 

Know The Fact 

Fig. 12.12 Working with Fonts 

M1(odLg,t 
'44 F.nt 

IPn Mit,, 
Adv.¼ 

Select Font 
Family from here 

On the Alignment tab, 

under Properties section, 

select Wrap text 

automatically to enable 

the text to wrap at the end 

the of cell. 
o$ WEU A arejBode  .(,ndjcli Pttcn  

Select font style 
from here 

Th. fo.* eyl.  .0 bu pntøm.d o'th. cIe$t t*)44*4 bu  ut.d. 

LL   

What do you understand 

by Text wrapping? 

TEXT ORIENTATION 

It is used to rotate the text through a specified 

angle. Text can be oriented in both up and down 

directions. Let us change the text orientation of 

the above data. 

4- Select the cell or range of cells and click on 

Format > Cells. Open Alignment tab from 

the FormatCells dialog box. 

Under the Text orientation section, specify the angle in Degrees. If you enter a positive 

value, the text will rotate to the left and vice-versa. 

+ Select the desired Reference edge to indicate the cell edge from which to write the 

rotated text. Click on OK and note the change in text orientation. Reference Edge 

displays three options: 

Text Extension from Lower Cell Border  I I: It displays the rotated text from the bottom cell 

edge onwards. 

- Select a suitable Font style from the displayed list consisting of Regular, Bold, Italic, and 

Bold Italic options. 

+ Select the desired Font size for the content from the scroll list. 

Click on OK and observe the change. 
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FIg. 12.15:  SelectIng Cells Option Fig. 12.16: Changing Column Width 
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APPLYING FORMAU!NG EFFECTS USING FORMAUING TOOLBAR 

We can also modify the Alignment, Font Family, Font Style, and Font Size using the tools present on the Formatting 

toolbar. It provides an easy access to the formatting options. As shown in the figure below, we can apply the formatting 

effects through the following buttons: 

To apply any of the above effects: 

Select the cell or range of cells. 

Click on the required option like, Font, Font Size, Font Color, etc., from the 

Formatting toolbar. 

au 

Wrapping the text means displaying multiple lines within the cell. The Wrap Text feature in Calc 

can help you display lengthy text in a single cell without moving the content to the other cells. 

When the text exceeds a column width, it is possible to wrap it, either manually or automatically. 

Follow these steps to wrap the text in cells: 

eIect the cells having the text which has to be wrapped. 

Select Format> Cell. 

electAlignmenttab in the Format Cells. 

Select Wrap TextAutomaticallyfrom the Properties section. 

 

Fig. 12.14: 
Selecting a Colour 

Caic automatically expands the row height in order to fit more than one line in a cell. This makes all the wrapped text 

entries visible. 



Fill Handle 

Fig. 12.18: Fill Handle 

A2 ____jfx 2  

14   

Fig. 12.18: Using Fill Handle to Generate a Series of 2 
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CHANGING COLUMN WIDTH 

Sometimes you see hash signs (######) in a cell instead of the data that you have entered. These signs indicate that the 

column is not wide enough to display the cell content. By increasing the column width one can see the cell content 

properly. To change the column width: 

Place the pointer overthe column line in the column heading so thatthe cursor becomes a double -headed arrow. 

Clicking and dragging the column to the right will increase the column width. Dragging it to the left will decrease the 

column width. 

The column width will be changed once the mouse is released. 

• j si1c•x-. 
A (+)  c r E 

Cootact  NO. 

        

        

A 
ContaCt  No. 

   

C I E F 

       

         

Fig.12,17:  Changing Column Width 

To set column width with a specific measurement: 

+  Selectthecolumnsthathavetobemodified. 

• Select Format> Column. 

~ Enter the desired column width. 

~ The width of each selected column will be changed. 

II  FILL HANDLE 

In LibreOffice Calc, Fill Handle is a feature that allows the user to extend and fill a series of 

numbers, dates, or even text to a desired number of cells. In the active cell of the 

spreadsheet, the Fill Handle is a small black box at the bottom right corner, as shown in 

the figure here. 

SPEEDING UP DATA ENTRY USING FILL HANDLE 

Entering data into a spreadsheet can be very laborious and time-consuming, but Calc provides Fill Handle tool to ease 

your work. Ashortcutwayto fill cells is by dragging the Fill Handle tool in the direction you want to fill. If the cell contains 

a number, the number will be filled in the series. If the cell contains text, the same text will be filled in the direction you 

choose. 

If you enter the number "1" in cell Al and the number "2" 

in cell A2, you could extend the numbering sequence 

down through as many cells as you want. You can do this 

by selecting both the cells, then clicking on the fill handle 

with the left mouse button. Then drag the mouse down 

the spreadsheet in column A. If you drag-down to the cell 

A20, then cells Al through A20 would now be sequentially 

numbered 1 to 20 without having to type each number 

individually. Similarly, to fill the numbers by skipping two 

digits, you need to write 2 in Al, 4 in A2. Select both the 

cells and drag the Fill Handle downwards to complete the 

series. 



A I a J 
Name Location DOB Percentage in 10' 

2 Tina Delhi 18/06/84 077 
s Riya Mumbai 19/06/80 0.65 
i Mohit Chandigarh 20/06/77 0.89 
s \/lvek Kolka(a 21106/77 0.9 
6 Kushal Pune 22/06/80 0.66 

Answer the Following Questions: 

1. What do you understand by wrapping the text? 

2 Sometimes, hash signs (#####) are displayed in a cell instead of the actual data, why? How can you remove 
them? 

3. How do we enter date and time in a Calc sheet? 

4. Write the steps for converting numeric data into labels. 

5 What is Fill Handle? What is its use? 

For Better Concept Clarity 

Let us write the following data in our worksheet and try to apply the formatting effects which you have learnt 
till now. 

COPYING FORMULA WITH FILL HANDLE 

When the same formula is needed to be applied in a continuous range of cells, then the Fill Handle makes the work easy 

and fast. Apply the formula on the topmost cell of the range and drag the Fill Handle through the range to the cell where 

the formula is to be copied. The formula gets automatically copied to allthe cells ofthe range. 

For example, in the figures below, sum of cells C3 to E3 is calculated in cell F3. Using the Fill Handle, the formula written in 

cell F3 is dragged and copied till cell F7. As a result, the formula gets copied to all the cells from cell F3 to F7. 

A 
El f E_. 

C E 

TOTAL MARKS - NA RO(L NO. 
MARKS 

EIIGUSH SCIENCE NATHS 
ifr4un 4 94 78 91 263 
4VaSMI 12 89 61 88 

28 82 83 78 
6Raq 6 95 92 84 
7'Bhia 17 63 62 58 

F? fz I 

TOTfrLMARK tNO.  ENGUSH SOENCE WITHS 

'Vasin 12 89 57 :. 244 
5Asni 28 82 83 78 243 
6 R,q 6 15 12 84 271. 

awna   17 63 62 58 183 

Fig. 12.19: Using Fill Handle to Copy Formula 

ASSESSMENT TIME 
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1. Convert the values of Percentage in 10th  column to Percent format: 

Select the Percentage in 10th  column and click on Format> Cells. 

+ Select the Numbers tab. Select Percent as the Category and 

choose the Format as -12.95%. 

Click on OK. Observe the desired change. 

2. Set the Horizontal Alignment as Center and Vertical Alignment as 

Middle for the data in top row. Change the Text Orientation to 60 

degrees: 

+ Select the top row and click on Format > Cells. Select the 

Alignment tab. 

3. Select the Name column 

and change the Font to 

'Monotype Corsiva', Style 

as 'Bold Italic', Size as '14' and Coloras 'Red': 

+ Select the Name column and click on Format> Cells. Select the 

Font tab. 

+ Browse the list under Font category to select 'Monotype 

Corsiva'. Select Bold Italic from the Style list and select Font 

Size as 14. Click on OK. 

Choose Center from 

the drop-down list of 

Horizontal alignment and Middle from the drop-down list of Vertical 

alignment. 

Click on the arrow key of the spinner box of Degrees to set it to 60 

degrees from the Text orientation section. Click OK. 

t*4 mv]  

I 
OeIh 18/06/84 7700% 

jya Mumbai 19106/80 65.00% 

9,loñit ChandegarP 20/06177 89.00% 

Vrve( Kolkata 21106/77 90.00% 

?cjssIa( Pune 22/06/80 66.00% 

Now, click on Font Color icon on the 

Formatting Toolbar and choose the Font 

Color 'Red'. 

After applying all the above formatting 

effects, the worksheet will appear as shown 

here. 

Save the modifications that you have made in 

the worksheet. 
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UN T - IV: Electronic S .readsheet 

Formula Refers 

=SUM(C2,D8) Cells C2 and D8 

=SUM(A1:F4) 

 

All cells from Al to F4 

=SUM(A1:F4, B7:G12) All cellsfromAl to F4and B7 to G12 

=Sheet2 I B5 

 

Cell B5 on Sheet2 

Cell Referencing 

II  INTRODUCTION 

The term Referring means indicating or mentioning. A cell reference refers to a cell or range of cells on a spreadsheet, 

that can be used in a formula orfunction from one cell to the next along the row orcolumn.. A cell reference can be used 

to referto the: 

s datafromoneormorecontiguouscellsontheworksheet. 

4 data contained in different areas of a worksheet. 

+ data on other worksheets in the same workbook. 

For example: 

There are three types of cell referencing in Calc. Let us discuss them in brief: 

RELATIVE REFERENCE 

Almost all spreadsheets use relative referencing as a default, e.g., D3, B24, A1O:D16, etc. When a relative cell reference is 

copied across multiple cells, they get changed based on the relative position of rows and columns. 

If you copy the formula =C3~D3+E3 from row 3 to row 4, the formula will automatically become =C4+D4+E4, as seen in 

the example below. If the same formula is pasted in cell 17, the formula will become F7+G7+H7. The relative cell 

reference changes itself according to the relationship with the position in the cell(s) on the worksheet. Like, the formula 

in cell F3 refers to the addition of three corresponding cells to its left, therefore, whereverthe formula is copied it carries 

the same relationship of adding its left three corresponding cells. Relative referencing is especially convenient when you 

need to repeat the same calculation across multiple rows or columns. 

CHAPTER  13 

b 

NAME ROLL NO. 
MARKS IN SUBJECTS ioiC1 

SCIENCE MATHS ENGLISH MARKS I 

Awn 5 89 94 83 C3+O3+E3 
Vasm 12 78 90 79. L_ 
Anklta 7 69 74 Relative Cell  • 

nesh 18 95 82 Reference 

Sakshl 2 64 73 1 
Ravi 9 59 67 50 

NAME 

X I .U.QI.4 
C I 

ROLL. NO. 
MARKS IN SUBJECTS TOTAL 

MARKS SCIENCE MATHS ENGLISH 
Awn 5 89 94 83 266 

Vasin 12 78 C4+D4+E4 
AnkIa 69 14 69 

Dneth 18 95 82 90 
Sakthi 2 64 73 

R8v 59 67 50 

Fig 13.1: Using Relative Reference 
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Absolute Cell 

ToTM MARKS' FT 
'N:- 247 90 j 79 

-  - 74 69 
82 90 

73 88 
50 67 

SHt 
TOTAL MA 

SOLT 

• Vasin 12 78 90 79 247 
' 74 69 212 

Dne5h 18 96 82 90 sC$5S01641E$S 

' 

Ss71 2 64 68 13 
R,rn 9 50 61 j 50 

I. 

NAME 

X d ..89.82 

ROLl. NO. 

Ann 
V85 m 12 78 
Aflk4a 7 69 
Onesn 18 95 
SaksiI 2 64 
R8vl 9 59 

ABSOLUTE REFERENCE 

Sometimes, you need to copy a formula in which the content of the cell(s) associated with this formula must be fixed. In 

that condition, absolute cell referencing is used. In this case, you can keep the cell address constant and it is designated in 

a formula by the addition of a dollar sign ($) preceding the column and the row referenced, e.g., $D$3, $B$24, 

$A$1O:$D$16, etc. 

If you copy the formula =$C$5+$D$5+$E$5 from row 5 to row 6, the formula will remain =$C$5~$D$5~$E$5. If the same 

formula is pasted in cell 17, the formula will still remain =$C$5+$D$5+$E$5. Unlike relative reference, an absolute 

reference does not change with the change of its address. 

Fig 13.2: Using Absolute Reference 

MIXED REFERENCE 

A mixed reference is a reference that refers to a specific row or column. It is a combination of relative and absolute 

referencing. In this case, either one of the row or column is absolute (fixed) and the other is relative (changeable), for 

example, D$3, $B24, $A1O:$D16, etc. 

If you copy the formula =$C7+$D7+$E7 from row 7 to row 8, the formula will become =$C8+$D8+$E8.  If the same 

formula is pasted in cell 19, the formula will become =$C9+$D9+$E9. Since the column reference is absolute, therefore, 

the column address will not change, whereas the relative row reference will change accordingly. 

p 
MARKS 4 SJB 

NM ROLL NO MARKS IN SUBJECTS 
-- OThARKS 

Mixed Cell 
Reference DTAI. MARKS 

scsEicE MATHS scIENcE MAThS ENGLISH 
89 94 83 \ 268 ' 89 94 83 266 

Valim I 12 78 go 79 \ \ 241 Vala 1 12 78 90 19 247 

Ankha I 7 69 I 74 69 212 1' Ankll4 I 7 69 74 69 212 

I 18 95 82 90 267 ' oman 18 05 82 90 267 
Salc9hi I 2 64 J 88 I S4kh( I 84 88 73 225 

I 9 59 I 67 50 i LL 70,,I 9 59  I 67 50 

FIg 13.3: Using Mixed Reference 

ASSESSMENT TIME 

Answer the Following Questions: 

1. What do you understand by Cell referencing? 

2 Define the following with an example: 

a. Absolute reference 

b. Relative reference 

C. Mixed reference 

3. Differentiate between Absolute and Relative referencing. 
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CIIV For Better Concept Clarity 

Prepare a worksheet as shown ri Figure A. Calculate the allowances, deductions, and salaries of employees 
according to the following rules: 

+ HP.A= 12% of Basic Pay 

+ DA lO% of Basic Pay 

• PF8%ofBasicPay 

+ Gross Salary = Basic Pay + HRA + DA 

+ Net Salary = Gross Salary — PF + TA + Bonus 

A B C 0 E F -- G H - 
S.No, NAME BASIC PAY I-IRA (12%) DA  (10%) PF (8%) GROSS SALARY NET SALARY 

2 1 Ashish Kumar 28000 =C2*121100 C2*1O/1OO C2*8IlOO SUM(C2:E2) $G2-$F2+$C$13+$G$13 
2 Awn Gaur 38500 

4 3 Vasim SaUl 35200 
4 Sakshi Sharma 20000 

6 5 Bhawna Oberoi 22800 
/ 6 Mrinal Kuniar 25000 

7 Jatinder Kaur 38700 
8 Abhay Dolra 40100 

10 9 Arpita Sinlh 42000 
ii 10 Shilpi Mittal 43800 

Ii3 TA 1500 BONUS 10000 - 

Figure A 

+ Use Relative, Absolute, and Mixed referencing to refer the values in the formulas. 

+ Drag the Fill Handle of the cells to fill their respective columns accordingly. 

+ Observe the calculated values as shown in Figure B. 

A 8 C 0 B F 6 

i S.No. NAME BASIC PAY HRA (12%) DA (10%) PF (8%) GROSS SALARY NET SALARY 
2 1 Ashish Kumar 28000 3360 2800 2240 34160 43420 

• 3 2 Nun Gaur 38500 4620 3850 3080 46970 55390 
4 3 Vasirn Saifi 35200 4224 3520 2816 42944 51628 
s 4 Sakshi Sharma 20000 2400 2000 1600 24400 34300 
6 5 Bhawna Oberoi 22800 2736 2280 1824 27816 37492 

6 Mrinal Kumar 25000 3000 2500 2000 30500 40000 
• 7 JatinderKaur 38700 4644 3870 3096 47214 55618 
9 8 Abhay Dora 40100 4812 4010 3208 48922 57214 
10 9 ArpilaSin!h 42000 5040 4200 3360 51240 59380 
ii 10 Shilpi Mittal 43800 5256 4380 3504 53436 61432 

o TA 1500 BONUS 10000 

FigureB 
- 
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UNIT -IV: Electronic Spreadsheet

CHAPTER 14 
Introduction to Charts 

A chart is a graphical representation of data in a worksheet. It helps to provide a better understanding of large quantities 

of data. Charts make it easierto drawcomparison, see growth and relationshipamong the values and trends in data. They 

provide an accurate analysis of information. LibreOffice Calc offers a wide range of charts to interpret data. These charts 

share some common features that assistthe users to comprehend the data logically. 

A  

English Hindi I Name Total 
Kavyansh 65 67 132 

3 Dinesh 76 45 121 
4 Ravinder 78 66 144 

Pardeep 56 65 121 
Ashish 77 87 164 

Fig.  14.1:  Sample Worksheet 

10  TYPES OFCHARTS 

BAR CHART 

It illustrates the data comparison between individual items in cases when time is not an important factor. It displays data 

in the form of long rectangular bars. The categories are organised vertically and values horizontally. 

You can also display the bar chart in stacked form to understand the relationship between different entities. They can be 

displayed as 2D or3D graphics. 

  

• Ensh 
• Id 
w  .flI 

ss 
. 

   

0 20 40 60 80 103 120 140 160 180 200 200 200 200 200 200 

Fig.14.2:  Bar Chart 

COLUMN CHART 

It is used for displaying data that shows different trends 

overtime. It is the default chart type ofLibreOffice Calc. It 

is comparatively quite easy to understand. In this type of 

chart, categories are organised horizontally, and values 

vertically to emphasise on magnitude of change over 

time. 

FIg. 14.3: Stacked Bar Chart 

KNyrh 0rnesh R001nder PadCP A.thilh 

FIg. 14.4:  Column Chart 
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The first Pie Chart was 

seen in Villiam Playfair's 

book of 'Statistical 

Breviary' in 1801. 

Fig. 14.5: Line Chart 

AREA CHART 

RfC A. 

A Bubble Chart is a 

variation of scatter chart in 

which the data points are 

replaced with bubble. 

.jJ  

UNECH:FI 

It is, in the form of lines and used to illustrate 

the trends in data at equal intervals. It is 

useful in emphasising continuity by showing 

change in data over time. It is generally used 

to represent a huge amount of data. This 

type of chart is quite similar to plotting a 

graph on the graph paper with its values on 

the X-and Y-axis. 

Fig. 14.6: Area Chart 

It is a unique version of line or column 

graph. This type of chart has a greater visual 

impact than a Line chart. It emphasises on 

the magnitude, i.e., the volume of change 

over time. By showing the sum of the 

plotted values, an Area Chart also displays 

the relationship of parts to a whole. 

XV (SCATTER) CHART 

It either shows the relationships in several 

data series or plots two groups of numbers 

as one series of XY coordinates. This chart 

shows uneven intervals or cluster of data U U U 

and is commonly used for displaying 
I. I

I 

scientific data. The X-axis is usually 

assigned to an independent variable, the
QS 1 5.5 2 15 3 15 4 5 5 5.5 

variable whose value is controlled or set by
Fig. 14.7: XV (Scatter Chart) 

an individual. The Y-variable then becomes the dependant variable, the values that follow 

from each value of X. 

 

0 

 

PIE CHART 

It displays data in the form of a circle. It shows 

the proportional size of individual items that 

makes up a data series to the sum of items. It 

always shows only one data series and is 

useful when you want to emphasise on a 

significant element. This chart works best 

with the small number ofvalues. 

  

     

 

Fig. 14.8: XY (Scatter Chart) 

   

Bar Chart 

VS 

Column Chart 

In the 14th century, Bar 

Chart was used for the first 

time to plot the velocity of 

a constantly accelerating 

object against time. 

a 
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Fig. 14.10:  Net Chart 

STOCK CHART 

FIg. 14.12: Column and Line Chart 

III  COMPONENTS OFA CHAR' 

- 

ii GDl 
aw. 

Fig. 14.13: Chart and Its Components 

DONUT CHART 

It is a subtype of Pie Chart; displaying data as sections of a circle. A 

Donut Chart can have more than one data series, which attempts to 

add another dimension to the Pie Chart. It is best suited forshowing the 

proportional nature of data. A Donut Chart represents data values as a 

percentage of the whole, while categories are represented by the 

individual slices. 

NET CHART Fig. 14.9: Donut Chart 

It looks just like a spiders net. It displays data values plotted as points 

that are connected by lines to form a grid. It is useful for comparing 

data that is not time dependent but shows different circumstances, 

such as variables in a scientific experiment or direction. The poles of 

the Net chart areequivalentto the Y-axis of the other charts. 

It is a type of column graph that has been designed specifically for 

plotting data values related to stocks and shares. The data required for 

these charts consists of a specific data series like opening price, closing 

price, and high and low prices. In this type of chart, the X-axis represents 

a time series. 

Fig. 14.11: Stock Chart 

CO LU M N AND LINE CHART 

It is a combination of two other chart types. It is beneficial for combining 

two distinct but related data series, like sales overtime(column) with a 

profit margin trend(line). 

Chart is an effective way to display the data in a pictorial form. A chart can be 

inserted after selecting the relevant data from the worksheet. Let us learn about 

the various components of a chart. 

1. CHARTARE& It includes allthe area and objects in the chart. 

2. CATEGORY AXIS:  Category axis or X-axis isthe horizontal axis. 

3. VALUE AXIS:  Value axis orY-axis is the vertical axis used to plot the values. 

4. DATA SERIES: Data series are bars, slices, or other elements that show the 

data values. 
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Know The Fact 

If you have not selected 
the source data for a chart, 
place the cursor anywhere 

in the area of the data. 

The Chart Wizard will then 
guess the range of data. 

Fig. 14.14:  Sample Data Fig. 14.15:  Insert Menu 

ASSESSMENT TIME 

Answer the Following Questions: 

1. Define chart. 

2. What is the use of inserting chart in a Calc worksheet? 

3. What is the default chart type of LibreOff9ce Calc? 

4. Definechartwall. 

5. CATEGORYNAME:  Category names arethe labels displayed on the X- and Y-axis. 

6. CHARTWALL:  Chart Wall is a window within the Chart area. It contains the actual chart 

itself and includes plotted data, data series, category, and value axis. 

7. .EGEND:  Legend depicts the colours, patterns, or symbols assigned to the data series. 

8. HARTTlTLE:  It describes the aim and contents of the chart. 

9. iRlDLlNES:  These can either be horizontal or vertical lines depending on the selected 

chart type. They extend across the plot area of the chart. They make it easier to read and 

understand the values. 

II  CREATING A CHART IN CALC 

Calc offers the features to create an embedded chart in a worksheet. It is displayed along 

with source data and other information present in a worksheet. An embedded chart is saved 

with the corresponding worksheet when a workbook is saved. 

let's Know  More 

Follow these steps to create a chart: 

Select the range of cells from the worksheet that contains the source data for the chart. 

Open the Chart Wizard dialog box using one of the two methods: 

ClickontheCharticon presentontheStandardToolbar. Or 

Click on Insert Chart. 

- ..T - 

- A B C 

Name English Hindi Science 
2 Kavyansh 65 67 75 
3 Dinesh 76 45 80 

Ravinder 78 66 90 
s Pardeep 56 65 65 
6 1 Ashish 77 87 85 

J. 

Chart Floor is the lower 
area that forms the base in 
3D charts. This component 

[insJ FQrmat StIes heet Qata: is not available in 2D 
charts. Image.. 

Media 

chart... 

gbjet 

LI shape 

Pivot Tab'e... 

Know The Fact 

The Percentage Stacked 
chart shows each value in 
the series as a part of the 

whole. 
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The following data shows the grocery expenses for each month from January to December 2018. Create a 

worksheet showing the below mentioned data and save the workbook with the name Grocery_Spends_2018. 

January 12800 

February 13200 

March 11950 

April 12360 

May 14110 

June 10905 

July 12150 

August iio 

September 13350 

October 18600 

November 16500 

December 15400 

Create charts of the following 3 types based on the above data: 

+ Column chart 

+ Pie chart 

+ 3DBarchart 

ó ecap
+ Formatting features help to make the worksheet more presentable. 

+ The number of decimal places and leading zeros can be formatted for a numeric 

data. 

The numeric data can be converted into labels by formatting them as Text. 

The Scientific format (also referred to as Standard or Standard Index Form) is a compact way to display very 

large orsmall numbers. 

All dates are stored as integers; representing the number of days since January 1,1900. 

Time entries are stored in Caic as decimals, between .0 and .99999, that represent a proportion of the day 

where .0 is 00:00:00 and .99999 is 23:59:59. 
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Caic stores dates and times as decimal numbers that comprises an integer representing the date and a decimal 

portion representingthe time. 

Data written inside a cell can be aligned both vertically and horizontally. 

+ Data written inside a cell can be rotated at any angle by changing its orientation. 

+ The Wrap Text feature in Calc helps to display lengthy text in a single cell without moving the content it to the 

other cells. 

+ The Hash signs (#######) in a cell indicate thatthe column is not wide enough to displaythe cellcontent. 

Fill Handlefeature allowstofilla series of numbers, dates, or even text to a desired numberof cells. 

A relative cell reference gets changed relatively when the formula is copied to another cell. 

An absolute cell reference remains constant even when the formula is copied to another cell. 

In a mixed cell reference, you can keep a part of the reference, changeable whereas the other part constant. 

Charts help us to understand and compare large quantities of data easily. 

Charts make it easierto see growth and relationship amongthe values and trends in data. 

Bar Chart, Column Chart, Line Chart, Pie Chart are some of the most commonly used chart types. 

The relevant data stored on the worksheet on which the chart is based is called the source data of the chart, The 

chart can change itselfautomaticallyaccordingto the change in the source data. 

Chart wizard helps in step-by-step process of creating a chart. 

DEVELOPER  

 

BRAIN 

 

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

A. Multiple Choice Questions: 

1. Which ofthefollowing techniques can be used to allow only a date value in cell? 

a. Data formatting b. Data sorting c. Data filtering d. Data validation 

2. Which function is used to calculate the total number of numeric entries in a worksheet? 

a.COUNT() b.SUM() c.CALCULATE() d.AVERAGE() 

3. If you copy the cell A5 containing the formula =SUM($A$1:$A$4)  to cell B5, what will be shown in cell B5? 

a. =SUM(B1:B4) b. =SUM($B$1:$B$4) c. =SUM(A1:A4) d. =SUM($A$1:$A$4) 

4. How many axes does a column chart in Calc have? 

a.One b.Two c.Three d.Four 
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a. Edit b. Format c.Insert d.Data 

• A Caic function can begin with: 

a.= b.+ c. - d. All of the above 

7. . allows the user to extend a series of data and thus results into speeding of data entry. 

a. Fill handle b. Data filtering c. Sorting d. Copying 

8. If I want to copy a formula from one cell to another and keep the rows references fixed while the column 

references change, what kind of referencing should I use? 

a. Relative b. Absolute c. Mixed d. None of the above 

9. is the value axis in a column chart. 

a. X-axis b. Y-axis c. Z-axis d. None of the above 

10. . depicts the colours, patterns, or symbols assigned to the data series in a chart. 

a. Category b. Chart area c. Axis d. Legend 

B Fill in the Blanks: 

1. ThecolumnimmediatelynexttocolumnZis  

2. The small black box at the bottom-right corner of the active cell that lets you fill a series quickly is called as 

3. The formula "=AVERAGE(D5 : D12)" stored in cell D13 when copied to cell F13 changes to  

4. The formula in cell A4 is =B4+C5. On copying this formula to cell C4, C4 will change to  

5. Labels entered into a cell are automatically  aligned. 

6. The absolute cell reference of the cell formed by the intersection of the sixth column and ninth row will be 

7. The formula to calculate the sum of first 15 rows of second column of the worksheet is  

8.  is a window within the Chart area that contains the actual chart itself and includes plotted 

data, data series, category, and value axis. 

9. The chart icon is present on the toolbar. 

10. The . chart is a subtype of Pie chart; displaying data as sections ofa circle. 

C. State True or False: 

1. There can be any numberof worksheets in a Calc workbook. 

2. In a spreadsheet, you can align the cells horizontally but not vertically. 

3. Cell orientation can be changed to 90 degrees. 

5. From which menu can you insert a chart on your worksheet? 
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4. Fill handle cannot be used to fill the series of dates. 

5. Calc stores dates and times as numeric values. 

6. F$8 isan example of mixed referencing. 

7. COUNT() function is used to calculate the total number of label entries in the cells. 

8. Charts make it easier to understand and compare large quantities of data. 

9. A bar chart can be displayed in 2D and 3D formats. 

10. A line chart is used to illustrate trends in data at equal intervals. 

A. Multiple Choice Questions 

1.(d) 2.(a) 3.(d) 4.(b) 5(c) 6.(d) 7.(al 8.(c) 9.(b) 10.(d) 

B. Fill in the Blanks 

1. AA 2. Fill Handle 3. =AVERAGE(F5:F12) 4. =D4+E5 5. Left 6. $F$9 7. =SuM(B1:B15) 8. chart Wall 

9. Standard 10. Donut 

C. State True or False 

1. (F) 2. (F) 3. (T 4. (F) 5. (T) 6. (1) 7. (F) 8. (1) 9. (T) 10. (T) 

SECTION 2: THEORY QUESTIONS-(SOLVED) 

What is cell referencing 

Ars. Cell referencing is the method by which a cell or series of cells is referred in a formula. For example, Al refers 

to the cell at the intersection of column A and row 1. 

What are the various types of cell referencing in 

Airis.  Calc uses three types of cell referencing: Relative, Absolute, and Mixed. Relative references change when a 

formula is copied to another cell. Absolute references remain constant no matter where they are copied. 

Mixed references are used when you want to change either the row reference or column reference when the 

formula is copied. For example, B4 is relative reference, $B$4 is absolute reference, and B$4 is mixed 

reference. 

What is Fill Handle? 

Fill Handle is a feature that allows the user to extend (and fill) a series of numbers, dates, or even text to a 

desired number of cells. In the active cell of the spreadsheet, the Fill Handle is a small black box at the 

bottom-right corner. 

What  iç  thp nurpose of inserting chart in  Calc worksheet? 

ns. Chart helps to provide a better understanding of large quantities of data through graphical representation. 

They also make it easier to draw comparison, see growth and relationship among the values, and trends in 

data. They provide an accurate analysis of information. 

5 Narn some commonly used chai yps n 

A s. Bar Chart, Column Chart, Line Chart, Area Chart, XY (scatter) Chart, Pie Chart and Donut Chart are some of 

the most commonly used chart types in Calc. 
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SECTION 3: APPLICATION BASED QUESTION-(SOLVED) 

Abhay is working on his Social Science project. He is trying to record some data on a spreadsheet about some 
Indian cities. He has recorded the below-mentioned data. 

A & C 0 t 

Today's Date 

3 
CITY 

TEMP 
(Celsius) 

TOTAL 
POPULATION 

- NO. OF 
VOTERS 

NO. OF 
NON-VOTERS 

4 LucknOw 32 2820000 1949956 
Surat 32 4460000 1484066 
De'hi 31 19000000 14316453 
Goa 30 1820000 1127007 
Mumbai 33 18400000 9639000 
Chennal 34 7090000 4006700 

lsrinaiar 16 1180000 120523 
: Amritsar  27 1130000 147726 

How will he perform the following on this data? 

a. Enter todays date in cell Di. 

b. Convert the temperature data into labels. 

c. Find which city has the maximum population. 

d. Find which city has the minimum population. 

e. Calculate the total population of the given cities. 

f. Find the average number of voters. 

g. Calculate total number of non-voters in Lucknow in cell E4. 

h. Copy the same formula from cell E4 to cells E5 to Eli. 

i. Convert the total population data into scientific notation. 

Ans. Do the following on the spreadsheet data: 

a. =TODAY() 

b. Select B4 to Bli, Format> Cells, choose Text in Numbers tab. 

c. =MAX(C4:Cii) 

d. =MIN(C4:Cii) 

e. =SUM(C4:Cii) 

f. =AVERAGE(D4:Dll) 

g. =C4-D4 

h. Drag the fill handle from cell E4 to cell Eli. 

I. Select cells C4 to C ii, Format> Cells, choose Scientific in Numbers tab. 

* 
I I c 

Today's Date  : 1oo4z19 

- CITY 
TEMP 

jOdsius) 
TOTAl. 

POPULATION 
NO. OF 

VOTERS 
NO. OF 

NON.VOTERS 
Ludnøw 32 2.82E•06 1949956 870044 
SInai 32 4466*06 1484068 2975932 

I Delhi 31 3906*07 14316453 4683541 
GOa 30 L82606 1127007 692993 

I 'Mumbaj 33 1.84E+01 9639000 8761000 
• Chenna, 34 7.096*06 4006700 306330C 
$ SnaQef 16 1.186*06 120623 1059477 
II Amiits& 27 1.13E'06 141726 992274 
U 

U Maximum Populallon 19000000 
II Minimum PopulatIon 1130000 
U Total PopulatIon 55900000 

- AvereQeVoltS 4098929.125 
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1 Marketing 

Sales 

Administration 

20000 

25000 

40000 

30000 

S. No. 2017 Department 

Content 3 30000 

SECTION 4: THEORY QUESTIONS-(UNSOLVED) 

1. Why do you need formatting features in Ca Ic? 

2. How to format numbers into labels and scientific notation in Caic? 

3. Write the mechanism of changing the text alignment. 

4. How can you change the orientation of text written in the spreadsheet cells? 

5. How will you format cells to enter date? 

6. What happens if you enter large amount of data in a narrow column? What is the process of changing the 

column width? 

7. What is the benefit of using Fill Handle? 

8. Explain cell referencing and its types with example. 

9. What is a chart? Why do you use chart in Calc? 

10. How will you insert chart on a Caic spreadsheet? 

SECTION 5: APPLICATION BASED QUESTION-(UNSOLVED) 

Aditya is helping his father in calculating the salaries of employees, who work in the accounts department of his 

company. Given below is the data on department-wise initial salaries of employees for the year 2017. 

Department Wise Salary increment 

Initial Salary 

45000 

30000 2 

On the basis of the given data, Aditya needs to do the following: 

a. Calculate the salary for the year 2018 with an increment of 22% for all the departments. 

b. Calculate the salary for the year 2019 with an increment of 30%. 

c. Calculate the department-wise average ofinitialsalaries for three years. 

d. Calculate the yearly average of initial salaries for all three years. 

e. Create a chart to show the comparison of salaries yearly as well as department-wise. 

4 

5 

6 if 

Accounts 

Human Resource 
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Quarter 1 IRs.) Quarter 2 (Rs.) Quarter 3 (Rs) Quarter 4 (Rs.) Actual Sales 2 
North 50000.00 4500.00 31000.00 4500.00 90000.00 

a East 4500.00 5000.00 5343.00 3067.00 
sWest 3067.00 1200.00 23870.00 1200.00 

6 South 50000.00 5400.00 3067.00 5400.00 

  

For Better Concept Clarity 

 

Create the following Calc sheet to calculate the actual sales for different quarters for the ABC Company. 

REGION WISE SALES REPORT OF ABC COMPANY 

Do the following on the data: 

+ Calculate the sum ofall quarters in Actual Sales. 

+ Validate cells B3 to G6 so thatthey can contain only numbers. 

+ Calculate the total sales of each quarter, total actual sales, and total projected sales in row 7. 

+ Find out which quarter has given the highest and lowest sale. 

+ Create a column chartto compare the region-wise sales of four quarters. 

+ Create a line chartto compare the region-wise actual and projected sales. 

I 
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CHAPTER 15 UNIT - V:  Digital Presentation 

  

  

   

Characteristics of a Good Presentation 
Over the last two decades, our lives have slowly been taken over by technology. The rapid development of technologies 

has considerably influenced mankind. The advent of advanced presentation graphics software has replaced the 

overhead projectors and transparencies of bygone days. The conventional method of presenting information is being 

gradually replaced by digital presentation. It has become more colourful, comprehensive, and appealing, which has 

made the process of delivering information more interactive, effective, and easyto comprehend. 

Presentation software is application software, which is used to create multimedia presentations in the form of slide 

shows. 

A presentation is a collection of slides arranged in a sequential manner to convey, persuade, motivate, and entertain or 

to provide information. It can be projected on a big screen by attaching the computer with a multimedia projector. The 

maximum usage of presentations can be seen in the fields of entertainments, educations, corporate training sessions, 

seminars, and conferences. 

Some of the most popular presentation software are: 

LibreOffice Impress OpenOffice Impress Adobe Connect 

Microsoft PowerPoint Google Slides(Part of G Suite) 

A slide can be defined as a digital or an electronic page of a presentation. A slide show is a sequential display of slides, 

which is shown to the audience with an objective of providing information and exchanging ideas/views on a particular 

to F)  c. 

ELEMENTS OF PRESENTATION 

A presentation can be made more interesting and effective by including: 

+ RegularText, Lists items 

Background 

Background and Title 

Graphical elements like, Clip Arts, 

Shapes, Diagrams, 3D objects, Table, 

etc. 

Audio and videos 

Transitions and animation 

Footer 

Date and time 

Slide number 

The next of the most interesting Environm.ntal 
Facts Is related to the pills and other medic aliorts 
in pharmacy stores which h,v. b.en mad, from 
some exotic plants. On. in every four purchases 
comes from the rainforests. With reducing th. 
deforestation of ralnforests there will b. a lot 
more plants available for pills producing. 
Unfortunat.iy. we hav, lost over a half of them 
already. 

Date 510115 Lnamlvg PovcorPcin Footer 

Fig. 15.1: Basic Elements of a Slide 

4. 

+ 
ENVIRONMENT FACTS 

Th.Worid Bank Group orb. largest sourc, of muldbt.ral financing 
for forests, Investing about $500.600 million a year. 

Reforestation Projects Bring Carbon Revenues And Co-Bsn.flts 1* 
Poor Communities 

Body Text 

Slide Number 
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III  CHARACTERISTICS OFA GOOD PRESENTATION 

A presentation is powerful communication tool to present the views and ideas effectively through visual aids. You should 

follow certain guidelinesto create a good quality presentation as listed below: 

WELL DESIGNED 

A presentation should be carefully framed keeping in viewthe situation, audience, and subject. Make sure that the slides 

are nottoo complicated. If theyare difficult to understand, the audience will losethe attention. 

NUMBER OF LINES 

You should include only a maximum 5 to 8 lines in a slide, and write in sentence fragments using keywords. Also, you 

should keepthe font size to 24 or bigger. 

USE OF COLOURS 

Make sure that your presentation is attractive and appealing. You should avoid light colours or busy backgrounds. Always 

use dark colours, bold letters, and different fonts to highlights some points. A striking colour contrast between words, 

graphics, and the background can be very effective in conveying both, message and emotions. Use easy-to-read fonts 

such asArial and Times New Roman. 

FORMAT FOR PERFECTION 

Make sure that yourtext is appealing and aligned properly in slides. If you have crowded slides in your presentation then 

people will be busy reading text and will not be able to listen to you. So, you should not include any unnecessary 

information in your slide. If there is anything that you need to show in detail, then split it into separate slides or try to 

explain it through a chart or image. 

USE HIGH-QUALITY GRAPHICS 

You should include high-rise graphics. Also, avoid inserting more than two graphics on a single slide. If you include more 

than two graphics then it makesthe slide crowded. 

ANIMATIONS AND VIDEOS 

Use of transitions, animation, and videos serve as a change of pace thereby increasing the interest of your audience. 

However, you should not use more than one animation or video on a single slide, and also avoid using excessively 

complicated transitions. Itloses credibility with youraudience. 

CORRECT USE OF GRAMMAR AND LANGUAGE 

Make sure that there are no spelling and grammatical errors in your presentation content. You must do a spell check on 

all the slides of your presentation before finalising it. You should also use direct and concise language. 

KEEP IT SIMPLE 

Always try to keep your presentation simple by using charts, which are easy to understand and graphics that reflect what 

you are saying. The thumb rule for making a good presentation is to ensure that there are not more than five words in 

each line and not more than five lines in each slide. 

MINIMISE FACTS AND FIGURES IN SLIDES 

You should avoid to include too manyfigures and numbers. 
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ASSESSMENT TIME  1= 

Answer the Following Questions: 

1. What is a presentation? 

2. Listthedifferentelementsofa presentation. 

3. Distinguish between slide and slide show. 

4. List any three presentation software. 

5. What points should you remember while making a presentation? 

For Better Concept Clarity 

List the possible multimedia contents that are included while creating a presentation. Also, prepare a 

storyboard of the presentation that you wish to create. 
,1 

EDIT RUTHLESSLY 

After creating all the slides, imagine yourself as one of the listeners, and critically review your presentation. If you find 

something unappealing, distracting, or confusing, either modify or remove it. 

POWERFUL FIRST IMPRESSION 

First impression is the last impression. You cannot make a first impression twice. The audience will make decisions about 

you from your first appearance, your words, and the intonation of your voice. Plan the opening of your presentation 

precisely. Use short sentences and keep minimum technical information. Grab the attention of your audience with a 

joke, an interesting fact, a short anecdote, a quotation, a positive statement, or a stimulating question, etc. 



Fig. 16.1:  Starting LibreOffice Impress 

UNIT - V:  Digital Presentation  

CHAPTER  

Getting Started with LibreOffice Impress 
LibreOffice Impress is a popular presentation software. It comes as an integral part of the LibreOffice Suite. Impress 

allows you to create dynamic slide presentations that can include text, pictures, charts, diagrams, audio, videos, 

narration, transitions, and animation. 

II  STARTING IJBREOFFICF MPRFSS 

You can open the LibreOffice Impress 6.2 on your computer using any of the following ways: 

Open the Start menu on your computer and select the LibreOffice 6.2> LibreOffice Impress from the Programs 

list. Or 

Type Impress in the Search bar, choose application name, and press the Enter key to open it. Or 

Double-click on the LibreOffice Impress shortcut icon, if it is available on the desktop. Or 

Open the LibreOffice suite using the Start menu or Search bar. 

The LibreOffice suite window appears. Select Impress 

Presentation under Create. 

You will find a window with a list of predefined templates. We will 

learn how to use the templates to create the presentation later on. 

Click on Close or Cancel button to close this window. You can also 

uncheck the Show this dialog at startup checkbox to avoid seeing 

this window every time you start Impress. 

A blank presentation named Untitled 1 with a Title Slide layout 

appears. 

I  PARTS OF LIBREOFFICE MPRESS W 

The main components of the Impress window are as follows: 

SLIDES PANE 

It contains thumbnail pictures ofthe slides in your presentation. They are given in the same order as they will be shown in 

a Slide Show. If you wantto seethe Iargeviewofanythumbnail, click on it. The selected slide appears in theworkspace. 

WORKSPACE 

It is the blank area in the middle of the window where a slide is displayed. y default, a slide appears in Normal view. You 

can change the defaultview in Outline view, Notes view, orSlide Sorterview. Allthese views are available underthe View 

menu. You can also access the views by clicking on the drop-down arrow of Display Slides on the Standard toolbar. 

SIDEBAR 

It contains eight buttons — Sidebar Settings, Properties, Slide Transition, Animation, Master Slides, Styles, Gallery, and 

Navigator. These buttons enable you to make changes in settings ofSidebar, and allowyou to formatthe presentation. 
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By default, LibreOffice 

Impress application opens 

- with the Title Slide as its 

first slide. 

Let's Know Mare 

  

To customize the Sidebar, 

click on the Sidebar 

Settings icon and select 

Customization. A 

submenu appears. By 

default, all features are 

selected. Uncheck the 

option you do not want to 
view on the Sidebar. 

Let's Know More . 

Many toolbars can be 

used during slide creation. 

They can be displayed or 

hidden by going to View> 

Toolbars on the Menu bar. 

85 

TITI.E BAR 

This bar is located at the top of the Impress window. It displays the current presentation 

(Untitled 1) and the name of the application (LibreOffice Impress). The Minimize, Maximize 

or Restore Down, and Close buttons are present on its extreme right. 

M EN U BAR 

The Menu bar includes all the menus present in the Impress application, like File, Edit, View, 

Insert, etc. 

Fig. 16.2: Components of Impress Window 

STANDARD TOOLBAR 

This bar is placed below the Menu bar. It contains the shortcut icons for the most frequently 

used commands in Impress. Some of its tools are: 

New It creates a new LibreOffice document. 

Open It opens an existing file from your system or remote location. 

Save  i Itsavesthe current document. 

Save A: It saves the current document in a different location or with a different file name 

or file type. 

Export As PDF It saves the current file to Portable Document Format (PDF) . A PDF file can 

be viewed and printed on any platform with the original formatting intact. 

- - Click on the Print icon to print the active document. The Print dialog box opens. It 

contains different options that you use to take printouts. 

Cut It copies the selection to the clipboard and removes it form its original location.
Lets Discuss 

Copy  [i?J: It copies the selection to the clipboard while keeping it in the original location as lide vs Presentation 

well. 
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Unsaved changesj LPa9e  (slide) style 

III de 

Paste r : It insertsthe contents of the clipboard atthe location of the cursor. 

Clone Formatting • : First select some text or an object, then click on the Clone Formatting icon on the Standard toolbar. 

Now, click on an object to apply the same formatting. 

Undo It reverses the last given command or the last entry you typed. To select a previous operation upto which you 

want to reverse, click on the arrow next to the Undo icon on the Standard toolbar. 

Redo It reverses the action of the last Undo command. To select the Undo step that you want to reverse, click on the 

arrow nextto the Redo icon on the Standard Toolbar. 

Spelling : It checks the document orthe current selection for spelling errors. 

insert Hypertink It opens a dialog boxthatenablesyou to create and edit hyperlinks. 

Fontwork It opens the Fontwork Gallery dialog box from which you can insert styled text not possible through 

standard font formatting into your document. 

STATUS BAR 

The Status bar is located at the bottom of the Impress window. It displays information, like cursor position, unsaved 

changes, digital signature, slide number, slide, style, zoom slider, etc. 

[Zoom percentage 

+ 3O% 

information areal  

Ted Riie Thck W_. se4ecd  S 9.92x479 

FIg. 16.3:  Status Bar 

boss 1.93 

Cursor position gitaI signatireJ—i Slide nu  • Zoom Sf 

From left to right, you will find: 

Information Area: It changes depend on the selection. For example: 

Example selection Examples of information shown 

Text area Text Edit: Paragraph x, Row y, Column z 

Charts/Spreadsheets Embedded object (OLE) "ObjectName" 

selected 

Graphics Bitmap with transparency selected 

Cursor Position: It is the position of the cursororthe top-left corner of the selection measured from the top-left corner of 

the slide, followed bythe width and height of the selection ortext box where the cursor is located. 

Unsaved Changes: The highlighted Save icon on the status bar indicates that the document has been modified. Click on 

the icon to save the changes done by you. 

Digital Signature: It is a flag indicating whetherthe document is digitally signed. After the file has been saved, click on this 

flag to open the digital signatures dialog box. 

Slide number:  This section on the status bar displays current slide number and the total number of slides in the 

presentation. 

Fit Slide to Current Window: It makesthe slide appear atthe centre ofthe workspace. 

Learning 
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Text Language: It shows the language dictionary which is currently in use. To choose new a new dictionary, right-click on 

the dictionary section and select the More option. The Language Settings dialog box opens. Here, select the dictionary of 

your choice and click on OK. 

ZoOm Slider: It adjuststhe zoom percentage of the Workspace displayed. 

ZoOm Percentage: It indicates the zoom percentage of the workspace displayed. Click on Zoom percentage to open the 

Zoom & View Layout dialog box. Here, you can select the different options to reduce or enlarge the screen display. 

You can hide the Status bar and its information by clicking on View on the Menu bar and deselecting the Status Bar 

option. 

DRAWING TOOLBAR 

It contains the icons of the most commonly used drawing tools, like shapes, text, images etc., which can be used to 

beautifythe slides. Some of the tools present in Drawing toolbar are: 

It is used to select an object on the current slide, click on the Select tool (white arrow) on the Drawing toolbar, 

and then click on the object. 

Rectangle : It draws a filled rectangle on your current workspace. Click where you want the rectangle, and drag to the 

sizeyou want. To drawa square, press the Shift keywhile dragging. 

Ellipse : It draws a filled oval on your current workspace. Click where you want to drawthe oval, and drag to the size you 

want. To draw a circle, hold the Shift key while dragging. 

Curve : It draws varioustypes of freeform orfilled curves and polygons. 

Connectors It draws connectors to connect two or more objects in the current slide. A connector is a line that joins 

objects, and remains attached when the objects are moved. If you copy an object with a connector, the connector is also 

copied. 

Lines and Arrows It draws various types of lines and arrows. 

3D Objects : It draws three-dimensional objects that have depth, illumination, and reflection, such as Cube, Sphere, 

Cylinder, Cone, Pyramid, Torus, Shell, and Half-Sphere. 

BasicShapes : It draws basic shapes on your current workspace like, Rectangle, Square, Circle, etc. 

Symbol Shapes : It draws symbols like, Smiley Face, Sun, Moon, Star, Flower, etc. on your current workspace. 

BlockArrows It draws various types of arrows on your current workspace. 

Flowchart - : It draws the shapes used in a flowchart on your current workspace. 

Callouts . : It draws various types of callouts on your current workspace. 

Stars and Banners:  It draws various types of starand bannershapes on your current workspace. 

Points : It highlights selection points on your drawing. The selection handles are used for moving, rotating or changing 

the shape of an object. 

Glue Points: Itenablesyou to editglue points on yourdrawing. Glue points are used to fix orglue a connectorto an object 

so that when the object moves, the connector stays fixed to the object. 

ROtate  : It enables you to rotate the object. 

Aign It modifies the alignment of selected objects. 



Arrange It changes the stacking order of selected objects. 

Toggle Extrusion: It turns ON or OFF 3D effects for the selected objects. 

II  CJ' !!pprnFprF !T'PF 

You can close the LibreOffice Impress window by using any of the following ways: 

Click on the File menu and select the Exit LibreOffice option. Or 

Click on the Close button on the top-left corner of the application window. Or 

Press the shortcut key Ctrl+Q. Or 

If the document has been saved, Impress closes immediately. 

If the document has been modified but not saved, a warning message appears. Choose the desired option to close 

the document, save it or discard the changes. 

$:II  CREATING A NEW PRESENTATION USING A TEMPLATE 

Templates are built-in designs used for creating a presentation. They include predefined elements like layouts, 

backgrounds, and colour schemes, text styles, etc. The following steps can be used to create a presentation using a 

template: 

The first screen afteropeninglmpress shows a list of templatesto choose from. Or 

Open the File menu and choose New>Templates(Ctrl+Shift+N). 

Select a template of your choice. Click on Open. 

The new presentation openswith the design and properties of the template chosen. The slides are pre-designed but 

the text and object areas are kept emptyfor you to enterthe content. 

Enter the text, objects, and images on the slides. 

You can also change the style and formatting of the slide as peryour choice. 

• CREATING A BLANK PRESENTATION 

You can create a new presentation by using any of the following ways: 

When you open Impress, you geta new presentation that contains onlyone emptyslide. Or 

To open a new presentation, click on the drop-down arrow next to the New icon present on the Standard toolbar and 

select Presentation. Or 

Click on File> New> Presentation. Or 

Press Ctrl+N. 

A new presentation will appearwith the Title Slide. Here, enterthe title of slide. 
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Fig. 16.4: Adding Text to the Slide 

I  ADDING TEXT 

To add text inside the placeholder,follow these steps: 

+ Move the mouse pointer within the placeholder and click on 'Click 

to add Title' place holder. A text box appears. 

+ The cursor appears in the centre. Type 'SUCCESS TRAIT" as a slide 

title. Now, click on Clickto add Text placeholder. 

Type the text "HARD WORK" inside the text box as a subtitle. 

"SUCCESS TRAIT" 

"HARD WORK" 

ii SELECTING A SIDE LAYOUT 

Layout refers to the way things are arranged on a slide. A slide 

layout contains placeholders, which in turn holds text, such as 

titles, bulleted lists, and slide content, such as tables, charts, 

pictures, shapes and clip arts. Each time you insert a new slide, you 

have to choose a layout that matches your requirement. You can 

also change the layout of the existing slide. The layout can be 

modified either in Normalview orSlide Sorterview. 

To apply a slide layout, follow the given steps: 

Select the slide in the Slides Pane. 

In the Properties pane, select the desired layout under the 

Layoutssection. Or 

Click on the Slide menu and select the Layout option. A 

submenu appears, select the required slide layout. 

You can now observe the change in the existing slide. 

II  SAVING A PRESENTATION 

It is important to save your work at frequent intervals to avoid data 

loss. Follow these steps to save the presentation: 

FIg. 16.5: Selecting a Layout in Properties Pane 

'V — 
Click on the Save icon on the Standard toolbar or select the File 

0.•. 
I 

menu >Save option. • c__a_n 

Impress displays the Save As dialog box. Enter the name 'Eco 
... — 

— 
__ 

IJ  c..- 

Friendly AC' in the File name text box and click on the Save 

b utto n. 

- - 

r*_.. - 

s.__,. Ot.p 

The presentation will be saved with the specified name and the 

extension will be .odp. 
ri 

Fig. 16.6:  Saving a Presentation 

If you want to save a presentation as another file type, click on the Save as type drop-down menu in the Save As dialog box and 

select the required file type while saving a file. 
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SAVING A PRESENTATION USING PASSWORD PROTECTION 

Sometimes, you have some crucial data that cannot be shared with everyone. In such a case, you can save the file with a 

password so that it can only be viewed by selective users who know the password. To use this feature, follow these steps: 

Click on the check box Save with password option, and then click 

on Save. 

You will receive a Set Password prompt message box. 

Type the desired password in the Enter password to open text 

box, and type the same in the Confirm password text box and then 

click on OK. 

The presentation will be saved with password protection. 

After a password has been set, the document will only open with 

the password. In case you forget the password, there will be no 

wayto recoverthe document. 

Remember, the password is case sensitive. 

    

Set Password 

  

 

File Encryption Psword 

enter password to open 

Confirm password 

  

 

Note After a password has been set, the document will only open 

with the password. Shosild you lose the password, there will be no 
way to recover the document. Please also note that thus password is 

case-sensitive 

  

cancel ] 

 

 

Fig. 16.7: SavIng with Password Protection 

 

Uj  RUNNINGASLIDESHOW 

A slide show is a sequential display of all the slides. To run a slideshow,follow these steps: 

Click on the Start from first Slide button present on the Standard toolbar. Or 

PresstheF5keytorunaslide. Or 

You can also start the slide show by clicking on Slide Show> Start from firstSlide. 

Click on the mouse button or use the Enter key or Spacebar keyto move to the next slide. 

Use the Page Up key or Page Down key, or Arrow keys to move between the slides. 

To quit the Slide Show view, press the Esc key on the keyboard. 

SAVING A PRESENTATION IN POF 

In LibreOffice Impress, you can create Portable Document Format (PDF) 

of the presentation easily. PDF files can be viewed using the Adobe 

Acrobat Reader which is free software. To create the PDF of your 

presentation, follow these steps: 

Click on the File menu and select the Export as PDF option. 

The PDF Options dialog box appears. Click on the Export button. 

The Export dialog box appears. Select the location where you want 

to keep your PDF file. 

Enter the name in the File name box. Click on the Save button. Your 

presentation will be saved in the PDF format. Fig. 16.b PDF Options Dialog Box 
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Fig. 16.9:  Message Box 

Fig. 16.10: Opening a Presentation 

CLOSING A PRESENTATION 

Click on File > Close to close an Impress presentation. If the presentation has not been saved since the last change, a 

message box will be displayed. 

You have three options in the Message box. Let us see what happens, if you click on them. 

+ Don't Save: The document is closed, and all modifications since the last 

save are lost. 

• Cancel: Nothing happens, and you return to the document. 

Save: The document is saved and then closed. 

Save Documort? 

Save changes to document UntitJed 1 before dosing? 

Your ch,nges wril be lost f you don't save the,rt 

[ 
RoctSave 

'II  OPENIIJG A PkES'ik1th 

You can open an existing presentation by using any of the following ways: 

ClickonFile>Open. Or 

Click on Open button on the Standard toolbar. Or 

Press the Ctrl+O key combination using the keyboard. 

In each case, you will see the Open dialog box. 

Selectthe presentation you want to open from the desired location. 

Now, click on the Open button to open your presentation. 

USING HELP 

The LibreOffice Impress provides the Help menu. The Help menu contains a list of options using which you can get the 

help on different topics. Totake help on a particular topic, click on Help>LibreOffice Help or press Fl. You can also select 

the User Guides option in the Help menu to getthe complete guide of LibreOffice Impress. 

TIME, 

Answer the Following Questions: 

1. How do you launch Impress LibreOffice Impress? 

2. What is workspace in LibreOffice Impress? 

3. Describe the use of Undo and Redo commands. Which toolbar has these commands? 

4. How can you create a new presentation with a blank slide? 

5. How do you save a presentation in PDF? 

    

For Better Concept Clarity 

 

+ Open a blank presentation, make a Title Slide with the Title being name of the school. Also, make a Title and 

Content slide with Name of students and Class. Save and close the presentation. 

+ Protect the created presentation with a password. Open the protected presentation file, make some 

changes, save it again, close the presentation, and finally exit the LibreOffice Impress. 
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Hg. 17.3: Inserting a New Slide 

with a Slide Layout 

Digital Presentation

CHAPTER 17 
Working with Slides 

By default, LibreOffice Impress provides only one slide. But, to create a presentation, you need to add more than one 

slide in your current presentation. Apart from adding slides, there are some more operations that you can perform on 

slides, such as insert duplicate slides, apply a slide layout, and so on. Let us learn some basic operations that help you to 

make an appealing presentation easily and quickly. 

To insert a duplicate slide, follow these steps: 

Select the slide in the Slides Pane. 

Click on the Slide menu and select the Duplicate Slide option. Or 

Right-click on the selected slide and select the Duplicate Slide option. Or 

Click-on the Duplicate Slide icon on the Presentation toolbar. 

II  INSERTING NEW SLIDE 

$11  INSERTING A 

Sometimes, it is required to use the title or other components of a slide to the next 

slide. In such situation, you can create a duplicate slide of the selected slide. Duplicate 

slide means creating a replica of the selected slide. 

You can insert as many new slides in your presentation as you need. 

To add new slides into your existing presentation, follow these steps: 
IideShow Jook indow Hcp 

Click on the Slide menu and then select the New Slide option. Or New Slide 

lnert SbdefroFiIe.. 

Click on the New Slide .- - icon on the Presentation toolbar. Or Duplicate ide 

elete Slide 

Select a slide and right-click on it. Selectthe NewSlide option. Or SuOpwy Slide 

Expand Slide 

Press the keyboard shortcut Ctrl+M. 
FIg. 17.2: lnsertJng a New Slide 

+ LibreOffice Impress will add a new blank slide. 

II  SLIDE LAYOUT 

After inserting a slide in the presentation, you need to apply a slide layout. However, 

you can apply a slide layout while inserting a new slide. To select a slide layout, follow 

these steps: 

Select a slide in the Slides Pane. 

Click on the Slide menu and select the Layout option. A submenu appears, select 

therequiredslidelayout. Or 

In the Properties pane, select the desired layout underthe Layouts section. Or 
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Fig. 17.4:  Copying a Selected Slide 

Fig, 17,: Pasting the Selected Slide 
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If you wantto insert a new slide with a slide layout, click on the drop-down arrow of NewSlide ' icon and select 

the required layout. 

II  COPYING AND MOVING SLIDES 

Sometimes, it is required to reuse the slides within the same presentation or in another presentation, or move the 

existing slides to rearrange the presentation. In such situation, you can use the Cut, Copy, and Paste commands. Let us 

knowhowyoucancopyand moveyourslides. 

COPYING SLIDES 

To copyslides, follow these steps: 

+ SelectslidesintheSlidesPane, Or 

Switch into Slide Sorter view by clicking on View>Slide 

Sorter. 

+ Select slides that are to be copied. 

+ Now,click on the Edit menu and selectthe Copyoption. Or 

4 Right-click on selected slides and select the Copy option. 

4 Paste the slides to the desired location by Clicking on 

Edit>Paste. Or 

• Select the Paste option from the Context menu. 

+ The slide gets copied at the new location. 

MOVING SLIDES 

To move slides, followthese steps: 

+ SelectslidesintheSlidesPane. Or 
kw lnit F9m Sde side 9iow 

Switch into Slide Sorterview by clicking on View>Slide Sorter. 4) 1Indo Ed oT*1ettckkto...' Sd+Z 

CM.V 
Select slides thatare to be moved. 

+ 

Now, click on the Edit menu and selectthe Cut option. Or 

Right-click on the selected slides and select the Cut option. 

X cut Qrt.X 

copy Ctr.0 

ctrt.v 

+ Paste the slides to the desired location by clicking on Edit>Paste. 
Fig. 17.6: Selecting Cut Option 

Or In Edit Menu 

Select the Cut option f rom the Context menu. 

' The slide gets moved at the new location. 

Ij  DELETING SLIDES 

To delete the slides from your presentation, followthese steps: 

Switch into the Slide Sorterview, and select the slides that are to be deleted. 

+ Click on the Slide menu and choose the Delete Slide option. Or 

+ Right-click on the slide and selectthe Delete Slide option in the Context menu. Or 

4 Press the Delete key. 
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+ Ctrl+C: To copy the 

selected text 

+ Ctrl+X: To cut the 

selected text 

ctrl +V: To paste the text 
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The term 'Eco-friendly' Is used for 
products and practces. 

What is Eco-friendly? 

In recent years. terms like "Go Green and EcoInendty 
have become buzz words on talk shows, commercials, and 
product packaging. The term Eco-tnendIr Is used for 
many different products and practices, 
By understanding the tnie meaning of the 
you can implement the practices that will Ic  r, w.-....'.,  
living for the planet and its Inhabitants. A .. 

A 

frhe term "Eco-friendly" is  used for many differer 
products and practices. 
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II  RENAMING SLIDES 

It is possible to rename the default names of slides In LibreOffice Impress. To rename a slide, 

follow these steps: 

Select the slide in the Slides Pa ne. 

Lets Know More - 

The Copy Cut <,, 

and Paste commands 

are available on the 

Standard toolbar. 

Click on the Slide menu and select the Rename 

Slide option. Or 

Right-click on the selected slide and choose the 

Rename Slide option. 

The Rename Slide dialog box appears. Enter the 

name for slide and click on OK. 

COPYING, MOVING, AND DELETING CONTENT 

You can copy or move the text anywhere on a slide, either between the slides or from one presentation to another. 

COPYING TEXT 

To copy the text, follow these steps: 

Selectthe text that is to be copied. 

Now, click on the Edit menu and select the Copy option. Or 

Right-click on the selected text and select the Copy option. 

A copy of the selected text will be placed in the clipboard. 

Place the cursor at the new position where you want to insert the 

copied text. 

ClickonEdit>Paste. Or 

Select the Paste option from the Context menu. 

+ Thecopiedobjectwillappearatthecursor'sposition. 

MOVING TEXT 

To move the text, follow these steps: 

+ Select the text that is to be moved. 

+ Now,clickon the Edit menu and selectthe Cut option. Or 

+ Right-click on the selected text and select the Cut option. 

+ The selected text will disappear from the slide and be placed in the 

clipboard. 

+ Placethecursorwhereyouwantthattexttoappear. 

+ ClickonEdit>Paste. Or 

+ Select the Paste option from the Context menu. 

+ The text will appear at the cursor's position. 
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II  DELETING TEXT 

To delete the text from a slide, follow these steps: 

Select the text that you want to delete. 

The border appears around the text placeholder. 

Press the Delete key.The selected text will be deleted. 

I  VIEWING A PRESENTATION 

LibreOffice Impress has the feature of viewing a presentation in different formats. By default, you work in Normal view. 

The view can be changed anytime by clicking on the View menu and choosing the required view. You can also enlarge the 

view by controlling the size of the window. Let us briefly discuss how to control the size of view and uses of different views 

of a slide. 

CONTROLLING THE SIZE OF THE VIEW 

Sometimes, it is required to enlarge a part of a slide or complete slide. In such case, you can use the Zoom & View Layout 

dialog box orZoom sliderthat helps you zoom in or zoom outthe slide view as peryour requirement. 

Tocontrol the size of the view usingthe Zoom &View Layout dialog box, followthese steps: 

Click on the View menu and selectthe Zoom option. 

A submenu appears. Selectthe Zoom option again. Or 

Click on the Zoom Percentage that is located next to the Zoom slider on the 

status bar. 

In the Zoom & View Layout dialog box opens. 

Enterthe value in Variable box to increase the size ofthe view. 

Click on OK. 

You can also use the Zoom slider to zoom in or zoom out of the slide. The zoom slider has two marked sections. By clicking 

on the first one, you can position the slide within the workspace. By clicking on the second one, you can increase the size 

of the view to 100%. 

WORKSPACE VIEWS 

Normal View:  It is the main view for creating and editing slides. You can use 

this view to add text, graphics, sound, animation, and other effects as well. In 

this view, the slide is displayed in the middle of the window. On the left side of 

the window, you see the Slides Pane. Click on the View menu and select the 

Normal option to switch to the Normal view. 
Fig. 17.11: Normal View 

Outline View: This view shows all the slides of a presentation in a sequence. This 

view only displays the text that is contained in the default text boxes (i.e., those 

text panels which are part of the original slide layout). So, the Outline view will not 

display any content that is present in the other text boxes or drawing objects, and 

also the slide names. It shows each slide in the outline format. Click on the View 

menu and select the Outline option to switch to the Outline view. 
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Fig. 17.13:  Notes View 

Notes View: In this view, you can add notes to a slide. These notes are not visible 

when the presentation is shown. They can easily be modified later. The steps to enter 

notes in a slide are described below: 

+ Click on View> Notesto switch to the Notes view. 

SelectaslidefromtheSlidesPane. 

+ You will find a text panel belowthe slide with a prompt box Click to add Notes. 

+ Click here to enter notes for the slide. 

Slide Sorter View:  It displays a miniature view of all the slides in a presentation. The 

slides are visible in the form of thumbnails. It is easy to work on multiple slides using 

this view. You can change the order of slides, copy, or delete slides, add transitions 

and animation effects, and set the timings for slide show in thisview. Click on the View 

menu and select the Slide Sorter option to switch to the Slide Sorter view. 

Fig. 17.14: Slide Sorter View 

II  FORMA1T1NG TEXT IN PRESENTATION 

Just like LibreOffice Writer, Impress provides various formatting features to enhance the appearance of the text added in 

your slides. You can format the text in your presentation by using: 

lhelext Formatting toolbar 

+ TheoptionsavailableunderFormatmenu 

+ The keyboard shortcuts 

THE TEXT FORMATTING TOOLBAR 

The Text Formatting toolbar contains common text formatting options. You can show or hide it by clicking on 

View>Toolbar> Text Formatting. 

B I -- A fl  •.- 

FIg. 17.15: Text Formatting Toolbar 
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Let us learn the use of some commonly used text formatting options available on the Text Formatting toolbar. 

Changing Font: To changefont, selectthetext and click on the Font Name -- drop-down arrow. Select the 

required font. 

FontSlze:To changefont size, selectthe text and click on the Font Size ;- drop-down arrow. Selectthe requiredfont size. 

You can also increase ordecreasethe font size by clicking on the Increase Font Size A1  orDecrease Font Size [g button. 

Making text Bold, Italic and Underline: You can easily make the text Bold B , Italic I and/or Underline U by selecting 

the text and clicking on the corresponding buttons on the Text Formatting toolbar. 

Changing Font Color: To change the font colour, select the text and click on the Font Color _4e. button. The color palette 

appears. Select the required colour. 

Highlighting Color: To highlight the selected text, click on the Highlight Color # button. The color palette appears. 

Select the required colour. 

Strikethrough: To draw a line through the middle of the selected text, click on the Strikethrough 5 button. 

AligningText: There are fourtypes of horizontal text alignments: 

+ Left Alignment: The text is aligned along the left margin while leaving a little space towards the right margin. To left 

align the selected text, click on the Align Left button. 

+ Centered Alignment: This is the default alignment of text in a slide. The text is aligned centrally between the left and 

right margin. It is mostly used for titles. To centre align the selected text, click on the Align Center button. 

+ Right Alignment: The text is aligned along the right margin while leaving a little space towards the left margin. This 

alignment is mostly used to put dates on letter heads. To right align the selected text, click on the Align Right - button. 

+ Justified Alignment: The text is aligned evenly between the left and right margin. To justify the selected text, click on 

the justified button. 

Inserting Bullets and Numbering Lists: You can use the Bullets and Numbering options to create the unordered list and 

the ordered list in Impress, respectively. To insert bullets or numbering list, follow these steps: 

+ Place the pointer from where you want to start the list item. 

+ Click on theToggle Bulleted List orToggle Numbered List button on the Text Formatting toolbar. 

' A bullet or a number appears in the document. Type yourtext and press the Enter key. 

~ The bullet or numberwill automaticallyappear on the next line. Or 

- Selectthe itemsthat you want to bullet or number. 

Click on theToggle Bulleted List orToggle Numbered List button on the Text Formatting toolbar. 

Inserting Superscript: To place the selected text slightly above the line of text, click on the Format> Text>Superscript 

(Ctrl+Shift+P). 

Inserting Subscript: To place the selected text slightly below the text baseline, click on the Format> Text>Subscript 

(Ctrl+Shift+B). 
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Answer the Following Questions: 

1. Write the keyboard shortcut to insert a new slide in a presentation. 

2. How can you copy and move contents in slides. 

3. Write the keyboard shortcuts to Cut, Copy, and Paste slide contents. 

4. What is Zoom slider? 

5. List the different presentation views available in Impress. 

6. How do you insert bulleted list in your document. 

For Better Concept Clarity 

Take an existing presentation and display it in all the available views. Take snapshots of each view by using the 

Ctrl+ Print Screen command. 

óRecap Presentation software is application software, which is used to create multimedia 

presentations in the form of slide shows. 

A presentation is a collection of slides arranged in a sequential manner to convey, persuade, motivate, and 

entertain orto provide information. 

A presentation can be made more interesting and effective by including lists items, background, graphical 

elements, audio and videos, transitions and animation, and so on. 

LibreOffice Impress popular presentation software used to create dynamic slide presentations that can include 

text, pictures, charts, diagrams, audio, videos, narration, transitions, and animation. 

The Standard toolbar gives you the access to use the most commonly used commands, including copy and 

paste, formatting text, and adding new slide. 

A workspace is the blank area in the middle of the window where a slide is displayed. 

When you open Impress, you get a new presentation that contains only one empty slide. 

Templates are inbuilt design used for creating a presentation. They include predefined elements like layouts, 

backgrounds, and color schemes, text styles, etc. 

Duplicate slide means creating a replica of the selected slide. 

The size of view can be controlled by using the Zoom slider orZoom & View Layout dialog box. 

ASSESSMENT TIME 
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The Normalview is the defaultview of the presentation. It is the main viewforcreating and editing slides. 

+ The Outline view only displays the text which is contained in the default text boxes, i.e., those text panels which 

are part of the originalslide layout. 

+ In Notes View, you can add notes to a slide. These notes are not visible when the presentation is shown. 

The Slide Sorter view displays a miniature view of allthe slides in a presentation. 

You can change the order of slides, copy or delete slides, add transitions and animation effects, and set the 

timings for slide show in the Slide Sorterview. 

 

    

   

+ TheText Formattingtoolbar contains common text formatting options. 

              

                   

BRAIN DEVELOPER 

                 

                 

                 

                 

                 

                 

                  

  

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

A. MultipleChoiceQuestions: 

1. Which area is used to edit and design slides? 

a. Slides Pane b. Status Bar c. Notes Pane d. Title Bar 

2. A presentation is a collection of: 

a. Notes b. Slides c. Panes d. Placeholders 

3. Which of the following is not a presentation software? 

a. LibreOffice Suite b. LibreOffice Impress c. OpenOffice Impress d. None of these 

4. It is a sequential display of slide. 

a. Presentation b. Slider Sorter c. Slide Show d. None of these 

5. Which key combination is used to create a new presentation? 

a. Ctrl+S b.Ctrl+O c.Ctrl+N d. Ctrl+C 

6. What do you call the inbuilt designs used for creating a presentation? 

a. Slide Design b. Templates c. Sample Design d. Slide Layout 

7. Which key combination is used to open an existing presentation? 

a. Ctrl+S b. Ctrl+O c. Ctrl+N d. Ctrl+C 

8. Which view is used to write and design a presentation? 

a. Normal b. Notes c. Slide Sorter d. Slide Show 

9. Which key is used to quit a Slide Show? 

a.Esc b.Enter c.Shift d. Tab 

10. From which menu can you get to the Notes option? 

a. Design b. Home c. View d. Insert 
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c.Amobileapp d. Noneoft hese 

slide number, Status Bar: It is positioned at the bottom of the Impress window. It displays information like 

zoom level, and other important information about the current slide. 

11. A handout is a slide in the form of: 

a. A piece of paper b. Slide on screen 

12. Which of the following contains Zoom slider? 

a. Slides Pane b. Status Bar 

B. Give One Word Answer: 

c. Title Bar d. Slides Tab 

1. What type of application software creates multimedia presentations in the form of slide shows? 

2. To which suite does the 'Impress software belong? 

3. When a presentation window opens, what name is displayed on the Title bar? 

4. Name the component of the Impress window which displays the name of the current presentation 

5. In which view do you add notes for slides? 

6. Write the key combination which is used to save a presentation. 

7. What is the default view of Impress window? 

8. Which view displays a miniature view of all the slides in a presentation? 

- 

A. Multiple Choice Questions 

1.(a) 2.lb) 3.(a( 4.(c) 5.(c) 6(b) 7.(b) 8.la) 9.lal 1O.lcl 11.(a) 12.(b) 

B. Give One Word Answer 

1. Presentation software 2. UbreOffice 3. Presenationi 4. Title bar 5. Notes view 6. ctrl+S 

7. Normal view 8. Slide Sorter view 

SECTION 2: THEORY QUESTIONS-(SOLVED) 

1. What is a presentation software? Where do you use this type of software? 

Ans: A presentation software is an application software which is used to create multimedia presentations in the 

form of slide shows. The maximum usage of this software can be seen in the field of entertainment, 

education, corporate training sessions, seminars, and conferences. 

2. What is the difference between Title bar and Status bar' 

Ans: Title Bar: This bar is located at the top of the Impress window. It displays the name of the current 

presentation (Untitled 1, by default). 
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What is a Layout? 

Ans:  A layout defines the basic structure of a slide and arranges your slide content. It provides you different ways 

to position your text, images, and other graphic options. 

Write the different ways of creating a new presentation in Impress. 

ns: We can create a new presentation by following any of the three given options: 

1. Click on the H:: icon present on the Standard toolbar. 

2. Press Ctrl+N. 

3. Click on HIe >New. 

Explain the three different options of alert message which you receive while closing a presentation that has 
not been saved. 

ns: While closing a presentation that has not been saved since the last change, you will get the following three 
options in the message box: 

Save: The presentation is saved and then closed. 

Don't Save: The presentation is closed and all recent modifications are lost. 

Cancel: Nothing happens and you return to the presentation. 

What is the default view of the Impress window? Explain it 

ns: Normal view is the default view of the Impress window. It is the main editing view, which is used to write and 

design a presentation. In the Normal view, you can add text, graphics, sound, animation, and other effects as 
well. In this view, you can also have a large view of an individual slide, notes pane at the bottom, an outline of 
the slide text (Outline tab), and slides displayed as thumbnails (Slides tab), all at the same time. 

Describe the steps used to enter notes in a slide. 

ns: We can add notes to a particular slide in the Notes view. Notes are not visible when the presentation is shown. 
The steps to enter notes in a slide are as follows: 

Select the option in the menu. 

Select a slide on which you wish to add a note. 

The Notes pane will appear below the slide with a prompt box, 'Click to add Text' Click inside the Notes 
pane and to enter notes for the slide. 

What is Slide Show view? How can you access it? 

ns: The Slide Show view shows all the slides of a presentation starting either from the first slide or the current 
slide one after another. In this view, one slide occupies the entire screen at a time. In this view, we can see 

how our graphics, timing, animated elements, movies, and transition effects will look in the actual show. 

To access the Slide Show, follow any one of the following options: 

Click on the Slide Show button present on the Status bar. Or 

Click on the Slide Show menu and select the Start from first Slide option. Or 

Press F5 to start the Slide Show. 
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SECTION 3: APPLICATION BASED QUESTIONS-(SOLVED) 

Mrs. Ahuja, a computer teacher has given you an image of the Impress window. Complete the picture by 

labeling the components of the Impress window. 

Ans: Afterfilling the names of the marked components, the given image will look like this: 
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Raman's computer teacher Mr. Tushar has asked him to create a new presentation. He has also asked Raman 

not to use the keyboard. List the ways by which Raman can create a presentation, without using the 

keyboard. 

Ans: We have two alternate ways to create a new presentation without using the keyboard. 

Click on the Ne icon present on the Qu i-ccssToolba. 

Click on the File menu New> Presentation. 

Aditi wants to create a confidential presentation for her office project. She does not want anybody else to 

view it. What feature should she add in her presentation to enable the prevention against an unauthorised 

access? 

Ans: Aditi needs to protect her presentation by using the Password protection. In this case, she can use the option 

of protecting the file using a password. To protect an entire presentation from being viewed by others, she 
has to follow the given steps: 

Select the option from the Fi! menu. 

The dialog box appears. 

Click on the check box  ye with asswon option, and then click on 

The Set Passworc prompt message box will appear. 

Type the desired password in the nter password to oper text box and type the same in the Confirm 
password text box and then click on DK. 

+ The presentation will be saved with password protection. 

Anita was given a presentation which had a slide whose text was in Times New Roman font, and font size 12. 
Her teacher asked her to change it to Calibri font with font size 14. How can she accomplish this task? 

Anita should first use the Ctrl+ A to select the entire text in the slide. Click on the  onts tab, and select the 
required font (Calibri) under , and required font size (14) under  Size  on the Text Formatting toolbar. 
Click on to apply the changes 

SECTION 4: APPLICATION BASED QUESTION-(UNSOLVED) 

Rohit has got an assignment on different views of slide. He has created sample images to illustrate the topic but 
forgot to name them. Complete his assignment by naming the different views: 
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SECTION 5: THEORY QUESTIONS-(UNSOLVED) 

Define presentation software. 

What do you mean by the term Slide? 

What is the difference between presentation and slide? 

What is Slide Layout? Name any two different Slide Layout options. 

Describe the steps of saving a presentation. 

Write the steps for adding a password to a presentation. 

Explain Standard toolbar. 

Explain the different ways of viewing a Slide Show. 

SECTION 6: LONG ANSWER TYPE QUESTIONS-(UNSOLVED) 

What do you know about Impress software? Explain its features. 

List elements of a presentation. 

Write any two characteristics of a good presentation. 

What is the use of presentation software? What are the most popular presentation applications? 

What are the different formatting options present in Impress? 

How do you insert a duplicate slide in your presentation? 

What is the use of Zoom & View Layout dialog box? 

Discuss the different views of a slide. 

Learning 
Computers wfth  KIPS  <p5 



vn*ofcoIvno - 

6 

 

QK LJ  

FIg. 18,2: Insert Table Through Slide Layout STUDENT DATA 

Fig. 18.3: Table Inserted 

UNIT - V:  Digital Presentation  

CHAPTER 18 
Working with Tables 

LibreOffice Impress is a powerful tool, which helps you to communicate yourviews and ideas effectively using diagrams, 

photos, clip arts, sounds, colours, designs, and animated special effects. Impress provides additionalfeaturesto organise 

the information in a tabular format. A table is a grid of cells arranged in rows and columns. In this section, you will learn 

how to insert a table, apply a table style, and format the table using various commands. 

PII  INSERTING A TABLE 

To insert a table in a slide, follow any of these methods: 

METHOD 1 

Choose Insert >Table. 

+ The Insert Table dialog box appears. 

+ Define the numberof columns and rows. 
18f: Insert Table Dialog Box 

+ ClickonOK. 
• Click to add Text 

+ Atable will be displayed according to the defined columns and rows. 

METHOD 2 

+ Open a new file by using the presentation software and change the 

layout of the slide from the context 

menu or choose Slides> Layout. 

+ Selectthe Title and Content option from the displayed list. 

+ Now, click on the InsertTable icon in the slide. 

+ The Insert Table dialog box will open. 

+ Define the number of columns and rows. 

+ Click on OK. 

• UI  ENTERING DATA IN A TABLE 

After insertingtable in a slide, followthe steps given belowto entercolumn headings or rowentries: 

STUDENT DATA 

Place the mouse pointer in the first cell of the table and type heading. 

Pressthelab keyto move the insertion pointto the next cell. 

Type heading forthe next cell. Similarly, you can insert data in the table 

using the Tab key or Arrow keys or by clicking in the required cell. After 

typing data in the table, click outside the table. 

+ To edit data in a table, click on the cell to be modified and make changes 

in it. 

STUDENT DATA 

8OP40 r48 9flh '380,5 

101 HCm,nt 90 80 90 

102 81, 90 80 

103 80 06 9? 

00 90 80 

100 '3. 90 90 80 

Entering Data in a Table 
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An entire table Place the mouse pointer over the top left corner of a table 

and click. 

To Select Action Do Like This 

 

   

   

A cell Triple-click inside cell. 

A row Move the mouse to the left of the row margin and click 

the left mouse button. 

A column Place the mouse pointer over the top of the column and 

click the left mouse button. 

To select text, follow any of these methods: 

INSERTING ROWS AND COLUMNS INATABLE 

To insert new rows in a table, follow these steps: 

Place the insertion point in a cell. 

Click the right mouse button. 

Select Insert> Rowfrom the Context menu. 

The Insert Rows dialog box appears. 

Specify the number of rows in the Number field. 

Define the placement of rows that are to be inserted using Before or After radio buttons present in the Position 

section. 

Click on OK. 

Likewise, you can insert column(s) in a table by selecting Insert> Insert Column and define its position. 

Ro1N0 

STUDEI 

Nome h... 
0* 

tt Rcy 

Numbe L 

I -- 

101 H0,flC 00 
PostiofI 

V 
I_ .*,- — 0 above eIection 

09 1 l 
eIow s&ectioo 

00 - 

100 00 00 90 liep nceI 

Fig. 18.5:  InsertIng Rows through Right-Click Fig. 18.6: Insert Rows Dialog Box 

FORMATflNG TABLE USING TABLE TOOLBAR 

Fig 18.7: Table Toolbar 

Learning 
Computers with  KLPS4> 



Lets Know More 

To adjust the column 

width and row height, 

bring the mouse pointer 

on the border line of 

column or row. Now, drag 

the pointer in or out to 

adjustthe column width 

or row height, 

respectively. 

Right-click on a 

row/column. Select the 

Row/Column option and 

choose the Delete option. 

The selected row/column 

disappears from the table. 

Quick View 
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When a table is selected by clicking on it, thelabletoolbarappears on the screen. It contains 

the following tools that are used to format the table. 

BODERS It opens a drop-down menu displaying various types of borders that can be 

applied on a table orselected cell(s). 

BORDERSTYLE It is used to change the border style of the selected cell(s) ortable. 

BORDER COLOR It opens a drop-down menu to show a pallete of colours to choose 

from. The colour chosen from the pallete becomes the border colour of the selected cell(s) 

ortable. 

AREASTYLE/FILLING  [coio vJiI l-: It allows you to fill colour, pattern or texture in 

the selected cell(s). Click on the spin arrows of Area Style/Filling button. It will display the list 

of options offering colour, pattern, gradient, etc. Click on the adjacent combo box to select 

the respective colour, pattern or gradient from the list. The selected style will be displayed in 

the cells. 

MERGE CELLS 2 : It is used to combine two or more cells. 

SPLIT CELLS .: Splitting cells refer to dividing the selected cell further into separate cells. 

Clicking on this icon opens the Split Cells dialog box. Specify the number of cells that you 

want the selected cell to split into. Now, select either Horizontally or Vertically option under 

the Direction section. Click on OK. The selected cell will be divided as perthe specifications. 

OPTIMIZE : It is used to evenly distribute the horizontal and vertical space in the selected 

cells. 

ALIGNMENTS : Table toolbar provides three types of vertical alignments — Top, 

Center, and Bottom. The contents of the selected cells are aligned according to the selected 

alignment. 

INSERT ROW ABOVE, INSERT ROW BELOW : It inserts a new blank row above/below 

the selected cell. 

INSERT COLUMN BEFORE, INSERT COLUMN AFTER T : It inserts a new blank column 

before/afterthe selected cell. 

DELETE ROW:  It deletes the selected row. 

DELETE COLUMN:  It deletes the selected column. 

TABLE PROPERTIES: This icon opens the Format Cells dialog box. Using this dialog box, you 

can format Font, Font Effects, Borders, and Background of the table. 

II  FORMA1TING TABLE USING SIDEBAR PROPERTIES 

When you insert a table, Impress automatically shows the table Properties on the Sidebar. 

The Table properties offer various options for formatting a table. Lets discuss some of these 

properties: 

Click on the 

Table tool on the 

Standard toolbar, it opens 

the Insert Table dialog 

box. 



Properti 

" Character 

1jbet ion Sars 

B I&A 

 

i.L 18  

 

  

 

. x2 x2 

Fig. 18.8: Table Character Properties 
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FE:. 13,0: Table Paragraph Properties 

For Better Concept Clarity 

CHARACTER 

The character properties are used to change the formatting of the text 

written inside the table. To apply the text formatting, select the cells and 

then click on the respective tool. The following character formatting tools 

are available: 

Font Name and FontSize 

Bold, Italic, Underline, Strikethrough and Toggle Shadow 

Increase Font Size and Decrease Font Size 

+ Font Colorand Highlight Color 

+ SetCharacterSpacing 

+ Superscript and Subscript 

PARAGRAPH 

The paragraph properties are used to change the alignment settings of the text 

written inside the table. To applythe paragraph formatting, select the cells and 

then click on the respective tool. The following paragraph formatting tools are 

available: 

For horizontal text alignment: Align Left, Align Center, Align Right and Justified. 

Forvertical alignment:  Align Top, Center Verticallyand Align Bottom. 

Toggle List: Bulleted and Numbered 

Spacing: Increase Spacing and Decrease Spacing 

Indent: Increase, Decrease and Hanging 

TABLE DESIGN 

To apply a table design: 

+ Selectthetable. 

+ Click on the desired design from theTable Design section in the Sidebar. 

+ Observethe change 

Your school has raised some funds from each class, i.e., 1 to 12, for the orphanage of your city/town. The 

computer teacher has given you the responsibility to keep the record of this fund. Create a table in Impress, 

and define the collection from each class. Save the table with the name My Collection. 
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A 

For Better Concept Clarity 

ASSESSMENT  TIME 

 

A. Fill in the Blanks: 

1. Atableisa  ofcells. 

2, One can easily format a table using  

 

toolbar. 

  

3. The  cells tool is used to combine two or more cells. 

4. The command evenly distributes the horizontal and vertical space in the selected cells. 

B. Answer the Following Questions. 

1. How to insert a table using Insert menu in an Impress slide? 

2. What are the various options present in the Paragraph section of the Table properties sidebar? 

Your school has raised some funds from each class, i.e., 1 to 12, for the orphanage of your city/town. The 

computer teacher has given you the responsibility to keep the record of this fund, Create a table in Impress, 

and define the collection from each class. Save the table with the name My Collection. 
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Hg. 191:  Insert Image Dialog Box 

  

ACTIVITIES OF THE MONTH 

 

 

  

Hg. 192:  inserting Image from LibreOffice Gallery 

UNIT - V:  Digital Presentation 

CHAPTER 19 
Inserting and Formatting Image in a Presentation 

Presentations can be enhanced by adding images and pictures in them. Images can be added substantially in various ways: 

INSERTING IMAGE FROM FILE 

When a desired image is already available on the computer, it can easily be inserted in a slide. Impress can import various 

types of file formats. The mostcommon are GIF,JPEG,JPG, PNG, and BMP. To insert an image from a file, followthe given 

steps: 

Click on the Insert menu. Select the Image option. Or 

Apply a layout that contains a picture placeholder. Click on the 

Insert Image icon. 

You will now see the Insert Image dialog box. 

Select the folderfrom where you wantto insert the picture. 

Choose the desired picture file and click on Open. _____ 

If the Insert as Link check box is checked, then Impress will 

create a link to the file rather than inserting the original 

image. Linking can reduce the size of a document. The linked 

image and presentation remain two distinct entities, and a copy of that image is not inserted within the slide. 

II  INSERTING IMAGES FROM LIBREOFFICE GALLERY 

The LibreOffice Gallery contains a collection of images that you can use in a presentation. The Gallery is available in all 

the corn ponents of LibreOffice. 

Follow these steps to insert a graphic from the Gallery: 

Click on the Gallery icon present on Sidebar. Or 

Choose View Gallery option. 

Select the Theme that contains the image to be inserted. 

Click on the image, then drag and drop the image into the 

slide. 

You can also right-click on the object and select the Insert 

option. 

FORMAITING IMAGES 

ROTATING A PICTURE 

+ Click on the picture that you want to rotate. 

+ Select the Rotate icon present on the Picture toolbar. 

+ Click on the picture again, the resizing handles change into rotation handleswith a default pivot point (centre point). 
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ACTIVITIES OF THE MONTH 

Fig. 19.3: RotatIng a Picture 

ACTIVITIES Of NTH 

 

 

 

   

   

Fig. 19.4: Flipping a Picture 

Move the pointer to any of the corner handles. The 

pointer changes to a rotate symbol . 

Click and drag the handle to rotate the object as 

required. Or 

You can right-click on the picture, to get the Rotate or 

Flip option. 

It displays furtherthree options to choose from: 

+ Choose Rotateto drag and rotate the picture 

using rotate pointer. 

Choose Vertically to flip the picture upside 

down. 

+ Choose Horizontally to flip the picture 

left to right. 

RESIZING A PICTURE 

Resizing stretches orshrinks the dimension of an object. 

To increase or decrease the size of an object, select 

the object. 

Bring the pointer to any of the eight resizing handles 

on the selected object, and drag the handle inward to decrease and outward to increase the size of the object. 

If you wantto resize the object uniformly, then hold down the Ctrl/Shift key while draggingthe resizing handle. 

DELETING AN IMAGE 

To delete an image from the slide, follow these steps: 

- Select the imagethat you want to delete. 

+ The border appears around the image placeholder. 

+ Press the Delete key. The selected image will be deleted. 

INSERTING IMAGE FROM THE INTERNET 

Toinsert an image of Swami Vivekananda, from the internet, follow the given steps. 

Open any web browserto search for an image of Swami Vivekananda. 

Various images will appear. 

Copy any one of the images of Swami Vivekananda by right-clicking on the image and selecting the Copy image 

option from the shortcut menu that appears. 

Go to the slide where you want to paste the image. Right-click on the slide and select the Paste option from the 

shortcut menu. 

The picture will be pasted on the slide. 

Resize the picture as per your requirement by dragging the resizing handles of the picture, and also position the 

picture properly on the slide. 
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FORMATTING USING THE IMAGE TOOLBAR 

The images inserted on a slide can be formatted using the Image toolbar. The Image toolbar can be inserted from View> 

Tool bars> Image. 
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Fig. 19.5:  Image Toolbar 

1. Position and Size (F4) 12. Area Style/Filling 

2. Align 13. Shadow 

3. Bringto Front (Ctrl~Shift++) 14. Filter 

4, BringForward(Ctrl+~) 15. ImageMode 

5. Send Backward (Ctrl+-) 16. Crop Image 

6. Send to Back (Ctrl+Shift+-) 17. (Flip) Vertically 

7. In Front of the Object 18. (Flip) Horizontally 

8. Behind Object 19. Transformations 

9. Line Style 20. Transparency 

10. LineWidth 21. Color 

11. LineColor 22. Interaction 

!II  DRAWING GRAPHIC OBJECTS 

INSERTING SHAPES IN A SLIDE 

Impress provides different shapes on the Drawing 

toolbar that you can insert in your slide as per your 

requirement. Shapes can be resized, rotated, 

flipped, and coloured. 

On the Drawing Toolbar, click on any of the 

Symbol drop-down arrow and select a symbol 

from the list. 

+  The pointer changes to + sign. Place the 

pointer on the slide and drag itto adjust the size. Fig. 19.6:  Inserting Shapes 

SHAPES 

 

Now, add text inside the shape by double-clicking on the shape. 

The insertion point appears in the shape object. Now, type the text. 

Aftertypingthe text, click on the blank area of the slide. 

The text gets added into the shape. 

Typing Text 
inside Shapes 
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GROUPING AND UNGROUPING SHAPES OR OTHER OBJECTS 

It is often convenient to group shapes together so that 

they are treated as a single shape by Impress. A group of 

shapes can be formatted in a way similar to a single 

shape. They can be moved, rotated, and deleted 

together. Follow these steps to group and ungroup 

shapes: 

Insert two or more shapes in the slide. 

Click on the Selection tool present on the Drawing 

toolbar and drag around the shapes to be grouped. 

Or 

Click on each shape to be added to the group while 

pressingthe Shift key. Fig. 19.8:  Grouping the Objects 

Afterselecting all the shapes, you willfind green resizing handles surrounding the shapes. 

Click on Format > Group > Group or right-click on the selected shapes and select the Group option from the context 

menu, or simply press Shift+Ctrl+G. 

To Ungroup the grouped objects, select the group by clicking on it. Right-click on the selection and choose Ungroup 

from the context menu. 

Fig. 19.9: Selecting the Group Option 

RESIZING A SHAPE 

To increase ordecrease the size of a shape: 

Select the shape. 

Bring the pointer to any of the eight resizing handles on the selected 

shape, and drag the handle inward to decrease and outward to 

increase the size of a shape. 

If you want to resize the shape uniformly, then hold down the 

Ctrl/Shift key while draggingthe resizing handle. 

  

Wr 

 

:1 r':  Resizing a Shape 
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Fiq.  19.11:Area Dialog Box 

Fig. 19.12 Area Dialog Box 

USING SHADOW EFFECTS 

In addition to adding textures and colours, you 

can apply shadow effects to any shape. It will 

make the shapes impressive in appearance. 

Select any shape object. 

Click on the Format menu. Select the Area 

option from the drop-down menu. 

+ The Area dialog box appears. Select the 

Shadow tab. 

Click on the Use shadow checkbox in the 

Properties section. 

Define the Distance between the object and 

its shadow, Color, and Transparency in their 

corresponding text boxes. Click on OK. 

+ The object will appear with a shadow. 

USING SHADOW EFFECTS 

In addition to adding textures and colours, you 

can apply shadow effects to any shape. It will 

make the shapes impressive in appearance. 

Select any shape object. 

Click on the Format menu. Select the Area 

optionfromthedrop-down menu. 

The Area dialog box appears. Select the 

Shadow tab. 

Click on the Use shadow checkbox in the 

Properties section. 

Define the Distance between the object and 

its shadow, Color, and Transparency in their 

corresponding text boxes. Click on OK. 

+ The object will appear with a shadow. 

To apply 3D effects to an object in LibreOffice Impress, use the Toggle Extrusion On/Off button in the 

--
Drawingtoolbar. 
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For Better Concept Clarity 

+ Draw the following shapes and add text boxes as headers to describe them. 

+ Group the relevant shapes and text boxes together and then ungroup them. 

Learning 
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ASSESSMENT TIME 

Answer the Following Questions: 

1. How will you insert an image from the LibreOffice Gallery? 

2. Is it possible to insert an image as a link in a slide? If yes, briefly explain the procedure to do the same. 

3. Which key is used to resize the shape uniformly? 

4. What are the advantages of grouping shapes? 
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UNIT  - V:  Digital Presentation 

CHAPTER2O  

Working with Slide Master 

lI  SLIDE MASTER 

In Impress, Slide Master is a master slide that enables you to control information and formatting of all the slides, such as 

theme, layout background, color, positioning, and so on. Every slide in a presentation has exactly one slide master, also 

known as master page. 

CREATING SLIDE MASTER 

Creating a new slide master is similar to modifying the default slide master. To 

create a slide master, follow the given steps: 

SelectSlide> MasterSlide. 

Clickon Load. 

Under Categories, select a slide design category. 

+ Under Templates, select a template with the design that you want to apply. 

+ To preview the template, click on 

Preview. 

+ Click on OK. Fig, 20.1:  Slide Design Dialog Box 

To apply the slide design to all of the slides in your presentation: 

+ Select the Exchange background page check box in the Slide Design dialog 

box. 

+ ClickonOK. 

To apply the slide design to the current slide only: 

+ Clear the Exchange background page check box in the Slide Design dialog box. 

Fig. 20.2: Load Slide Design Dialog Box  + Click on OK. 

LibreOffice uses three terms for one concept: slide Master, Master Slide, and Master Page. All refer to a slide which is used 

to create other slides. 

T  II  APPLYING THEMES USING SLIDE MASTER 

Themes are the sets of predesigned formats that include text, layouts, background, colour schemes, etc., which can be 

applied to any presentation in orderto enhance its appearance. To applya theme, followthe given steps: 

Click on the Master Slides button on the Sidebar. Under the Available for use section, Impress shows a list of 

availablethemesthat can be applied to yourslides. 

You can click on any theme and see your slide change the way it looks. 

Learning 
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FIg. 20.6:  SettIng image Transparency 
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+ You can also save a particular theme's background image by 

followingthe steps mentioned below: 

+ Selectthethemetobeapplied. 

+ Right-click on the slide to choose Save Background Image 

from the context menu. 

+ Provide a name to save the image file in the LibreOffice gallery. 

• 1I  CHANGING BACKGROUND COLOUR OFA SLIDE 

You can change the background colour, pattern, and texture of a slide, which 

helps you to give a different appearance to your slide. 

RACKGROUND COLOUR 

Click on the Properties button from the Sidebar, The Properties bar is 

displayed. 

Fig. 20.3: Applying Theme to the Slide 
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+ Choose the Background drop-down option and select Color to colour 

the slide background. 

+ From the palette of colours, choose your desired colour for the slide 

background. 

 GRADIENT 
'-   i 

-9- 

I- *N] 

Applying Background Colour 

slide background a mix of two colour shades. 

+ Similarly, a Pattern can also be selected. 

BACKGROUND IMAGE 

+ In the same manner, you can also insert a background image, by choosing 

Insert Image button from the Properties from the side bar. 

Fig. 205:  Setting up the Slide Background 

t I
You can choose Properties from the Slide menu. In the Page Setup dialog box, click on the Background tab and choose 
Color, Gradient, Bitmap, or Pattern. 

II  SEllING IMAGE TRANSPARENCY 

Toset image transparency, follow the steps mentioned below: 

Choose Properties f rom the Slide menu. 

The Page Setup dialog box opens. 

Go to the Background tab and choose Bitmap to insert an image to 

the slide background. 

Open the Page Setup dialog box again. 

Go to the Transparency tab and set image Transparency percentage. 

Click on OK. 



Apply Iransition to All Slides 

Slide Transition 

Modify Trmition 

Variant: 

Duration: 

u n d: 

2.00 sec 

Li hoop until next sound 

Fig.20.7:Applylng Slide Transition 

Shape Box 

Wipe Wheel None 

II lIII ::E 
Uncover Bars theckers 

Wedge 

FEE 
Venetian Fade Cut 

No sound 

Advance Slide 

On mouse click 

L automatic ally after 1.00 sec 

Automatic Preview Play () 

!II  ADDING TRANSITIONS 

Transition effects are special effects that are used to enhance the interest of the audience and make the slides attractive. 

To give a presentation the professional touch, you need to add Transition effects to the slides. Let us learn how to apply 

this effect to the slides. 

APPLYING TRANSON EFFECTS TO A SLIDE 

A Slide Transition is the visual motion when one slide changes to the next during a presentation like Roll down from top 

or Fly in from left, etc. These effects liven up your Slide Show and add dynamic flair to it. Follow these steps to add 

transition effects:- 

Select the slide on which you want to apply the transition 

effects. 

Click on Slide> Slide Transition or click on the Slide Transition 

tab from the sidebar. 

Click on any transition effect under Slide Transition section. 

The current slide will displaya preview of the selected effect. 

You can also select a Variant of the selected transition effect 

underthe Modifylransition section. 

Select any given speed from the drop-down list of Duration 

under Modify Transition section. 

To play a sound, select any sound effect by clicking on the 

drop-down list of Sound box under the Modify Transition 

section. 

The Loop until next sound option now becomes active. Select 

this option to play the sound repeatedly until another sound 

starts. 

If you want to advance to the next slide manually, choose 'On 

mouse click' available in the Advance slide section, else 

select Automatically after for automatic advancement and 

also specify the duration for which a particular slide stays 

visible. 

Click on the Apply Transition to All Slides button, if you want 

to applythe transition to all slides. 

If the Automatic preview checkbox is marked, the effect of 

the selected transition is immediately displayed in the work 

area. You can replay the effect at any time by pressing the 

Play button. 

Click on the SlideShow button ifyou wantto startthe slide showfrom the currentslide. 
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Answer the Following Questions 

1. What do you understand by Presentation Themes in LibreOffice Impress? 

2. What is SlideTransition? Why do you apply it in your presentation? 

3 How will you make your slides advance automatically to the next slide after a certain duration during a slide 

show? 

4 Howwillyouaddanimageinthebackgroundofyourslide? 

For Better Concept Clarity 

1 Create a presentation with ten slides on the topic 'Diversity in India. The presentation should depict the 

history, culture, festivals, food, languages, etc., of our country. Apply various transition animation effects 

to your presentation and make it attractive. 

2. Open any existing presentation. 

+ Select the first slide of the presentation. 

+ Provide transition effects to this slide according to the following settings: 

+ Set Box transition effect. 

+ Choose the variant Inside Out. 

+ Set the transition duration to 3 seconds. 

• Seta sound for this effect. 

$ Set the slide advancement time to 10 seconds. 

+ Let all the slides of the presentation have the same transition effects. 

+ Watch the preview while making the settings apply. 

+ Save the presentation. 

+ Viewtheslideshow. 

ASSESSMENT TIME 
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A table is a grid of cells arranged in rows and columns. They help us to input data in 

the form of fields and records. 

Impress provides Table toolbarthat offers all the tools that are used to formatthe table. 

The Table properties on the sidebar also offer various options for formatting a table inserted on an Impress 

slide. 

Impress supportsvarioustypes of imagefile formats. The mostcommon are GIF,JPEG,JPG, PNG, and BMP. 

Impress supports inserting image links. Image links can help to reduce the size of the presentation file. 

The LibreOffice Gallery contains a collection of Images that can be used in a presentation. 

An image inserted on an Impress slide can be rotated, flipped, resized using various tools present on the image 

toolbar. 

Shapes is a drawing feature that helps in drawing different built-in shapes, that can be further formatted as per 

choice. 

Grouping two or more Shapes together helps in treatingthem as a single shape by Impress. 

Shadow effects makethe shapes impressive in appearance. 

Presentation themes are the sets of predesigned formats that include text, layouts, background, colour 

schemes, etc., which can be applied to any presentation in orderto enhance its appearance. 

+ A SlideTransition is the visual motion when one slide changes to the next during a presentation. 

DEVELOPER  

SECTION 1: OBJECTIVE TYPE QUESTIONS-(SOLVED) 

A. Multiple Choice Questions: 

1. menu contains the New Slide and Layout options in Impress. 

a. Insert b. Format c. Tools d. Slide 

2. The  in the Table toolbar allows you to change the pattern of the border of a table. 

a. Area Style b. Area Filling c. BorderStyle d.BorderPattern 

3. Which alignment option is to be used to align text in the middle ofa cell? 

a. Align Center b. Center Vertically c. Both a and b d. None of these 

4. To apply different background colours to a table, you can use option from the Table toolbar. 

a. Border Color b. Area Style/Filling c. Shape Fill d. Border Style 
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5. To evenly distribute the horizontal and vertical space in the selected cells, use  tool from the Table 

toolbar. 

a. Optimize b. Distribute c. Spacing d. Indent 

6. Which effect is applied to all the slides of a presentation? 

a. Animation b. Transition c. Design d. Layout 

7. Which checkbox is unchecked to set the presentation to advance on its own and display each slide for a specific 

amount of time? 

a. On Mouse Click b. Preview c. Automatically Clicked d. Automatic Preview 

8. The transition effects are available under the menu. 

a. Slide b. Slide Show c.Tools d. Insert 

9. cells option divides the selected cell further into separate cells in a table. 

a. Merge b. Split c. Divide d. Combine 

10. A  is the visual motion when one slide changes to the next during a presentation. 

a. Animation b. Layout 

B. State True or False: 

1. You can insert a Table in an Impress slide by using theTitle and Content Layout. 

2. The Intersection of a Row and Column in a Table is called as a Box. 

3. Once you insert a table, Impress does not have an option to insert new rows or columns in the table. 

4. The Table Design properties allow you to apply various Table Styles. 

5. The Paragraph Properties in the Sidebar allow you to align the text only vertically. 

6. Variation, Duration, and Sound are used to modify transition effects. 

7. Transition effects can be applied to only one slide at a time. 

8. A Slide Transition is the visual motion when one slide changes to the next during a presentation. 

9. You can apply transition effects in the Slide Sorter view. 

10. All the slides of a presentation must have the same transition speed. 

C. Fill in the Blanks: 

1. The images inserted on a slide can be formatted using the toolbar. 

2. . option brings the image in front of other overlapping objects/text. 

3. Impress automatically shows the table Properties on the . of the Impress window when a table is 

selected. 

4. option helps to combine two or more cells ofa table. 

5. The tool on the Image toolbar helps in changing the kGB colour shades of the selected image. 

6. Presentation  are the sets of predesigned formats that include text, layouts, background and colour 

schemes. 

c. Slide Transition d. None of the above 
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7. The Image  button available on the Sidebar helps you change the background colour, pattern, and 

texture of a slide. 

8. The transparency of an image inserted on an Impress slide can be regulated by increasing or decreasing the 

Transparency of the image. 

9.  option present on the Slide Transition dialog is used for automatic advancement of slide(s), 

and also lets you specify the duration for which a particular slide stays visible. 

10. A variant of the selected transition effect can be applied under transition section. 

1 .t!LT1. 

1.(d) 2.(c) 

1.111 2.(Fl 

3.(c} 4.(b) 

3.(Fl 4.(T) 

A. Multiple Choice Questions 

6.(b) 7.(al 8.(al 

B. State True and False 

5.(F) 6.(T) 7.(Fl 8.(T) 

C. Fill in the Blanks 

3. Sidebar 4. Merge cells 

9. Automatically after 10. Modify 

9.(b) 

9. (T) 

5. Color 

10. (c) 

10. (Fl 

 

1. Image 

7. Properties 

2. Bring to Front 

8. Percentage 

 

6. Themes 

SECTION 2: THEORY QUESTIONS-(SOLVED) 

1. What is a Table and how is it useful 

Ans. A table is a grid of cells arranged in rows and columns. It can be used to both store and display data in a 

structured format. Tables are useful for presenting text information and numerical data in an organized 

format. 

2. Name the three common types ui image tiles thai. can be inserted iii a presentation. 

Ans. Impress supports various types of image file formats. The most common are GIF, JPEG, JPG, PNG, and BMP. 

7. \'batarethemes? 

Ans. Presentation themes are the sets of predesigned formats that include text, layouts, background, colour 

schemes, etc., which can be applied to any presentation in orderto enhance its appearance. 

4. Wnat is the purpose ol a Vaterrnark? 

Ans. A watermark is a logo, text, or pattern that is intentionally superimposed onto another image or background. 

Its purpose is to make it more difficult for the original image to be copied or used without permission. 

5. How do von select objects that ynii wish to crouo 

An, To select two or more objects that you wish to group, follow any one of the below mentioned steps: 

+ Click on the Selection tool present on the Drawing tool bar and drag around the shapes to be grouped. 

+ Click on each shape to be added to the group while pressing the Shift key. 

6. How do you ungroup the grouped objects? 

Ans. To ungroup the grouped objects, select the group by clicking on it. Right-click on the selection and choose 

Ungroup from the context menu. 

7. How nm you cppiy a var ant to a Liansition effect? 

Ans. Click on any transition effect under Slide Transition section on the Sidebar. The current slide will display a 

preview of the selected effect. Select a Variant of the selected transition effect under Modify transition 

section. 
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Where can a picture placeholder be found? 

Picture placeholder is found in the layout of a slide. To insert picture on a slide, choose the respective slide 

layout that contains a picture placeholder. 

Which button, when selected, will ensure that the transition effect of all slides is the same as the one applied 

to the current slide? 

ns. The nplv Transition to All Slides button on the 5lide Transitio dialog is used to apply the current slide 

transition effects to all slides. 

0. Why do  YOU need to group objects sometimes? 

n. Grouping multiple objects together helps in treating them as a single entity or object. They can be moved, 

rotated, resized, flipped, copied and deleted together. 

SECTION 3: APPLICATION BASED QIJESTION-(SOLVED) 

foti needs to create a beautiful presentation with the title, 'Diwali' and show the presentation in front of her class 

uring Diwali celebration. How will she perform the followino? 

Download pictures of beautiful Diwali lamps from the internet. 

Insert the downloaded pictures on the second slide of the presentation. 

Group all the pictures of lamps. 

Resize the grouped picture of lamps. 

Rotate the grouped picture of lamps. 

Ungroup the grouped picture of lamps. 

Copy the picture of the most colourful lamp to the next two slides. 

Apply 'Random' transition effect to the slides of the presentation. 

All the slides of the presentation should move automatically one after the another. 

Apply the same transition effects to all the slides of the presentation. 

Use Google or any other search engine to search and download pictures of Diwali lamps. Save all the pictures 

in the same folder to make it easy for further use. 

After the Title slide, Insert the second slide with a picture layout. Click on the picture placeholder to insert 

picture(s), or choose Insert> 

Select all the pictures by pressing Shift key while clicking on them, right-click to open the context menu, then 

choose 

Select the grouped image, drag the selection points to resize the image. 

Select the grouped image, right-click on the picture to get the Rotate or option in the context menu. 

Select the grouped image, right-click on the picture and choose Ungroup from the context menu. 

Select the desired picture, press Ctrl+C to copy it, then go to the next slide and press Ctrl+V to paste. 

Click on Iide> Slide Transition or click on the Slide Transition tab from the sidebar, then choose ndom. 

Select Automatically after  in the  Slide Transitiot dialog on the 

8 
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j. Click on  Apply Transition to All Slides  in the  Slide Transition dialog on the 

SECTION 4: THEORY QUESTIONS-(IJNSOLVED) 

1. What are the different ways to insert a table in a slide? Explain any one way to insert a table. 

2. In which menu is the Picture option found? 

3. What are the three options at the bottom of the Insert Picture dialog box? 

4. How can multiple pictures be inserted at the same time? 

5. In which menu is the gallery of shapes present? 

6. How can you resize a shape? 

7. How can you add text in a shape? 

8. How will you add various effects to a graphical object? 

9. How can you change the colour scheme of a theme? 

10. How can you display the gallery of different background styles? 

11. What are the different Fill options in the Format Background dialog box? 

12. In which dialog box and tab is the Solid fill option found? 

13. What do you understand by transition effects? 

14. How do you apply a sound effect to a slide? How do you check how it sounds? 

15. How do you set the advancement so that each slide advances to the next slide after 15 seconds? 

SECTION 5: APPLICATION BASED QUESTION-(UNSOLVED) 

1. Rajan has created a presentation on school books to show during the Book Reading Week' organised in his 

school. His class teacher asks him to insert a banner on the second last slide of the presentation with text 

"KIPS... The Best School Computer Books". Fill it with light-green colour and apply a suitable Gradient fill to it. 

2. Using shapes create an attractive slide on 'Summer Camp' as shown in the figure below. 
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reate a new presentation as shown in the figure: 

4- First open a blank presentation. 

* Type the Title Heading- Healthy Habits. 

* Add a new slide. 

4- On the second slide, type the 

heading - Healthy Habits. 

4- Type the text as shown in the figure 

4- Insert the picture. 

4- Choose any theme by clicking on 

the Design tab and selecting any of 

the available themes from the All 

Themes list. 

Healthy Habits 

For Better Concept Clarity 
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Time: 2 Hours INFORMATION TECHNOLOGY (SUBJECT CODE 402) Max. Marks: 50 

Sample Question Paper 

General Instructions: 

1. This Question Paper consists of two parts viz. Part A: EmployabilitySkills and Part B: Subject Skills. 

2 PartA: EmployabilitySkills (10 Marks) 

i. Answerany 4 questions out of the given 6questionsofl mark each. 

ii. Answerany3 questions out of the given 5 questions 0f2 marks each. 

3 Part B: Subject Skills. (40 Marks) 

i. Answer any 10 questions out of the given 12 questions of 1 mark each. 

ii. Answerany4 questions from the given 6 questions o12 marks each. 

iii. Answerany4 questions from the given 6 questions of3  marks each. 

iv. Answer any 2 questions from the given 4 questions of 5 marks each. 

4. This question paper contains 39 questions out of which 27 questions are to be answered. 

5. All questions of a particular part/section must be attempted in the correct order. 

6. Themaximum time allowed is2hrs. 

PART A: EMPLOYABILITY SKILLS (10 MARKS) 

A. Answer any4 questions out of the given 6 questions of 1 mark each: 

1. communication isthe mostformal form of communication. 

2. Being accountable means being foryour actions. 

3. isthe master control program ofthe computer. 

4.  price is the price of goods or products when they are sold to customers for 

consumption, and notfor resale. 

5. Green economy emphasises on becoming more efficient. 

6. Ourfamily, neighbourhood, friends, relatives, school constitute our  

B. Answer any3 questions out of the given 5 questions of 2 marks each: 

7. What are the features of effective communication? 

8. Describe briefly the three keyskills required forSelf-Management. 

9. What doyou mean by peripheral devices? How can we categorise them? 

10. What do you understand by the term Business? What are the four forms of business organisations based on 

ownership? 

11. What are the benefits of moving towards green economy? 
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LPART B: SUBJECT SKILLS (40 MARKSJ J 

C. Answer any 10 questions out of the given 12 questions: 

12. RapidTypingincludesa keyboard. 

13. The general appearance and arrangement of text in a document is called  

14. is a group of contiguous cells in a spreadsheet which form the shape of a rectangle or 

square. 

15. A allows you tovisuallydisplaydata in a variety ofdifferentgraphicalformats. 

16. lieS enabled services radically reduce and improve service standards. 

17. Which of the following option in a Word Processor indents all lines other than the first line? 

a. RightTab b.LeftTab c. Hanging Indent d. None of these 

18. Which bar is used toenter, edit, and display the contents ofthe active cell in Spreadsheet software? 

a. Formula bar b. Address bar c. Scroll bar d. None 

19. Which viewcontainsthethumbnailsview of all slides in a presentation? 

a. Normal b. Notes Page c.Slide Sorter d. Slide Show 

20. In a presentation software, which element of the design template stores information about the template, 

placeholder sizes, and position of text and objects, bullet styles, background design, and colour schemes? 

a. Slide Transition b. Slide Master 

21. WhatisthefullformofAiM? 

a. All Time Money 

c.Automaticiransaction Machine  

c. Sample Design d. Slide layout 

b. Any Time Money 

d. Automated Teller Machine 

22. Mention the home row keys for the left and right hand. 

23. What doyou understand byTyping Rhythm? 

D. Answer any 4 questions out of the given 6 questions of 2 marks each: 

24. How has IT influenced the modern education field? Mention anythree points. 

25. Explain the role of typing ergonomics. 

26. What is Thesaurus? How is it used while preparing a document? 

27. What is a Spreadsheet? What are its various elements? 

28. What is the basic difference between BPO and BPM? 

29. What is a slide layout? Howcan it be modified in a presentation? 

L1U.LTJ1 . 
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E. Answer any4 questions out of the given 6 questions of 3 marks each: 

30. Definethefollowingfeaturesofa word processor: 

a) Find & Replace 

b) Navigator 

c) Page Break 

31. What are functions? Suggest the Calc functions which can be used forthe following: 

a) To calculate the average marks obtained by a student in examination, assuming that his/her marks of individual 

subjects are given. 

b) To find the highest marks of Hindi in your class, if marks of all students are given. 

c) To calculate the quarterly sales of a sales executive, if the sales data of all months is given. 

d) To find out the minimum quoted tender rates submitted by various companies to the Govt. of India. 

32. Define the term table. Briefly explain the use of a table in a document. How will you create a table in LibreOffice 

Writer? 

33. Mention the characteristics ofa good quality presentation. 

34. Define lieS. Brieflydescribe the impact of IT in youreveryday life. 

35. What do you understand by Templates? How will you create an Impress presentation based on a pre-defined 

template? 

F. Answer any 2 questions out of the given 4 questions of 5 marks each: 

36. What is cell referencing? What are the various types of cell referencing that can be used in Spreadsheet? Explain 

with suitable examples of each. 

37. What are the various views in LibreOffice Impress? Mention the various operations that can be performed on a 

slide in the Slide Sorter view. 

38. What is Mail Merge? What are the advantages of using Mail Merge in a document? Write the steps involved in 

Mail Merge. 

39. What is Slide Master? How do you create a master slide in LibreOffice Impress and apply it to all the slides of the 

presentation? 
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PROJECT WORK 

LibreOffice Writer 

LibreOffice Caic 

LibreOffice Impress 



ENSURE IT IS NOT YOU! 
So many people lose their lives, succumbing to 

uik ver E)iwah. ()tily bewse they do not 

take enough r autions while bursting 

tireerachers. Do not let it happen in your family. 

Slav away from tirecrackers. 

For a safe and enjoyable Diwali, ensure the following: 

Do not leave children unattended 
l)o not burst flying crackers 
Keep candles, diyas, agarbattis away from clothes and other 
materials that can catch fire 
Avoid wearing loose clothes 
Keep water bucket nearby 
Remove the inflammable material / storage of undemned articles 
from roof tops 
Keep doors and windows closed 

j 

Writer Pro ect-1 

Create a greeting card on HAPPY DI WALl. You can use the search engines, like Google and Bing 

to take image from the Internet. Use any suitable Hindi fonts, like Kruti Dev, Devnagri, Narad, etc. 

Writer Project-2 
Make Poster On 'Say No to Crackers' in writer application. 

Learning 
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Food aMd I#aet1 

Vegetarianism promotes a natural way of life. 

However, despite its implicit message of universal 

love and non-violence, the concept has not spread, as 

it should have. This may be because it usually is an 

inward-looking habit, and is best cultivated in the 

mind. 

In India, a vegetarian is usually a lacto-vegetarian. In 

the Western world vegetarians are sub-divided as 

"vegans"(pure vegetarians who do not take any food 

coming from animal kingdom), lacto-vegetarians, who 

use diary products of the vegetable kingdom, and 

lacto-ova-vegetarians. The last category-includes 

eggs, in addition to the diary products. 

The Western science of food considers food as 

something to sustain only the human body, 

whereas Indian science considers food as 

something which sustains not only the body, 

but also maintain purity of heart, mind, and 

the soul. 

Vegetarian food provides an infinite variety of 

flavours whereas, non-vegetarian foods have 

hardly any taste of their own. In fact, non-

vegetarian food has to be seasoned with 

ingredients from the vegetable kingdom to make them 

palatable. 

In most sports disciplines, vegetarians lead in 

endurance test. "You are what you eat" is an old 

saying, and it is a fact that it is the food that makes the 

man. The food we eat, its quality, quantity, its timing, 

and combination is of utmost importance to healthy 

life. 

It is significant to note that in USA nearly 30 to 40 

million people have adopted vegetarianism in the last 

decade. 

In UK, surveys have shown that the medical bills of 

vegetarians are considerably lower than the non-

vegetarians. 

A vegetarian diet is more useful in the 

treatment of liver disorders including last stage 

of liver failure, when the dietary intake of fat is 

to be reduced. Vegetarians tend to have lower 

blood pressure. Lacto-vegetarian diets with 

higher fiber content, low acid, and high vitamin 

and minerals prevent, and to a certain extent 

relieve the pain felt with the progression of 

arthritis. 

Writer Project-3 

 

 

     

- INSTRUCTIOiJ-- 

+0 In a new document, set the Page Style: 

Top Margin :1" Bottom Margin: 1" 

Left Margin :2" Right Margin: 1.25" 

+ OCreate two columns 

Font: Calibri Heading: Bold, Font Size: 16 

+ Olype the given matter in the columns. 

Font - Anal, Font Size: 12 Pt 

Line Spacing- 1.5 

Paragraph Spacing: 6 Pt each (Before and After) 

+0 Insert a picture from file, and place it in the center of the text. 

+0Click  Arrange group on Format tab. Click on Wrap Text drop-down menu and applyTight option on the 

picture. 

+ 0 Make the first character 'V of'Vegetarianism' a little bigger usingthe Drop Cap effect. 

+ 0 Save the document. 

Learning 
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Provides slow energy. 25% of our diet 
should be fat. 

 

Oils, dairy products, nuts, and 

fish 

Builds and repairs muscle. We only Meats, pulses, and fish 
need 15% of our diet to be protein. 

Writer Proect-4 

 

- 

 

Wh th' wr re€d food? 
We all enjoy and eat food the but why do we need it and what does our body do with it? Below are some of the main 

reasons why we need food: 
Forenergy 

You need food to work your muscles and other body organs. Food is the bodys fuel that keeps it going, without it 

the bodywould not work. 
> For growth and repair 

In orderfor your body to grow you need to make new cells. New cells are also needed to replace old or damaged 

cells. Your body makes these new cells from the chemicals in yourfood. 

> Tostayhealthv 
There are lots of reactions taking place in the cells of your body to keep you healthy and keep your body working. 

Certain chemicals are needed for these reactions which can only be taken in from the food you eat. 

A balanced diet 
In orderto maintain good health, our body must have a healthy and balanced diet. This means we must eat sufficient 

food and also eat a variety of foods, in this way our bodygets alithe different nutrients it needs. 

There are seven nutrition groups found in the food we eat, these are: 

1. Carbohydrates. 

2. Proteins. 

3. Fat. 

4. Fiber. 

5. Vitamins. 

6. Minerals. 

7. Water. 

The different food groups, the sources, and how they help: 

FOOD TYPE 

 

HOW DOES IT HELP? fr  WHERE DO WE GET IT? 

     

CARBOHYDRATES 

 

Provides quick energy. 60% of our diet 
should comprise 'carbs'. 

 

Pasta, cereals, and potatoes 

   

FATS 
Unsaturated fats are healthy. Too much 
saturated fat from animal products can 
lead to heart disease. 

PROTEIN 

VITAMINS 
A- forvision 
B - for energy production and stress 

reduction 
C - to keep skin healthy 
0 - to help bones and teeth  

Helps the body work. Helps 
concentration. 

Fresh fruit and vegetables 

MINERALS 
Calcium - 
Iodine - 
Iron - 

to strengthen bones 
for energy production 
prevents fatigue 

Helps release energy from food. Helps 
decision making 

Fruit, vegetables, and fish 

FIBER Cant be digested. Fills you up and 
keeps you 'regular' 

Fresh fruit, vegetables, and 

wholegrain cereals 

WATER Maintains fluid level The lap! It's all you need most 

of the time 
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I INSTRUCTIONS I 

4 Type an MS Word document as shown in the example. 

4 Page Margins: 

Top: 0.56" 

4 The Headings: 

Font: Anal Black 

Font Size: 18 

4 The Sub-headings: 

Font: Calibri 

Font Size: 16 

4 Document Text: 

Font: Calibri 

Text Alignment:Justify 

Left, Right, Bottom Margins: 1" 

FontStyle: Bold 

Font Color: Green 

Font Style: Bold, Underline 

Font Color: Purple 

Font Size: 14 

4 Give the first page a Border by choosing a color and line style of your choice from the Page Layout Menu 

Option. 

4 Use Bullets and Numbers forthe lists on the first page as shown in the example. 

o Insert an image and format it as follows: 

Give the picture Effects and Borders of your choice from the Picture Tools Menu Option. 

• Create a table showing the Food Groups as given in the example. 

4 Formatthetableasfollows: 

Font: Times New Roman FontStyle: First Column - Bold 

Font Size: Table Heading -16, Table Contents— 12 

Text Alignment: Table Heading- Centre, Table Contents— Left 

Give the table appropriate background colors as peryour choice. 

4 Savethedocument. 

Writer Pro ect-5 
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Roflectnd radirietkrn 
by earth surface 

Infrared 
radiation 
emitted by 
earth 

Effects of Global Warming 

Greonfrouie panes are 
WrsouOta I?rat rise sPa Ih 
•tr000c.n.m and Sap the 
eurt. ounorpy, keopisg heap 
front o,captng. M0atCthewOdd 
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pau000mttndtnthhl. andtsdcttie. 

Dut'mp the 150 oee 
I.. tanat. hens riSen 
4 Poe hells. 
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Global Warming Causes & Effects 

Eathz ,uneea5,e has daso 
a5 I degeo Faiamnhsft 

thetutcenaay The 
pauP 50 pasts OP 
wwrrt9 
has been 
attnbuted e 
human 
athvdy. 

Bumht9 fui auth aa 
coat, aturat pa, and 
Ott produOsa pmun 

houta gaasa In 
oxcoesiva otrt000ta. 

Solution to the problem... 
Investing in renewable energy. (Wind and Solar), 

Plant more trees 

Build more cool cities projects 

Save electricity and power 

Use public transportation 

Eat more organically grown food 

Recycling 

Re-think about your life style 

What is Global Warming? 

Earth is naturally insulated by a delicate 

balance of heat-trapping "Greenhouse" 

gases in the atmosphere. 

When the sun shines on the 

Earth, some of the heat is 

absorbed, keeping Earth 

warm enough to support life. 

Causes of Global Warming 
1. Natural Causes 

- Greenhouse effect 

2. Man-made Causes 

- Carbon Dioxide (Cars, Airplanes and 
Factories) 

- Burning fossil fuels 

- Population 

- Cuttingdowntrees 

Create a thought provoking presentation on GLOBAL WARMING. Take guidelines from the ideas given 
below. Also take the help of the Internet to gather facts and images about Global Warming. You can use 
sites, like slideshare.com, wikipedia.org, etc. and search engines like Google and Bing. 

Global Warm g 

Im 'ress Proaect1 
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Wireless computing uses the radio spectrum rather 

than telephone or Ethernet cables to send digital 
information. The name hearkens back to the earliest 
days of radio, and appropriately since wireless 
computingisvery much a youngfield. 

AN6, LANa, CANs, 
WANs, MANs, GSM, 

GPRS, COMA, WLA,N. 
1DMA. ok'.  

Web Content 
omrnuncabons Da 

Enterpose Data 
Drectory Data 

Appicaton Data 
Vo!ceMdeo 

Any Data 
(To which the user is entittod) 

Create an interesting presentation on WIRELESS TRENDS. Take guidelines from the ideas given below 

but do proper research on the Internet to gather facts and images about WIRELESS TRENDS. You can use 

sites, like slideshare.com, wikipedia.org, etc. and search engines like Google and Bing. 

Wireless Computing 

Any data, any time, any place 

Handset Evolution & Convergence 

Seven Trends in Wireless Living 
WIRELESS COMPUTING 

1. Widespread Consumer Adoption 

2. Convergence in technologies 

3. Connectivity improvements 

4. Desktop power in pocket wireless devices 

5. Enterprises have seen the value of mobilizing 

6. Monetization of content and services 

7. Mobile devices become mobile appliances 

Full Range of Wireless Technologies 

A Vision of the Future 

Impress Project-2   
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Impress Project-3 

Disasters whether natural or man-made can strik 

at any time. 

The general response to a disaster is in terms 01 

relief and rescue operations. 

If we are adequately prepared, its possible to 

severely reduce the impact of a disaster. 

The impact can be reduced through a good 

understanding of preventive actions. 

Create an interesting presentation on DISASTER MANAGEMENT. Take guidelines from the ideas given 

below but do proper research on the Internet to gather facts and images about DISASTER MANAGEMENT. 

You can use sites, like slideshare.com, wikipedia.org, etc. and search engines like Google and Bing. 

Types of Natural Disasters 

Disaster Management Cycle •Mltigstion: Rcduccs the chance of a hazard 
taking place. 

• Risk reduction: Seeks to avoid future risks as a result 
o(a disaster. 

Prevention: Avoiding a disaster even at the eleventh 
hour. 

• Preparedness: Plans made to save lives or property. 

• Response: Actions taken to save lives arid prevent 
property damage. 

• Recovery: Actions that assist a community to 
return to a sense of normalcy after a 
disaster. 

i Disaster can be defined as: 

A sudden accident or natural 

event tIit causes los. of life. 

The biggest problem with the 

disasters is tla suddenne.s 

and swiftness with which 

the arrive. 
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Caic Project-i 

F F E B C D G A 
.1  

2 

3 

4 

PROGRESS REPORT 

ROLL NO NAME HINDI COMPUTER MATHS ENGLISH TOTAL PERCENTAGE 

5 101 Ajay 67 50 77 45 239 

6 102 Arshla 34 67 66 67 

7 103 Ahana 66 78 44 89 

8 104 JaVa 88 56 22 67 

9 105 Joy 66 67 78 67 

10 106 Tom 55 45 56 56 

11 107 Sarika 34 55 66 34 
12 108 Ramesh 45 78 89 78 
13 109 Gagan 56 34 67 56 
14 110  Sarab  70 89 89 L 66 

INSTRUCTIONS 

4 Entertheheading'PROGRESSREPORT'incellC2. 

4 Set the Font- 'Bookman old style', Font Size-16 pt. 

4 Highlightthe heading and select Merge Cells option to merge the cells intoone. 

4 For the field names, set Font- 'Aria I' and Font Size44. 

4 Enter the data. After entering Roll number 101 and 102, use AutoFill option to fill rest of the 

entries. 

4 CalculateTotal using Sum function. 

4 Copythe formula of Total in rest of the cells in the same column by using drag method upto G14. 

4 Calculate the percentage in cell H5 using the formula =G5/4. 

4 Copy the formula in rest of the cells. 

4 Select cell B8and clear its contents. 

4 Move the contents of cell BlOto 88 and type Vikram in cell B1O. 

4 Plot the data in Column chart. 

• Display the Students' name on X axis and Marks on Y axis and apply all formatting effects to it. 

• Savetheworksheet. 

Learn in 
Computers with  KIPS  4P 



£ 

L 
6 

7 

8: 

9 

WEATHER REPORT 

- 
CITIES 

L 
MAX 

TEMPERATURE 

MIN 

Amritsar 40.2 21.3 

Mumbai 32.1 20.5 

Chandigarh 33.0 19.5 

Chennai 40.1 28.5 

Delhi 38.4 24.6 

Pune 39.3 24.7 

Jaipur 38.3 24.1 

12 Lucknow 31.0 20.5 

INSTRUCTIONS 

4> Design a Worksheet as shown above to display Weather Report of different cities. 

4> For the Headings, set Font-Anal and Font Size-16 pt. Set Font Size -14 pt. for field names and for 

rest of the data entries Font Size -12 pt. 

4> Find Maximum Temperature of column C using MAX() function. 

4> Find Minimum Temperature of column D using MlNfunction. 

4> Apply border on the worksheet by clicking on More Border button in the Font group on the 

Home tab. Select your desired Borders style and change its colorto red. 

4> Select thefield namesand fill with yellowshade. 

4> Change the color ofthetextto blue. 

• Plot the data in Bar chart. Give the ChartTitle - "Weather Analysis". Change its Font to 'Tahoma 

Font Size-14 pt, and Font Color- 'Blue'. 

4> Right-click on ChartArea and select Format ChartArea tab. Change the background color of the 

Chart Area to gray. 

4> Change the placement of Legend to bottom. 

4> Savethefile. 

'p 
Caic Project-2 
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INSTRUCTIONS 

• Design a Worksheet as shown above to display the score of each cricketer. 

• Find the total score of Rohit Sharma in cell D4 by using the formula =SUM(B4:C4) 

• Drag and Copy the formula from cell D5 to D14to calculate the total score of other players. 

• Find maximum and minimum score in the innings by using Max() and MIN() functions. 

• PlotthedatainaColumnchart. 

• Change the Font, Font Size, Font Color, and Style of ChartTitle CRICKET MATCH'. 

o Change the minimum Scale value of V axis to 20. 

o Format the Legend by applying Border color and Border style of your choice. 

o Savetheworksheet. 

Caic Project-3 

A B C 

 

D 

   

I CRICKET MATCH 
RUN 

TOTAL I! 
2 

PLAYERS 
3 INNING4 

157 

INNING.lI 

63 4 Rohit Sharma 

5 Shikhar Dhawan 101 125 

6 ViratKohli 60 73 

7 Yuvraj Singh 82 2 

8 Suresh Raina 58 75 

9 MS Dhoni 48 62 

10 RavindraJadeja 130 54 

11 RavichandranAshwln 72 23 

12 Bhuvneshwar Kumar 68 53 

13 MohitSharma 42 28 

14 Mohammed Shami 15 10 
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